
HP Server Automation

for the HP-UX, IBM AIX, Red Hat Enterprise Linux, Solaris, SUSE Linux Enterprise Server, 
VMware, and Windows® operating systems

Software Version: 9.0
User Guide: Server Automation
Document Release Date: June 2010
Software Release Date: June 2010
 



Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2001-2010 Hewlett-Packard Development Company, L.P.

Trademark Notices

Intel® Itanium® is a trademark of Intel Corporation in the U.S. and other countries.

Java™ is a US trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, Windows® XP are U.S. registered trademarks of Microsoft Corporation.

Oracle™ is a registered trademark of Oracle Corporation and/or its affiliates.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

The title page of this document contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:

http://support.openview.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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1 Getting Started with the SAS Web Client
SAS Web Client

The following section describes Supported Browsers for the SAS Web Client (a web 
application) and Browser Configuration Requirements.

Supported Browsers for the SAS Web Client

The following table lists the supported browsers for the SAS Web Client.    

Browser Configuration Requirements

To use the SAS Web Client, your browser must be configured in the following manner:

• The browser must accept cookies and be able to use Java. 

• The browser must support SSL and should provide 128-bit encryption (recommended).

• Using a pop-up blocker might prevent some functions from working correctly. Either 
disable the pop-up blocker completely or use the supported browser’s native pop-up 
blocking function instead of a third-party product.

Table 1 Supported Browsers for the SAS Web Client

Browser
Windows

Vista
Windows 

2000
Windows 

2003
Windows

XP

Microsoft Internet 
Explorer 5.5 X

Microsoft Internet 
Explorer 6.0 X X X

Microsoft Internet 
Explorer 7.0

X X X X

Microsoft Internet 
Explorer 8.0

X X X X

Mozilla 1.6 X X X

Firefox 1.0 X X X

Firefox 2.0 X X X X

Firefox 3.0, 3.5 X X X X
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Access to Features in the SAS Web Client

This section explains how to configure your user profile to access features within the SA 
System. This section contains the following topics:

• System Management of SA User Information

• Best Practices for Selecting Passwords

• Updating User Profiles and Passwords

System Management of SA User Information

An SA administrator creates additional users who can use the SAS Web Client, and the SA 
administrator assigns them temporary passwords. Once added to the system, an SA user can 
update their personal information, password, and time zone and date display preferences by 
using the My Profile link. 

An SA user cannot change their access permissions by using the My Profile link. If an SA user 
needs additional access permissions, they contact their SA administrator.

Best Practices for Selecting Passwords

The HP Server Automation  enforces a security policy that allows only authorized users to log 
into the SAS Web Client. SA users are advised to select a password based on the following 
guidelines:

• Change your password frequently to ensure that your account information is secure.

• Select a password that is easy to remember so that you don't have to write it down.

• Use a mixture of upper and lower case letters, numbers, and punctuation in your 
password.

• Do not share your password.

• Do use a password that you can type quickly, without having to look at the keyboard.

Updating User Profiles and Passwords

As an SA user you can change your name, contact information, password, and preferences 
such as time zone and date display. You cannot change your access permissions. Contact your 
SA administrator to change your access permissions.

Perform the following steps to change your profile and password.

1 Log into the SAS Web Client. The SAS Web Client Home Page appears.

2 Click the My Profile link located at the top of the page. The My Profile Page appears.

3 To change your profile information, enter new information on the User Identification tab 
of the My Profile Page.

4 Click Save.

5 To change your password, click the Change Password Link. The Password Change page 
appears.

6 Enter your old password.
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7 Enter your new password.

8 Confirm your new password in the Confirm Password field.

9 Click Save. A confirmation page appears indicating that your password was successfully 
changed. 

10 Click Okay. The Profile page appears.

 User Interface

The following section discusses getting started with the SA System and contains the following 
topics:

• Requirements for Logging In

• Overview of the SAS Web Client User Interface

• My Profile

• Search

• My Servers

• Mouseover Icon Tooltips

Requirements for Logging In

In order to log in and access SAS Web Client features, your SA administrator must have 
created a user name and password for you, and assigned user permissions that control the 
features you can access, the actions you can perform, and the resources you can access.

Overview of the SAS Web Client User Interface

The SAS Web Client user interface consists of the five following sections: 

• Home Page

• Tasks

• My Jobs

• My Customers

• Navigation Panel

Home Page

Figure 1 shows the Home page as it appears when you log in or when you click the Home link 
in the navigation bar.
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Figure 1 SA System Home Page 

The time zone that appears in the upper right corner of the Home page is taken from the time 
zone preference that was defined for you when your profile was created. Consequently, the 
date and time information that displays throughout the SAS Web Client is for that time zone. 
The occasional exceptions however are always labeled GMT.

Tasks

The Tasks area of the Home page displays links to the wizards that you have permissions to 
access, a link to the Code Deployment page if you have that permission. If you do not have 
permissions to a task in this area, the task name still displays, but it is italicized and it is not 
an active link. Figure 2 shows the Tasks area with all permissions enabled. 

Figure 2 Tasks Area of the Home Page    

My Jobs

The My Jobs area of the Home page is populated with details of the jobs that you have run, 
jobs that are currently in progress, or jobs that you have scheduled to run, including the name 
of the job, the start time, the number of servers affected by the job, and the status of the job. If 
there are more than six jobs, you can see the rest of them by clicking the See All link, which 
also shows the total number of jobs in parentheses, as Figure 3 shows.
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If the job was run in the SA Client, then there will be a link next to the job that (when clicked) 
will launch the SA Client. You can view the more detailed information about the job in the SA 
Client.

Figure 3 My Jobs Area of the Home Page    

My Customers

The My Customers area of the Home page is populated with customer information, including 
unreachable servers associated with a customer and the total number of servers associated 
with that customer. To select the customers to display in the My Customers area of the Home 
page, click Edit and select the check box next to the customer name. See Figure 4.

Figure 4 My Customers Area of the Home Page 

Navigation Panel

The navigation panel on the left side of the SAS Web Client shows all possible features, as 
shown in Figure 5. The features you can access and the actions you can perform depend upon 
your user profile, as defined by the SA administrator. 
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Figure 5 Navigation Panel, All Permissions View 

The items that appear in the navigation panel depend on the permissions the user has. 
Clicking an item on the navigation panel displays that feature in the main part of the Home 
page. For a user with all permissions, the following links appear:

Home: Displays the top level of the SAS Web Client. The Home page is described in this 
section of the guide. Wizards are documented in their respective functional areas of the 
system.

My Jobs: Displays the My Jobs page, showing jobs completed during the previous 30 days, 
jobs currently in progress, and currently scheduled jobs. This page is an expanded view of the 
contents of the My Jobs area of the Home page and has the same effect as clicking Show All 
in the My Jobs area of the Home page.

Servers: Expands to display these selections:

— My Servers: Use to add any server or server group to your own personal view of 
servers. My Servers provides an efficient way to manage servers when your 
operational environment contains hundreds or thousands of servers.

— Manage Servers: Use filters to display a list of servers and perform operations on 
them such as edit server values, assign, run scripts, and add servers to My Servers. 
See Server Management in the SAS Web Client on page 225 for more information.

— Search: Find specific servers using default criteria or user-defined criteria. See 
Server Search on page 201 for more information.

— Server Pool: Use filters to display a list of servers, install operating systems on the 
servers, and delete the servers. See SA User Guide: Application Automation for more 
information.

Software: Expands to display these selections:

— Operating Systems: Prepare operating systems for installation and delete existing 
operating systems. See SA User Guide: Application Automation for more information.
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— Scripts: Run scripts, upload scripts, and create new scripts. See Script Execution on 
page 34 for more information.

Environment: Expands to display these selections:

— Customers: Create new customers and edit or delete existing customers. See the SA 
Administration Guide.

— Facilities: Create new facilities, edit facility properties, and assign and edit custom 
attributes for facilities. See the SA Simple/Advanced Installation Guide.

— Hardware: A read-only view of servers categorized by the hardware manufacturer 
and model, and their related information. See Hardware Information for Managed 
Servers on page 223 for more information.

— Service Levels: Define service levels and custom attributes. See Service Levels on 
page 273 for more information.

— IP Ranges: Identify and create IP ranges and IP range types. See the SA Policy Setter 
Guide for more information.

— IP Range Groups: Create IP Range Groups. See the SA Policy Setter Guide for more 
information.

Code Deployment (when enabled): Expands to display these selections:

— Deployment Home: The exact CDR links that you see in the Code Deployment area 
are based on the permissions that you have for the customer you want to work with. 

— Service Management: Create, modify, and delete service definitions. Services define 
the location and commands to manipulate applications on hosts. 

— Run Service: Perform service operations on one or more hosts, or request that a 
service operation be performed on your behalf. Service operations include starting or 
stopping applications, cutting over or rolling back code, and backing up or restoring 
code. 

— Sync Management: Create, modify, and delete synchronization definitions. 
Synchronizations define the path for pushing code from a source host to one or more 
destination hosts. 

— Synchronize: Perform a synchronization to one or more hosts, or request that a 
synchronization be performed on your behalf. 

— Sequence Management: Create, modify, and delete sequence definitions. Sequences 
allow the grouping of service operations and synchronization operations to define 
higher level code deployment operations. 

— Run Sequence: Perform a pre-defined sequence of service operations and 
synchronizations on one or more hosts, or request that a sequence be performed on 
your behalf. 

— View History: Get information about previously run Code Deployment operations. 
See Code Deployment and Rollback on page 309 for more information.

Administration: Expands to display the following features. For more information about 
these features, see the SA Administration Guide and SA Policy Setter Guide. 

— Users & Groups: Administrators use this feature to create user groups, define 
permissions for those groups, create new administrators, and add users to groups. 

— Server Attributes: Define and edit server use attributes, enable them for code 
deployment, and define deployment stages. Also define and edit server deployment 
stage attributes.
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— Software Repository Mirroring: Contains the configuration parameters that 
control whether Software Repository mirroring is enabled for the selected host and 
the amount of time in minutes between mirroring runs.

— System Configuration: Contains the configuration parameters that define how the 
SA System works in your environment. This selection is only used at the direction of 
SA.

— System Diagnosis: Runs a series of tests on SA components to make sure that they 
are functioning correctly. 

— Opsware Software: Provides a view of the properties, custom attributes, installation 
order, and history of the software attached to the SA in the system.

— Gateway: Allows you to connect Satellites associated with this or other cores. 

The Administration set of features is only available if you are logged in as an SA 
administrator.

Navigation

Top-level navigation from the Home page is simple. To access any of the features in the 
navigation panel, click the feature name. To access any of the wizards or other features in the 
Tasks area of the Home page, click the name of the task. 

After you select a task or a feature, other pages appear, which might have one or more of the 
following means of navigation:

• Clicking a hyperlinked name to display a page

For example, if you select Software ➤  Scripts (assuming that you have the correct 
permissions), the page that appears shows all of the scripts that have been uploaded so 
far. 

• Selecting a tab to display a page

For example, when you select Manage Servers and click one of the hyperlinked server 
names, the resulting page shows a row of tabs, like Figure 6 shows.

Figure 6 Example of Tabs 

Each tab displays a page, each with its own buttons and functionality.

• Clicking a button to display a page

For example, when you select the Custom Attributes tab, a page appears with several 
buttons: Add, Delete, and Copy, which are common to each page called by these tabs, 
and Add Custom Attribute, which is unique to this particular tab. You will find similar 
functionality on all tabbed pages in the SA System.

My Profile

You can update your own personal user information without the assistance of the SA 
administrator with the My Profile link. You can change your first and last name, your contact 
information, your password, and your time zone and date display preferences.
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Search 

At the top of the Home page open the dialog box as Figure 7 shows.

Figure 7 Search Function 

You can search for servers, jobs, and server groups, by making the selection from the 
drop-down list, and then entering an identifying string in the text box.

My Servers 

The My Servers feature provides a convenient place to store a set of servers that have been 
selected and stored using the Add to My Servers function in Manage Servers. You might use it 
as a shortcut to the servers you work with most often, or as a way to gather a group of servers 
when you want to apply the same changes to all of them. All functions that are available in 
the Manage Servers page are also available from within My Servers.

Mouseover Icon Tooltips

When an icon appears on a page in the SAS Web Client, a tooltip displays information about 
the icon when your mouse pointer hovers over it. For example, server icons display messages 
such as “Available or Build Failed” to describe the state of the server. Packages and patches 
display messages such as Available, Managed, Unmanaged, and so forth.
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2 Getting Started with the SA Client
Overview of the SA Client

The SA Client is a powerful Java client for the HP Server Automation (SA) system. It provides 
the look-and-feel of a Microsoft Windows desktop application with the cross-platform 
flexibility of Java. 

The SA Client provides the following features: 

• Discovery and Agent Deployment

• Server Explorer

• Virtualization Director

• Audit and Remediation

• Server Automation Visualizer (SAV)

• Storage Visibility and Automation

• Software Management

• Patch Management for Windows

• Patch Management for Unix

• Application Configuration Management

• Global Shell

• Integration with NA and SE

For descriptions of all the SA Client features, see SA Features on page 31.

In order to visualize networking information with Network Automation (NA) inside of Server 
Automation Visualizer (SAV), you must have both a licensed version of NA integrated with 
your SA core, plus an additional license to run SAV showing NA data. 

Additionally, to visualize storage data in the SA Client, your SA core must be configured to 
connect to Storage Essentials (SE). For information, see the Storage Visibility and Automation 
User Guide. 
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SA Client and SA Launcher

The SA Launcher is a self-contained Java application that allows you to access the SA Client 
from any core in your mesh. You can use the SA Launcher to log in to and download the latest 
version of the SA Client. If the SA Client has been upgraded on a specific core or on a core in a 
different mesh, you can choose which core you would like to use for downloading the SA 
Client. 

The SA Launcher also allows you to configure advanced settings, such as debug settings, 
locale settings, proxy server settings, and more.

This section contains the following topics: 

• SA Client and SA Launcher Requirements

• Installing the SA Launcher

• Launching the SA Client

• SA Launcher Advanced Options

SA Client and SA Launcher Requirements

The SA Client is a Java application that installs and runs with its own Java Runtime 
Environment (JRE). The SA Client will not interfere with any other versions of JRE installed 
on your system. The JRE will not be used (and is not usable) by any other Java application on 
the target computer, and it will not set itself as the default JRE on the target computer. 

The SA Client is supported on the following Microsoft operating systems: 

— Windows Server 2003

— Windows 2000

— Windows XP

— Windows Vista

The minimum system requirements to run the SA Client are as follows: 

— Minimum 1 GB of DRAM

— Minimum 100 MB of disk space each for SA Client and SA Launcher

— If using the SA Client to connect to a core with a residential VoIP connection, a 
minimum 384 Kbps DSL connection is recommended. 

— You must be logged in as a user with sufficient permissions to install software on the 
computer. (You do not need to be an administrator user to install the launcher.)

To run the SA Client, you must download and install the SA Launcher (accessible from the 
SAS Web Client). In order to install the launcher, you must be a Windows user that is able to 
install applications on your system.

If you are upgrading to SA 7.80, you will need to uninstall the previous verion of the SA SA 
Launcher (using the Windows uninstall utility), and then install the latest version according 
to the instructions found  at Installing the SA Launcher on page 31
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Installing the SA Launcher

In order to run the SA Client, you need to download and install the SA Launcher, which is a 
Java application that allows you to access the SA Client from any core in your mesh. When 
you install the SA Client launcher, it installs all of the necessary Java applications (Java Web 
Start and JRE) you need to run the SA Client.

If you are upgrading to SA 7.80, you will need to uninstall the previous version of the SA 
Client SA Launcher (using the Windows uninstallation utility), and then install the latest 
version.

To install the SA Launcher, perform the following steps: 

1 Open a Web browser and enter the URL that points to the SAS Web Client.

2 On the SAS Web Client login page, click the Download SA Launcher.

3 Download the SA Launcher installation file and double-click to start the SA Launcher 
installer 

4 In the Welcome window, click Next to begin the SA Launcher installation.

5 In the License Agreement window, select the “I accept the agreement” and then click Next 
to proceed with the installation.

6 In the Select Destination Directory window, accept the default installation directory, or 
click Browse to select a custom location. Click Next. 

7 In the Select Start Menu Folder window, accept the default name and click Next.

8 In the Select Additional Tasks window, accept the default options or choose your own, and 
then click Next to install the SA Launcher. 

9 When the installation has completed, click Finish to exit.

Launching the SA Client

The launcher allows you to log in to an SA core using the SA Client. If your organization has 
installed and configured one or more multimaster meshes in your data center, you can choose 
to log into any SA core in your meshes. The SA Client gives you access to all devices in your 
data center as well as all the features you need to automate and manage your data center. 

You also have the option of choosing which core you want to use to download the latest version 
of the SA Client, separate from the core you log in to. For example, when you log into a core 
and that core has a new version of the SA Client, the new version will automatically be 
downloaded when you log in. Using the launcher, you can choose one core to log in to and a 
separate core to download the latest client. This gives you the freedom to not have to 
download the SA Client every time you log into a different core.

The SA Launcher allows you to log on to a SA 6.50 and above core. If you attempt to log into a 
pre-SA 6.50 core, you will get a 404 page not found Java Web Start error message and not be 
able to log on to the core.

If you are running the SA Launcher on Windows 2000, you may see a missing DLL error 
message when you log on. This error will not affect the log on procedure. To fix this so the 
error message does not appear, install this Microsoft update: http://
support.microsoft.com/default.aspx?scid=kb;en-us;259403&Product=vc6.
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To launch the SA Client, perform the following steps: 

1 Start the SA Launcher from one of two locations: 

— On your desktop, double-click the Server Automation  Client icon.

Or

— From the Start menu, select ➤  All Programs ➤  HP Business Service 
Automation ➤ HP Server Automation Client 

2 In the Log In to Server Automation  window, enter your SA user name, password, and the 
SA core server you want to log in to, as shown in Figure 8. 

Figure 8 Log In the SA Client Window 

The user name is not case sensitive. If you have access to more than one core server in a 
mesh, you can enter the core server’s IP address or name in the core server field. If you do 
not specify a port with the host:port notation, port 80 is used to download the SA Client.

If this is the first time you are logging in to a specific core, the launcher will download the 
latest version of the SA Client when you log in. If you would like to differentiate between 
the core you log in to and the core from which you download the latest version of the SA 
Client, you can change those options by clicking More in the log in window and 
configuring your Client Host Server. For information on this and other advanced SA 
Client SA Launcher options, see SA Launcher Advanced Options on page 33.

3 Click Log In.

4 If you are asked to accept the certificate from the core server, click Yes. The SA Client 
appears. 
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SA Launcher Advanced Options

You can configure the following advanced options for the SA Client: 

• Debug Settings: Gives you control over the level of detail as well as the type of 
information included in SA Client log file. 

• Client Download Server: Allows you to change the host server from which you want to 
download the SA Client. 

• Proxies: Allows you to configure the SA Client proxy server settings.

• Server Automation  Home: Allows you to change the default location SA Client is 
downloaded and saved on your local computer, and to delete the SA Client’s cache, and to 
change the location of SA Client log files. 

To configure the SA Launcher’s advanced options, perform the following steps: 

1 Start the SA Launcher from one of two locations: 

— On your desktop, double-click the SA Launcher icon

Or

— From the Start menu, select ➤  All Programs ➤  HP Business Service 
Automation ➤ HP Server Automation.

2 In the Log In to Server Automation  window, you can set the following configuration: 

• Username: Enter your SA username.

• Password: Enter your SA user password. 

• Core Server: Choose the SA core server to log in to. 

3 Next, click More. In the expanded launcher window, you can now configure the following 
settings: 

• Locale: Select the version of the SA client to match your system’s locale. English (en) 
is the default, but you can also select either Japanese (ja) or Korean (ko). 

• Debug Settings: Debugging options that are captured in the following log file: 
<user_home>\Application Data\HP BSA\deployment\log\javaws\*.log

— Enable Debug Logging (Fine): Enables debugging and sends SA Client 
operations and errors to the log file. 

— Enable Server Method Call Logging: Adds server method calls to the log file. 

• Show Console: Displays the Java Console window while the SA Client runs. 

4 Click Advanced Settings.

5 In the Advanced Settings window, you can configure the following SA Launcher options: 

Client Download Server 

You can configure the SA Launcher so the default core you log in to is different from the 
core you use to access the latest version of the SA Client. This can be useful if you do not 
want to download a new version of the SA Client each time you log in to a different core 
running the same version of SA.

— Use Core Server: Select this option to download the SA Client from the same 
server you want to log in to. 

— Use: Enter a core server you want to use to download the SA Client. 
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The SA Client uses two ports: port 80 to download the SA client; port 443 to connect to the 
core specified in the main log in window. If you select the Use Core Server option, the connect 
port (443) cannot be overridden. If you select the Use option, the download port (80) can be 
overridden in the Use field and the connect port can be overridden in the Core Server field in 
the main log in window.

If you do not specify a port with the host:port in the Use field, port 80 is used to download the 
SA Client. In the Core Server field in the main log in window, if you do not specify a host:port, 
then port 443 is used to connect to the core.

Proxies 

By default, the SA Client uses the proxy server settings configured for the default browser 
on your local system. For example, if your default browser has no proxy server settings 
configured, neither will the SA Client. You can change those proxy server settings here:

— None: Do not use a proxy server to connect to the SA Client.

— Use Browser: Use the proxy server settings specified in your default browser. 

— Manual: Enter the proxy server hostname and port. 

— No Proxy Hosts: If you want to add proxy server overrides, add them here, 
separated by commas. (This is only enabled when proxy server settings is set to 
Manual.)

Server Automation  Home 

— Location: The location where the SA Client is downloaded and saved on your 
local computer, along with all log files generated when the SA Client runs.

Note that starting with SA 7.50, this location also controls where the SA Client data cache 
is stored.

The default home location is <user_home>\Application Data\HP BSA, which is private to 
each user. If you choose to change this location, be aware that other users may have access to 
the new directory. You are responsible for setting the permissions on the new directory if you 
want to prevent unwanted access to your SA Client home.

— Delete Application Cache: Clicking this completely removes all downloaded 
copies of the SA Client. This ensures the launcher will download the latest SA 
Client from the core the next time the user logs in.

— Delete Logs: Delete all log files created by previous sessions of the SA Client. (All 
SA Client log files are located at: <user_home>\Application Data\HP 
BSA\deployment\log\javaws\*.log)

6 When you are finished setting the options, click OK to save your settings. 

7 Click Log In to log in to the SA Client.
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SA Client User Interface

The SA Client user interface provides easy access to all of the SA Client features and 
functionality. The SA Client user interface has six main areas: 

— Menus

— Navigation Pane

— Search

— Content Pane

— Details Pane

— Status Bar

Figure 9 SA Client User Interface    

Menus

The SA Client includes the following menus: 

— File: This enables you to open a new SA Client window, or close the current window, 
or exit all open SA Client windows. 

— Edit: This enables you to cut, copy, paste, delete text, and copy SA Client URLs.

Status Bar

Navigation 
Pane

Content Pane

Details Pane
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— View: This refreshes the current view and shows the latest information from the core 
that you are currently logged into (such as compliance test information for the 
compliance dashboard). You can also access SA Client features in the Navigation 
pane, such as Devices (groups of devices, managed and unmanaged servers), Reports 
(Compliance Dashboard, Reports) Software Library (application configuration, patch 
management), OS sequences and OS installation profiles, Jobs and Sessions (job logs 
and shell sessions), and Administration (patch settings and patch compliance rules). 
This also allows you to show or hide the Search pane and the Details pane.

— Tools: This enables you to open a Global Shell session, open the Server Automation 
Visualizer, or access the SA Client options. 

— Actions: Depending upon the feature that you have selected in the Navigation pane, 
this menu enables you to perform numerous functions related to all main SA Client 
features. 

— Window: This enables you to access multiple instances of SA Client windows, if more 
than one window is open. 

— Help: This menu provides help for the SA Client. Help F1 provides context-sensitive 
help relevant to the current feature window selected or opened (same as pressing the 
F1 key). The contents and index will open the SA Client help system to the main table 
of contents. (The About SA Client menu provides version and system information.) 
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Navigation Pane

To access SA Client features, select a feature in the Navigation pane, as shown in Figure 10. 
When you select a feature, its contents appear in the Content pane. You can access functions 
related to it through the Actions menu. 

Figure 10 Navigation Pane    

Search

The Search feature allows you to search for any information in HP Server Automation, such 
as Server, Device Group, Folder, Job, Software, Patch, Application Configuration, Software 
Policy, Database and Storage Systems, Patch Policy, Audit, and Snapshot Results. For more 
information on how to use the search tool, see SA Client Search on page 43.
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Figure 11 Search in the SA Client 

Content Pane

Depending on the selection in the Navigation pane (Devices, Library, Reports, Jobs and 
Sessions, Administration), the Content pane lists the following information:

— All managed servers and device groups, including unmanaged servers — both 
physical and virtual

— Agent deployment information

— Application Configurations and configuration templates

— Software Policies

— Storage objects and their attributes

— Audit and Remediation audits, audit policies, and snapshots

— Patches and patch policies

— OS installation profiles and OS sequences

— Packages

— Reports and the Compliance Dashboard

— Custom attributes

— Jobs that the user has run

— Access to the Global Shell sessions

— Patch configuration and patch compliance rules

Figure 12 is an example of the Content pane for managed servers. You can perform actions on 
features in the Content area using the Action Menu, or you can right-click to perform various 
actions or double-click to open.
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Figure 12 Content Pane Showing Server History  

Content Pane Tools

From inside the Content pane, you can perform the following actions: 

— With the View drop-down list, you can change the view of a selected feature. For 
example, you can select a server from the Content pane, and then from the View 
drop-down list, choose Software Policies. This shows all software policies attached to 
the server, as shown in Figure 13.
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Figure 13 View Drop-down List    

— You can click the column headings of the Content pane to sort data about a feature. 
For example, for a managed server, you can sort by Summary, Properties, IP address, 
OS, and so on.

— With the search tool, you can search the Content pane by filtering a a single column 
by a substring search, as shown in Figure 14.

Figure 14 Search Tool  

Details Pane

The Details pane allows you to preview information about servers, device groups, patches, and 
patch policies selected in the Content pane without having to open a new window. 

You can use the Details pane to perform the following actions: 

— Preview information about a server, device group, patch, or patch policy. To do so, 
select it in the Content pane. 

— Select the type of information you view in the Details pane. From the top of the 
content area, choose a view from the View drop-down list. 

— Deactivate the Details pane. To do so, from the View menu, select Details Pane ➤  
Minimize. 

For example, if you are viewing Windows 2003 patches from the Library, you can select a 
patch in the Content pane and see information about the patch in the Details pane. This is 
shown in Figure 15.
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Figure 15 Main Application Windows Showing Package Properties Information in 
the Preview Pane  

To view other types of information about the selected patch, from the View drop-down list, 
choose a view.

Details Pane Show Filter

Some features displayed in the Details pane allow you to further filter the feature. Using the 
Show drop-down list, you can choose different views of the feature.

For example, if you are viewing all of the servers that the patch policy is attached to, in the 
Details pane, you can filter either Servers with Policies Attached or Servers with Policies Not 
Attached, as shown in Figure 16.

Figure 16 Details Pane Show Drop-down List  

Details Pane
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Status Bar 

At the bottom of the SA Client Application window, the status bar provides the following 
information: 

• Informational text (left hand side) about the selected object

• A progress bar that shows progress on retrieving information from the core

• The user ID

• The current HP Server Automation time

Figure 17 SA Client Status Bar 

Sharing SA Client Objects with Drag and Drop

You can easily drag and drop servers and other SA Client objects out of the SA Client and into 
an email, a chat window, or a document editor. When you drag an object out of the SA Client, 
a URL is constructed that enables you to launch the object in the SA Client. 

You can share such SA Client objects as servers, application configurations, audits, a Business 
Application, Patch Policies, OS Profiles, and more — basically, any device (server, storage, 
network, and so on) or any object from in the SA Library that is searchable.

You can also use the URL that is created during drag and drop as a link on a web page, which 
gives you easy access to those SA objects you are most interested in. 

In order to drag and drop networking devices from the SA Client, you must have a licensed 
version of Network Automation (NA) integrated with your SA core. Additionally, in order to 
drag and drop storage devices from the SA Client, SA core must be configured to connect to 
SE. For more information, contact your HP sales representative. 

To drag and drop a SA Client object, perform the following steps: 

1 From inside the SA Client, select a server, network or storage device, device group, Patch 
Policy, a Business Application, an audit, or any other object in a table.

2 CTRL+drag the selected object to one of the following locations: 

• Document editor

• Chat window text entry box

• Email

3 When you or another user clicks the link, you are asked to open or save the file. After the 
file is downloaded and saved, click Open. 

4 In the Log In to Server Automation window, enter your SA user name, password, and the 
SA core server you want to log in to and click OK. 

If the SA Client is already opened, and the object you are opening belongs to the core you 
are logged into, the object appears in its own window without requiring you to log in.
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Besides CTRL+drag, you can also use the Edit ➤  Copy menu, or SHIFT+CTRL+C to copy 
the link into the Windows clipboard, and then paste it into another application.

Copy and Paste Table Data

In this release, you can copy and paste data from tables inside the SA Client into other 
applications. For example, if you are viewing a list of managed servers, Windows Audits, 
Solaris 10 patches stored in the SA Client Library, or jobs scheduled to run in the next month, 
you can select one or more rows in the list, and then copy and paste them into a text file, email 
message, spreadsheet application, or other document processor.

The following restrictions to this capability:

• Column headings for a list are not selectable. This means that they are always copied.

• Values in the copied list might appear differently when pasted into a target application, 
depending on how the target application renders tables.

• The target application must understand a table description either in HTML format (with 
mimetype "text/html") or as a tab/newline delimited string (with mimetype "text/plain")

To copy and paste table data in the SA Client, perform the following steps: 

1 From inside the SA Client, browse to the table that you want to copy. 

2 Make sure that the application you want to paste the data into is open.

3 Select the rows you want to copy.

4 To copy the rows, perform one of the following actions:

a Press CTRL + C. 

b From the Edit menu, select Copy. 

c Use the cursor to drag the rows.

5 In the application you want to paste this data into, place the cursor and press CTRL + V 
or drop the rows if you are dragging them with the cursor. The data is copied.

SA Client Search

In the SA Client, you can search for any information about your operational environment that 
is available in Server Automation  using the SA Client Search feature. This information 
includes: Application Configuration, Application Configuration Template, Audit, Business 
Application, Database, Device Group, Extension, Folder, Job, OGFS Script, Packages, Patch, 
Patch Policy (Windows), Server, Server Script, Snapshot, Software Policy, Patch Policy 
(Solaris), and Storage Systems.

To search for storage devices in the SA Client, your SA core must be configured to connect to 
Storage Essentials. For more information, contact Support.

The SA Client Search feature enables you to perform the following actions:

• Perform a simple search by using keywords.
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• Perform an advanced search by creating search queries.

• Save a search query. 

• Delete a saved search query.

• Perform actions on search results. 

• Email search results. 

• Print search results.

• Customize search results formatting. 

Performing a Simple Search

In the SA Client, a simple search enables you to search for items by entering a keyword in the 
search text field. When you enter a keyword or any phrase, simple search carries out a 
“contains” operator search on the entered text.

The search operation returns only items on which you have (at minimum) read permissions. 
To perform an action on an item, you must have write permission on that item.

To perform a simple search, complete the following steps:

1 From the drop-down list in the Search Pane, select the item you want to search, such as 
Software Policy, as shown in Figure 18. 

Figure 18 Simple Search in the SA Client 

2 Enter the search text in the text field. The SA Client search feature does not support a 
wildcard search and the search is not case sensitive.

3 Click  to search. The search results appear in the Content pane. 

4 (Optional) Click on any column heading to sort the search results. You can also change the 
order of the columns by dragging the column heading and dropping it in the desired 
location.

5 (Optional) Click Save to save your search query. The Save As dialog appears. Enter the 
name of the search and then click Save. The name of the saved search cannot exceed 64 
characters. See Creating a Device Group Using Search on page 141 for more information 
about saving a search query as a device group.

6 (Optional) Click Export to export search results to a .csv or .html file. The Export Results 
window appears. Enter the location, file name, and file type and then click Export 
Results.

7 (Optional) After you export the search results, you can email the search results by 
attaching the exported file to the email. 
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8 (Optional) You can also print the search results by printing the exported file from an 
application that supports .csv or .html files.

9 (Optional) To perform an action on the search results, select an item from the Content 
pane and then from the Actions menu, select the appropriate action.

Performing an Advanced Search

In the SA Client, an Advanced search enables you to create complex queries on search items. 
In a search query, you can specify up to five search rules and combine each rule with a logical 
“And” or logical “Or” operator. You cannot use both the “And” and “Or” operator in a single 
search query.

You can create more complex logical expressions using the SearchService interface in the 
com.opsware.search package of the SA Twister API. For more information on the SA Twister 
API, see the HP Server Automation Platform Developer’s Guide.

Each rule is a combination of an attribute, operator, and value that enables you to search for a 
specific attribute value for the selected search item. Depending on the attribute that you 
select, the options for the operator and value are displayed. You can specify the attribute 
values by entering text or a numerical value in the text field, by selecting a value from the 
drop-down list, or by selecting multiple values from a list of values in the Select Values 
window. 

The Select Values window appears when you need to specify multiple values for a rule 
containing an “equals” or “not equals” operator. In this window, you can select one or more 
values from a list of available values.

Format of Advanced Search Rules

Advanced search rules take the following form:

Search for: <Item>

Where: <Attribute> <Operator> <Value>

• <Item> is the object you are searching for, such as servers, patches, patch policies, storage 
devices, jobs, folders and other items in your managed environment.

• <Attribute> is data about the item you want the rule to examine.

• <Operator> is a comparison you want to perform between the <Attribute> and the 
<Value>.

• <Value> is the specific data you want to compare to the <Attribute> using the <Operator>.

The search operation returns only items on which you have (at minimum) read permissions. 
To perform an action on an item, you must have write permission on that item.

Searching for All Items

To perform an advanced search, complete the following steps:

1 From the Navigation pane, select Advanced Search. The Advanced Search page appears 
in the Content pane. 
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By default, the Search For “Server” item is selected in the first drop-down list and one 
search rule is added to the search. 

2 From the Search For drop-down list, select the item you want to search for. Figure 19 
shows “Server” as the item to search for.

Figure 19 SA Client Search 

3 Create a rule by selecting the attribute from the first “Where” drop-down list. The figure 
above shows “Agent Discovery Date” as the search attribute. Depending on the attribute 
that you select, the operators and values for the rule will change.

4 Select the operator from the second “Where” drop-down list. The operator selected defines 
how the search text is treated. Figure 19 shows “Equals” as the operator.

5 Enter a value in the field or select a value from the drop-down list or click  to select one 
or more values from the Select Values window. Figure 19 shows “02-04-09” as the value 
for the Agent Discovery Date.

6 (Optional) Click  to add rules and repeat steps 3 to 5. 

7 (Optional) Click  to delete any rules.

8 Select the Logic (logical And or logical Or) to be applied for every rule in the query. 

9 Click Search or press Alt-S to run the search query. The search results appear in the 
Content pane.

Figure 20 shows a search for all managed servers with unreachable agents that are 
running Red Hat Linux AS 3.
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Figure 20 Server Search Results for Servers with Unreachable Agents

10 (Optional) Click Reset to clear the search query rules or click Cancel to cancel the search 
operation. 

11 (Optional) Click on any column heading to sort the search results. You can also change the 
order of the columns by dragging the column heading and dropping it in the desired 
location.

12 (Optional) Click Save to save your search query as a .csv or .html file. The Save As dialog 
appears. Enter the name of the search query and click Save. The name of the saved 
search cannot exceed than 64 characters. The saved search query appears in the Saved 
Searches drop-down list. See Creating a Device Group Using Search on page 141 for more 
information about saving a search query as a device group.

13 (Optional) Click Export to export search results to a .csv or .html file. The Export Results 
window appears. Enter the location, file name, and file type and then click Export 
Results.

14 (Optional) After you export the search results, you can email the search results by 
attaching the exported file to the email. 

15 (Optional) You can also print the search results by printing the exported file from an 
application that supports .csv or .html files.

16 (Optional) To perform an action on the search results, select an item from the Content 
pane and then from the Actions menu, select the appropriate action.

Searching for Jobs

You can search for jobs by device groups they affect. To search for jobs, perform the following 
steps:

1 From the Navigation pane, select Jobs and Sessions. The Job Logs pane appears. 
Getting Started with the SA Client 47



2 From the Search drop-down list, select Advanced Search. 

By default, the Search For “Job” item is selected in the first drop-down list and one search 
rule is added to the search.

3 Create a rule by selecting the attribute from the first “Where” drop-down list. Depending 
on the attribute you select, the operators and values for the rule will change.

4 Select the operator from the second “Where” drop-down list. The operator selected defines 
how the search text is treated.

5 Enter a value in the field or select a value from the drop-down list or click  to select one 
or more values from the Select Values window.

6 (Optional) Click  to add rules and repeat steps 3 to 5. 

7 (Optional) Click  to delete any rules.

8 Select the Logic (logical And or logical Or) to be applied for every rule in the query. 

9 Click Search or press Alt-S to run the search query. The search results appear in the 
Content pane.

See Browsing Job Logs on page 56 for more information.

Running a Saved Search Query

To run a saved search query, perform the following steps:

1 From the Navigation pane, select Search.

2 From the Saved Searches drop-down list, select a search query. The query appears in the 
Advanced Search Content pane. The query is automatically executed and the search 
results appear in the Content pane.

Deleting a Saved Search

To delete a saved search query, perform the following steps:

1 From the Search pane, in the Saved Searches drop-down list, select a search query that 
has been previously saved. The saved search is displayed in the Advanced Search Content 
pane.

2 Click Save to display the Save As dialog box.

3 Select the saved search, right-click, and then select Delete. 

4 In the “Delete existing search” dialog box, click Delete. In the Save As dialog box, the 
deleted search query does not display because it has been deleted.

5 Click Cancel to exit the Save As dialog box.

Accessing SA Client Options

You can configure the following options for the SA Client: 
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• General Options: This enables you to set options such as choosing the core you want to log 
into by default, how to handle caching, and so on. 

• Unmanaged Server Options: This enables you to set options for the Agent Discovery and 
Deployment feature.

• Terminal and Shell Settings: This enables you to configure your Terminal (UNIX) and 
RDP (Windows) client for the Global Shell and Remote Terminal connections. 

• Patch Policies: This enables you to specify that a confirmation message will display when 
you try to remove a patch policy or a patch policy exception from a managed server.

• Network Automation: This enables you to reset the name of the NA host that you log into, 
restore the previously saved (default) host name, and launch the NA login window.

• Server Automation Visualizer: This enable you to specify timeout values for launching 
SAV and the manner in which you want SAV to scan virtual server relationships. 

Accessing SA Client Options

To set SA Client options, perform the following steps: 

1 From the Tools menu, select Options.

2 From the left side of the Set Options window, choose an option. 

General Options

The following general options enable you to select your default core: 

Core Server Defaults

This option allows you to configure the core that you log into from the SA Client. Options 
include: 

• Host: This enables you to choose the name or IP address of the SAS Web Client host that 
you log into by default.

• Port: This enables you to choose the port number of the SAS Web Client host that you log 
into by default; 443 is the default.

Cache

This option enables you to configure the caching of data displayed inside the SA Client. You 
can configure the following cache settings: 

• Check for updates every X minute(s): This enables you to enter a value for how many 
minutes will pass before the cache is refreshed.

• Update Cache: This enables you to check instantly for new information from the core. 

• Reload the Cache: This enables you to immediately reload (refresh) the cache.
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Progress Information

This option shows the progress of a job. When a job finishes, the Progress window closes.

Equals Operator Limit in Search and Reports

This sets limits on the number of available value selections in the Advanced Search and 
Reports interfaces. To prevent delays and excessive system load, the list of available values is 
not populated when the number of values exceeds this setting. Values are added by entering 
them in a text box.

Unmanaged Server Options

These options allow you to specify how you will communicate with unmanaged servers and 
how you will bring them under SA management. You can set the following options: 

• Installer Options on page 50 explains certain actions you can specify when installing the 
SA agent to bring the server under SA management.

• Protocol Port Settings on page 51 explains how to set the port numbers to use for different 
remote communication protocols.

• Advanced Installer Options on page 51 explains other actions you can specify when 
installing the SA agent to bring the server under SA management.

For more information, see Agent Management on page 63.

Installer Options

From the Installer Options window, you can set the Installer options and control the 
installation of a Server Agent on a server. The Installer Options window enables you to 
perform the following actions:

• Start the Server Agent after Installation: This enables you to start the Server Agent 
after installing it on the server. By default, the Server Agent Installer does not start the 
Server Agent.

• Ignore prerequisite check failures: This enables you to ignore prerequisite check 
failures and forces Server Agent installation.

• Set the server’s time from the Opsware core: This enables you to synchronize the 
time on the server in which the Server Agent is installed with the SA core.

• Install Windows Installer (MSI) if required: This enables you to install MSI along 
with the Server Agent. If MSI is already installed, this option has no effect.

• Install Windows Management Instrumentation (WMI) if required: This enables 
you to install WMI along with the Server Agent. If the WMI is already installed, this 
option has no effect.

• Reboot Windows servers after agent installation: This enables you to reboot 
Windows servers after the Server Agent installation is complete. 

• Install Red Hat Package Manager (RPM) on AIX and Solaris: This enables you to 
install the RPM handler with the Server Agent. SA recommends that you always include 
this option when you install Server Agents on Solaris and AIX servers.

• Reset Server Agent configuration, if present: This enables you to replace the 
existing Server Agent configuration.
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• Delete gateway address list, if present: This enables you to delete the SA Gateway 
address list, if present and no longer required. 

• Overwrite staged Server Agent installer: This enables you to overwrite the existing 
Server Agent Installer.

• Log Level: This enables you to set the log level for log messages. With this option, you 
can specify levels for error, warning, info, and trace.

Protocol Port Settings

The Protocol window allows you to specify the standard port to connect to the servers for 
deployment. The following protocols are used:

• SSH: This enables you to determine the standard port to connect to the servers for 
deployment using the SSH protocol.

• Rlogin: This enables you to determine the standard port to connect to the servers for 
deployment using the Rlogin protocol.

• Telnet: This enables you to determine the standard port to connect to the servers for 
deployment using the Telnet protocol.

• NetBIOS: This enables you to determine the standard port to connect to the servers for 
deployment using the NetBios protocol.

• WTS: This enables you to determine the standard port to connect to the servers for 
deployment using the WTS protocol.

Advanced Installer Options

The Advanced Installer Options window allows you to set the following options:

• Immediately do a full hardware registration: This enables you to force the Server 
Agent Installer to report full hardware information to the core.

• Immediately do software registration: This enables you to force the Server Agent 
Installer to report full software information to the core.

• Suppress Server Agent reachability check: This enables you to disable this check 
during installation. By default, the installer triggers the core to check if the server is 
reachable. 

• Disallow anonymous SSL connections if Server Agent is dormant: This enables 
you to configure the Server Agent so that browsers cannot connect without a valid 
certificate.

• Force creation of new device record if conflict found: This enables you to suppress 
this functionality. During registration, the Data Access Engine creates a new device 
record. 

• Fail if initial hardware registration fails (do not go dormant): This enables you to 
ensure that the Server Agent does not become dormant, if it fails to report hardware 
information.

• Do not open Windows Firewall for core-agent communications: By default, the 
Server Agent Installer will modify the Windows Firewall configuration on Windows XP 
and Windows 2003 (r2) servers to allow the SA core to contact the managed server on port 
1002. If you select this option, the firewall configuration will not be modified. The server 
may not be manageable by SA in this case.
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• Remediate software policies: This enables you to remediate the server against any 
software policies attached to the server.

• Attach to software Policy ID: This enables you to attach the server to the software 
policy ID.

• Reconcile Type (deprecated): (Applicable only for upgrades) This enables you to 
reconcile the server against any nodes assigned to the server. The reconcile type can be 
Full or Add only.

• Attach to template ID (deprecated): (Applicable only for upgrades) This enables you 
to assign the nodes contained in the template to the server.

• Install directory (UNIX): This enables you to specify the directory where the Server 
Agent will be installed. By default, the Server Agent is installed in /opt/opsware/agent 
on UNIX, and %ProgramFiles%\Opsware\agent on Windows.

Extra Installer options: This enables you to specify any other installer options. For 
example:

--log file <path> allows you to specify the path to the installer log file. By default, 
the installer log files are placedin the /tmp on Unix or 
%SYSTEMDRIVE%\WINDOWS\SYSTEM on Windows.

--workdir <path> allows you to specify the path to the working directory to use 
while the installation is in progress.

• nmap parameters: This option allows you to specify parameters used when scanning for 
unmanaged servers. If you find that the Discovery and Agent Deployment is unable to 
correctly locate and identify unmanaged servers due to the network firewall 
configuration, you can specify a different set of scan parameters. See the nmap 
documentation for more information.

Terminal and Shell Settings

These settings define the command that the SA Client invokes on your PC to open a Global 
Shell or start a remote terminal session. (For instructions on using an ssh client instead of the 
SA Client, see Opening a Global Shell Session on page 289.) See also Opening a Remote 
Terminal Session on an Unmanaged Server on page 82.

To view and change terminal and shell settings, perform the following steps.

1 In the SA Client, select the Tools ➤  Options menu item. This displays the Set Options 
window.

2 In the View pane, select Terminal and Shell. This displays the commands that will be 
used when connecting to managed and unmanaged servers.

The following sections describe how the terminal and shell settings are used and how to set 
them.

In order to use remote login capabilities to access unmanaged servers using the Secure Shell 
(ssh) or Remote Login (rlogin) protocols, you will need to install a client program capable of 
communicating via these protocols. Once you have installed these programs, you must 
configure the SA Client to invoke those programs.
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Terminal Client

This setting specifies the terminal client that the SA Client uses for remote terminal sessions 
on Unix managed servers, on unmanaged servers using telnet and for Global Shell sessions. 
This setting is used when you select a managed Unix server and select Actions ➤ Open 
With ➤ Remote Terminal. It is also used when you select an unmanaged server and select 
Actions ➤  Log in with ➤  telnet. It is also used when you run the Global Shell using 
Tools➤  Global Shell.The default value is:

cmd /c start /w cmd /c "(telnet %h %p || echo > nul) && echo %m && pause > nul"

The telnet program emulates a command-line terminal session. The %h represents the host 
and the %p is for the port number. See Table 2 "Variables for the Terminal, RDP, Rlogin and 
SSH Client Options" on page 54. 

If you change the Terminal Client setting from the default value, make sure that the 
command blocks until the terminal application terminates. The terminal application must not 
run in the background. If you specify cmd /c start, include the /w switch to make cmd block 
until the underlying command (such as telnet) completes.

You are not required to use telnet as the terminal application. For example, you could use 
putty, the free Windows application that supports SSH, rlogin and telnet. To use a putty 
client, you could specify the following command: 

"C:\\Program Files\\putty\\putty.exe" -telnet %h %p

RDP Client

This setting specifies the Remote Desktop Protocol (RDP) client that the SA Client uses for 
remote terminal sessions on Windows managed servers and unmanaged servers. This setting 
is used when you select a managed Windows server and select Actions ➤ Open With ➤  
Remote Terminal. It is also used when you select an unmanaged server and select Actions 
Actions ➤  Log in with ➤  Windows Terminal Services. The default value is the 
Microsoft Terminal Services Client:

mstsc "%r"

The SA Client supports the Windows XP version of the Remote Desktop Connection Software, 
which can be downloaded from http://www.microsoft.com/windowsxp/downloads/tools/
rdclientdl.mspx.

The specified terminal client must be installed on your PC. To verify the existence of the 
terminal client, click the Test button.

The command can include variables such as %h and %p representing the host name and port 
number, respectively. When the terminal client is launched, these variables are replaced with 
the values shown in Table 2 "Variables for the Terminal, RDP, Rlogin and SSH Client 
Options" on page 54. To override a replacement value, specify a constant instead of a variable. 
For example, you might specify 435 for the port instead of %p.

Rlogin Client

This setting specifies the terminal client and configuration settings that the SA Client uses to 
remotely log in to unmanaged Unix servers. This setting is used when you select an 
unmanaged server and select Actions ➤ Log in with ➤ rlogin.

You must specify a client program that can communicate over the rlogin protocol. For example 
you could use putty, the free Windows application that supports SSH, rlogin and telnet.
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For the Rlogin Client setting, specify the command line to invoke your rlogin client.

The following shows a sample putty command you can use to remotely log in to an unmanaged 
server using rlogin.

putty -rlogin -l %u -P %p %h

SSH Client

This setting specifies the terminal client and configuration settings that the SA Client uses to 
remotely log in to unmanaged Windows servers. This setting is used when you select an 
unmanaged server and select Actions ➤ Log in with ➤ ssh.

You must specify a client program that can communicate over the SSH protocol. For example 
you could use putty, the free Windows application that supports SSH, rlogin and telnet.

For the SSH Client setting, specify the command line to invoke your SSH client.

The following shows a putty command you can use to remotely log in to an unmanaged server 
over SSH.

putty -ssh -l %u -P %p %h

 

Table 2 Variables for the Terminal, RDP, Rlogin and SSH Client Options

Variable Description Replacement Value

%e The character encoding. For Remote Terminal sessions, the encoding of 
the managed server. For Global Shell sessions, 
the value of the Encoding field.

%h The host name that the client 
is to connect to.

The value of the localhost of the managed 
server.

%m A locale-specific message on 
how to close the window.

For English locales, click the Enter key to close 
this window.

%p The port that the telnet client 
is to connect to.

A randomly chosen port.

%r The name of the Remote Desk-
top (RDP) connection file. This 
variable is used only for the 
Microsoft Terminal Services 
Client (mstsc).

A temporary RDP file generated at runtime by 
the SA Client.

%t The title displayed in the ter-
minal window.

For Remote Terminal sessions, the name of the 
managed server. For Global Shell sessions, the 
string “Global Shell.”

%u The user name to pass to the 
client.

Specifying %u causes SA to display a dialog and 
request a user name. Enter the user name and 
select Log In. SA passes the specified user 
name to the client.
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Encoding

This sets the encoding for Global Shell and the Remote Terminal sessions. This option is the 
replacement value of the %e variable in the command specified by the Terminal Client field. 
The default value of the Encoding option is UTF-8.

Patch Policies

This option allows you to specify that a confirmation message will display when you try to 
remove a patch policy or a patch policy exception from a managed server.

Network Automation

This options allows you to reset the name of the NA host that you log into, restore the 
previously saved (default) NA host name, and test whether SA can communicate with NA by 
using the new host name.

• Host: This option specifies the name of a server that is acting as a proxy for the NA host. 
Only the format of the host name is verified.

• Restore Default: This option restores the previously saved NA host name.

• Test: This option opens the NA login window to verify whether the host name is valid.

Server Automation Visualizer 

For SAV, you can specify the following options: 

• Virtualization Settings

• Scan Time-Out Preference

• Discovery Settings

• Reset All Settings

Virtualization Settings

You can configure SA Client options that allow you to choose whether or not you want to 
perform a scan on any virtual servers or hypervisors related to the virtual server you want to 
open in SAV.

For example, if you want to visualize a VMware virtual machine (VM) or Solaris zone in SAV, 
by default you will be asked if you also want to scan any virtualization relationships — in 
other words, the system asks if you want SAV to also scan the hypervisor that is hosting the 
selected virtual server. Depending upon the virtual server you select, SAV might have to scan 
several related virtual servers in order to visualize a single virtual server in SAV. 

Conversely, if you select a hypervisor to open in SAV, you are asked if you want to scan any 
virtualization relationships — in this case, SAV would need to scan all of the hosted virtual 
servers, which could take a long time to perform.

By default, SAV will always ask you if you want to scan virtual relationships, but you can set 
your own default behavior for scanning related virtual servers with the following 
virtualization options:
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• Ask each time if you want to scan related virtual and host servers.

• Always scan related virtual and host servers.

• Never scan related virtual and hypervisor servers.

To change the virtualization settings, perform the following steps:

1 From the Edit menu, select Options.

2 In the Set Options window, in the Views pane, select Service Automation Visualizer.

3 Specify your desired Virtualization Settings, then click OK when you are finished.

Scan Time-Out Preference

SAV is optimized to scan a maximum of 50 servers. A number of factors affect the time it takes 
for a scan to complete, including the load on the scanned servers and the load on SA. The 
default scan time-out is set to 300 seconds. You can reset this time-out value to a minimum of 
30 seconds or to a maximum of 3600 seconds.

To change the scan time-out, perform the following steps:

1 From the Edit menu, select Options.

2 In the Set Options window, in the Views pane, select Service Automation Visualizer.

3 In the Scan Timeout section, move the slider to increase or decrease the number of 
seconds at which you want the scanning process to stop.

4 Click OK to save your changes or click Cancel to close the window without saving your 
changes.

Discovery Settings

If servers are scanned and it is determined that they are dependent on external IP addresses, 
when this option is selected SAV attempts to determine which servers or network devices 
those IP addresses refer to.

Keep in mind that this could cause scan time to increase, depending on the numbers of 
servers you selected for the scan and how many remote dependencies are discovered. 

For recurring background business application snapshots, this detection is always done and 
cannot be turned off.

Reset All Settings

Restores all SAV settings to their defaults.

Browsing Job Logs

A job is any major process run by the SAS Web Client or the SA Client, such as Audit Servers, 
Create Snapshot, Create Virtual Zone, Deploy Application, Install Software, Push 
Configurations, Run Communication Test, Run OS Sequence, Scan Configuration 
Compliance, Uninstall Patch, and so on.
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The Job Logs window shows all jobs that the user is configured to see, based on his 
permissions. It also displays jobs scheduled to run, including the job ID, the job type, the start 
and end times, the number of servers and groups affected by the job, the status of the job, the 
ticket ID, and the user name of the person who ran the job. 

If the job status is Pending Approval, then the job is blocked until it is approved by a process 
that is external to HP Server Automation. If jobs are blocked indefinitely, the SA 
Administrator should check the settings of the Approval Integration window or the 
configuration of the backend connector.

The format of the Start Time and End Time for a job is determined by the original user 
preferences set in the SAS Web Client. These preference may be different than those of the 
current user. 

If you are working in multiple time zones, make sure the preferences for Start Time and End 
Time are set to include the time zone in the date display. 

To see the details of a finished job, open the job. If the job is recurring (scheduled to be run), 
then opening the job will cause the Schedule Job window to display. You will only be able to 
modify the scheduled job if you created the job or have Edit All Jobs permissions. To obtain 
these permissions, contact your SA Administrator. See the SA Administration Guide for more 
information.

To view a job, select it, right-click, and select Open.

To cancel a non-recurring job, from the Job Logs window, right-click the job and select End 
Job. You cannot cancel a job while it is running (that is, when the job status is In Progress).

To cancel a recurring (scheduled) job, from the Recurring Schedules window, right-click the 
job and select Delete Schedule.

In order to view a job in the SA Client, you must have permissions to run or execute the 
feature action. For example, if you wanted to view Application Configuration Push jobs in the 
SA Client and you had the Manage Application Configurations permission set to Read, but 
not Write, you would not be able to see any Application Configuration Push jobs in the SA 
Client.

At the top of the Job Logs window, you can filter jobs by specifying the following criteria:

• Job Time Frame: Enables you to limit the search for a job by a time restriction, such as 
jobs run anytime, in the last 24 hours, last week, last month, last quarter, and so on. Or, 
for scheduled jobs, you can filter the jobs list by those jobs scheduled to run in the next 24 
hours, next week, and so on. 

• Job Status: Enables you to search based on the status of a job, such as Succeeded , 

Warning , Failed , Pending Approval, Cancelled, and so on. 

• Job Type: Enables you to search for jobs by type, such as Audit Servers, Modify Virtual 
Zone, Reboot Server, Remediate Policies, Run OGFS Script, and so on. These are jobs that 
have already run or are scheduled to run.

• Job ID: Enables you to search by the job ID. 

• Ticket ID: Enables you to search by the ticket ID, if one was given for the job.

• User: Enables you to enter a username to see only those jobs a certain user has run. Only 
users with the View All Jobs or Edit All Jobs permissions will be able to view jobs in the 
core. If you do not have these permissions, this filter will not appear.
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You must click Search to update the list based on the current filter settings.

• Search: Click Search to filter the job table (based on the previous fields). Open the 
Search drop-down list and then select Advanced Search to open the Advanced Search 
panel. In the Advanced Search panel, you can perform additional searches for jobs.

See Advanced Search on page 59 for more information about this feature or SA Client 
Search on page 43 for general information about the search feature.

Recurring Schedules

The recurring schedules window shows all jobs that are scheduled to run on a recurring basis. 
You can choose to view all recurring jobs or filter the list of recurring jobs by specifying the 
following criteria:

• Job Status: Enables you to search for scheduled jobs by their status, such as Any Status, 
jobs that have been Cancelled, jobs that are Pending Approval, or all jobs that are 
Recurring.

• Job Type: Enables you to search scheduled jobs by their job type, such as Audit Servers, 
Create Snapshot, Push Configurations, and so on. 

• Job ID: Enables you to search for recurring jobs by their job ID. 

• Ticket ID: Enables you to search by the ticket ID, if one was given for the job.

• User: Enables you to enter a username to see only those jobs that a certain user has 
scheduled to run on a recurring basis. If a user is not specified, all recurring jobs will 
display. 

Only users with View All Jobs or Edit All Jobs permissions will be able to view all jobs in the 
core. If you do not have these permissions, you will not be able to see all jobs.

• Search: Enables you to perform a search query of scheduled recurring jobs. Click Search 
to display the detailed results.

Viewing and Deleting Recurring Schedules

To view a recurring job schedule, select it, right-click, and select Open.

To delete a recurring job, select it, right-click, and select Delete Schedule.

Job Notification Emails

If a job was configured to send an email notification to a recipient when the job has finished, 
either on success, failure, or both, the email provides the following information:

• Job Information: Provides data about the job, such as the Job ID, Status, and start and 
end time.

• Job Type Information: Provides data relevant to the specific job type that was run. For 
example, if the job run was an Audit, the job notification email will provide information, 
such as Audit task ID and audit results ID.
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• Job Results URL: The job results URL launches the specific job type window. For 
example, if the job was an audit, the job type URL launches the audit results window. 
Other information in the notification email provides job results details, such as number of 
differences found in the audit results, source and target server information, and so on.

Advanced Search

Using the Advanced Search action, you can search for jobs that affect certain managed 
servers or device groups.

To perform an advanced search, complete the following steps:

1 From Job Logs in the Search drop-down list, select the Advanced Search option to display 
the Advanced Search panel. By default, the Search For field is set to Job. 

Or

From Advanced Search, select Job in the Search For list.

2 Use the Where filters to narrow your search of the job logs, such as by Device Group 
Name, Server Name, Status, job Type, and so on.

3 Click Search to display the detailed results.

4 (Optional) Click Save to save your search query. The Save As dialog appears. Enter the 
name of the search and then click Save. The name of the saved search cannot exceed 64 
characters.

5 (Optional) Click Export to export search results to a .csv or .html file. The Export Results 
window appears. Enter the location, file name, and file type, and then click Export 
Results.

Finding Jobs by Managed Server

You can search for jobs by the managed servers they affect, such as by name, ID, IP, or 
operating system. This enables you to easily find jobs performed on servers that you manage.

Finding Jobs by Device Group

You can search for jobs by the device groups they affect, such as by name or ID). This enables 
you to easily find jobs performed on device groups that you manage. These are device groups 
that are already in the database.

Finding Information in Job Results

To easily find key information in the Job Status pane, you can filter, group, sort, search for, 
and highlight information in detailed job results.
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Filtering the Display

Filtering enables you to control what displays in the Job Status table. You can narrow or 

expand the detailed job results. In the Job Status pane, in the filter box, click on the  filter 
menu to display a list of filtering criteria. The filter menu options display in the following 5 
sections:

1 The first section is a list of the column names you can select to filter on. Depending on the 
Job type, the column names will vary. Select a column heading that you want to filter: 

All

Item

Status

Only the following job types are filterable:

– Audit Servers

– Create Snapshot

– Deploy Application

– Install Software

– Push Configurations

– Remediate Audit Results

– Remediate Policies

– Reboot Server

– Restore Configurations

– Rollback Application

– Undeploy Application

– Uninstall Software

2 The next section is a list that specifies whether you want to filter with case sensitivity on 
or off:

Case sensitive

Case insensitive

3 This section specifies whether you want to filter using wildcards:

Use wildcards 

If you enable wildcards, enter a string, using different wildcards, in the filter box. A 
wildcard is any character, including alpha, numeric, and special characters.

+ — The plus sign wildcard can be substituted for one or more of any character.

* — The asterisk wildcard character can be substituted for zero or more characters.

? — The question mark wildcard character can be substituted for one character.

4 This section specifies where in the field to match the string:

Match from start

Match exactly (This means you want to match the entire line.)

Match anywhere
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5 This section specifies how to keep the grouping when it filters a string. If neither is 
selected, it just keeps the rows that have the string:

Keep parent row if any of the children match — This will display the parent row 
along with all the children rows that contain the string that the filter requested.

Keep the children if any of their ancestors match — This will display the 
children rows along with all the parent rows that contain the string that the filter 
requested.

Grouping and Ungrouping Columns

You can group any one or multiple columns. When you group multiple columns, you create 
nested groups.

1 Right-click on the column heading you want to create a group of and then select Group 
This Column.

2 To ungroup a column, right-click on any column heading and then select Ungroup 
Column <name>.

Expanding and Collapsing Information in Columns

You can expand or collapse information in a column.

1 Right-click on a column heading and then select Expand All.

2 Right-click on a column heading and then select Collapse All.

Resizing Columns

You can auto resize one or all columns in the display.

1 To auto resize one column, right-click on the column heading and then select Auto Resize 
This Column.

2 To auto resize all columns, right-click on any column heading and then select Auto 
Resize All Columns.

3 (Optional) Double-click on the edge of a column heading in the job results display. This 
action will auto resize the column width to fit the data.

4 (Optional) You can also drag the vertical line between column headings to resize them.

5 (Optional) You can also drag-and-drop a column heading to change its horizontal position.

Sorting Columns

You can sort information displayed in a column.

1 To sort column information, click on the column heading.

2 To reverse sort column information, click on the column heading again.

3 To add a secondary, tertiary (and so on) sort, press CTL-Click.
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Finding & Highlighting

You can use the Find tool to narrow your search and highlight what you see in the table or in 
the details pane.

1 To find key information in the table view, click in the table and then press CTRL-F to open 
the Find bar. Enter any string in the Find text box. This action finds the string you 
entered, whether it is an entire string or part of a string.

2 To find key information in the details pane, select a row in the table to open the details 
pane. Click in the details pane and then press CTRL-F to open the Find bar. 

Example: 

a Enter “ORA” in the Find text box. This will highlight the first occurrence of “ora” in 
the details pane.

If you enter text that does not have any matches, “Phrase not found” will display next 
to the Find bar.

b (Optional) You can have either one or both Find bars open at the same time. If you 
have both Find bars open simultaneously, one displays at the bottom of the table and 
the other one displays at the bottom of the details pane.

c (Optional) Click Highlight to highlight all occurrences of "ora".

d (Optional) Click Find Next or Find Previous to jump forwards or backwards to the 
next occurrence of “ora” and highlight it.

e (Optional) Click Match Case to narrow the find to “ORA” database errors in this 
example.

3 To close the Find bar, click the X in front of the Find text box or position the cursor in the 
Find text box and then press Esc.
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3 Agent Management
The SA Server Agent on Managed Servers

This section provides information about the SA Server Agent that is installed on managed 
servers and contains the following topics:

• Overview of the Server Agent on Managed Servers

• Security for Agents Running on Managed Servers

• Agent Functionality on Managed Servers

• Server Information that the Agent Tracks

Overview of the Server Agent on Managed Servers

The SA Server Agent is intelligent software that is installed on a server that you want to 
manage with SA. After an agent is installed, it registers with the SA Core which can then add 
that server to its pool of Managed Servers. The Server Agent also receives commands from the 
Core and initiates the appropriate action on its local server, such as software installation and 
removal, software and hardware configuration, server status reporting, auditing, and so on.

SA does not install a Server Agent on VMware ESXi servers. Instead, SA manages ESXi 
servers remotely using a web services interface. For more information, see Virtual Server 
Management on page 155.

The SA Server Agent regularly performs management tasks on each server autonomously. On 
a regular interval, the Agent gathers a hardware and software inventory of each managed 
server. It opens a secure communication channel to the core, presenting its IP address and 
public-key certificate for authentication purposes. If properly authenticated, the Agent is 
permitted to write its updates about the server to the Model Repository. 

Every twelve hours, the Server Agent submits minimal hardware information, such as 
changes in IP address, node name and so on, for the managed server on which it is running. 
Every 7 days, the Server Agent submits a full hardware inventory for the managed server on 
which it is running. Hardware registration also occurs during Server Agent installation or 
software installation. Every 24 hours, the Agent submits software inventory and information 
for the managed server to the core. It reports the software found on the server and the core 
determines any differences. See Figure 21.
63



Figure 21 Server Management Tasks Performed by Agent 

The Reporting field indicates the status of the Agent's reporting capability and tells you 
whether or not the Agent is reporting regularly and successfully. The four possible reporting 
states for the Agent are as follows:

— OK: The Agent is reporting properly. 

— Registration in progress: The Agent is currently registering server hardware 
information.

— Reporting error: The Agent encountered an error while trying to report hardware 
information.

— Last reported days ago: This indicates when the Agent last reported.

You can access Agent reporting information in Server Properties by using advanced search, 
and by viewing managed servers by Communication status. When viewing by Communication 
status, the SAS Web Client user interface displays this information in the registration 
column. 

If the Agent experiences an error in reporting, or has not reported within 24 hours, you can 
run a Communication Test to troubleshoot the problem. See Agent Reachability 
Communication Tests on page 84 for more information.

If you modify the server hardware, it could take up to 12 hours for the change to appear in the 
SAS Web Client user interface, depending on the time that the Agent for that server contacted 
the core.

If you install or uninstall software on a managed server outside of HP Server Automation, it 
could take up to 24 hours for the change to appear in the SAS Web Client user interface. For 
example, if you update the Microsoft Patch Database, it could take up to 24 hours for all 
managed servers to display whether they need new patches based on the updated Microsoft 
Patch Database. 

In some cases, not all of a server’s hardware information is reported. For example, if the Agent 
was installed with its default settings, not all hardware information is reported to the SAS 
Web Client until an hour after the agent is installed. There also might be a problem retrieving 
certain hardware information, such as a disk failure, that could prevent some hardware 
information from being reported. In these cases, the server’s property page lists unreported 
information as not set. 

If configuration tracking is enabled for a server, the Agent sweeps through the managed 
server on a regular interval to see if any of the configurations being tracked are changed. If a 
tracked configuration is changed, the Agent performs the action specified by the tracking 
policy, namely, writing the information to a log file, generating a backup, or sending an email 
message through SMTP to the email address specified in the tracking policy. 
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Security for Agents Running on Managed Servers

 Agents act as both clients and servers when they communicate with HP Server Automation. 
All communication is encrypted, integrity-checked, and authenticated using X.509v3 client 
certificates using SSL/TLS. 

A small number of core components can issue commands to the Agent over a well-defined 
TCP/IP port. The Agent can also call back to core components, each with its own well-defined 
port.

The Code Deployment & Rollback (CDR) feature uses agent-to-agent communication for 
performance reasons. In particular, CDR synchronizations (the process of copying changed 
files and directories from one server to another) happen when an Agent connects to another 
Agent and sends across the network files that have changed since the last time the two 
Agents connected. 

To further safeguard the SSL/TLS-based communication channel, the two Agents 
participating in the code deployment also need to have a common shared secret provided by 
the Command Engine. Before one Agent can begin a file transfer to another Agent, the two 
agents must verify that they have a common shared secret provided on a per-session basis by 
the Command Engine. This safeguard prevents unauthorized users from copying files from 
one managed server to another. 

Agent Functionality on Managed Servers

The Agent is designed such that:

• It can only discover information about its own managed server (and no others). 

• It cannot make changes on a server unless explicitly instructed to do so by a core 
component. 

HP Server Automation runs with administrator privileges (root on UNIX servers and Local 
System on Windows servers), because it performs tasks that require administrator privileges, 
such as installing patches and rebooting servers. 

The core performs client authentication and checks to see if the presenting certificate belongs 
to that particular server. HP Server Automation does this by comparing the certificate to the 
server’s IP address that is generated when the Agent is initially installed. If the certificate is 
not valid or the originating IP address does not match the IP address stored in the Model 
Repository, authentication fails and the Agent cannot continue communication with HP 
Server Automation. 

If an unauthorized user were able to log on to a managed server with administrator privileges 
and compromise a server’s security, the user would have only limited access to the following 
information in the Model Repository:

• The server’s own hardware inventory (already available to someone logged on with 
administrator privileges)

• The server’s own software inventory (already available to someone logged on with 
administrator privileges)

• The custom attribute information
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Server Information that the Agent Tracks

For each managed server, the Agent reports software, networking, and hardware information, 
as shown in Figure 22 and Figure 23. By communicating with the core and reporting the 
installed hardware and software for the server, HP Server Automation determines what 
software should be installed on a server.

Figure 22 Manager Servers: Properties Page: Server Information 
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Figure 23 Server Properties-Hardware and Additional Information 

Software Information 

The software that should be installed is recorded in the Model Repository. To access that 
information, click the Install List or Installed Packages tabs. This shows the software that 
should be installed on the server or all software that is installed on the server. 

To display the list of what software packages should be installed on that server, select the 
Install List tab from the Managed Servers: Server Properties page. 

To display the list of software that is reportedly installed on the server, select the Installed 
Packages tab from the Managed Servers: Server Properties page.

Partially-installed Solaris packages do not show up in the Installed Packages list, even 
though the package was partially installed. 
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Hardware Information

HP Server Automation tracks hardware information in a variety of manners. Table 3 shows 
how the Agent obtains the server and hardware information about each managed server.  

Table 3 Hardware Information that the Agent Reports for Servers

Attribute Description How Obtained

Name The user-configurable 
name for the server. By 
default, HP Server 
Automation uses the 
configured host name 
of the server until a 
user edits it.

Windows: Uses the fully qualified DNS name 
of the server.

Linux, Solaris, AIX, HP-UX: Uses the current 
host name of the server that the hostname 
command returns.

Reported OS The version number of 
the server's operating 
system.

Windows: Uses the Windows version number 
as reported by the operating system. This 
information includes the major version number, 
the minor version number, the Windows build 
number, and the Service Pack level. 

Linux, Solaris, AIX, HP-UX: Uses the 
operating system version that the uname 
command returns.

OS Version The OS version 
specified for the OS 
definition.

Specified by the user who prepared the OS with 
the Prepare Operating System Wizard.

See the SA Policy Setter Guide for more 
information.

Serial Number The serial number of 
the system. HP Server 
Automation attempts 
to report a chassis ID, 
if possible.

Windows, Linux: Obtained from the system 
BIOS.

Solaris, AIX, HP-UX: Obtained from the 
system ROM.

Manufacturer The manufacturer of 
the server if available.

Windows, Linux: Obtained from the system 
BIOS.

Solaris, AIX, HP: Obtained from the system 
ROM.

Model The model of the 
server if available.

Windows, Linux: Obtained from the system 
BIOS.

Solaris, AIX: Obtained from the system ROM.

HP-UX: Output of model command (which is 
read from the system ROM).
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In addition to hardware and software reporting, the Agent reports networking information. 
See Network Configuration on page 277 for descriptions of the networking information 
reported and how you can modify that information using the Network tab in the SAS Web 
Client.

Memory The amount of 
physical RAM and the 
total amount of virtual 
memory paging space 
configured.

Windows: Uses the Windows 2000 API 
GlobalMemoryStatus().

Linux: Obtained from information in the file 
/proc/meminfo. 

Solaris: Obtained from the sysconf and 
swapctl APIs.

AIX: Uses the lsattr command for memory 
information and the lsps command for paging 
space.

HP-UX: Uses the pstat system call. 

Processors Information about 
each of the processors 
in the system.

Windows: If WMI is available, iterates over all 
instances of Win32_Processor. If WMI is not 
available, parses the registry key 
HARDWARE\DESCRIPTION\System
\CentralProcessor. There is one sub-key for 
each processor.

Linux: Obtained from information in the file 
/proc/cpuinfo.

Solaris, HP-UX: Uses system APIs to 
enumerate the processors in the system.

AIX: Uses the lscfg command.

Storage Information about 
each installed disk 
drive or RAID array.

All Platforms: Uses system APIs to discover 
and probe disk drives and RAID arrays. 

Server ID The internal ID that 
HP Server Automation 
uses to identify the 
server.

In most cases, the server ID is the same as the 
MID.

MID The MID (Machine ID) 
is a unique number 
that HP Server 
Automation assigns 
when the server first 
registers. The server 
stores the MID and 
reports it each time the 
server registers.

Windows: The MID is stored in the file 
%ProgramFiles%\Common 
Files\Opsware\cogbot\mid if present.

Linux, Solaris, AIX, HP-UX: The MID is 
stored in the file /etc/opt/opsware/agent/
mid

Table 3 Hardware Information that the Agent Reports for Servers (cont’d)

Attribute Description How Obtained
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Starting an Agent

To start an Agent, log onto the managed server and enter the following command.

Unix:

/etc/init.d/opsware-agent startt

HP-UX: 

/sbin/init.d/opsware-agent start

AIX: 

/etc/rc.d/init.d/opsware-agent start

Windows:

net start opsware-agent

To stop an agent, enter the same command, specifying stop instead of start.

Discovery and Agent Deployment 

The Discovery and Agent Deployment (ODAD) feature helps to deploy Agents to a large 
number of servers through the SAS Client. This feature helps to identify servers on which to 
install an Agent, specify the deployment actions to be carried out on each server, select the 
login protocols to connect to each server, specify the Agent Installer options for installing an 
Agent, and generate reports on Agent installation status. See Figure 24.

Figure 24 Agent Deployment Process 

This overview section contains the following topics:

• Discovering Servers for Installing an Agent

• Setting Deployment Actions for Each Server

• Specifying Login Settings

• Agent Installer Options

• Reports on Server Status
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See Installing Agents Using ODAD on page 76 for more information about how to install an 
agent.

Discovering Servers for Installing an Agent

Using the Discovery and Agent Deployment (ODAD) feature, you can select a location to scan 
for servers. After selecting a location, you can specify the IP addresses or IP address ranges to 
perform a network scan to identify servers in which to install an Agent. Instead of performing 
a network scan, you can also import a file containing a list of IP addresses or IP address 
ranges. When the scan is complete, a list of scanned servers is shown. 

For each server, this feature determines the status of the server, its IP address, its host name, 
detected operating system, and open ports used to connect to the server.

Setting Deployment Actions for Each Server

Once you have identified the servers, you can select the servers and perform the following 
deployment actions:

• Verify installation prerequisites.

When you select this action, SA verifies that the Agent is successfully installed on the 
server. The verification includes:

— Checking for sufficient disk space for Agent installation on the server

— Verifying that no other application is using port 1002

— Verifying if ports to the Gateway are accessible

• Verify prerequisites, and copy the Agent Installer to servers.

When you select this action, SA verifies that the Agent is successfully installed on the 
server and the Agent Installer is copied to the server.

• Verify prerequisites, copy installer, and install Agent.

When you select this action, SA verifies that the Agent is successfully installed on the 
server, the Agent Installer is copied to the server, and the Agent is installed on the server. 

Specifying Login Settings

After selecting the deployment action, you can select the network protocols to connect to the 
server and specify the user name and password to login to each server. The Agent needs 
administrator-level privileges (root on Unix servers and administrator on Windows servers) to 
manage a server. Therefore, Agent installation is performed as root on Unix operating 
systems and as administrator on Windows operating systems. ODAD tries to log into each of 
the selected servers with the specified user name and password and performs the specified 
deployment actions.
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Agent Installer Options 

The Discovery and Agent Deployment feature allows you to specify the installer options listed 
in Table 4.

Table 4 Agent Installer Options

Option Description

Start the Agent after Installation Starts the Agent after installing it on the server. 
By default, the Agent Installer does not start the 
Agent.

Ignore prerequisite check failures Ignores the prerequisite check failures and 
forces Agent installation.

Set the server’s time from the core Synchronizes the time on the server in which the 
Agent is installed to the core.

Install Windows Installer (MSI) if 
required

Installs MSI along with the Agent. If MSI is 
already installed, this option has no effect.

Install Windows Management 
Instrumentation (WMI) if required

Installs WMI along with the Agent. If WMI is 
already installed, this option has no effect.

Reboot Windows servers after agent 
installation

Reboots windows servers after Agent installation 
is complete. 

Install Red Hat Package Manager (RPM) 
on AIX and Solaris

Installs the RPM handler with the Agent. 
Always include this option when you install 
Agents on Solaris and AIX servers.

Reset Agent configuration, if present Replaces the existing Agent configuration.

Delete gateway address list, if present Deletes the Gateway address list if present and 
is no longer required.

Overwrite staged Agent installer Overwrites the existing Agent Installer.

Log Level Sets the log level for log messages. With this 
option, you can specify the log levels of error, 
warning, info, and trace.

Use Gateways Specifies the Gateways used during Agent 
installation.

Immediately do a full hardware 
registration

Forces the Agent Installer to report full 
hardware information to the core.

Immediately do software registration Forces the Agent Installer to report full software 
information to the core.

Suppress Agent reachability check By default, the installer triggers the core to 
check if the server is reachable. This option 
disables this check during installation. 

Disallow anonymous SSL connections if 
Agent is dormant

Configures the Agent so that browsers cannot 
connect without a valid certificate.
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Force creation of new device record if 
conflict found

During registration, the Data Access Engine 
creates a new device record. This option 
suppresses this functionality.

Fail if initial hardware registration fails 
(do not go dormant)

Does not allow the Agent to become dormant, if it 
fails to report hardware information.

Do not open Windows Firewall for 
core-agent communications

By default, the Agent Installer will modify the 
Windows Firewall configuration on Windows XP 
and Windows 2003 (r2) servers to allow the core 
to contact the managed server on port 1002. If 
you select this option, the firewall configuration 
will not be modified. The server may not be 
manageable in this case.    

Remediate software policies Remediates the server against any software 
policies attached to the server.

Attach to software Policy ID Attaches server to the software policy <ID>.

Table 4 Agent Installer Options (cont’d)

Option Description
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Extra Installer options Allows you to specify any other installer options. 
For example:

--log file <path> allows you to specify the 
path to the installer log file. By default, the 
installer log files are placed in /tmp on Unix or 
%SYSTEMDRIVE%\WINDOWS\SYSTEM on Windows.

--workdir <path> allows you to specify the 
path to the working directory to use while the 
installation is in progress. 

Install directory (UNIX) Allows you to specify the directory where the 
Agent will be installed. By default, the Agent is 
installed in /opt/opsware/agent on UNIX, and 
%ProgramFiles%\Opsware\agent on Windows. 

Core certificate fingerprint Enter the fingerprint of the core certificate.

If you specify a value for this option, the agent 
installer will verify that the Certificate 
Authority certificate used to sign the core's SSL 
certificate matches the value you provided. 
Specifying a value for this option increases 
security during the agent installation process by 
ensuring that the agent attaches itself to the 
correct core.

To obtain the correct value for the core certificate 
fingerprint option, log on to the core as root (you 
may need to have an SA System Administrator 
perform this task for you) and run the following 
command:

/opt/opsware/bin/openssl x509 -in /var/
opt/opsware/crypto/agent/opsware-ca.crt 
-fingerprint -noout

The output looks like the following:

SHA1 Fingerprint=D2:3B:F8:72:B9:55:0D: 
DE:97:04:D5:C2:A5:6B:B2:09:5C:0A:0D:7F

The fingerprint is the string of hexadecimal 
numbers following the equal sign:

D2:3B:F8:72:B9:55:0D:DE:97:04:D5:C2:A5:6
B:B2:09:5C:0A:0D:7F

Copy this value into the Core certificate 
fingerprint field. All agent deployments will use 
that fingerprint value.

Table 4 Agent Installer Options (cont’d)

Option Description
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Reports on Server Status

After the deployment action is complete, the SA Client displays the results and updates the 
status icons for the servers as shown in Table 5.    

A server is considered to be managed when the ODAD determines that the Agent is listening 
for TCP connections on port 1002.

For a failed deployment action, you can view the errors on each server. You can also log into 
the server and correct the errors. 

Using this feature, you can create the following reports:

• All the servers in the current network scan

• Selected servers in the current network scan

Table 5 Server Status

Icons Server Status

The server is unmanaged.

The server is managed.

The server failed prerequisite checks.

The server passed prerequisite checks.

The server passed prerequisite checks and the Agent Installer was copied 
to the server.

The Agent was successfully deployed.

The Agent was not successfully deployed.
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• All the servers in the current network scan with successful deployments 

• Servers in the current network scan with failed deployments

You can save and export the reports to a CSV, HTML, or text format file.

Agent Installation Using ODAD

The Discovery and Agent Deployment (ODAD) feature helps you to deploy Agents to a large 
number of servers through the SA Client. This section contains the following topics:

• Permissions Required for Discovery and Agent Deployment

• Installing Agents Using ODAD

Permissions Required for Discovery and Agent Deployment 

To use the Discovery and Agent Deployment feature you must have certain permissions. See 
the SA Administration Guide for more information about the permissions. To obtain the 
required permissions for scanning and deploying Agents, contact your administrator. 

To bring a VMware ESXi server under SA management, you need the Manage Virtual Servers 
permission and the Manage Credentials permission. See Managing VMware ESXi Servers on 
page 164 for more information.

Installing Agents Using ODAD

To install Agents using ODAD, launch the SA Client. See SA Client and SA Launcher on 
page 30 for more information.

Perform the following steps to install an Agent:

1 Log into the SA Client. The SA Client Page appears.

2 From the navigation pane, select Devices and then select Unmanaged Servers.

3 Select a realm to scan for servers from the “Scan in” drop-down list. For more information 
about realms, see “Facilities and Realms” in the SA Simple/Advanced Installation Guide.

4 Select “Supply IP Address Ranges” from the drop-down list to specify a set of IP address 
ranges to scan. Enter the IP address range in the From and To field. Click the plus (+) 
button (next to the To field) to add another IP address range. You can add a maximum of 
five IP address ranges. Click the minus (-) button to delete the IP address range field.

Or

Select “Explicit IPs/Hostnames” from the drop down list to specify the list of IP addresses 
to scan, separated by spaces (commas not supported). Click the ellipsis (...) button as 
shown in Figure 25 to display a text editor that allows you to load and scan a file with IP 
ranges to scan.
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Figure 25 Loading a File with IP Addresses 

5 Click Scan to scan for servers. When the scan is complete, the list of servers is shown. For 
each server, ODAD determines the status of the server, its IP address, its host name, the 
detected operating system and open ports that can be used to connect to the server. 

If you have a firewall enabled, ODAD may not be able to accurately detect a managed server’s 
actual installed operating system. Some firewalls can interfere with the methods ODAD uses 
to detect the operating system. ODAD must be able to access at minimum one open port and 
one closed port to gather the information needed to determine the operating system. If you 
find that ODAD has not identified any operating system or has misidentified the operating 
system, you may need to configure your firewall to allow network packets from the HP Server 
Automation Core.

See Figure 26. The actual operating system of the server can be only determined if ODAD 
is able to successfully log into the server.

Figure 26 Scan Results 

6 Click on any of the column headings to sort the server list by that column.

Bringing a Server Under SA Management

1 Select servers you want to manage with SA. The SA Client supports hot keys to make 
multiple selections.

2 From the Actions menu, select Manage Server. The Manage Servers dialog box appears 
as shown in Figure 27.
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Figure 27 Manage Servers Dialog 

3 Select a network protocol to use for connecting to the server from the drop-down list.

In most cases, choosing Select Automatically to allow SA to select an appropriate protocol 
for each server is recommended.

For VMware ESXi servers where the Linux-based service console (COS) has been 
removed, you must choose VMware ESX Web Services. For more information on managing 
virtual servers, see the SA User Guide: Server Automation.

4 Enter a username and password to use for logging into the managed server. For 
Windows-based systems, log in using the Windows administrator username/password. For 
Unix, log in as root. 

5 Enter a username and password to use for logging into the managed server. 

Windows-based systems: log in using the Windows administrator username/password. 

Unix-based systems: log in as root. If logging in as root is not permitted, select the 
Become root (UNIX) checkbox. Select Supply root password and enter the password or 
select Use sudo if sudo access is enabled for that account.

If you log in using sudo, the sudo user’s configuration file (typically /etc/sudoers) must 
allow the account to run any command with root privileges. This is typically accomplished 
by using the “ALL” alias in the sudoers file.

6 If you are unable to deploy the agent to a UNIX server by logging in as root, the system 
you are deploying to may be configured to disallow direct root logins. In such cases SA 
allows you to log in as a non-root user and then escalates your privileges via either the 
“su” command or the “sudo” command.

Perform the following steps to deploy agents as a non-root user:

a Enter the unprivileged user name in the Username field to log into the server.

b Enter the unprivileged password in the Password field.
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c Select the Become root (UNIX) checkbox. Select “Supply root password” and enter the 
password or select “Use sudo”. If you choose to use sudo, the unprivileged account 
must be able to run any command as root.

7 Select one of the following deployment actions:

• Verify installation prerequisites.

• Verify prerequisites and copy agent installer to servers.

• Verify prerequisites, copy installer, and install agent.

See Setting Deployment Actions for Each Server on page 71 for more information.

8 Specify the Agent Installer options to control the way the Agent is installed on a server. 
See Agent Installer Options on page 72 for more information.

9 Click OK to make the selected servers into managed servers.

10 After the deployment action is completed, the SA Client displays the results and updates 
the status icons for the servers. You can view information on an unmanaged server and 
generate reports on Agent Installation status. See Reports on Agent Installation on page 
82 for more information.

Viewing Unmanaged Server Information

After the deployment action is completed, you can review the results and generate reports. 
You can view the summary and history information for an unmanaged server. For a failed 
deployment action, you can view the errors on each server. You can also log into the server 
from SA and correct the errors. 

This section discusses the following topics:

• Summary Information for an Unmanaged Server

• History Information for an Unmanaged Server

• Opening a Remote Terminal Session on an Unmanaged Server

• Reports on Agent Installation

Summary Information for an Unmanaged Server

The Unmanaged Server Summary browser shows the following information about the 
unmanaged server:

• Host Name: The host name of the unmanaged server, if defined in the Domain Name 
System (DNS).

• IP Address: The IP address of the unmanaged server.

• Detected OS: The operating system detected on the server after performing the network 
scan. The listed operating system is a best guess made by comparing the Managed 
Server’s response to a network probe of a list of known operating system ”fingerprints”. 
The listed operating system may not always be accurate, for example when a firewall 
exists between the HP Server Automation Core and the Managed Server and does not 
allow or alters the network probe.
Agent Management 79



• Actual OS: The actual operating system detected on the server after the deployment 
action. This entry will be blank until ODAD can successfully log on to the managed Server 
and identify the operating system type and version.

• MAC Address: The Media Access Control (MAC) address, which is the network interface 
card’s unique hardware number of the unmanaged server. The MAC is used as the server’s 
physical address on the network. The MAC address is only detected if the server is on the 
same physical network as the Gateway.

• NIC Vendor: The vendor name for the Network Interface Card (NIC) driver. The NIC 
vendor is only detected if the server is on the same physical network as the Gateway.

• Open Ports: The discovered open ports on an unmanaged server. ODAD does not perform 
a comprehensive search for open ports. There may be open ports not listed.

• Number of Deployment Attempts: The number of deployment attempts on an 
unmanaged server.

• Last Deployment Attempt Date/Time: The date and time of the last deployment 
attempt.

• Last Deployment Attempt Message: The message stating the possible cause for the 
failure of the last deployment attempt. 

Viewing Summary Information of an Unmanaged Server 

Perform the following steps to view the summary of an unmanaged server.

1 Log into the SA Client. The SA Client Page appears.

2 From the navigation pane, select Devices and then select Unmanaged Servers.

3 From the Unmanaged Servers page, select the unmanaged server. From the Actions 
menu, select Open.

The Unmanaged Server Browser page appears. 

4 From the left Navigation pane, click Summary to view the summary of the unmanaged 
server. See Figure 28.
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Figure 28 Unmanaged Server Summary Page 

History Information for an Unmanaged Server

The Unmanaged Server History Browser shows a history of all actions executed on 
unmanaged servers such as:

• A summary of the actions performed on the unmanaged server

• Details of all the actions performed on the unmanaged server

• Log information

The history is read-only. 

Viewing History Information of an Unmanaged Server

Perform the following steps to view the history of an unmanaged server:

1 Log into the SA Client. The SA Client Page appears.

2 From the navigation pane, select Devices and then select Unmanaged Servers.

3 From the Unmanaged Servers page, select the unmanaged server. From the Actions 
menu, select Open.

The Unmanaged Server Browser page appears. 

4 From the left Navigation pane, click History to view the history of all actions executed on 
unmanaged servers. 
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Opening a Remote Terminal Session on an Unmanaged Server

You can open a remote terminal session on an unmanaged server and log in to the server 
using the appropriate protocol and correct any errors on the server or perform any other 
operations. 

To open a remote terminal session on an unmanaged server perform the following steps.

1 Log into the SA Client.

2 From the navigation pane, select Devices and then select Unmanaged Servers.

3 Select an unmanaged server.

4 Either right click or select the Actions menu, select Log in with and select the 
appropriate protocol.

The specific commands that SA uses to log in to the remote server are specified in the 
Terminal and Shell options, under the Tools ➤  Options menu. For more information, see 
Terminal and Shell Settings on page 52.

Reports on Agent Installation

Using the Discovery and Agent Deployment feature, you can create the following reports:

• All the servers in the current network scan
• Selected servers in the current network scan 
• Servers in the current network scan with successful deployments 
• Servers in the current network scan with failed deployments

You can also save and export the reports to a CSV, HTML, or text file format.

Creating Reports on Agent Installation

Perform the following steps to create reports:

1 Log into the SA Client. The SA Client Page appears.

2 From the navigation pane, select Devices and then select Unmanaged Servers.

3 From the Unmanaged Servers page, select the unmanaged server. From the Actions 
menu, select Export to the desired report format. The Save Report dialog box appears.

4 From the drop-down list, select the type of report as shown in Figure 29.
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Figure 29 Generating Reports 

5 Enter the location and file name to save the report.

Example Report 

The following example shows a report of servers with failed deployments.

Servers which the Agent could not be deployed to:

Hostname : Unknown

IP Address : 192.168.198.93

Detected Operating System : Microsoft Windows 2003 Server or XP SP2

Open Ports : 139 3389 

MAC Address : Unknown

NIC Vendor : Unknown

# of Deployment Attempts : 2

Last Deployment Message : The credentials supplied conflict with an existing 
set of credentials.

Last Deployment Attempt Date/Time : "Wed, 6 Apr 2005 16:18:46"

Failed Phase : Check

Return Code : 2013

Suggested Resolution : Unable to log in to the unmanaged server. An incorrect 
login name or password was specified. Try a different login name and/or 
password.
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Agent Reachability Communication Tests

This section provides information on agent reachability Communication Tests within HP 
Server Automation and contains the following topics:

• Overview of Communication Tests

• Communication Tests and Unreachable Agents

• Communication Test Types

• Communication Test Errors

• Additional Information on Communication Tests

• Running a Communication Test on an Individual Server

• Running a Communication Test on Multiple Servers

• Viewing Servers by Communication Status

• Searching for Unreachable Servers

• Viewing My Jobs Communication Tests

• Exporting the Unreachable Server Status List to a CSV File

The communication test is not available on VMware ESXi servers because SA does not install 
a Server Agent on ESXi servers. You can determine if an ESXi server is reachable by selecting 
the ESXi server in the SA Client and selecting Actions ➤ Refresh Server. This contacts 
and scans the ESXi server. Select the ESXi server and select the Properties view to display its 
status. If the server is reachable, the Status line will read “OK”.

For more information on ESXi servers, see Managing VMware ESXi Servers on page 164.

Overview of Communication Tests

Sometimes an Agent can become unreachable, which means that the SAS Web Client has 
difficulty communicating with the Agent. When an Agent is unreachable, the server it is 
installed on is considered unmanaged. This section explains how to use the Communication 
Test to find unreachable Agents and suggests ways that you can resolve these problems. 

To help identify those managed servers that have unreachable agents, the SAS Web Client 
runs periodic Communication Tests to verify that HP Server Automation can communicate 
with all servers under its management. You can always check the reachability of Agents by 
looking at the server’s properties, or by viewing the current agent reachability status for all 
managed servers since the last Communication Test was run by choosing the Communication 
view from the Managed Servers list. 

To determine the current reachability of a specific Agent, you can run a Communication Test 
to find those servers that have unreachable agents by using the Communication Test feature 
located in the Server menu of the Managed Server list. A Communication Test lists all servers 
with unreachable agents, returns specific errors associated with each unreachable Agent, and 
provides troubleshooting information to help you get the Agent back in working order. 
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You have the ability to check Agent reachability for individual servers, selected servers, or all 
servers under the management of HP Server Automation. Each time that you run a 
Communication Test, this test is saved in the My Jobs panel, which allows you to view a 
history of all the Communication Tests that you have run. You can even export the current 
reachability status of all managed servers to a CSV file.

Communication Tests and Unreachable Agents

The Communication Test works by testing communication and data exchange between the 
specific components of the core and each managed server. The core is the entire collection of 
servers and services that provide services. In order to successfully manage servers, the core 
needs to be able to communicate with each Agent on all servers under HP Server Automation 
management. 

Communication Test Types

The Communication Test performs the following diagnostics to determine if an Agent is 
reachable: 

• Command Engine to Agent Communication (AGT): Determines if the Command 
Engine can communicate with the agent. The Command Engine is the HP Server 
Automation component that enables distributed programs to run across many servers. 
The Command Engine handles the entry of scripts into the Model Repository (the script 
storage location in HP Server Automation) and the versioning of stored scripts. 

• Crypto Match (CRP): Checks that the SSL cryptographic files that the agent uses are 
valid.

• Agent to Command Engine Communication (CE): Verifies that the agent can connect 
to the Command Engine and retrieve a command for execution. 

• Agent to Data Access Engine (DAE): Checks whether or not the agent can connect to 
the Data Access Engine and retrieve its device record. The Data Access Engine provides 
an XML-RPC interface to the Model Repository that simplifies interaction with various 
clients such as the SAS Web Client, system data collection, and monitoring agents on 
servers.

• Agent to Software Repository Communication (SWR): Determines if the agent can 
establish an SSL connection to the Software Repository. The Software Repository is the 
central repository for all software that HP Server Automation manages. It contains 
software packages for operating systems, applications, databases, customer code, and 
software configuration information.

• Machine ID Mismatch (MID): Checks that the Machine ID (MID) on the server 
matches the MID registered in the Model Repository for the agent.

When the test finishes, it returns results that show either success or failure for each test run 
on each server. For each failed test, the nature of the failure is indicated in the Test Summary 
column of the Communication Test results page. In some cases, the failure of one test might 
prevent other tests from being executed.

See Agent Functionality on Managed Servers on page 65 for more information about the 
agent and its relationship to managed servers. 
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Communication Test Errors

After you run a Communication Test, three icons indicate the success or failure of agent 
reachability as Table 6 shows.  

Table 7 describes each type of Communication Test and all possible errors for each test.  

Table 6 Agent Unreachability Status Icons

Status Icon Description

Communication Test passed. Agent is reachable. 

Communication Test unable to be executed. 

Communication Test failed. Agent is unreachable. 

Table 7 Communication Test Types with Possible Results

Test Description Results

Command Engine to 
Agent Communication 
(AGT)

Determines if the 
Command Engine can 
communicate with the 
agent

1 OK

2 Untested

3 Unexpected error

4 Connection refused

5 Connection time-out

6 Request time-out

7 Server never registered

8 Realm is unreachable

9 Tunnel setup error

10 Gateway denied access

11 Internal gateway error

12 Gateway could not connect to 
server

13 Gateway time-out

Crypto Match (CRP) Checks that the agent’s 
SSL cryptographic files 
are valid

1 OK

2 Untested

3 Unexpected error

4 Agent certificate mismatch

5 SSL negotiation failure
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Agent to Command 
Engine Communication 
(CE)

Verifies that the agent 
can connect to the 
Command Engine and 
retrieve a command for 
execution

1 OK

2 Untested

3 Unexpected error

4 Connection refused

5 Connection time-out

6 DNS does not resolve

7 Old agent version

8 Realm is unreachable

9 No gateway defined

10 Tunnel setup error

11 Gateway denied access

12 Gateway name resolution error

13 Internal gateway error

14 Gateway could not connect to 
server

15 Gateway time-out

16 No callback from agent

Agent to Data Access 
Engine (DAE)

Checks whether or not 
the agent can connect to 
the Data Access Engine 
and retrieve its device 
record

1 OK

2 Untested

3 Unexpected error

4 Connection refused

5 Connection time-out

6 DNS does not resolve

7 Old agent version

8 Realm is unreachable

9 No gateway defined

10 Tunnel setup error

11 Gateway denied access

12 Gateway name resolution error

13 Internal gateway error

14 Gateway could not connect to 
server

15 Gateway time-out

Table 7 Communication Test Types with Possible Results (cont’d)

Test Description Results
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See Communication Test Troubleshooting on page 353 for information on how to troubleshoot 
Communication Test Errors.

Additional Information on Communication Tests

In the case that the Communication Test cannot be performed on a server, you see an error 
named Unexpected Error with a small plus (+) button next to it. Click the plus (+) button to 
see the Additional Information window, which provides traceback information regarding the 
error. You can send this information to Customer Support to solve a problem of this nature. 
See Figure 30.

Agent to Software 
Repository 
Communication (SWR)

Determines if the agent 
can establish an SSL 
connection to the 
Software Repository

1 OK

2 Untested

3 Unexpected error

4 Connection refused

5 Connection time-out

6 DNS does not resolve

7 Old agent version

8 Server identification error

9 Realm is unreachable

10 No gateway defined

11 Tunnel setup error

12 Gateway denied access

13 Gateway name resolution error

14 Internal gateway error

15 Gateway could not connect to 
server

16 Gateway time-out

MID Match Checks that the 
Machine ID (MID) on 
the server matches the 
MID registered in the 
Model Repository for the 
agent

1 OK

2 Untested

3 Unexpected error

4 MID Mismatch

Table 7 Communication Test Types with Possible Results (cont’d)

Test Description Results
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Figure 30 Additional Information on an Unexpected Error 

Running a Communication Test on an Individual Server

Using the SAS Web Client, perform the following steps to run a Communication Test on an 
individual server to find out if the Agent on that server is reachable:

1 Run the SAS Web Client and log in to the desired core.

2 From the navigation panel, click Servers ➤ Managed Servers. 

3 From the Managed Servers list, click the display name of the server that you want to 
perform a Communication Test on.

On the Server Property page, look in the Status field and notice that the server is either 
listed as Reachable or Not reachable. If listed as Not Reachable, a date indicates when the 
last regularly scheduled Communication Test was performed. 

4 To see the results of the last Communication Test for this server, click Details. The 
Communication Test window for the server appears, as Figure 31 shows. 
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Figure 31 Communication Test Results on an Individual Server 

The results listed in this window show details from when the last regularly scheduled 
Communication Test was run. 

5 To view troubleshooting information for any of the test errors, move your mouse over the 
error name (for example SWR). When your mouse cursor changes to a question mark, 
click the question mark to view the troubleshooting help. 

6 To rerun the Communication Test, click Run Test Again. The new results display in the 
same window when the test finishes. 

Running a Communication Test on Multiple Servers

Perform the following steps to run a Communication Test on multiple servers and to find out 
which managed servers are not reachable: 

1 From the navigation panel, click Servers ➤ Managed Servers. 

2 In the Managed Servers Summary View page, select the servers for which you want a 
Communication Test. 

3 Choose Tasks ➤ Run ➤  Communication Test. The Communication Test window opens 
and the test is initiated. The top of the test window shows the status report for the 
Communication Test, which indicates the time of the test, how many servers in the test 
were reachable, which servers were not reachable, and a progress bar. This summary 
information is shown in Figure 32.
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Figure 32 Communication Test Summary 

— Date: Provides the date of the test.

— Statistics: Shows start and finish time, total servers OK, total servers with 
unreachable agents, and a summary of errors.

— Progress Bar: Provides live feedback of Communication Test progress. Progress data 
includes the number of servers completed, the total number of servers to be 
completed, and the list of servers completed so far.

— Refresh Results Button: Refreshes the results screen with new results. 

Below the summary section is a list of all Agents that were not reachable and their 
details, as Figure 33 shows. 

Figure 33 Communication Test Results on an Unreachable Agent   

— The results section shows a table of all unreachable servers, detailing server name, 
host name/IP address, OS, Agent version, registration (when the Agent last reported 
to HP Server Automation), and the time the test was completed.

— Click the title of each column to sort the test information by specific categories. 

— The Test Summary section shows a list of all Communication Test types that were 
run, and which errors were returned. For information about each type of error and 
how to troubleshoot Agent reachability problems, click the link on each error to view 
online help.
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Viewing Servers by Communication Status

Perform the following steps to view all managed servers with the most recent Communication 
Test results for each managed server:

1 From the navigation panel, click Servers ➤ Managed Servers. 

2 From the View menu, choose Communication. A list of the most recent Communication 
Test that was run on all managed servers appears. All servers listed in this view are listed 
as unreachable or reachable since the last regularly scheduled Communication Test was 
run. 

3 To sort the information in this view, click any of the column headings. For example, you 
might want to view the servers by number of errors. Click the Error column title by name, 
by OS version, and so on. 

4 To export this view to the CSV file format, choose Export to CSV from the Resource 
menu. 

5 To run a new Communication Test for some or all of the servers in this view, select the 
servers that you want to run a Communication Test on and then choose Run ➤  
Communication Test from the Tasks menu. 

Searching for Unreachable Servers

Another way you can discover unmanaged servers (those with unreachable agents) is to 
search for all servers that have a status of unreachable. See SA Client Search on page 43 on 
page 171 for more information. 

Perform the following steps to search for unreachable agents:

1 From the navigation panel, click Servers ➤ Server Search. The Server Search page 
appears.

2 From the Server Search page, choose the Agent Reporting attribute from the first list, as 
Figure 34 shows.
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Figure 34 Agent Reporting Server Search Attribute 

More criteria displays for the search parameters. 

3 From the far right list of search attributes, select Not Reporting. Your search parameters 
are Agent Status is Not Reporting.

4 Click Search. Wait a few moments for the results (the speed of the search results depends 
on how many managed servers are being searched). If any of your managed servers are 
not reachable, these servers will be listed in the search results. 

5 To run a new Communication Test on these servers, select the server (check box next to 
the server), and choose Run ➤ Communication Test from the Tasks menu. 

Viewing My Jobs Communication Tests

Each time that you run a Communication Test, the information is saved as a My Job. This 
feature automatically saves a history of all tests that you run. To view saved Communication 
Tests, perform the following steps: 

1 From the navigation panel, click My Job.

2 From the My Job list, click the Communication Test job that you want to view. 

3 In the Communication Test window, wait a few moments for the Communication Test 
information to load, then click View Details. You see the Communication Test window. 
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Exporting the Unreachable Server Status List to a CSV File

Perform the following steps to export the list of all servers that have a status of unreachable 
to a CSV (comma-separated value) file: 

1 From the navigation panel, click Servers ➤ Managed Servers. 

2 From the View menu, choose Communication. This displays a list of all servers that are 
in an unreachable or reachable state. 

3 To export a list of these servers to a CSV file, select the check box next to each server that 
you want to include in the report.

4 From the Resource menu, choose Export to CSV.
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4 Exploring Servers and Groups in the SA Client
Exploring Servers in the SA Client

The SA Client allows you to view a list of all your servers in your data center, which can exist 
in various states of SA management. All your servers can be accessed from the Devices pane 
in the main SA Client interface, as shown in Figure 35.

Figure 35 Servers in the Device Pane 

In order to visualize networking information with Network Automation (NA) inside of the SA 
Client, you must have both a licensed version of NA integrated with your SA core, plus an 
additional license for NA.

Additionally, in order to view storage devices and SAN information inside of the SA Client, 
Storage Essentials (SE) version 6.1.1 or later and the Server Automation SE Connector 
component must be installed and configured your SA core. For more information, contact your 
SA sales representative.

Server list

Devices pane 
showing device 

categories

Details pane
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Server Status

In the SA Client, you can determine the status of a server by the type of icon used next to the 
server in the list, as defined in Table 8.  

Table 8 Server Status Icons in SA 

Server Icon Description

Planned 

Indicates that a device record has been created for the server, but an OS 
Build Agent has not yet been installed on it. Servers in this stage cannot 
be provisioned until the OS Build Agent is installed. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Unprovisioned — Unreachable 

Indicates a server that has been registered with the core via the OS Build 
Agent, but has not reported as ready for provisioning recently. This may 
be due to networking problems between the server and the SA core or the 
server having been disconnected or powered off.

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Unprovisioned — Reachable 

Indicates a server that has been registered with the core via the OS Build 
Agent and is available to have a target OS installed on it. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Provisioning — Unreachable 

Indicates a server on which the OS Provisioning feature was in the 
process of installing the target OS, but for some reason stopped because 
the server is unable to communicate with the SA core. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Provisioning — Reachable 

Indicates a server on which the OS Provisioning feature is in the process 
of installing the target OS. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 
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Provisioning Failed — Unreachable 

Indicates an available server on which an error occurred while the OS 
Provisioning Subsystem was installing a target OS, and that the server is 
not able to communicate with the SA core. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Provisioning Failed — Reachable 

Indicates an available server on which an error occurred while the OS 
Provisioning Subsystem was installing a target OS. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Managed — Reachable 

Indicates a server has a Server Agent is running on it and that it is able 
to communicate with the SA core. 

In the SA Client, appears in the All Managed Servers list and Virtual 
Servers list.

In the SAS Web Client, appears in the My Jobs panel in the home page, 
in the list in the My Jobs page, in the Manage Servers list, and in the 
server lists in the SA wizards. 

Managed — Unreachable 

Indicates a managed server cannot communicate with the SA core (it is 
Not Reachable). 

If you want to discover reasons why the managed server is unreachable, 
you can run a Communication Test. See Agent Reachability 
Communication Tests on page 84 for more information.

In the SA Client, appears in the All Managed Servers list and Virtual 
Servers list.

In the SAS Web Client, appears in the My Jobs panel in the home page, 
in the list in the My Jobs page, in the Manage Servers list, and in the 
server lists in the SA wizards. 

Table 8 Server Status Icons in SA  (cont’d)

Server Icon Description
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Unmanaged 

Indicates the server is unmanaged, which means it does not have a 
Server Agent installed on it. 

For unmanaged virtual servers, this means that someone created a 
VMware Virtual Machine (VM) or Solaris local zone outside of SA and 
thus does not have a Server Agent installed on it. 

For virtual servers, this state could also mean that the VMware VM has 
not yet been provisioned, or that your user belongs to a group that does 
not have permissions to perform operations on this virtual server. 

For more information on installing a Server Agent on an unmanaged 
server, see Agent Management on page 63.

Deactivated 

Indicates a server that was deactivated in HP Server Automation so that 
it is currently not managed and is no longer reachable.

Appears in the Manage Servers list and in the server lists in the SA 
wizards (however, it is not selectable in the wizards).

Scheduled 

Indicates a server that is scheduled for an operation (install software, 
uninstall software, and so forth).

In the SA Client, appears in the Job Logs list. 

In the SAS Web Client, appears in the My Jobs panel in the home page 
and in the list in the My Jobs page.

Error 

Indicates a managed server on which an error occurred while HP Server 
Automation was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the My 
Jobs page.

Warning 

Indicates a managed server on which a warning occurred while HP 
Server Automation was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the My 
Jobs page. 

Application Configuration Out of Sync 

Indicates a managed server on which the configuration file on the server 
is out of sync with the Application Configuration Template (SA model).

Appears only in the Application Configuration feature and the server list 
in the SA Client.

Table 8 Server Status Icons in SA  (cont’d)

Server Icon Description
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Device Group Status

Device groups let you gather servers into logical sets to make performing actions on groups of 
servers easier and more efficient. The following table shows the icons displayed for device 
groups. See Device Groups on page 128 for more information.

Table 9 Device Group Status and Icons

Ways to Use the Device Explorer

The Device Explorer allows you to browse and manage servers, devices (such as network or 
storage), and groups of servers in your environment. 

Using the Device Explorer you can perform the following actions on individual servers: 

— Browse basic device system information, such as device, operating system, memory, 
Server Agent version, and more. 

— View device compliance information and view the details of any policies attached to 
the server, such as all audits, patch policies, software policies, as well as any 
application configurations attached to the server. 

— Run audits of the server, remediate any software policies attached to the server, and 
push application configurations on to a server.

— Browse live and up to date information about a server’s file system, registry, hardware 
inventory, hardware, ethernet and SAN connections, installed software and patch 
lists, runtime state, user and user group membership, services, snapshots, and more

— View server group membership. 

— View virtual server hypervisors and virtual machines (VMware, Solaris, and Microsoft 
Hyper-V).

Device Group 
Icon Description

Static Device Group 

Indicates a static server group. The same states that apply to single 
servers apply to groups. 

See Device Groups on page 128 for more information about the different 
types of server groups.

Dynamic Device Group 

Indicates a dynamic server group. The same states that apply to single 
servers apply to groups. 

Public Static Device Group 

Indicates a public and static server group. The same states that apply to 
single servers apply to groups. 

Public Dynamic Device Group 

Indicates a public and dynamic server group. The same states that apply 
to single servers apply to groups. 
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— Add and delete custom attributes.

Some Device Explorer features are not available for VMware ESXi servers because SA does 
not install a Server Agent on ESXi servers. For more information on ESXi servers, see Virtual 
Server Management on page 155. For more information on Server Agents, see Agent 
Management on page 63.

Network and Storage Devices in the Device Explorer

For more information on the types of information you can view in the Device Explorer for 
network and storage devices, see the following: 

— SA Integration Guide for network devices

— Storage on page 112

For more information on storage in the SA Client, see the Storage Visibility and Automation 
User’s Guide. 

Device Explorer Interface

The Device Explorer consists of two main sections: the Views pane and the Content pane. The 
Views pane lists server objects from the managed server, and the Content pane displays 
content for each of the server’s objects. When you select a server object in the Views pane, its 
corresponding content appears in the Content pane. See Figure 36.
100 Chapter 4



Figure 36 Device Explorer Interface 

Device Explorer Views Tabs

The Device Explorer Views tabs organize four different types of information about your 
device: 

— Information: Shows general property and system information, such as computer 
manufacturer, hardware type, system, processor and memory, OS version, Server 
Agent version and status (for those managed servers that have a Server Agent 
installed), SA customer assignment, history of changes to the server, and more. 

— Management Policies: Displays a roll up of all compliance policies attached to the 
server, as well as compliance for individual compliance policies, such as audits, 
software and patch policies, application configurations, and any custom user-create 
policies. It also shows any custom attributes created on the server. 

— Relationships: Shows all groups that the selected server is a member of and allows 
you to modify group membership (if your user has sufficient permissions). 

— Inventory: Displays a list of live server configuration objects and server modules 
captured directly from the server, such as registered hardware, network connections, 
snapshots taken of the server, installed packages, patches, discovered software, 
runtime information about processes running on a server, local security settings, 
users and groups memberships, and so on. 
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Accessing the Device Explorer

To access the Device Explorer, perform the following steps: 

1 Launch the SA Client and then from the Navigation pane, select Devices ➤ All 
Managed Servers. 

2 A list of servers will display in the Content pane.

If the list of servers is long, use the filter tool  to locate a server (upper right corner) by 
name, IP address, OS, customer, facility, or description. If you filter by user name, the text 
entry is case insensitive. 

You can also sort the list by clicking a column heading, such as name, IP address, OS, 
customer, and so on. To reverse sort, click the column heading a second time. 

3 Open a server from the Content pane. This opens the Device Explorer. From the Actions 
menu, you can perform many types of operations, such as:

• Open in Server Automation Visualizer (SAV) if your core is licensed to run SAV

• Run a script on the server

• Create or run an audit or snapshot of the server

• Scan software, application configuration, or patch compliance

• Add to a device group

• Export patch information to a .csv file

• And more

Action menu items change according to the server object selected. 

For example, if you select the Configured Applications object from the server object tree, 
then from the Actions menu, you can add, remove, or open an application configuration, 
create a package, and so on.

For VMware ESXi servers, some actions are not available because the SA Server Agent is not 
deployed on VMware ESXi servers. For more information on ESXi servers, see Virtual Server 
Management on page 155. For more information on Server Agents, see Agent Management on 
page 63.

Opening a Remote Terminal

You can open a remote terminal for any managed server, but not a group of servers. To do so, 
perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select Devices ➤ All Managed 
Servers.

2 Select a managed server and open it.

a In the Device Explorer window, from the Actions menu, select Launch Remote 
Terminal. 

b Log in to the remote terminal. 

See Opening a Remote Terminal on page 298 for more information.
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Information

The Device Explorer — Information allows you to review the following information: 

— Summary

— Properties

— Custom Attributes

— History

For VMware ESXi servers, some Device Explorer information is not displayed because the SA 
Server Agent is not deployed on VMware ESXi servers. For more information on ESXi servers, 
see Virtual Server Management on page 155. For more information on Server Agents, see 
Agent Management on page 63.

Summary 

The Summary view in the Device Explorer lists the following information: 

— System: This displays operating system information.

— Computer: This displays server manufacturer, hardware, and system details. 

— Agent: This displays communication status, the time when the server was last 
registered, the number of applications and patches registered with SA, and so on. 
(Servers that do not use an SA agent, such as VMware ESXi, will not display agent 
information.)

Properties

The Properties view in the Device Explorer lists the following information for the server that 
you are viewing: 

— Management Information

— Custom Fields

— Reported Information

— Server Modules

— Login Credentials

Management Information

— Name: This displays the name of the managed server.

— Notes: This displays any notes listed. 

— IP Address: This displays the IP address of the managed server.

— OS Version: This displays the operating system (platform) that the managed server 
is running on.

— Customer: This displays an account within HP Server Automation that has access to 
designated resources, such as servers and software.
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— Facility: This displays the location of the server. Users can manage servers in any 
facility from a SAS Web Client.

— Realm (link speed): This displays the minimum bandwidth limit between the 
Server Agent and the core (if the agent is going through gateways).

— Server Use: This displays how an organization is using the managed server; for 
example, a server could be a staging server, a production server, a development server, 
and so on. 

— Deployment Stage: This displays the stages of deployment for a server; for example, 
a server could be live or offline. 

— Lifecycle: This displays the server’s stage in the managed server lifecycle; for 
example, unprovisioned, available, managed, or deactivated. 

— Server ID: This displays the internal ID that SA uses to identify the server.

— Status: This displays whether or not the server is reachable and thus managed by SA. 
“OK” means that the server (its Server Agent) is reachable; unreachable means that 
there is a communication problem and SA cannot communicate with the server.

Custom Fields

This view lists the Custom Fields defined for the device and the value of each custom field.

SA can store a large amount of information about your managed servers. Custom Fields 
provide a way for you to store additional information about your servers quickly and easily. 
Customer Fields are data elements you can create for servers and other objects in SA.

For more information about custom fields, see “Running SA Extensions” in the SA User 
Guide: Application Automation.

Reported Information

— Reporting: This displays information about the ability of the server’s agent to 
communicate with the core. Statuses include Has not reported, OK, Registration in 
progress, and Reporting error. 

— Agent Version: This displays the version number of the agent. This only applies to 
managed servers where a Server Agent is installed.

— Hostname: This displays the host name of the managed server.

— Reported OS: This displays the operating system (platform) that the managed 
server is running on.

— MAC Address: This displays the Media Access Control (MAC) address. This is the 
network interface card’s unique hardware number. The MAC address is used as the 
server’s physical address on the network.

— Serial Number: This displays the serial number of the system. HP Server 
Automation attempts to report a chassis ID if possible.

— Chassis ID: This displays a unique hardware-based identifier that the Server Agent 
discovers, typically derived from some property of the server's chassis. As a common 
source for this ID, HP Server Automation uses an interface's MAC address or the host 
ID on Solaris servers, or the serial number for one of the interfaces.

— Encoding: This displays the character encoding of the managed server, such as 
Shift_JIS (Japanese) or Windows 1252 (Western).

From this window, you can also open a remote terminal on the selected server. 
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Server Modules

Server Modules extend the power of the SA Agent to provide rich configuration information 
for a specific server or group of servers. Server modules are deployable for specific platforms. 

When used in Audits or Snapshot Specifications, you can create configuration policies for 
specific Server Modules such as Windows Servers and Groups, and remediate any 
configurations that do not meet your data center’s standards. 

For more information about the Software Discovery Server Modules, see the SA Policy Setter 
Guide, or contact your SA administrator.

Login Credentials

This section displays the status of the stored login credentials for the managed server. The 
login credentials are only shown for VMware ESXi servers because SA does not install a 
Server Agent on ESXi servers. Instead SA manages ESXi servers remotely and stores an 
encrypted copy of the user login and password of the ESXi server.

If the credentials change on the ESXi server and are not updated in SA, SA will not be able to 
connect to the server. In this case, select the Edit Connection button to update the 
connection credentials. Note that the Manage Credentials permission is required for the Edit 
Connection button. If you do not have Manage Credentials permission, the Edit 
Connection button will not be displayed.

Custom Attributes

This view displays the custom attributes attached to a server. You can add, edit or remove 
custom attributes from this view.

Custom attributes can be one of two kinds:

• Inherited: Custom attribute value inherits from another source, such as a customer, a 
facility, a software policy, ISM control, and so on. 

• Locally Specific Value: Custom attribute is created directly on a servers.

To create a new custom attribute, click the Add  icon, and then enter a value. 

Overriding Inherited Custom Attribute Values

For all custom attributes that a server inherits from another source, such as from a customer 
or facility or device group, you can choose to override the inherited attribute’s value. 

To override inherited custom attribute values, perform the following steps:

1 From inside the Device Explorer Views pane, select Information ➤  Custom Attributes. 

2 In the Contents pane, for the inherited custom attribute you want to override, from the 
Source column select Overridden with Specified Value from the drop down list.

3 Enter a value in the Value field. 

For more information about custom attributes, see Custom Attributes for Servers on page 270 
of the SA User’s Guide: Server Automation.
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History

The History view shows changes made to the selected server. For example, it displays who 
modified a server, what change was made, when it was modified, and so on. Server History 
specifically shows when a user has performed one of the following actions: 

• Added the server to a group

• Removed the server from a group

• Reassigned the server from one group to another

• Login sessions

• Jobs that were run on the server, such as snapshots, audits, patch and software policy 
remediations

• And more

Entries are generated when actions are performed for managed servers in the SAS Web 
Client. The History is read-only. Double-click an entry to see more detailed information, such 
as:

• Date: The date when the last change occurred.

• Device Name: Name of the server or device where the change was made.

• User: The user who made the change. 

• Details: A description of the change.

Use the View drop-down list to sort the server history list according to a range of time, such as 
last week, the last two months, and so on. 

Management Policies

The Device Explorer — Management Policies allows you to review the following information:

— Compliance

— Audits

— Archived Audit Results

— Software Policies

— Patch Policies

— Configured Applications

Compliance

The Compliance view of the Device Explorer displays overall compliance levels — a roll up of 
all compliance policies attached to the server — and compliance for individual compliance 
policies, such as audits, software and patch policies, application configurations, and any 
custom user-created policies. 
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You can select and expand a compliance category and view all tests in each category. For each 
test you can view policy details and remediate any tests that are out of compliance. Each 
compliance category contains an expandable list that contains all the policies of this type. The 
top-level node shows the rollup compliance status of all policies in this category. If you expand 
the list, you can see each individual policy and its compliance status as well, for a detailed 
breakdown of compliance for the server. 

You can also sort the list to show all policies, or filter it to show only the policies for one 
compliance categories, such as all Audit policies and their compliance statuses. You can also 
sort by status filter, such as, show all compliance tests that are compliant, non-compliance, 
are currently scanning, and so on. 

For more information on server and device group compliance, see “Server Compliance” in the 
SA User Guide: Application Automation.

Compliance Categories

Compliance categories a server include: 

• Audit: A roll up compliance status of all scheduled audit that target this server appears 
by on the top node of the Audit category in the Details pane. This category displays the 
overall compliance status of all recurring audits that run on this server. To see the 
individual audits that use this server as a target, expand the Audit list, which shows each 
audit’s compliance status in the Status column. 

• Software: A roll up compliance status of all software policies attached to the server 
appears the top node of the Software category in the Details pane. Software compliance 
indicates whether or not all software policies attached to the selected server are compliant 
with the actual server configuration. 

A software policy can include installed packages and patches, application configurations, 
and other software policies. If the actual server configuration does not match the software 
policy definitions, then the server’s software policies are considered out of compliance. To 
see the individual software policies attached to this server, expand the Software list, 
which shows each software policy’s compliance status in the Status column.

• App Config: A roll up compliance status of all application configurations attached to the 
server appears the top node of the App Config category in the Details pane. An 
Application Configuration (App Config) policy defines how specific application 
configurations files should be configured on a managed server. Application Configuration 
compliance indicates whether or not all of the Application Configurations attached to a 
server are compliant with the actual application configuration files on the server. If the 
actual server configuration does not match the Application Configuration definitions, then 
the server’s Application Configurations are out of compliance. To see the individual 
application configurations attached to this server, expand the App Config list, which 
shows each application configuration s compliance status in the Status column.

Patch: A roll up compliance status of all patch policies attached to the server appears the 
top node of the Patch category in the Details pane. Patch compliance determines whether 
all patches in a patch policy and a patch policy exception were installed successfully. To 
test patch compliance, servers are scanned to determine whether they conform to their 
attached policies and exceptions, based on compliance status and rules. If any of the 
patches defined in the patch policy do not match what is actually installed on the server, 
then the server’s patch policies are out of compliance. To see the individual patch policies 
attached to this server, expand the Patch list, which shows each patch policy’s compliance 
status in the Status column.
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Audits

Audits view shows a list of all audits associated with the server, where the selected server is 
either the source or the target of an audit. 

Show Options

• Audit - Server is Target: Shows all audits where the selected server is the target of 
an audit. 

• Audit - Server is Source: Shows all audits where the selected server is used as the 
source of an audit. 

For more information, see “Audit and Remediation” in the SA User Guide: Application 
Automation.

Archived Audit Results

This list displays all audits results associated with this server that have been deliberately 
archived by a user. In some cases, audits that run regularly can accumulate many audit 
results. In the main Audit and Remediation feature, you can select to archive audit results if 
you want to save them for later viewing. All audit results for the selected server are displayed 
here. 

For more information, see “Audit and Remediation” in the SA User Guide: Application 
Automation.

Software Policies

This window displays all software policies associated with the selected server (or device 
group). You can perform actions such as attaching a policy, detaching a policy, remediating a 
server, and scanning software compliance from the Actions menu.

For more information, see Software Management on page 265.

Patch Policies

This window displays all patch policies associated with the selected managed server (or 
groups of server group). 

Show Options

The Show drop-down list displays the following patch policy information:

• Policies Attached to the Server: This displays all policies attached to the server, or 
policies attached to a server group to which the selected Windows managed server 
belongs. 

• Policies Not Attached to the Server: This displays a list of all patch policies relevant 
to the selected server that are not attached to the server.
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Configured Applications

The Configured Applications screen shows all the Application Configurations attached to the 
managed server. Each node under the Configured Applications node represents an application 
configuration attached to the server. Each subnode under each application configuration lists 
all the instances of the application configuration defined for the server.

You can edit the value sets at the server level and the server instance level.

• Selecting the Configured Applications node displays all the application configuration 
instances available to be pushed to the selected server.

• Selecting an application configuration displays the value set in the value set editor at the 
server level for the selected template.

• Selecting an instance of an application configuration displays the value set in the value 
set editor at the server instance level for the selected template.

For complete information on managing software and application configurations, see the SA 
Application Configuration Management Guide.

The example below shows two application configurations attached to the server m528 named 
myappcfg and WAS-app-config. Two instances are defined for WAS-app-config named 
“Primary Instance WAS-app-config” and “Secondary Instance WAS-app-config”.
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Running a Script on the Server

The Run Script button executes the selected Application Configuration’s data-manipulation 
script. If the application configuration contains no data-manipulation script, the Run Script 
button is disabled. For more information, see “About Running Scripts with Application 
Configurations” in the SA Application Configuration Management Guide.

Previewing an Application Configuration Push Operation

The Preview button compares the configuration file on the server with the configuration file 
defined by the selected instance and shows the two files. For more information, see in the SA 
Application Configuration Management Guide.

Push an Application Configuration to the Server

Thie Push button saves any changes you have made to the Application Configuration and 
starts the Push Configurations wizard to push the selected instance of the configuration file to 
the server. For more information, see “About Pushing Application Configurations to Servers” 
in the SA Application Configuration Management Guide.

Relationships

The Relationships view of the Device Explorer lists all device groups of which this server is a 
member. Members of a group can include servers, network devices (for NA-enabled cores), 
storage devices and assets (for SE-enabled cores), and other device groups.

You can select a group, right-click and select Open to view its contents. You can also select to 
Add to Group to select other devices to add to the group. 

If the list of groups is long, use the search tool  to locate a server (upper right corner) by 
name, description, access, type, modified by, and so on. If you search by device group name, 
the text entry is case insensitive. 

Storage Relationships

If your core is configured to connect to SE, Device Explorer view also gives you viewing access 
to various storage objects such as SAN switches, SAN fabrics, storage targets, and databases. 
For more information on these storage objects and relationships, select an object and press F1, 
or see the Storage Visibility and Automation User’s Guide.

Inventory

The Inventory tab shows gives you access to the following server objects discovered on the 
selected server:

— Hardware

— Network
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— Storage

— Disks

— Virtualization

— Snapshot Specifications

— Installed Packages

— Patches

— Files

— Windows COM+ Objects

— Windows IIS Metabase

— Windows IIS 7.0

— Internet Information Server (IIS)

— Windows Registry

— Services (Windows and Linux)

— Windows .Net Framework Configuration

— Local Security Settings

— Registered Software

— Runtime State

— Users and Groups

Hardware

The Hardware view lists all the reported hardware on the selected managed server. This 
includes the following information: 

— Processors: This lists the processor information for all processors on the managed 
server. 

— Memory: This lists the total amount and the types of memory on the managed server. 

— Storage: This lists all storage devices on the managed server.

— Network Interfaces: This lists the network interfaces on the managed server, 
including Ethernet cards (NICs) and any Fibre Channel Adapters, ports—including 
the switch ports that a port is connected to as well as any zones.

Network

The Network view shows all network connections (or SAN, for Storage-enabled cores), 
providing such details as IO address, subnet mask, MAC address, duplex, and more for all 
network interfaces.
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Storage

If your core is configured to connect to SE, the Inventory tab includes a Storage view that 
provides information about SAN, NAS and DAS (Direct Attached Storage) assets related to 
the selected server. 

This view also provides a summary of the storage (if applicable) consumed by and allocated to 
the selected server, as well as insight into Database storage (if applicable) consumed by the 
selected server.

In order to view storage devices and SAN information inside of the SA Client, Storage 
Essentials (SE) version 6.1.1 or later and the Server Automation SE Connector component 
must be installed and configured your SA core. For more information, contact your SA sales 
representative.

This Storage view provides details about the following storage assets:

• File Systems: Shows a list of local and remote file systems (SAN-based storage). It 
provides information such as mount location, type of file system, storage capacity and free 
space. From the View drop-down list, you can select four different views into File Systems: 

– Properties: Displays information like mount location, description for mount 
point; mount point, type of file system, storage capacity and free space.

– Volumes: Displays a list of volumes based on the selected file system.

– Disks: Displays a list of disks on which the selected file system is dependent.

– Connectivity: Displays supply chain information for the selected file system in a 
tree format. 

• Volumes: Shows a list of volumes consumed by the selected server. These volumes could 
be local or remote (SAN volumes). From the View drop-down list, you can select four 
different views into Volumes: 

– Properties: Displays the name, type, service type, status and storage capacity for 
the selected volume.

– Composition: Displays upstream and downstream storage dependencies. 
Upstream storage dependency means that the storage asset depends on the 
selected volume; downstream storage dependency means that the selected volume 
is dependent upon other storage assets.

– Disks: Displays the list of disks on which the selected volume is dependent.

– Access Path: Displays data which is mostly interesting if the selected volume is a 
remote SAN volume. This sub-view provides LUN Mapping information for the 
remote SAN Volume — the target storage array, target storage array port, target 
storage volume, LUN number and initiator port.

– Connectivity: Displays the supply chain information for a volume in a tree 
format. This view is useful in the context of remote SAN volumes.

• Unmounted Volumes: Shows a list of volumes that are available to the selected server 
but that are not used by the server. These volumes are typically remote SAN volumes 
which are mapped to the selected server but the server is not using them. From the View 
drop-down list, you can select four different views into Unmounted Volumes:

– Properties: Displays name, type (raid type), service type, status, storage capacity 
and target device for the selected Unmounted volume.
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– Composition: Displays downstream storage dependencies, which means that the 
unmounted volumes are dependent upon the selected storage asset.

– Disks: Displays the list of disks on which the selected unmounted volume is 
dependent.

– Access Path: Displays data which is mostly interesting if the selected unmounted 
volume is a remote SAN volume. This sub-view provides LUN Mapping 
information for the remote SAN Volume — the target storage array, target storage 
array port, target storage volume, LUN number and initiator port. 

– Connectivity: Displays the supply chain information for a unmounted volume in 
a tree format. This view is useful in the context of remote SAN volumes.

• Disks: Shows information about local and remote (SAN-based) disks. Detailed 
information includes name, manufacturer, model, device (server), storage capacity, status 
and if its spare or not. From the View drop-down list, you can select two different views 
into Disks Volumes:

– Volumes: Displays list of volumes based on the selected disk.

– File Systems: Displays a list of file systems based on the selected disk.

• Manager Software: Shows information about Volume Manager software and MultiPath 
software on the selected server, including vendor, version and details about logical 
volumes managed like name, type (RAID Type), service type, status, storage capacity and 
number of paths.

Disks

The Disks views provides local disk information for the managed server, including such 
information as disks names, manufacturer, the device that contains the disk, model number of 
the disk, its capacity, its status (identifies the disk health, such as OK, ONLINE, Disable, Not 
Ready, Error, READONLY), and whether the disk is used as a spare (Yes) or not used as a 
spare (No). 

Virtualization

The Virtualization view displays information about virtual servers — both hypervisors and 
virtual guest servers. For example, for a hypervisor server, the Virtualization view displays all 
virtual servers being hosted on the server. For virtual servers, the Virtualization view 
displays all virtual server information as well as the hypervisor server name that is hosting it.

For more information, see Virtual Server Management on page 155 and Server Status on 
page 96.

Solaris 10 — Device Explorer

You can use the Device Explorer to view a Solaris 10 global zone hypervisor and local zone 
server information. A global zone or local zone as seen through the Device Explorer looks 
nearly the same as a regular physical server, except that it has an extra property named 
“Virtualization,” which provides the following information: 

• Hypervisors: When you view a Solaris 10 global zone hypervisor in the Device Explorer, 
the Virtualization view shows all hosted local zones. From here, you can also stop and 
start the local zones.
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• Solaris Local Zones: When you view a Solaris local zone in the Device Explorer, the 
Virtualization view indicates the name of its hypervisor, its reserved CPU shares, and 
virtual hardware information.

VMware ESX — Device Explorer

You can use the Device Explorer to view a VMware ESX VM or a hypervisor’s server 
information. A VM as seen through the Device Explorer looks nearly the same as a regular 
physical server, except that it has an extra property named “Virtualization,” which provides 
the following information: 

• Hypervisors: When you view a VMware ESX hypervisor in the Device Explorer, you can 
see all of its hosted VMs. 

• VMware ESX VMs: When you view a VMware ESX VM in the Device Explorer, the 
Virtualization view shows you the VM’s virtual server properties, its virtual network 
configuration, and its data store configuration. 

Windows Hyper-V — Device Explorer

You can use the Device Explorer to view a Windows Hyper-V partition or a hypervisor’s server 
information. A partition as seen through the Device Explorer looks nearly the same as a 
regular physical server, except that it has an extra property named “Virtualization,” which 
provides the following information: 

• Hypervisors: When you view a Windows Hyper-V hypervisor in the Device Explorer, you 
can see all of its hosted partitions. 

• Windows Hyper-V Partitions: When you view a Windows Hyper-V partition in the 
Device Explorer, the Virtualization view shows you the partition’s virtual server 
properties, its virtual network configuration, and its data store configuration. 

Snapshot Specifications

The Snapshot Specifications view shows a list of all Snapshot Specifications where the 
selected server is listed as a target. To view the results of one of the Specifications, select it in 
the Contents pane (right side). When you select a Snapshot Specification, a list of all snapshot 
results appear in the pane below (for all servers that are targets of the Snapshot 
Specification). 

To open a Snapshot Specification, select one, right-click, and select Open (or double-click it). 
To view the results of a snapshot, select one from the lower pane, right-click, and select Open 
(or, double-click it). 

Installed Packages

The Installed Packages view enables you to view any installed packages on the selected 
managed server that are managed by the SA system. For each package, you can view name, 
type, size, last modified, and description. To sort the list by these categories, click the title of 
each column. See the SA Policy Setter Guide on how to create a package. 

For information about using the Device Explorer to see packages that exist on the manager 
server but are not yet managed by SA, see Patches on page 115.
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Patches

This window displays all patches associated with the selected managed server. 

Show Options – Windows

You can use the Show drop-down list to filter the following types of patch information:

• Patches Installed: This option displays all patches that have been installed on the 
server.

• Patches Recommended By Vendor: This option displays all application and operating 
system patches that have been recommended by Microsoft (MBSA 2.1) for the selected 
server. If multiple patches have the same QNumber, Patch Management detects the 
application files that are already installed on a managed server and, subsequently, 
recommends the correct patch to install.

• Patches with Policies or Exceptions: This option displays patches in policies attached 
to the selected server, or patches that have always install exceptions, and have one of the 
following conditions: 

— The patches are not currently installed and are recommended by the vendor.

— The patches are currently installed.

• Patches Needed: This option displays all patches that should be installed on the selected 
server but are not. These include patches that are in policies attached to that server, or 
patches that have always install exceptions, and are recommended by the vendor.

• Patches with Exceptions: This option displays all patches that have exceptions (such as 
always install or never install) and have one of the following conditions: 

— The patches are not currently installed and are recommended by the vendor.

— The patches are currently installed.

• All Patches: This option displays all patches that are associated with the operating 
system of the server.

Show Options – UNIX

The Show options for UNIX patches display the following information: 

• All Patches: This option displays all patches that are associated with the operating 
system of the server.

• Patches Installed: This option displays all patches that have been installed on the 
server.

Patch Contents – Windows

The Show options for Windows patches display the following information: 

• Icon: A dimmed icon means that the patch has not yet been uploaded to the Software 
Library. 

• Name: This is the QNumber of a patch that is a hotfix or an update rollup. Service pack 
patches do not have a QNumber.
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• Compliance: This shows one of the following three levels of patch compliance, as defined 
by a patch administrator:

— Non-Compliant (red): This indicates that the patch is installed on the server, but is 
not in the policy, or that the patch is not installed on the server but is in the policy. 

— Partial (yellow): This indicates that the policy and exception do not agree, and the 
exception does not have data in the Reason field.

— Compliant (green): This indicates one of the following conditions:

– A patch is installed on the server and is in a policy, or a patch is not installed on 
the server and is not in a policy.

– A patch is installed on the server and there are additional patches with the same 
QNumber in a patch policy or exception. In this case, all patches with the same 
QNumber are considered installed when Patch Management calculates patch 
compliance.

– A patch is not installed on the server and is in a patch policy or has an always 
install exception, and is not recommended by the vendor. In this case, the patch 
has a never install exception, because it is not recommended by the vendor.

In the Preview pane, move the cursor over the icon or text in the Compliance column to 
view patch compliance information about a server.

• Type: This shows the type of patch, such as Windows Hotfix or Windows Update Rollup.

• Bulletin: (Optional) This shows the Microsoft Security Bulletin ID number for this patch.

• Severity: (Optional) This shows one of the following three Microsoft severity ratings for 
this patch:

— Critical: This indicates a patch whose exploitation could allow the propagation of an 
internet worm, without user action.

— Important: This indicates a patch whose exploitation could result in a compromise of 
the confidentiality, integrity, availability of user data, or of the integrity or availability 
of processing resources.

— Moderate: This indicates a patch whose exploitability is mitigated to a significant 
degree by certain factors, such as default configuration, auditing, or the difficulty of 
exploitation.

— Low: This indicates a patch whose exploitation is extremely difficult, or whose impact 
is minimal.

• Release Date: This displays the date that Microsoft released this patch.

• Exception: This displays the type of patch policy exception set for the selected server.

• Installed: This shows if the patch is installed on the selected server.

• Recommended: A check mark indicates that this patch was recommended by the vendor 
(MBSA 2.1) during the last software registration.

• Description: This displays a description of the server.

• Opsware ID: (Optional) This displays a unique Opsware ID that identifies the patch 
object. 

• Locale: (Optional) This displays the encoding of the patch contents. 

• OS: (Optional) This displays the operating system version of the server.
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Patch Contents – UNIX

This shows the following Unix patch content information: 

• Icon: A dimmed icon means that the patch has not yet been uploaded to the Software 
Library. 

• Type: This shows the type of patch, such as Solaris Patch, HP-UX Patch Fileset, and so 
on. 

• Installed: This shows if the patch is installed on the selected server.

• Description: This displays a description of the server.

• Install Date: This displays the date the patch was installed on the server.

• Opsware ID: (Optional) This displays the unique Opsware ID that identifies the patch 
object. 

• OS: (Optional) This displays the operating system version of the server.

Files

The Files view enables you to browse the file system of a managed server. The File System has 
two main sections (similar to the Windows file system explorer): the server’s directories and 
the contents of the selected directory. 

The left side navigation panel of the Device Explorer shows all the directories of the selected 
server, and the right side of the Device Explorer lists the contents of the selected directory. 

For each file, the SA Client lists the file’s name, size, type, and date modified. To sort the files 
by any of these categories, click on the top of the column. 

Depending upon your user permissions, you might not have access to a particular server's file 
system. In such a case, you cannot select and view the server's file system in the Device 
Explorer. If you have access to a server's file system, then you will see user names, such as 
Administrator, root, and Local System. These are user names used to access that server's file 
system as the selected user.

Viewing File Contents

To view file contents, perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select Devices ➤ All Managed 
Servers. 

2 A list of servers will display in the Content pane. Select a server and open it. This opens 
the Device Explorer. 

3 From the left side of the Device Explorer, select a File System object. 

4 You are prompted to select a user name to log into the computer, such as Administrator, 
LocalSystem, or root. Select a user. 

5 To view the contents of disk drives or folders, expand the icon. Select a directory. 

6 From the Actions menu, select View Contents. The file content view pane appears at 
the bottom of the window. 

7 To change the character encoding, select an item from the Encoding drop-down list. 
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Ways to Copy Files

You can copy files from a server to another directory on the same server, to a directory on 
another SA-managed server, or to your local computer (where the SA Client is running). You 
can also copy a file from your local computer to a directory on the managed server. A few 
restrictions apply when copying files on a managed server’s file system using the Device 
Explorer: 

— You cannot copy folders/directories. 

— You can only copy to servers that you have permissions to write to and to view. 

— You can only copy one file at a time.

— You cannot undo a deletion — once you delete a file, it's gone. 

Copying Files Between Managed Servers

To copy files between managed servers, perform the following steps:

1 Launch the SA Client. From the Navigation pane, select the Devices ➤  All Managed 
Servers. 

2 To launch the Device Explorer, open a server from the server list.

3 From the left side of the Device Explorer, select a File System object. To view the contents 
of disk drives or folders, expand the icon.

4 Navigate to the directory that contains the file that you want to copy and select it. 

5 From the Actions menu, select Copy To. 

6 In the Copy To dialog box, select from the following locations in the drop-down list: 

• Managed Servers (other managed servers in the core)

• This Server

• Local File System

7 Navigate to the desired directory.

8 Click Select. 

Copying Files from Your Computer to a Managed Server

To copy files from your computer to a managed server, perform the following steps:

1 Launch the SA Client. From the Navigation pane, select Devices ➤ All Managed 
Servers. 

2 To launch the Device Explorer, open a server from the server list.

3 From the left side of the Device Explorer, select a File System object.

4 Navigate to the target directory where you want to copy the file. 

5 Use your system’s file system explorer to select the file that you want to copy, then drag 
the file to the desired location in the Device Explorer. 
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Deleting Files

Once you delete a file, it cannot be recovered. (However, before you delete, you are prompted 
with a confirmation dialog box.)

To delete a file, perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select the Devices ➤  All Managed 
Servers. 

2 To launch the Device Explorer, open a server from the server list.

3 From the left side of the Device Explorer, select a File System object.

4 Select a file to delete from the Content pane.

5 From the Actions menu, select Delete. 

6 Click Yes in the confirmation dialog box.

Renaming Files

To rename a file, perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select the Devices ➤  All Managed 
Servers. 

2 To launch the Device Explorer, open a server from the server list.

3 From the left side of the Device Explorer, select the File System object. To view the 
contents of a folder, expand the folder.

4 Select the file that you want to rename, and from the Actions menu, select Rename. 

5 Enter a new name for the file, then press ENTER. Pressing the ESC key on your keyboard 
will cancel the rename operation. 

Creating a Configuration Template from a File

For any file on a managed server, you can create a configuration template. 

To create a configuration template from a file, select the file. From the Actions Menu, select 
Create Configuration Template. See the SA User Guide: Application Automation for more 
information. 

Creating a Package from a File

For any file on a managed server, you can create an installable software package. For each 
package, you can specify the customer assignment, the reboot requirements, and the pre/post 
install and pre/post uninstall scripts.

To create a package from a file on the managed server file system, select the file. From the 
Actions menu, select Create Package. See the SA Policy Setter Guide on how to create a 
package. 

Windows COM+ Objects

This window displays a read-only view of all the COM+ objects on the selected managed 
server. In the Server Explorer window, the Views pane displays the following two folders for 
browsing COM+ objects: 
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— All Objects: This is a flat list of all the COM+ objects on the managed server.

— Component Categories: This contains an alphabetical list of all COM component 
categories. 

To view the contents of a COM+ object, perform the following steps: 

1 Select the All Objects or the Component Categories folder. In the Content pane, expand 
the folder until you reach an object.

2 To view the contents of a COM+ object, from the Actions menu, select View Contents. The 
contents will then display.

3 If the content of the COM+ object uses a different encoding, choose the appropriate 
encoding type from the Encoding drop-down list.

You must have specific user permissions to view Windows COM+ objects. If you are unable to 
access the Windows Registry, contact your SA administrator.   

Windows Registry

This window displays a read-only view of the Windows registry on the selected Windows 
managed server. You can navigate to this registry much like the regedit tool on the Windows 
operating system.

Folders on the left side of the window represent keys in the registry. Clicking a folder on the 
left displays entries in a key in the right window.

To view Windows Registry items, select the top-level Windows Registry icon in the Server 
Explorer and select a user from the menu. Your user must have proper permissions to view 
Windows Registry keys. If your user is unable to access the Windows Registry for the selected 
managed server, contact your SA Administrator.

The HKEY_CLASSES_ROOT might have thousands of entries and can take time to load.  

Services (Windows and Linux)

The Services window shows you a list of all running services on the selected managed server. 
Depending on the installed operating system, you can perform different operations on the 
services: 

• For Windows services, you can start, stop, pause, resume, and restart a service. You can 
also set the service to start manually, to start automatically when the system is rebooted, 
or to be disabled altogether. 

• For Linux servers (supported by Red Hat and SuSE versions), you can perform any action 
that a particular service supports. Supported actions may vary from service to service, for 
example, start, stop, restart, condrestart, or status. You can also specify the run levels 
that you want a service to run under.

To perform an operation on a service, select the service and right-click.
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Discovered Software

The Discovered Software feature provides a signature-based software discovery mechanism 
for Windows and UNIX managed servers to help you manage applications and software that 
are not managed by SA. 

Specifically, Discovered Software:

• Discovers unregistered software which is not currently managed by SA.

• Creates an inventory of software that is not installed as part of an OS-registered 
application, or that was custom built

• Provides system administrators the ability to create snapshots of the discovered software 
on a server and then periodically audits against the snapshots over time.

• Enables system administrators to track in-house or custom built software.

• Gives auditors a convenient method for discovering unsupported or unlicensed software 
installed on a server.

To enable this feature, you need to create an “inventory” snapshot of a server, which takes a 
picture all of the software and application information on the server. Additionally, you can 
also use an audit to capture the current state of a server’s software installations and, by 
running the audit on a regular schedule, you can monitor any installation changes over time. 

For more information on creating an inventory snapshot, see “Creating a Snapshot 
Specification” in the SA User Guide: Application Automation. 

Windows IIS Metabase

This window displays a read-only view of the IIS Metabase on the selected Windows managed 
server. You can use this window to browse the IIS Metabase much like one of the metabase 
browsing tools such as metaedit or the IIS Metabase Browser.

The left side of the Metabase window displays the hierarchical layout of the metabase tree. 
Selecting an item in the tree on the left shows the data items associated with the selected key 
in the right hand view. Clicking the (+) symbol to the left of a key item will expand the item's 
child keys.

To view Windows IIS Metabase items, select the top-level Windows Metabase icon in the 
Server Explorer, right-click, and select a user. Your user must have permissions to view 
Windows Metabase items. If your user is unable to access the Windows Registry, contact your 
SA Administrator.  

Windows IIS 7.0

The Windows IIS 7.0 server module allows you to view various elements and configuration of 
a server’s IIS 7.0 application, such as Application Pools, Web Sites, and Features. 

Add to Library/Add to Software Policy

From inside a server’s Device Explorer ➤  Inventory, you can add selected IIS .70 
configuration items to the SA library or to a software policy.
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For example, you can expand the IIS 7.0 Application Pools hierarchy in the Device Explorer, 
select an AppPool, right-click, and select Add to Software Policy. Using software policies, 
you can create a policy based upon the Application Pool configuration, attach it to other 
servers, and then remediate (install) onto other servers running IIS 7.0 and force them to 
conform to your company’s standards. 

If you select Add to Library, the IIS 7.0 configuration item becomes accessible to other users 
on your data center, for use specifically in software policies.

For more information on using Software Policies, see Software Management on page 265.

Using with Audits and Snapshot Specifications

You can also use IIS 7.0 inside of audits and snapshot specifications. In a snapshot 
specification, you can capture the state of your IIS configuration on a server you know to have 
a good configuration (a “golden” server), and use that to compare against other “target” 
servers running IIS 7.0. If any target server IIS 7.0 configurations do not match the golden 
server’s IIS 7.0 configuration, you can remediate those servers to ensure they are configured 
how you want them to be.

You can also use Audits to check a server’s IIS 7.0 configuration on a time or regular basis, so 
you can keep track of a server’s IIS 7.0 configuration, and remediate the server if it ever 
becomes “non-compliant.” 

For more information on creating audits and snapshot specifications for auditing and 
snapshotting IIS 7.0 configurations, see “Configuring Specific Audit and Snapshot Rules” in 
the SA User Guide: Application Automation.

Internet Information Server (IIS)

The Internet Information Service (IIS) window allows you to view the real time information 
about IIS for a Windows server, including IIS 7.0 for Windows 2008. For a Windows server you 
can view IIS information such as Server name, Server type, Server state, Log file path, and 
Document file path. 

For Windows 2008 servers running IIS 7.0, you can view Application Pools, Sites, and 
Features. You can select these objects and 

To view the information for the Internet Information Service server object, you will need the 
appropriate permissions. See the SA Administration Guide for information about the 
permissions required for the server object.

When you access the Internet Information Server for the first time, it may take a few minutes 
to load the server object. Subsequent usage of the server object will be significantly faster.

Using the Audit and Remediation feature you can specify audit rules for the Internet 
Information Service to compare Internet Information Service configurations against a 
baseline server, or user-defined values, or a server snapshot. For more information, see “Audit 
and Remediation” in the SA User Guide: Application Automation.

Local Security Settings

The Local Security Settings window allows you to view the real time information about 
security settings for a Windows managed server. For every Windows server you can view 
security settings such as Password policy, Audit policy, User rights, and Security options.
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To view the information for the Local Security Settings server object, you will need the 
appropriate permissions. See the SA Administration Guide for information about the 
permissions required for the server object.

When you access the Local Security Settings for the first time, it may take a few minutes 
minutes to load the server object. Subsequent usage of the server object will be significantly 
faster.

In the SA Client you can manage the Local Security Settings information by adding it to a 
software policy or audit.

• Using the Software Management feature, you can deploy the Local Security Settings on a 
managed server. See the SA User Guide: Application Automation for information about 
the Software Management feature.

• Using the Audit and Remediation feature you can specify the audit rules for the Local 
Security Settings and then remediate any differences found between the target server and 
the audit rule. See the SA User Guide: Application Automation for information about 
Audit and Remediation.

Registered Software

The Registered Software view allows you to view real time information of all the packages and 
patches installed on a managed server. For each package or patch you can view information 
such as Name, Version, Release, Unit Type, and Installed Unit.

To view the information for Registered Software, you will need the appropriate permissions. 
See the SA Administration Guide for information about the permissions required for the 
server object.

When you access Registered Software for the first time, it may take a few minutes to load the 
server object. Subsequent usage of the server object will be significantly faster.

Using the Audit and Remediation feature you can specify the audit rules for Registered 
Software to compare package and patch configurations against a baseline server, or 
user-defined values, or a server snapshot. For more information, see “Audit and Remediation” 
in the SA User Guide: Application Automation.

Runtime State

The Runtime State window allows you to view real time information about the run time data 
for a managed server. It provides information about the DNS servers, Routes, and Processes 
for every managed server.

To view the information for the Runtime State server object, you will need the appropriate 
permissions. See the SA Administration Guide for information about the permissions 
required for the server object.

When you access the Local Security Settings for the first time, it may take a few minutes 
minutes to load the server object. Subsequent usage of the server object will be significantly 
faster.
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Using the Audit and Remediation feature you can specify the audit rules for the Runtime 
State to compare Runtime state configurations against a baseline server, or user-defined 
values, or a server snapshot For more information, see “Audit and Remediation in the SA User 
Guide: Application Automation.

Windows .Net Framework Configuration

The Windows .Net Framework Configuration window allows you to view real time 
information about Assembly Cache and Configured Assembly List for a Windows server. 

For each Assembly Cache you can view information such as Assembly Name, Version, Locale, 
Public Key Token, Cache file (GAC or ZAP), Processor Architecture, Custom, and File name.

For every Configured Assembly List, you can view information such as Assembly Name, 
Public key token, Codebases, Binding policy, File name, File data.

To view the information for the Windows .Net Framework Configuration server object, you 
will need the appropriate permissions. See the SA Administration Guide for information 
about the permissions required for the server object.

When you are accessing the Windows .Net Framework Configuration for the first time, it may 
take a few minutes to load the server object. Subsequent usage of the server object will be 
significantly faster.

In the SA Client you can manage Windows .Net Framework Configuration information by 
adding it to a software policy or audit.

• Using the Software Management feature, you can deploy the Windows .Net Framework 
Configuration on a managed server. See the SA User Guide: Application Automation for 
information about the Software Management feature.

• Using the Audit and Remediation feature you can specify the audit rules for assembly 
cache and configured assemble list and then remediate any differences found between the 
target server and the audit rule. For more information, see “Audit and Remediation in the 
SA User Guide: Application Automation.

Users and Groups

The Windows Users and Group window allows you to browse and manage users and groups 
information on a Windows server. The Unix Users and Group window allows you to browse 
and manage users and groups information on a Unix server.

For every SA User you can view information such as Name, Description, Country code, Home 
directory, Password, Number of Logons, and Last logoff and logon time.

For every SA User Group you can view information such as Group Name and Description.

To view the information for the User’s and Groups server object, you will need the appropriate 
permissions. See the SA Administration Guide for information about the permissions 
required for the server object.

When you access the Users and Groups for the first time, it may take a few minutes to load 
the server object. Subsequent usage of the server object will be significantly faster.

In the SA Client you can manage the Users and Group information by adding it to a software 
policy or audit.
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• Using the Software Management feature, you can deploy the Users and Groups on a 
managed server. See the SA User Guide: Application Automation for information about 
the Software Management feature.

• Using the Audit and Remediation feature you can specify the audit rules for the Users 
and Groups and then remediate any differences found between the target server and the 
audit rule. For more information, see “Audit and Remediation in the SA User Guide: 
Application Automation.

Basic Server Management Tasks

You can perform the following basic server management tasks in the SA Client: 

• Refreshing Server Status

• Deactivating a Server

• Rebooting a Server

• Opening a Remote Terminal

Refreshing Server Status

Refresh a server to see if anything has changed on the server since you last looked at it in the 
SA Client. Refreshing a server retrieves the latest server information from the model 
repository and displays it. Refreshing a server’s status is good idea from time to time to make 
sure you are looking at current data on the server. 

For more information on server statuses, see Ways to Use the Device Explorer on page 99.

To refresh a server’s status, perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select Devices.

2 Select one of the server categories, such as Device Groups, All Managed Servers, 
Unprovisioned Servers, or Virtual Servers. (You cannot refresh server status of 
unmanaged servers or a device group.) 

3 Select one or more servers. 

4 Right-click or select the Actions menu and select Refresh Server. 
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Deactivating a Server

Deactivating a server removes the server from management by SA. You might want to 
deactivate a server, for example, if you are moving the server to a warehouse for storage. Or, 
you might want to deactivate a server when you need to rebuild it from scratch, without using 
the OS Provisioning feature.

When you deactivate a server, information about the server remains in the Model Repository 
for auditing purposes.

After you deactivate a server, you can reactivate it by re-installing a Server Agent with the 
Server Agent Installer and the --clean command line option. See Agent Reachability 
Communication Tests for more information.

Deactivating a server accomplishes the following tasks:

• Removes custom attributes from the server.

• Deletes any configuration tracking policies from the server that are associated with 
backups.

• Sets the server life cycle value to Deactivated.

To deactivate a server, perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select the Devices ➤  All Managed 
Servers. 

2 Select a server, right-click, and select Deactivate Server. 

Rebooting a Server

You can reboot a single server or a group of server immediately, or schedule the reboot for a 
later time. If you choose to reboot a group of servers, all servers contained in the group will be 
rebooted.

In order to be able to reboot a server, your user needs to belong to a user group that has the 
Reboot Server permission. For more information, contact your SA Administrator. 

If you are rebooting a hypervisor server that is hosting other virtual servers, then all virtual 
servers being hosted by that hypervisor will be shut down as well. Whether or not the hosted 
virtual servers get rebooted depends upon the individual virtual server’s configuration. 

To reboot a server, perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select Devices ➤ All Managed 
Servers or ➤  Device Groups. 

2 Select a server or group of servers, right-click, and select Reboot Server.

3 In the Reboot Server window, step one lists the server or servers you have selected to 
reboot. Click Next.

4 In the Scheduling page, choose if you want to reboot the server or group of servers 
immediately, or at some later time and date. To run the reboot at a later time, select 
Analyze and Run Task At, and then choose a day and time.

5 Click Next. 
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6 In the Notifications page, by default your user will not have a notification email sent when 
the reboot finishes, whether or not the reboot job is successful. To add an email notifier, 
click Add Notifier and enter an email address. 

7 (Optional) You can specific if you want the email to be sent upon success of the reboot job 

( ) and/or failure of the reboot job ( ). 

8 (Optional) You can specify a Ticket Tracking ID in the Ticket ID field. The ticket ID field 
is only used when SA Professional Services has integrated SA with your change control 
systems. It should be left blank otherwise.

9 Click Next.

10 In the Summary View page, click Start Job to reboot the selected server or group of 
servers. When the job has run, click View Results to view the results of the reboot job. 

11 In the Job Status page, you can see the progress of the job if you ran the job immediately. 
If the job is scheduled to run, you can close the window, and to view the job details, from 
the left side of the SA Client, select Jobs and Sessions ➤ Job Logs.

SA Tasks that Reboot a Server

There are a few other SA tasks that will initiate a server reboot, depending on the options set 
in the task:

• Installing or uninstalling a patch on Windows or UNIX. See Setting Reboot Options for 
Remediation on page 193 (Windows) or Setting Reboot Options for a Unix Patch 
Installation on page 245 for more information. 

• Remediating a Patch policy. See Remediating Patch Policies on page 191 for more 
information.

• Installing a package and remediating a software policy. See Specifying Options for 
Remediation on page 281 for more information.

Opening a Remote Terminal

You can open a remote terminal for any managed server, but not a group of servers. To do so, 
perform the following steps: 

1 Launch the SA Client. From the Navigation pane, select Devices ➤ All Managed 
Servers.

2 Select a managed server and open it.

a In the Device Explorer window, from the Actions menu, select Launch Remote 
Terminal. 

b Log in to the remote terminal.
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Device Groups

The Device Groups feature provides a useful way to gather servers and other types of network 
and storage devices into logical sets. A device group simply acts as a container for a set of 
servers and other devices. Grouping servers lets you perform actions such as installing 
patches or remediating servers on all of the servers in a device group simultaneously, instead 
of having to perform the action on each individual server one at a time.

Below are some recommended ways of grouping servers.

• Grouping servers by OS version

• Grouping servers by customer

• Grouping servers by facility

• Grouping servers by deployment stage

• Grouping servers by use

• Group servers by virtual technology

• Grouping servers by operational boundaries, for example, grouping together all servers 
that require identical application configurations

• Grouping servers to control access, for example, creating device groups that are associated 
with a specific user group

Characteristics of Device Groups

Device groups contains the following characteristics listed in Table 10:

• All device groups are either public or private.

— Public groups are accessible to all users with the Manage Public Device Groups 
permission.

— Private groups are accessible only to the user who created the group.

• All device groups are either static or dynamic.

— Static groups contain a fixed set of devices that you add manually to the group.

— Dynamic groups contain all the servers that satisfy a set of rules that you define. 
Dynamic groups automatically add or remove servers based on whether or not the 
servers satisfy the defined rules.

• Individual servers can be included in multiple device groups or not included in any device 
groups.

Table 10 Device Group Characteristics

Public Groups Private Groups

Static Groups Access: Visible to all.

Membership: Fixed.

Access: Visible only to the owner.

Membership: Fixed.

Dynamic Groups Access: Visible to all.

Membership: Based on rules.

Access: Visible only to the owner.

Membership: Based on rules.
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— Adding a server to a device group does not remove the server from the All Managed 
Servers list in the SA Client.

Figure 37 shows these four types of device groups in the SA Client. The group named “M1 
group” is a private, dynamic group. The group named “Hardware Groups” is a public, static 
group.

Figure 37 Device Group Types

Groups and Subgroups

Device groups can contain other device groups, called subgroups. In other words, device 
groups are hierarchical, meaning they can be nested, with the following caveats:

• Private and public groups cannot be mixed in a hierarchy. That is, a private group cannot 
be a member of a public group and vice versa.

• Static and dynamic groups can be mixed in a hierarchy. That is, a static group can be a 
member of a dynamic group and vice versa.

• The rules for a dynamic group are not inherited from a parent dynamic group to a child 
dynamic subgroup. Each group defines its own set of rules, independent of whether or not 
it is part of another group.

• Groups do not inherit custom attributes from their parent groups.

• When you run an operation on a device group that contains subgroups, the operation also 
applies to all the servers in the subgroups. For example, remediating a device group 
remediates all servers in its subgroups, but the subgroups do not inherit the software 
policy attached to the device group. However, when an Application Configuration 
operation within the SA Client is applied to a device group that contains subgroups, the 
operation does not apply to all the servers in the subgroups. It only applies to the servers 
in the group upon which the operation was directly applied.

Public Device Groups

Public groups are visible to all users, and can be used by any SA user. Public device groups 
can also be used for modeling. For more information on modeling, see Public Device Group 
Modeling below.
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Public device groups can be created, edited, or deleted by any user who has Manage Public 
Device Groups permissions. Only users with Manage Public Device Group permission can add 
members to a static public device group or change the rules that govern the dynamic public 
device group.

Accessing servers in a public device group also depends on the Device Group permission in the 
SAS Web Client. See the SA Administration Guide for more information about setting device 
group permissions. 

Public Device Group Modeling

With SA modeling, the desired state of a server is defined and then applied to servers. In the 
case of public device groups (static and dynamic), you can define a model consisting of 
application configurations, patch policies, software policies, and custom attributes, which will 
be applied to all servers in the group. The modeling information is attached to the group, but 
not to any subgroups.

If the modeling information changes, the servers in the group are not affected until the 
remediation operation runs on those servers. If the model has already been remediated on 
that server when it is removed from the group, the installed material will be removed during 
the next remediation.

Private Device Groups

Each SA user automatically gets their own private device group area with the same name as 
their SA user name. Only the user who creates the private device groups can see and manage 
them. These groups are not visible to the other SA users. Private groups behave the same way 
as public groups, with the exception that modeling is not available for private groups.

Private device groups can be created by any user belonging to a user group that has access to 
the Servers list.

Static Device Groups 

A static group has servers that are added to and removed from the group manually. When 
using static groups, you first create the group, and then select the servers to populate it.

Dynamic Device Groups 

Dynamic device groups contain servers and other devices that are added to or removed from 
the group based on a set of user-defined rules. Once the rules have been created, SA will 
search for servers and devices that match the rules and add them to the group.

If the rules are changed and if the servers in the environment change or if servers are added 
to or removed from the managed environment, servers will be added to or removed from the 
group automatically. SA automatically recalculates dynamic group membership every hour.

Rules apply only to the group being created or modified and not to any of its subgroups.
130 Chapter 4



Ways to Create Device Groups

In the SA Client, you can create a device group from the All Managed Servers list or by 
performing a server search, and saving the resulting list of servers or the rules as a group.

You can create the following types of device groups: 

• Creating a Static Device Group on page 131

• Creating a Dynamic Device Group on page 135

• Creating a Device Group Using Search on page 141

Creating a Static Device Group 

This section describes how to create a static device group. Static groups contain a fixed set of 
devices that you manually add to or remove from the group. Static device groups must be 
either public or private. 

To create a public static device group, you must have Manage Public Device Group 
permissions. To obtain these permissions, contact your SA Administrator.

To create a static device group, perform the following steps:

1 From the navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Content pane. All the public device groups are under Public. All your 
private device groups are under your user name.

2 Navigate to the location where you want to create your group.

— To create a public group, select Public or an existing group under Public.

— To create a private group, select your user name or an existing group under your user 
name.

3 From the Actions menu, select Device Group ➤  New Static Group.

This creates an empty device group named New Device Group (n), where n is a number 
based on the number of new device groups already in existence.

4 You can rename the device group by selecting it and either right clicking on it and 
selecting Rename or by selecting the Actions ➤ Rename menu item.

After you create a static device group, you can add servers to the group. See Adding a 
Server to a Static Device Group below.

Adding a Server to a Static Device Group

You can use either of the following two methods to add a server to a static device group: 
Method 1 - Select Device Group First, then Servers on page 132 or Method 2 - Select Servers 
First, then Device Group on page 132.

To add a server to a public static device group, you must have Manage Public Device Group 
permissions. To obtain these permissions, contact your SA Administrator.
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Method 1 - Select Device Group First, then Servers

To add a server or device group to a static device group, perform the following steps:

1 From the Navigation pane, select Devices ➤  Device Group. The device groups appear 
in the Content pane. You can distinguish between static and dynamic device groups by 
their icon. See Table 9 Device Group Status and Icons on page 99.

2 Navigate to the desired static device group. Select the device group in the Content pane, 
and from the Actions menu, select Open. The Device Group Explorer appears.

3 From the Views pane of the Device Explorer window, select Device Membership. This 
displays a list of servers in the group.

4 From the Actions menu, select Add. The Add Members to Static Group window appears.

Figure 38 The Add Members to Static Group Window in the SA Client 

5 Select one or more servers to add to the static device group.

6 Click Add to Group. The selected severs are added to the device group and appear in the 
Device Group Browser.

7 From the File menu, select Save to save the device group.

Method 2 - Select Servers First, then Device Group

Perform the following steps to add a server to a static device group:

1 From the Navigation pane, select Devices ➤  All Managed Servers. The list of managed 
servers appears in the Content pane.

2 From the Content pane, select one or more servers and then from the Actions menu, 
select Add to Device Group. The Add to Group window appears.

3 Select the static device group to add the servers to.
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4 Select Add to Group. The selected servers are added to the static device group.

Method 3 - Import CSV File

You can add servers to a static device group by importing a CSV (comma-separated value) file 
containing the host names of the servers you want to add to the group. The CSV file contains 
a single column of string data representing server host names. The following characters have 
special meanings:

• The asterisk (*) indicates zero or more of any legal character (letters, numbers, the 
underscore character and dot).

• Lines that start with the “#” character are ignored. You can use them to insert comments.

• Blank lines are ignored.

For example, the following shows a CSV file that specifies a server named “myhost.hp.com”, 
all servers that start with the string “ca”, and all servers that end with “.mycustomer.com”:

# This is a comment line.
myhost.hp.com
ca*
*.mycustomer.com

The following shows a list of hosts and which hosts would be selected by this CSV file:

myhost.hp.com            This host would be selected.
myhost2.hp.com           This host would not be selected.
ca23.hp.com              This host would be selected.
ca28.hp.com              This host would be selected.
carl.hp.com              This host would be selected.
acam.hp.com              This host would not be selected.
host01.mycustomer.com    This host would be selected.

To add servers to a device group from a CSV file, perform the following steps.

1 From the Navigation pane, select Devices ➤  Device Group. The device groups appear 
in the Content pane. You can distinguish between static and dynamic device groups by 
their icon. See Table 9 Device Group Status and Icons on page 99.

2 Navigate to the desired static device group. Select the device group in the Content pane, 
and from the Actions menu, select Open. The Device Group Explorer appears.

3 From the Views pane of the Device Explorer window, select Device Membership. This 
displays a list of servers in the group.

4 From the Actions menu, select Import.... The Import window appears.

5 Select the CSV file and click Open. This displays the Add Members to Static Group 
window that lists the servers that can be added to the device group.

6 Select the servers you want to add to the device group.

7 Select Add to Group. This adds the selected servers to the device group.
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Removing Servers from a Static Device Group

In a static device group, servers must be removed manually. Removing a server only removes 
the server from the device group and not from the All Managed Servers list. Servers can 
belong to more than one device group, so if you want to remove a server from each device 
group that it belongs to, then you must locate and remove each instance of the server from all 
the device groups it is a member of.

To remove servers from a public device group, you must have Manage Public Device Group 
permissions. To obtain these permissions, contact your SA Administrator.

Method 1 - From the Device Group Explorer

To remove a server from a static device group, perform the following steps: 

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Content pane.

2 Navigate to the desired static device group. Select the device group in the Content pane, 
and from the Actions menu, select Open. The Device Group Explorer appears.

3 From the Views pane, select Device Membership. The list of servers in the device group 
appears in the Content pane.

4 Select the server you want to delete. From the Actions menu, select Remove. Or right 
click on the server and select Remove. The selected server is removed from the static 
device group.

5 From the File menu, select Save to save the device group.

Method 2 - From the SA Client

To remove a server from a static device group, perform the following steps: 

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Content pane.

2 Navigate to the desired static device group. Select the device group and double-click to 
display its members.

3 Select the server displayed in the Content pane. From the Actions menu, select Remove 
Member. The server selected is removed from the static device group.

Method 3 - From the Device Explorer

To remove a server from a static device group, perform the following steps: 

1 From the Navigation pane, select Servers ➤  All Managed Servers. The list of servers 
appears in the Content pane.

2 Navigate to the desired server. Select the server and double-click to display it in the device 
explorer window.

3 Select Relationships in the Navigation pane. This displays all the static groups the server 
belongs to.

4 Select a static device group from the Content pane.
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5 From the Actions menu, select Remove from Group. Or right click the server and 
select Remove from Group. The server selected is removed from the static device group.

Creating a Dynamic Device Group 

Dynamic device groups are defined by one or more rules. The servers in a dynamic group are 
added or removed automatically based on the rules that you define. This section describes 
how to create a dynamic device group. The following section describes how to create rules that 
determine the members of the group.

To create a public dynamic device group, you must have Manage Public Device Group 
permissions. To obtain these permissions, contact your SA Administrator.

To create a dynamic device group, perform the following steps:

1 From the Navigation pane, select Devices ➤ Device Groups. The list of existing device 
groups appears in the Content pane. All the public device groups are under Public. All 
your private device groups are under your user name.

2 Navigate to the group where you want to create your new group.

— To create a public dynamic device group, select Public or navigate to a group under 
Public.

— To create a private dynamic device group, select your user name or navigate to a group 
under your user name.

3 From the Actions menu, select Device Group ➤  New Dynamic Group.

This creates an empty device group named New Device Group (n), where n is a number 
based on the number of new device groups already in existence.

4 You can rename the device group by selecting it and either right clicking on it and 
selecting Rename or selecting the Actions ➤  Rename menu item. Enter the name of 
the device group in the Content pane. 

5 After you create a dynamic device group, you need to define the rules for the group. For 
more information, see About Rules for a Dynamic Device Group below.

About Rules for a Dynamic Device Group

Servers and other devices are automatically added to and removed from dynamic device 
groups by SA based on the rules you create for the group. You can change the membership of a 
dynamic group by adding, deleting, or modifying these rules. See also Adding Rules for a 
Dynamic Device Group on page 138 and Modifying Rules for a Dynamic Device Group on page 
140.

A rule is a condition that specifies values for some attribute of servers such as IP address, 
server name, operating system, and many others. Servers either comply with each rule or not. 
For example, the following are example rules and example servers that demonstrate how 
servers would be included in the group or excluded from the group.

• All servers with a name that begins with the string “pro”. A server named 
“provision1.hp.com” would be included by this rule. A server named “approval4.hp.com” 
would not.

• All servers that are in the subnet 192.168. A server at IP address 192.168.123.7 would be 
included by this rule. A server at IP address 192.167.43.18 would not.
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• All servers with operating system HP-UX version 11.31. All servers with this operating 
system would be included by this rule. Servers with any other operating system or any 
other version of HP-UX would not.

• All servers attached to a particular software policy named “AccountingDB”.

• All servers that have a particular patch installed.

You can define a wide variety of rules and create as many device groups as you need to make 
managing your IT environment faster, easier and more efficient.

Format of Rules

Rules take the following form:

Search for: <Device>

Where: <Attribute> <Operator> <Value>

• <Device> is typically Server because device groups contain servers, but it can also be other 
kinds of devices.

• <Attribute> is some piece of data about the device you want the rule to examine.

• <Operator> is a comparison you want to perform between the <Attribute> and the 
<Value>.

• <Value> is the specific data you want to compare to the <Attribute> using the <Operator>.

Example Rule 1 - Servers Running a Particular OS

Figure 39 displays a dynamic device group rule that selects all servers running the AIX 6.1 
operating system and places them into the device group:

Figure 39 Select All Servers Running AIX 6.1 Device Group Rule
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Example Rule 2 - Servers Attached to a Software Policy

Figure 40 displays a dynamic device group rule that selects all servers attached to the 
software policy “HP-UX ISMTool”:

Figure 40 Servers Attached to a Software Policy Device Group Rule

Example Rule 3 - Servers with a Particular Name

Figure 41 displays a dynamic device group rule that selects all servers with a name beginning 
with the characters “pro”:

Figure 41 Servers with a Particular Name Device Group Rule

Example Rule 4 - Servers in a Subnet

You can create device groups containing servers on a particular subnet. You can use an IP 
address and either a subnet mask or a CIDR number to specify the network address of the 
subnet. When you select IP Address as the server attribute to search on and Within Subnet as 
the operator, you must enter an IP address and either a subnet mask or a CIDR number as 
follows:

• <IP address>/<Subnet mask>

• <IP address>/<CIDR number>

For example, both of the following examples specify a subnet of 192.168:

• Subnet mask: 192.168.0.0/255.255.0.0
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• CIDR block: 192.168.0.0/16

Configuring Multiple Rules

You can configure multiple rules and combine them with a logical And or a logical Or. Select 

 to add a rule. Select  to remove the selected rule or rules. Select either Logical And or 
Logical Or to logically combine the rules.

You can create more complex logical expressions using the SearchService interface in the 
com.opsware.search package of the SA Twister API. For more information on the SA Twister 
API, see the HP Server Automation Platform Developer’s Guide.

Example of Multiple Rules

Figure 42 displays a dynamic device group rule two rules combined with a logical And to 
select all servers that both have a name that begins with the characters “pro” and run AIX 
6.1: 

Figure 42 Multiple Dynamic Device Group Rule

Adding Rules for a Dynamic Device Group

Rules determine which servers are included in a dynamic group. 

To add a server to a dynamic public device group, you must have Manage Public Device Group 
permissions. To obtain these permissions, contact your SA Administrator.
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To add a rule to a dynamic group, perform the following steps.

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Navigation pane and the Content pane.

2 In the Navigation pane, navigate to the dynamic device group you want to modify.

You can determine whether a device group is static or dynamic from the icon next to its 
name as described in Table 9 Device Group Status and Icons on page 99.

3 From the Content pane, select the device group and then select the Actions ➤  Open 
menu item. This opens a Group View window.

You can determine whether a group is static or dynamic from the Summary View, under 
Properties.

4 From the Views pane, select Device Membership. This displays the rules defined for the 
group in the Content pane. See Figure 43 below.

Figure 43 Defining Rules for a Dynamic Device Group

5 Create a rule by first selecting the type of device you want to include in the device group 
from the “Search For:” drop-down list. Depending on the type of device you select, the 
other drop-down lists change to correspond to the device type. Figure 43 shows Server 
selected.

6 Select the attribute to search on from the “Where:” drop-down list. Depending on the 
attribute that you select, options available for the operator and values for the rule in the 
remaining drop-down lists will change.

7 Select the operator from the next drop-down list.

8 Enter a value in the field, or select a value from the drop-down list, or click  to select 
one or more values from the Select Values window. 

9 Click  to add additional rules and repeat steps 6 to 8. Click  to delete a rule.

10 Select the logic (logical And or logical Or) to be applied to the set of rules.
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11 Click Preview to view the servers that satisfy all the rules and are therefore members of 
the device group.

12 From the File menu, click Save to save your rules in the dynamic device group.

Modifying Rules for a Dynamic Device Group

Rules determine which servers are included in a dynamic group. To modify a rule in a 
dynamic group, perform the following steps.

To modify rules for a dynamic public device group, you must have Manage Public Device 
Group permissions. To obtain these permissions, contact your SA Administrator.

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Navigation pane and the Content pane.

2 In the Navigation pane, navigate to the dynamic device group you want to modify.

You can determine whether a device group is static or dynamic from the icon next to its 
name as described in Table 9 Device Group Status and Icons on page 99.

3 From the Content pane, select the device group and then select the Actions ➤  Open 
menu item. This opens a Group View window.

You can determine whether a group is static or dynamic from the Summary View, under 
Properties, or from the Properties view next to Type.

4 From the Views pane, select Device Membership. This displays the rules defined for the 
group in the Content pane. See Figure 43 below.

5 Modify the rules for the device group as needed. For more information on rules, see About 
Rules for a Dynamic Device Group on page 135 and Adding Rules for a Dynamic Device 
Group on page 138.

6 Click Preview to see the list of servers that satisfy all the rules and are therefore 
members of the device group.

7 From the File menu, click Save to save your rules in the dynamic device group.

Converting a Dynamic Group to a Static Group

You can convert a dynamic device group to a static device group. When a dynamic device 
group is converted to a static device group, all the servers that match the rules at that time 
are placed in the static device group, but the rules used to define the server membership are 
lost. To convert a dynamic group to a static group, perform the following steps.

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appear in the Content pane.

2 From the Navigation pane, navigate to a dynamic device group.

You can determine whether a device group is static or dynamic from the icon next to its 
name as described in Table 9 Device Group Status and Icons on page 99.

3 From the Content pane, select the dynamic device group.

4 Select the Actions ➤  Open menu item. This displays information about the device group 
in a new window.
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5 In the Views navigation panel on the left, select Properties. This displays detailed 
information about the device group.

6 Locate the Type row and drop-down list next to it. In the drop-down list, select Static.

7 Select the File ➤  Save menu item. This saves the group as a static group. All the rules 
that were used to define the dynamic group are lost.

Creating a Device Group Using Search

To create a public device group, you must have Manage Public Device Group permissions. To 
obtain these permissions, contact your SA Administrator.

You can create a search for servers and use the search results to create a device group. To 
create a device group using search, perform the following steps:

1 From the Navigation pane, select Advanced Search. The Advanced Search page appears 
in the Content pane.

For more information on advanced search, see the User’s Guide: Server Automation.

2 From the first drop-down list, select Server.

3 Create your search criteria by setting up a rule in the “Where:” line. Select a server 
attribute to search on from the first drop-down list. Depending on the attribute that you 
select, options in the remaining two drop-down lists (operator and value) will change.

4 Select the operator from the second drop-down list. The operator selected defines how the 
search value is treated.

5 Enter a value in the third field or select a value from the drop-down list or click  (only 
shown for some attributes) to select one or more values from the Select Values window. 

6 Click  to add rules and repeat steps 3 to 6. Click  to delete any rules.

7 Select the logic (logical And or logical Or) to be applied the set of rules in the search. 

Figure 44 shows an advanced search with two conditions logically Anded together:

Figure 44 Advanced Search with Two Conditions Logically Anded Together

8 Click Search to run the search. The results appear in the Content pane. 

9 Click Save to save your search. The Save Search window appears as shown in Figure 45 
below.

10 In the Search Type drop-down list, select Dynamic Device Group or Static Device Group.
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11 Navigate to the location where you want to save the group, either under Private Groups or 
under Public Groups.

12 Enter the name of the new device group in the Save As text box.

13 Click Save to save your new device group.

Figure 45 The Save Search Window in the SA Client 

When you save the device group as a dynamic group, if the rules change or the servers in the 
environment change, servers will be added to or removed from the device group automatically. 
When you save the device group as a static group, the servers will be added to the device 
group, but all rules will be lost.

If the search query does not return any results, then you can only save the device group as a 
dynamic device group.

Moving a Device Group 

You can move device groups to a different location under Device Groups. You can move device 
groups from a private group to a public group, but you cannot move device groups from a 
public group to a private group. If you move a device group containing subgroups, the 
subgroups are also moved.
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To move a public device group or to move a private group to a public group, you must have 
Manage Public Device Group permissions. To obtain these permissions, contact your SA 
Administrator.

To move a device group, perform the following steps:

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Content pane.

2 From the Navigation pane, navigate to the desired group.

3 From the Content pane, select the device group you want to move. 

4 From the Actions menu, select Device Group ➤ Move.... The Move Group window 
appears as shown below.

Figure 46 The Move Device Group Window in the SA Client 

5 Select the desired new location for the device group.

6 Click Move Group. The device group is moved to the new location.

Duplicating a Device Group

When you duplicate a device group, the servers are copied to a new group and they remain in 
the original group. In the SA Client, you can only select one device group at a time to 
duplicate. 
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To duplicate a public device group, you must have Manage Public Device Group permissions. 
To obtain these permissions, contact your SA Administrator.

To duplicate an existing device group, perform the following steps:

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Content pane.

2 From the Navigation pane, navigate to the desired group.

3 From the Content pane, select the device group you want to duplicate.

4 From the Actions menu, select Device Group ➤ Duplicate. This creates a copy of the 
device group.

5 You can rename the group by selecting it and selecting Actions ➤  Rename.

Deleting a Device Group

Deleting a device group removes the group, but the servers in the group still remain in the All 
Managed Servers list and in any other groups they are members of.

A group cannot be deleted when any of the following conditions apply:

• The device group contains other device groups.

• Software policies or patch polices are attached to the group.

• Access controls are set for the group. For more information on controlling access to device 
groups, see “Setting the Device Group Permissions” in the SA Administration Guide.

To delete a public device group, you must have Manage Public Device Group permissions. To 
obtain these permissions, contact your SA Administrator.

To delete a server group, perform the following steps:

1 From the Navigation pane, select Devices ➤  Device Groups. The list of device groups 
appears in the Content pane.

1 From the Navigation pane, navigate to the desired group.

2 From the Content pane, select the device group you want to delete.

3 From the Actions menu, select Device Group ➤  Delete. 

4 Click Delete Selected Groups on the confirmation dialog to delete the device group.

Device Group Explorer

The Device Group Explorer allows you to view and manage the properties of a device group in 
the SA Client. From the Device Group Explorer, you can perform the following actions: 

• View the properties and members of a device group.

• Change a dynamic device group to a static device group.

• Add or remove members from a device group.

• View rollup compliance information for group members targeted by compliance policies 
such as Audit, Software, App Config, and Patch.

• Add application configurations to a device group.
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• View and manage patches, patch policies and software policies associated with the servers 
in the group.

• Create an audit.

• Take a snapshot.

• View and create custom attributes.

• View server history.

See Device Group Explorer on page 146 for more information.

To access a Device Group Explorer, perform the following steps: 

1 From the Navigation pane, select Devices ➤  Device Groups. The device groups appear 
in the Content pane.

2 Select a device group and from the Actions menu select Open. The Device Group browser 
appears as shown below.

Figure 47 The Device Group Explorer Window 

3 To view the properties or perform an action on the device group, select one of the following 
views:

— Summary: This window allows you to view the type of device group and the members 
associated with the device group.

— Properties: This window allows you to view the properties of the device group and 
edit the Name, Description, and the Type of the device group. 

— Compliance: 

— Device Membership: This window allows you to view the members associated with 
the device group and also manage members in the device group.

— Configured Applications: This window allows you to view and edit application 
configurations attached to a device group, and add an application configuration to the 
device group. 
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— Patches: This window allows you to view all the patches associated with the device 
group, add patches to a patch policy, and install patches on the device group.

— Patch Policies: This window allows you to view all the patch policies associated with 
the device group, and remediate the servers in the device group with the patch 
policies.

— Software Policies: This window allows you to view all the software policies 
associated with the device group and remediate the servers in the device group with 
the software policies.

— Audit and Remediation: This window allows you to create and run audits and 
snapshots.

— Custom Attributes: This window displays the custom attributes set to a device 
group and allows you to add, edit or remove custom attributes from a device group.

— History: This window allows you to view the changes made to a device group. For 
each action on the group (but not group members), the history displays the date, the 
action occurred, and the user who performed the action (if the group is public).

Device Group Explorer

The Device Group Explorer provides access to all groups of servers and other devices in the 
core. From the Device Group Browser, you can perform the following actions: 

• Browse groups of servers and access servers inside of groups:

• View patches, patch policies and software policies associated with the servers in the 
group.

• Create an audit.

• Take a snapshot.

• View and create custom attributes.

• View server history.

Accessing the Device Group Explorer

To access the Device Group Explorer, perform the following steps: 

1 Launch the SA Client and select Devices ➤  Device Groups. 

2 Select a device group and open it. (You can expand a group to find subgroups.)

3 If the list of device groups is long, sort the list by clicking a column name, such as name, 
IP address, OS, customer, or facility.

4 For each device group, you can also perform an audit, take a snapshot, or configure 
applications.

Device Group Explorer Interface

The Device Group Explorer allows you to review the following information about a group of 
servers:
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• Summary

• Properties

• Server Membership

• Configured Applications for Device Groups

• Patches for Device Groups

• Audit and Remediation

• Custom Attributes for Device Groups

• History Properties for Device Groups

Summary

The Summary view lists the following information: 

— Properties: This displays if the device group is Private, Public, Dynamic or Static.

— Members: This displays the total number of members in the device group.

Properties

The Properties view lists the following property information such as name, type, status, 
accessibility for the group of servers that you are browsing.

Server Membership

From inside each device group, you can view all members — managed servers and other 
groups of servers and other devices — that belong to the group. For each server that belongs 
to the group, the system displays its name, IP address, OS, customer, facility, and any 
description. 

Configured Applications for Device Groups

If the device group is public, then you can add an Application Configuration to the group. The 
Application Configuration applies to all servers and groups in this group.

• The Installed Configurations tab allows you to browse and edit all Application 
Configurations attached to the device group. 

• The Backup Configurations tab provides a history of all changes made to the selected 
application configuration template, and allows you to revert to a previous version of the 
configuration. 

See SA User Guide: Application Automation for more information.

Patches for Device Groups

This window displays all patches associated with the selected server group.

Show Options

You can use the Show drop-down list to filter the following types of patch information 
displayed in the Device Groups Explorer.
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• Patches with Exceptions (Windows Only): This option displays all patches that have 
exceptions for Windows servers (such as always install or never install) and have one of 
the following conditions: 

— The patches are not currently installed and are recommended by the vendor.

— The patches are currently installed.

• All Patches: This displays all patches that are associated with the operating system of a 
server. 

Patch Contents

This section displays the following patch contents information. 

• Icon: This displays a dimmed patch icon when the patch has not yet been uploaded to the 
Software Library. 

• Name: This indicates the QNumber of a patch that is a hotfix or an update rollup. Service 
pack patches do not have a QNumber.

• Compliance: This shows one of the following three levels of patch compliance, as defined 
by a patch administrator: 

— Non-compliant (red): This indicates that the patch is installed on the server, but 
that it is not in the policy, or the patch is not installed on the server but is in the policy. 

— Partial (yellow): This indicates that the policy and exception do not agree, and that 
the exception does not have data in the Reason field.

— Compliant (green): This indicates any of the following conditions:

– A patch is installed on the server and is in a policy, or a patch is not installed on 
the server and is not in a policy.

– A patch is installed on the server and there are additional patches with the same 
QNumber in a patch policy or exception. In this case, all patches with the same 
QNumber are considered installed when Patch Management calculates patch 
compliance.

– A patch is not installed on the server and is in a patch policy or has an always 
install exception, and is not recommended by the vendor. In this case, the patch 
has a never install exception because it is not recommended by the vendor.

In the Preview pane, move the cursor over the icon or text in the Compliance column to 
view patch compliance information about a server.

• Type: This indicates the type of patch, such as Windows Hotfix or Windows Update 
Rollup.

• Bulletin: (Optional) This indicates the Microsoft Security Bulletin ID number for this 
patch.

• Severity: (Optional) This displays one of following Microsoft severity ratings for this 
patch:

— Critical: This indicates a patch whose exploitation could allow the propagation of an 
internet worm, without user action.

— Important: This indicates a patch whose exploitation could result in a compromise of 
the confidentiality, integrity, or availability of user data, or of the integrity or 
availability of processing resources.
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— Moderate: This indicates a patch whose exploitability is mitigated to a significant 
degree by factors, such as default configuration, auditing, or difficulty of exploitation.

— Low: This indicates a patch whose exploitation is extremely difficult, or whose impact 
is minimal.

• Release Date: This shows the date that Microsoft released this patch.

• Exception: This indicates the type of patch policy exception set for the selected server.

• Installed: This indicates if the patch is installed on the selected server. 

• Recommended: A check mark indicates that this patch was recommended by the vendor 
(MBSA 2.1) during the last software registration.

• Description: This shows a description of the server.

Patch Policies for Device Groups

This window displays all patch policies associated with the selected device group. You can use 
the Show drop-down list to filter the type of patch policies to display in the Server Explorer.

Show Options

This section displays the following patch information:

• Policies Attached to Device Group: This displays all policies attached to the device 
group, or policies attached to a server group to which the selected managed server 
belongs. 

• Policies Not Attached to the Server: This displays a list of all patch policies relevant 
to the selected server group that are not attached to the group. 

Patch Contents

This section displays the following patch content information:

• Name: This displays the name of the patch policy. 

• OS: This displays the operating system associated with the patch policy. 

• Description: This shows a description of the patch policy. 

Software Policies for Device Groups

This Software Policies view displays all software policies associated with the selected server 
(or group of servers). You can perform actions such as attaching a policy, detaching a policy, 
remediating a server, and scanning software compliance from the Actions menu.

Audit and Remediation

This window allows you to create and run audits and snapshots.

Custom Attributes for Device Groups

This window displays the custom attributes set to a server or device group. You also can add, 
edit or remove custom attributes from this window.

Custom attributes can be one of the following two types:
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• Inherited  from another source, such as a customer, a software policy, group of servers, 
ISM control, and so on.

• Attached directly to the server.

To override inherited custom attribute values, click the inherited arrow icon  once, and 

enter a new value in the value field. Press ENTER. The inherited arrow changes  to 
indicate that the custom attribute value has been overridden.

History Properties for Device Groups

The History view shows changes made to the selected device group. Entries are generated 
when actions are performed on a device group in the SAS Web Client. The History is 
read-only. Each entry shows the following information:

• Date: The date when the last change occurred.

• Event: A description of the change.

• User: The user who made the change.

Use the View drop-down list to sort the device group history list according to a range of time, 
such as last week, the last two months, and so on.
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5 Virtualization Service Management
HP Server Automation manages Virtualization Services (VS) such as VMware vCenter 
Server. VMware vCenter provides a scalable and extensible platform that centrally manages 
hypervisors and virtual machines (vm). With SA you can manage the hypervisors and virtual 
machines under Virtualization Services. For details on managing hypervisors and virtual 
machines, see Virtual Server Management on page 155.

Quick Start to Managing Virtualization Services

You need to register Virtualization Services (VS) in SA, at which point SA connects to the VS 
and brings all the hypervisors under SA management. Virtual machines that were already 
managed servers in SA continue to be managed by SA through the VS. Virtual machines not 
managed by SA appear in the Unmanage Server list of the SA Client and can be brought 
under SA management like any other server.

Figure 48 A Virtualization Service (VS) Manages Hypervisors
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Permissions Needed for Managing VSs

You need the “Administer Virtualization Integrations” permission to manage VSs. This 
permission can be set from the SAS Web Client, under Users & Groups, by selecting a group 
and selecting the Client Features tab. For complete information on permissions, see the SA 
Administration Guide.

Bringing a VS into SA Management

This section describes how to bring a Virtualization Service (VS) into SA management, after 
which all the hypervisors under the VS will be managed by SA. The managed servers under 
the VS continue to be managed servers in SA. The unmanaged servers appear in the 
Unmanaged Servers view of the SA Client and can be brought under SA management.

1 In the SA Client, select the Administration tab.

2 In the navigation pane, select Virtualization Integrations as shown below. This displays 
all the Virtualization Services that are currently registered to SA.
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3 Select the Add VS button  or select the Actions ➤  Add... menu or right-click and 
select Add. This displays the Add Virtualization Service screen as shown below.

4 Enter the IP address or host name of the server where the VS is running. Select the realm 
where the server is. Enter the user name and password to connect to the VS. The VS user 
must have adequate permissions to view the VS and the hypervisors managed by the VS 
because the permissions of the VS user control what SA discovers and manages.

5 Optionally select the Verify Connection button and SA will attempt to connect to the VS. If 
the connection attempt fails, check the following:

— Make sure the information you entered is correct.

— Make sure the VS is running and accessible.

— Make sure the VS user name you entered has adequate VS permissions.

If the connection succeeds, you can proceed to the following step.

6 Select the Add button. SA registers the VS and its hypervisors and makes their virtual 
machines managed servers if they were previously managed servers. Otherwise it lists the 
virtual machines under Unmanaged Servers in the SA Client.

7 If you did not select the Verify Connection button in the previous step, SA verifies the 
connection and then registers the VS.

Reloading Information about a VS

This section describes how to reload the information about a Virtualization Service (VS), 
including all the hypervisors and virtual machines (vm) under the VS. This can be useful if 
someone has added or remove hypervisors or vms using the VS. Reloading data refreshes SA’s 
information about the hypervisors and virtual machines.

1 In the SA Client, select the Administration tab.

2 In the navigation pane, select Virtualization Integrations.

3 Select a VS.
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4 Select the Reload Data  button or select the Actions ➤  Reload Data menu or 
right-click and select Reload Data. SA connects to the VS, reloads information about the 
VS, its hypervisors and their virtual machines.

Editing a VS

This section describes how to edit the credentials for connecting to a Virtualization Service 
(VS).

Use care when changing the credentials to Virtualization Services in SA because it could 
result in the hypervisors and managed servers being deleted from SA. If the permissions on 
the new credentials do not allow visibility to the hypervisors or managed servers managed by 
the VS, those hypervisors and managed servers will no longer be managed by SA.

1 In the SA Client, select the Administration tab.

2 In the navigation pane, select Virtualization Integrations.

3 Select a VS.

4 Select the Actions ➤  Edit... menu or press the Enter key or right-click the VS and select 
Edit or double-click the VS. These open the Edit Virtualization Service window.

5 Enter the new user name and password to be used to connect to the VS.

6 Optionally select the Verify Connection button to attempt to connect to the VS with the 
new user name and password.

7 Select the Save button to save the new user name and password. If you did not select the 
Verify Connection button, SA verifies the connection with the new credentials and saves 
the VS information if the connection was successful.

Removing a VS

This section describes how to remove a Virtualization Service (VS) from SA management.

Use care when removing Virtualization Services from SA management because it could result 
in the hypervisors and managed servers becoming deleted from SA. Any hypervisor or virtual 
machine under the VS not managed by SA will be deleted from SA.

1 In the SA Client, select the Administration tab.

2 In the navigation pane, select Virtualization Integrations.

3 Select one or more VSs.

4 Select the Remove button  or select the Actions ➤ Remove menu or right-click and 
select Remove. This displays the Remove Virtualization Service screen which lists all the 
hypervisors and virtual machines managed by the VS.

5 Examine the list of hypervisors and virtual machines and verify that you want the VS to 
be removed from SA management.

6 Select the Remove button. This removes the VS and possibly its hypervisors and virtual 
machines from SA management.
154 Chapter 5



6 Virtual Server Management
HP Server Automation automates virtual server management. SA enables you to perform the 
same operations on virtual servers as you can on physical servers, including audit, 
remediation, application configuration, software management, patching, and more. Cloning is 
performed only on virtual servers. This integrated management solution enables you to use 
the same policies on virtual servers that you currently use on physical servers. You can also 
automate virtual server creation and other administrative tasks.

Supported Virtualization Platforms

In this release, SA supports the following virtualization platforms:

• Virtualization Services such as VMware vCenter. For more information, see Virtualization 
Service Management on page 151.

• Solaris 10 Zones

• VMware ESX Server 3.0, 3.5, and 4.0

• VMware ESXi Server 3.5 and 4.0

• Microsoft Hyper-V

SA does not support Solaris 8 and Solaris 9 Containers in Solaris 10 Zones. SA does not 
support Solaris Containers for Linux Applications (SCLA) in Solaris 10 Zones.

Virtualization Features

You can perform the following virtualization tasks:

• Manage hypervisors and virtual machines under Virtualization Services such as VMware 
vCenter. For more information, see Virtualization Service Management on page 151.

• Provision VMware ESX, Windows 2008 x64 with the Hyper-V role installed, and Solaris 
10 hypervisors on bare metal servers.

• In a single operation, create a virtual server, provision the operating system, apply 
patches, and install application software on VMware ESX servers and Windows Hyper-V 
servers.

• Discover, audit, and remediate virtual servers and create reports.

• View the physical-to-virtual relationships between hypervisors and virtual servers. You 
can easily find out which virtual servers are hosted by a given hypervisor.

• Map dependencies for the entire application environment in the HP Server Automation 
Visualizer (SAV), including virtual and physical servers, software, network devices, and 
storage devices.
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• On Solaris Zones, perform the following operations: create, modify, remove, start, and 
stop.

• On VMware virtual machines, perform the following tasks: create, modify, clone, remove, 
power on, power off, suspend, and reset the vms.

• On Microsoft Hyper-V virtual machines, perform the following tasks: create, modify, 
delete, start, shut down, turn off, pause and reset the vms.

• Search on virtualization properties to find virtual servers in the SA Client. 

• Create dynamic device groups which associate servers based on virtual server properties. 
Device groups enable you to easily perform operations on multiple servers.

• Control access to virtual and physical servers with a common authentication and 
authorization structure.

Like all features in SA, virtual server management tasks are governed by permissions. To 
obtain these permissions, contact your SA administrator. For more information about 
permissions, see the Permissions Reference in the SA Administration Guide.

Virtualization Terminology

Due to different implementations of virtualization by different vendors, terminology can vary 
with platform and operating system. 

The following terms are non-platform specific:

• Virtualization Service (VS)—A scalable and extensible platform that centrally 
manages hypervisors and virtual machines. VMware vCenter is an example virtualization 
service. For more information, see Virtualization Service Management on page 151.

• Hypervisor—A hypervisor is a virtualization platform that allows multiple, 
heterogeneous operating systems to run on a single host computer at the same time. A 
Type 1 hypervisor (or bare-metal architecture) is software that runs directly on the 
hardware platform. Any guest operating systems runs at the second level above the 
hardware.VMware ESX, Microsoft Hyper-V, and Solaris 10 Zones are type 1 hypervisors. 
A Type 2 hypervisor (or hosted architecture) is software that runs within the operating 
system environment. Any guest operating systems run at the third level above the 
hardware.

• Virtual Server—The logical server (or virtual machine) that runs on a hypervisor. To an 
application, the virtual server appears to be a physical server. Each virtual server can run 
its own operating system, and each server can be independently rebooted. Examples of 
virtual servers are VMware virtual machines and Solaris zones.

• Physical Server—An operating system running on a hardware device. In this chapter, 
the term physical server refers to a non-virtual server.
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Table 11 maps the terms hypervisor and virtual server to the values displayed in the SA 
Client and to corresponding terms in the vendor’s platform documentation.  

* Formerly referred to as a local zone. 

OS Provisioning and Agent Installation for VMware Hypervisors 
and Windows Hyper-V Hypervisors

Before you can create or manage a virtual server with SA, you must install an SA Server 
Agent on the hypervisor that hosts the virtual server.

SA does not install an Agent on VMware ESXi servers. Instead, SA manages ESXi servers 
remotely using a web services interface. See Managing VMware ESXi Servers on page 164 for 
more information.

To provision an operating system or install an Agent on a hypervisor, you follow the same 
procedures as with physical servers. The following sections summarize how to make 
hypervisors managed by SA. For complete details, see Agent Management on page 63.

As Figure 49 shows, you can make a hypervisor a managed server and provision an operating 
system. Alternatively, you can install an Agent on a pre-existing hypervisor using SA. After 
an Agent has been installed, the hypervisor will be listed in both the All Managed Servers and 
Virtual Servers lists of the SA Client.

Table 11 Virtualization Terminology

Term that is not 
platform 
specific

Virtualization
field in 
SA Client

OS field 
in SA Client

Related terms in
vendor documentation

Virtualization 
Service (VS)

N/A N/A VMware vCenter Server

Hypervisor Hypervisor SunOS 5.10 Solaris 10,
global zone

Hypervisor VMware ESX 
Server

ESX Server,
computing server,
host

Hypervisor Microsoft Hyper-V Hyper-V Server
host

Virtual Server,

Virtual Machine

Solaris Zone SunOS 5.10 zone
non-global zone *

VMware VM (varies) virtual machine,
guest operating system

Microsoft 
Hyper-V 
Partition

(varies) virtual machine
parent partition
root partition
child partition
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Figure 49 OS Provisioning and Agent Installation of a Hypervisor

To find out more about the tasks shown in Figure 49, see the documentation referenced in 
Table 12.

OS Provisioning and Agent Installation for Solaris Zones

Figure 50 shows the process for creating a non-global zone and bringing it under management 
by SA. You can create a zone using either the SA Client or the Solaris CLI. When you use the 
SA Client to create a zone, SA also installs an Agent on the zone which allows you to manage 
the zone using SA.

Table 12 Documentation for Hypervisor OS Provisioning and Agent Installation 

Task in Figure 49 Where to get more information

Install a Host OS without using SA OS vendor documentation

Install an Agent using SA Installing an Agent on an Existing 
Unmanaged Non-Global Zone on page 
171

Manually Installing an SA Server 
Agent on an Unmanaged Virtual 
Machine on page 180

Provision the Host OS and Agent using 
the SA Client and the OS Provisioning 
feature.

“Operating System Provisioning” in the 
SA User Guide: Application Automa-
tion
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Figure 50 OS Provisioning and Agent Installation on a Solaris Zone

To find out more about the tasks shown in Figure 50, see the documentation referenced in 
Table 13.

OS Provisioning and Agent Installation for Virtual Machines on 
VMware and Hyper-V

Like a physical server, a virtual machine must have a Server Agent installed in order to be 
managed by SA. Figure 51 shows the two different approaches you can take to install an 
Agent on a virtual machine. In the figure, the path on the left uses SA for the entire process. 
When you create a virtual machine using the SA Client, you can specify an OS sequence and 
provision the OS immediately, or you can provision the OS at a later time. As with a physical 
server, provisioning an OS using the SA Client on a virtual machine automatically installs an 
Agent. The path on the right shows the process when the virtual machine is created and 
provisioned without using SA. This situation typically occurs when you need to bring existing 
virtual machines under SA management.

Table 13 Documentation for Zone OS Provisioning and Agent Installation

Task in Figure 50 Where to get more information

Create a Zone using the SA Client Creating a Zone on page 170

Create a Zone using Solaris Solaris 10 documentation

Install an Agent using the SA Client Installing an Agent on an Existing Unmanaged 
Non-Global Zone on page 171
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Figure 51 OS Provisioning and Agent Installation on a Virtual Machine

To find out more about the tasks shown in Figure 51, see the documentation referenced in 
Table 14.

Adding a Hypervisor to SA Management

You can make a hypervisor a managed server in SA by scanning for unmanaged servers as 
described in Agent Management on page 63. Alternatively, you can use the SA Client and 
perform the following steps: 

1 From the Navigation pane, select Devices.

2 Expand Servers in the Navigation pane.

Table 14 Documentation for VM OS Provisioning and Agent Installation 

Task in Figure 51 Where to get more information

Create a vm using vendor’s tools Vendor’s documentation

Create a VMware vm using the SA Client Creating a VMware Virtual Machine on page 
173

Create a Hyper-V vm using the SA Client Creating a Hyper-V Partition (Virtual 
Machine) on page 183

Install an Agent using SA Agent Management on page 63

Install a Guest OS using vendor’s tools Vendor’s documentation

Provision a Guest OS using the SA Client “Operating System Provisioning” in the SA 
User Guide: Application Automation
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3 To view the hypervisors and virtual servers as a tree structure, select Virtual Servers. 
The Content pane displays a list of managed hypervisors, as shown in Figure 52.

Figure 52 Virtual Servers List in the SA Client
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4 Select . This brings up the Add Hypervisor window as shown in 
Figure 53 below.

Figure 53 Add Hypervisor Window

5 Select the appropriate method for managing the server:

— For VMware ESXi servers, select “Manage Embedded Hypervisor (VMware ESXi)”. 
This selection does not install a Server Agent on the server. Instead, SA manages the 
server using a web services interface.

— For other hypervisors such as other VMware ESX servers, Windows Hyper-V servers 
or Solaris Zones servers, select “Manage Installed Hypervisor with Server Automation 
Agent.” This selection will install a Server Agent on the server.

6 Enter the IP address of one or more hypervisor servers.

7 In the Scan In: field, select the SA realm in which to search for the hypervisor server. For 
more information about realms, see “Facilities and Realms” in the SA Overview and 
Architecture Guide.

8 Enter the user name and password to log in to the hypervisor server.

9 If you selected “Manage Embedded Hypervisor (VMware ESXi)”, select OK to add the 
specified server to SA management. Skip the remaining steps.
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10 If you selected “Manage Installed Hypervisor with Server Automation Agent,” select a 
network protocol to log in and connect to the server from the drop-down list. To allow SA 
to select an appropriate protocol for each server, choose “Select Automatically.”

11 If logging in as root is not allowed, SA allows you to log in as a non-root user and then 
escalates your privileges using either the “su” command or the “sudo” command. If you log 
in using sudo, the sudoers configuration file (usually /etc/sudoers) must allow your 
account to run any command with root privileges. This is typically accomplished by using 
the “ALL” alias in the sudoers file. If only certain commands are permitted, then deploying 
agents using SA will fail. See Specifying Login Settings on page 71 for more information.

Perform the following steps to deploy agents as a non-root user:

a Enter the unprivileged user name in the Username field to log into the server.

b Enter the unprivileged password in the Password field.

c Select the Become root (UNIX) check box. Select “Supply root password” and enter the 
password or select “Use sudo”. If you choose to use sudo, the unprivileged account 
must be able to run any command as root.

12 Enter the appropriate Installer Options and Advanced options. For details on these 
options, see Agent Installer Options on page 72.

13 Select OK to install the Server Agent and bring the server under SA management.

14 Perform a registration scan of the hypervisor server to update the hardware, software and 
patch information about the server in SA. Alternatively, you can wait for a regularly 
scheduled scan to be performed automatically. For more information, see Agent 
Management on page 63.

Adding Hypervisors Listed in a Text File to SA Management

This functionality is not available for Microsoft Hyper-V hypervisors.

You can make one or more hypervisors managed servers in SA by listing their IP addresses, 
SA realms and user credentials in a text file in CSV (comma-separated value) format and 
importing the CSV file into the SA Client. The format of each line in the CSV file is as follows.

<IP address>,<Realm to scan>,<admin login name>,<password>

• <IP address> is the IP address of the hypervisor server.

• <Realm to scan> is the SA realm name to scan for the server. For more information 
about realms, see “Facilities and Realms” in the SA Overview and Architecture Guide.

• <admin login name> is the user name of an administrative user on the server.

• <password> is the password for the administrative user.

The following shows a simple example CSV file.

192.168.234.7,RegionA,root,rootpass123
192.168.89.142,RegionB,admin,x5wo393kEm

To add hypervisors to SA managed servers from a CSV file, perform the following steps: 

1 From the Navigation pane, select Devices.

2 Expand Servers in the Navigation pane.
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3 To view the hypervisors and virtual servers as a tree structure, select Virtual Servers. 
The Content pane displays a list of managed hypervisors, as shown in Figure 52.

4 Select . This brings up the Add Hypervisor dialog as shown in Figure 53.

5 Select the appropriate method for managing the servers:

— For VMware ESXi servers, select “Manage Embedded Hypervisor (VMware ESXi)”. 
This selection does not install a Server Agent on the server. Instead, SA manages the 
server using a web services interface.

— For other hypervisors such as other VMware ESX servers or Solaris Zones servers, 
select “Manage Installed Hypervisor with Server Automation Agent.” This selection 
will install a Server Agent on the server.

All the servers specified in the file must use the same management method. That is, you 
cannot mix servers that use different management methods in one file. Use separate files for 
each set of servers.

6 Select the Import from file... button. This brings up a file selection window.

7 Select your CSV file and click Import. This validates the contents of the file, scans the 
specified IP addresses in the specified realms, installs the Server Agent (if applicable) and 
brings the servers under SA management.

8 Perform a registration scan of the hypervisor server to update the hardware, software and 
patch information about the server in SA. Alternatively, you can wait for a regularly 
scheduled scan to be performed automatically. For more information, see Agent 
Management on page 63.

Managing VMware ESXi Servers

The VMware ESXi server is functionally equivalent to the ESX 3 servers, however, in the 
ESXi, the Linux-based service console (COS) has been removed. As a result, SA does not 
install an Agent on ESXi servers. Instead, SA manages ESXi servers remotely using a web 
services interface. ESXi servers are listed in both the All Managed Servers and Virtual 
Servers lists of the SA Client the same as other ESX servers. However, some SA features are 
not available for ESXi servers.

Storing and Managing Credentials for ESXi Servers

Since SA manages ESXi servers remotely using a web services interface, SA must store an 
encrypted copy of the user login and password for all managed ESXi servers. SA uses the 
stored credentials whenever communicating with or running commands on the managed 
ESXi server.

To view the status of stored credentials, you must have the Manage Credentials: Read client 
permission. For information about SA permissions, see the SA Administration Guide.

To check the status of the stored credentials, perform the following steps.

1 From the SA Client Navigation pane, select Devices.

2 Expand Servers in the Navigation pane.
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3 To view the hypervisors and virtual servers as a tree structure, select Virtual Servers. 
The Content pane displays the hypervisors.

4 Select an ESXi server.

5 In the View pull-down, select Properties. This displays information about the server, 
including the Login Credentials, as shown below.

Figure 54 Login Credentials for a VMware ESXi Server
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Modifying Stored Credentials for ESXi Servers

If either the user login or password on the ESXi server changes, but the credentials stored in 
SA have not been updated, when SA attempts to connect to the ESXi server, it will fail. SA 
will prevent all future attempts to connect to the ESXi server until the stored credentials are 
updated to avoid locking out the user’s account. SA uses the custom fields “Invalid login 
attempts” and “Time of invalid attempt” for this purpose.

If either the user login or password on the ESXi server changes, you must update the stored 
credentials in SA. To modify the stored credentials you must have the Manage Credentials: 
Read & Write client permission. For information about SA permissions, see the SA 
Administration Guide.

To update the stored credentials, perform the following steps.

1 Display the status of the stored credentials as described in Storing and Managing 
Credentials for ESXi Servers on page 164. This displays the Login Credentials in the 
Properties view as shown below.

Figure 55 Login Credentials for VMware ESXi Server

2 Select Edit Connection... This displays the Edit Connection dialog as shown below.

Figure 56 The Edit Connection Dialog for an ESXi Server

3 Edit the IP address, select the appropriate realm in the “Scan In” field, enter the user 
name and password, and select Connect to validate the credentials. SA checks the 
credentials against the specified ESXi server. If the credentials are valid, SA encrypts 
them and stores them and uses them for future connections with the ESXi server.
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Viewing Virtual Servers

The tasks described in this section apply to VMware virtual machines, Microsoft Hyper-V 
partitions, and Solaris Zones.

Searching for Servers by Virtualization Properties

The Search feature of the SA Client enables you to find servers and other objects according to 
certain criteria. You can search for virtual servers or hypervisors by the following properties:

• Virtualization type, such as Hypervisor, Solaris Zone, VMware VM, or Microsoft Hyper-V.

• Solaris Zone properties, such as Zone CPU Shares and Zone Device Directories.

• VMware virtual server properties, such as VM Data Store Name and VM Virtual 
Processors.

• Microsoft Hyper-V properties such as the Hyper-V virtual machine name.

• Properties common to both physical and virtual servers, such as Operating System and 
Software Policy.

For step-by-step instructions, see SA Client Search on page 43. 

Microsoft Windows Server 2008 Hyper-V servers must have the Hyper-V Role installed and 
enabled before SA recognizes and lists them as Virtual Servers.

Viewing Physical-to-Virtual Relationships

To view hypervisors and virtual servers in the SA Client, perform the following steps: 

1 From the Navigation pane, select Devices.

2 Expand Servers.

3 To view the hypervisors and virtual servers as a tree structure, select Virtual Servers.

The Content pane displays the hypervisors. To see which virtual servers belong to a 
hypervisor, expand the hypervisor in the tree. The Virtualization view of a hypervisor also 
lists its virtual servers.

4 To identify the hypervisor of a virtual server displayed in the All Managed Servers list, 
select the virtual server, select the Virtualization view, and note the value of the Hosted 
By field.

Viewing Configuration Properties of Virtual Servers

In the SA Client, perform the following steps: 

1 From the Navigation pane, select Devices.

2 Expand Servers.

3 Select the virtual server from either the Virtual Servers or All Managed Servers list.

To see if a server is a hypervisor or a virtual server in the All Managed Servers list, 
choose Virtualization from the column selector. 
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4 For the View, select Virtualization.

The Content pane displays the configuration properties of the virtual server.

Reloading Virtual Server Information

Because virtual servers can be created and managed outside of SA, SA automatically reloads 
the virtual server information every 24 hours.

To manually reload the virtual server information, perform the following steps:

1 From the Navigation pane, select Devices.

2 Expand Servers.

3 In the Virtual Servers list, right-click the hypervisor whose information you want to 
reload.

4 Depending on the virtualization platform, select one of the following menu items:

• Solaris Zones ➤  Reload Data

• VMware Virtual Machines ➤ Reload Data

• Microsoft Hyper-V Partition ➤ Reload Data

Virtual Servers and Server Automation Visualizer (SAV)

This section briefly describes virtual servers and hypervisors in Server Automation Visualizer 
(SAV). For more information on SAV, see “Server Automation Visualizer” in the SA User 
Guide: Application Automation. 

SAV enables you to manage the operational architecture and behavior of distributed 
applications in your IT environment. The SAV Server Map displays the relationships between 
hypervisors and virtual servers. For VMware ESX hypervisors, you can also view vSwitches 
alongside virtual machines in addition to the connections between the virtual machines and 
vSwitches' port groups. The buttons on the Virtualization tool bar in SAV enable you to start, 
stop, restart, and pause virtual servers.

To view virtual servers in SAV, perform the following steps: 

1 In the SA Client, from the Navigation pane, select Devices.

2 Expand Servers.

3 From the Virtual Servers list, select the hypervisor.

4 From the Actions menu, select Open with ➤  Server Automation Visualizer 

After scanning is complete, the SAV window appears.

5 In the SAV window, select the Server Map tab. 
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Virtual Server Reports

The SA Client reporting feature provides the following virtualization reports:

• All Virtual Servers: Lists all managed hypervisors and virtual servers.

• Virtual Servers by Virtualization Technology: Displays a pie chart with slices for 
each virtualization technology (Zones, Hypervisors), as well as a list that summarizes the 
number of servers for each technology.

• Virtual Servers by Hypervisor: Lists properties of individual virtual servers, grouped 
by hypervisor.

• Resource Allocation by Hypervisor: Displays the resource allocation (such as CPU 
shares or memory) for each hypervisor. 

For instructions on running reports, see the SA User Guide: Application Automation.
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Solaris Zone Management

This section provides step-by-step instructions for managing Solaris non-global zones using 
the SA Client. The read-only tasks available for non-global zones are described in Viewing 
Virtual Servers on page 167. 

To perform any of these tasks, the global zone must be reachable by SA.

Creating a Zone

The SA Client enables you to create a fully operable, non-global zone on a Solaris 10 global 
zone (hypervisor). 

Before a non-global zone can be created with the SA Client for the first time, the global zone’s 
hardware must be registered with SA. This hardware registration only needs to occur once. 
Creating a non-global zone also installs an Agent on the zone, bringing the zone under 
management by SA. After Agent installation, the non-global zone appears in the All 
Managed Servers and the Virtual Servers lists in the SA Client.

To create a non-global zone, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, right-click the global zone that will host the new zone, and select 
Solaris Zones ➤  Create Zone.

4 In the Zone Definition Method step of the Create Virtual Zone window, select one of the 
following methods:

• Manual (Fill out data form): Using this method, you must manually enter the zone 
configuration parameters in the fields provided on the Zone Definition dialog.

• Zone Creation Command Script: Using this method, you provide a command 
script that contains the zone creation and configuration commands. This command 
script has the same syntax as the command_file specified by the following Solaris 
command:

zonecfg -z zone_name -f command_file

SA does not validate the contents of the zone creation command script, so ensure that your 
script works. For the syntax of the commands allowed in the script, see the Solaris 10 
documentation on zonecfg.

5 Click Next to proceed to the Zone Definition step. 

6 If you are using a Zone Creation Command script, skip to step 7 below. If you chose the 
manual method in step 4 above, complete the following fields:

• Server: Enter the SA server name for the new virtual server. (The global zone 
(hypervisor) that will host the new non-global zone is displayed below this field.)

• Zone Name: Enter an appropriate name for the new non-global zone. 

• Locale: Enter the language code for the non-global zone. 
170 Chapter 6



• Terminal Type: Specify the terminal client that the SA Client uses for Remote 
Terminal sessions on the non-global zone. 

• Auto Reboot: Specifies whether to automatically reboot the non-global zone if the 
physical server running the hosting Global zone is rebooted.

• Time Zone: Specify a time zone for the non-global zone.

• Root Password: Enter the root password for the non-global zone. 

• Confirm Password: Enter the root password again for verification. 

• CPU Shares Reservation: Enter an integer that allocates the shares of the CPU 
resource. 

For the CPU Shares Reservation to take effect, the Fair Share Scheduler (FSS) must be 
enabled on the Solaris 10 hypervisor server on which you are creating the new zone. By 
default, the FSS is not enabled.

• IP Address: Click Add to enter the IP address and the name of the virtual network 
interface. A zone that requires network connectivity must have one or more dedicated 
IP addresses. These addresses are associated with the physical network interface of 
the global zone. 

• Device: (Optional) Click Add to enter a path name to a device, for example, /dev/
pts*, on the global zone hypervisor. This action gives the new zone access to a device 
on the global zone. 

• Inherited Package Directory: (Optional) Click Add Sparse Root Directory to 
enter a default package directory inherited by the new zone from the global zone. Or, 
click Add to enter a path name to the package directory you want the zone to inherit. 
These package directories are read-only.

• Mount Directory: (Optional) Click Add to mount a file system type and path for the 
zone. This action grants the zone access to a physical disk or file system of the 
non-global zone. A ufs file system creates a file system mount within the zone; the 
lofs type is a loopback file system mount to the global zone.

7 If you are using a Zone Creation Command Script, you will see the Zone Configuration 
Commands section. Here you can manually enter the contents of the zone creation 
command script, cut-and-paste from another file, or select Import File to import the 
script directly from another file. 

8 Click Next.

9 Continue through the remaining steps of the Create Zone window, as explained in the 
following sections:

• Removing/Scheduling/Notification Step for Virtual Servers on page 190

• Notifications Step for Virtual Servers on page 190

• Job Status Step for Virtual Servers on page 190

Installing an Agent on an Existing Unmanaged Non-Global Zone

To bring a zone under management by SA, you must first install an SA Server Agent. Before 
installing an Agent, verify that the following requirements are met:

• The non-global zone is running.
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• All services on the non-global zone are up and running. If they are not, the zone may not 
have the necessary sysconfig information that is provided when the non-global zone is 
booted for the first time. See the Sun Solaris 10 documentation on zone configuration for 
more information.

You can install an Agent on an unmanaged Solaris zone in two ways:

• Using SA as described in “Agent Management” in the User Guide: Server Automation.

• Using the SA zone management interface.

To install an Agent on an unmanaged non-global zone through the SA zone management 
interface, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the Global zone that hosts the unmanaged non-global zone 
you want to modify.

4 Right-click the non-global zone and select Solaris Zones ➤  Install Agent.

Modifying a Non-Global Zone

You can modify a subset of the zone parameters that were defined when you created the 
non-global zone. For example, if an HTTP server running on a zone is sluggish because of 
increased usage, you can increase the CPU Share Reservation parameter for the zone. After 
you modify a zone with the SA Client, the zone is automatically re-started.

To modify the parameters of a non-global zone, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the global zone that hosts the zone you want to modify.

4 Right-click the non-global zone and select Solaris Zones ➤  Modify Zone.

The Modify Virtual Zone window appears. In the Zone Definition step of the Modify 
Virtual window, edit the parameters you want to change.

5 Click Next.

6 Continue through the remaining steps of the Modify Zone window, as explained in the 
following sections:

— Removing/Scheduling/Notification Step for Virtual Servers on page 190.

— Notifications Step for Virtual Servers on page 190.

— Job Status Step for Virtual Servers on page 190

Starting or Stopping a Non-Global Zone

To start or stop a zone, perform the following steps: 

1 From the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the global zone that hosts the non-global zone. 

4 Right-click the zone and select Solaris Zones ➤ Start Zone or Stop Zone.
172 Chapter 6



Or

5 In the Virtual Servers list, open the hypervisor. In the Virtualization view, select the 
zone and click either Start or Stop.

If a non-global zone is not running, the state displayed is Installed.

Removing a Non-Global Zone

To remove a non-global zone, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the global zone that hosts the zone you want to remove.

4 Right-click the non-global zone and select Solaris Zones ➤  Remove Zone.

VMware Virtual Machine Management

This section provides step-by-step instructions for managing VMware virtual machines with 
the SA Client. The read-only tasks for virtual machines are described in Viewing Virtual 
Servers on page 167.

Creating a VMware Virtual Machine

With the SA Client, you can create a virtual machine on a VMware ESX server (hypervisor). If 
you specify an OS Sequence during this task, SA also provisions an OS and installs an SA 
Agent on the virtual machine.

When you create a virtual machine and provision the OS for the virtual machine, the virtual 
machine must be in the same facility as the hypervisor.

After Agent installation, the virtual machine appears in the All Managed Servers and the 
Virtual Servers lists in the SA Client.

To create a VMware virtual machine, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, right-click the VMware ESX Server that will host the virtual 
machine, and select VMware Virtual Machines ➤ Create....

4 In the Virtual Machine Definition step of the Create Virtual Machine window, complete 
the following fields:

• Name: The SA server name of the new virtual machine and the name of the new 
virtual machine as it should appear within the ESX Server.

• Memory Size: The amount of memory for the virtual machine.

• Virtual Processors: The number of CPUs for the virtual machine.
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• Guest OS: Specify an operating system (OS) for the virtual machine. This field is just 
a label, specifying this field does not cause SA to provision the OS on the virtual 
machine.

• OS Sequence: (Optional) To provision an OS when the virtual machine is created, 
select an OS sequence. If it has a software policy, the OS sequence installs the 
software in the policy on the virtual machine immediately after the OS is provisioned.

5 Under Network Configuration, click Add to create a virtual network adapter (NIC). To 
connect the virtual network adapter when the virtual machine powers on, select “Connect 
at power on.”

6 Under Data Store Configuration, click Add to create a virtual disk. To select a data 
store from the hypervisor, double-click the entry under Name. You can also change the 
default values for Size and Units by double-clicking those entries.

7 Click Next.

8 Complete the remaining steps in the Create Virtual Machine window, as explained in the 
following sections:

• Removing/Scheduling/Notification Step for Virtual Servers on page 190.

• Notifications Step for Virtual Servers on page 190.

• Job Status Step for Virtual Servers on page 190

If you are installing Solaris 10 as a guest OS on a VMware ESX server, the following 
configurations are strongly recommended:

Solaris 10 32-bit

Guest OS: SOlaris 10 32 bit
SCSI controller: LSI logic
Network Adapter: flexible

Solaris 10 64-bit

Guest OS: Solaris 10 64 bit
SCSI controller: LSI logic
Network Adapter: E1000

Installing Software During Virtual Machine Creation

Using the SA Client, you can perform the following operations individually or as a single task:

• Create a virtual machine.

• Provision an OS on the virtual machine.

• Install software on the virtual machine.

To bundle these operations as a single task, perform the following steps:

1 Decide which OS will be provisioned on the virtual machine.

2 Locate or create the corresponding OS sequence.

For instructions on creating OS sequences, see the SA Policy Setter Guide.
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In the OS sequence, be sure to select Enable Remediation.

3 Decide which software to install on the virtual machine.

4 Create a software policy.

For instructions, see the SA Policy Setter Guide.

5 Add the software to be installed to the software policy.

Using the instructions in Creating a VMware Virtual Machine on page 173, create a new 
virtual machine.

6 In the Virtual Machine Definition dialog, specify the OS sequence. 

While the virtual machine is created, the OS is provisioned and the software policy is 
remediated on the virtual machine. The remediation operation installs the contents of the 
software policy on the virtual machine.

Cloning a VMware Virtual Machine

When you clone an existing virtual machine, you create a copy of the source virtual machine. 
Server Automation provides several key benefits that add business value when you clone an 
SA-managed virtual server. The cloning process enables you to create a new virtual machine 
that:

• SA can manage, patch, and configure.

• Is compliant with your operating system patch levels.

• Inherits the identical SA management model, whose compliance status you can manage.

The management model consists of the following items:

— Custom Attributes

— Custom Fields

— Installed Software

— Installed Packages

— Application Configuration Instances

— Static Device Group Associations

— Snapshot Specification Associations

— Audit Policy Associations

— Windows Patch Policy Associations

— Solaris Patch Policy Associations

— Software Policy Associations

See Best Practices on page 178.

SA supports cloning a virtual machine to the same hypervisor on which the source virtual 
machine resides or to a different hypervisor within the same VS. You can also clone to a 
hypervisor in a different datacenter within the VS. For more information, see Virtualization 
Service Management on page 151.

You can also configure your network adapters for DHCP or static IPs, and you can select any 
available datastore. See Cloning Process on page 177.
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Supported Platforms

SA cloning is supported on virtual machines that are installed with the following operating 
systems:

• RedHat Enterprise Linux

• SUSE Linux Enterprise Server 10 (SLES10)

• Windows

SA does not support cloning on Solaris, SUSE Linux Enterprise Server 11 (SLES11), Oracle 
Enterprise Linux (OEL), and CentOS.

Requirements and Limitations

You can clone a virtual machine in SA when it meets the following requirements:

• The virtual machine is managed by an SA 9.0 Agent. 

• The virtual machine is reachable.

• The virtual machine state is “OK”

• The virtual machine belongs to an ESX/ESXi 3.5 or ESX/ESXi 4.0 hypervisor that is 
managed by a Virtualization Service (VS) that has been integrated with the SA core.

The following known limitations display, during various steps of the cloning process, as  
warning messages.

•  Windows Shutdown Event Tracker & Reason—Make sure the Windows 
Shutdown Event Tracker is disabled on the source virtual machine. Otherwise (if the 
Windows Shutdown Event Tracker is enabled on the source virtual machine), when 
the clone operation is complete and the new server is rebooted, the Shutdown Event 
Tracker will display a dialog box prompting you to enter a reason. If you do not 
provide a reason, it prevents the reboot from completing so that SA can finish 
registering the Agent and scanning the new server.

Note: You can remote terminal to the Windows virtual machine to determine the 
status of the Shutdown Event Tracker and disable it if it is enabled.

•  RedHat Enterprise Linux DHCP—When the source virtual machine is 
RHEL and one or more network interfaces are set to DHCP, VMware may not enable 
networking after the cloning process is completed. If one or more network interfaces 
have the IP Type set to DHCP, SA displays a warning message that explains this 
limitation and the recommended action. You must either reset the network or reboot 
the clone so that the virtual machine is managed.

• Windows 2000 and Windows 2003—When the source virtual machine is 
Windows 2003 or Windows 2000, the warning icon displays next to the Password 
Source option called “Create new Administrator password”. If the Administrator 
password for the source virtual machine is not blank, VMware does not set the 
Administrator password.
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•  Windows 2008—When the source virtual machine is Windows 2008, the default 
Password Source option is “Create new Administrator password”. SA displays a 
warning message next to the “Clone credential from source VM” option. VMware does 
not clone the credential from the source virtual machine. This option creates an 
unsecure clone with a blank Administrator password.

Cloning Process

To clone a VMware virtual machine, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, select the hypervisor that owns the virtual machine you want to 
clone

4 Expand the hypervisor and then select the managed virtual machine you want to clone.

5 Right-click to select VMware Virtual Machines ➤  Clone....

6 In the Virtual Machine Definition step of the Clone Virtual Machine window, enter the 
following information:

• Name: The SA server name for the cloned virtual machine.

• Customer: The default customer is the source virtual machine’s customer—if you have 
read write permissions to that customer. If you do not have this permission, the Customer 
field is blank. Click the Change button to select a customer. The Next and Start Job 
buttons will be enabled when the Customer field is filled in.

• Auto-Start VM: (Default) Start the virtual machine after it is created.

• Hostname: The virtual machine name.

• Domain Name: The domain name of the clone.

 Windows Shutdown Event Tracker—See Requirements and Limitations on 
page 176.

7 Click Next to complete the remaining steps. Go to step 8.

Or

Click Start Job to start the cloning operation. 

Note: The remaining steps use the defaults that match the properties of the source 
(non-Windows) virtual machine. However, if you want to clone to a different hypervisor, 
click Next to select a Host and/or datastore.

8 (For cloning a Windows virtual machine only.) In the Windows Guest Customization step, 
specify the new administrator password and the Windows License Product Key for a 
cloned Windows virtual machine.

Clone credential from source VM—When the source virtual machine is Windows 2003 
or Windows 2000, this is the default Password Source option. However, when the source 
virtual machine is Windows 2008, a warning icon displays next to this option. Move your 

cursor over the  icon to display the following message:

“VMware does not clone the credential from the source virtual machine. This option 
creates an unsecure clone with a blank Administrator password."
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To hide this message, click outside the icon or message.

Create new Administrator password—When the source virtual machine is Windows 

2008, this is the default Password Source option. A warning icon  displays next to this 
option. Move your cursor over the icon to display the following message:

“VMware may not correctly set the Administrator password when the source VM’s 
Administrator password for the source virtual machine is not blank.”

To hide this message, click outside the icon or message.

Product Key—If the HPSA_WINDOWS_PRODUCT_KEY custom attribute for the 
Windows clone source virtual machine is already defined, whether directly assigned or 
inherited, it will be used as the default value of this field. This allows the policy setter to 
predefine this field so that you are not required to enter this value during virtual machine 
cloning steps.

9 In the Host step, select the host on which you want to run this virtual machine. From the 
list of hypervisors that are managed by the VS, select a target hypervisor for the clone. 
The default is the host of the source virtual machine.

10 In the Storage Configuration step, select a datastore in which to store the virtual machine 
files. 

From the list of datastores associated with the selected host, select one datastore for the 
entire clone. By default, if the host was not changed, the selected value will be that of the 
source virtual machine. If the host was changed, then it would default to the first row.

11 Complete the remaining steps in the Clone Virtual Machine window, as explained in the 
following sections:

• Removing/Scheduling/Notification Step for Virtual Servers on page 190

• Notifications Step for Virtual Servers on page 190

• Job Status Step for Virtual Servers on page 190.

Best Practices

This section describes best practices for cloning golden images to rapidly deploy identically 
provisioned SA-managed virtual machines. In this document, the following terminology is 
used:

• A golden image is an SA-managed virtual machine that is used as a template for creating 
other identical SA-managed virtual machines.

• A VMware Template is a VMware object that VMware product users can instantiate to 
create virtual machines.

You can follow these best practices to designate virtual machines as golden images in SA, 
clone them as a means to instantiate identical virtual machines, and convert your VMware 
Templates into SA golden images.

➤ Creating a Golden Image Using SA OS Provisioning

As a best practice, if you have existing SA OS sequences and want to use an OS sequence to 
create a golden image, use the create virtual machine operation in Server Automation. SA can 
execute an OS sequence in the context of creating a virtual machine. When you use the create 
virtual machine operation in SA, you can install an OS on a newly created virtual machine. 
The resulting virtual machine is an SA-managed server that can be used as a golden image to 
expedite future virtual machine provisioning. See Creating a VMware Virtual Machine on 
page 173.
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➤ Collating Golden Images for Rapid Deployment & Security

Static device groups in SA enable you to identify golden images. To identify golden images in a 
certain datacenter (location), create one or more static device groups. After device groups are 
created, user groups (that use device groups to restrict access to golden images) can be 
defined. This provides a detailed permissions model around classes of golden images. See the 
SA Administration Guide for information about device group security. 

As a best practice, create SA user groups to facilitate roles surrounding golden image use. 
Typical user group roles include an:

• Image Policy Setter - who patches and maintains SA model objects associated with 
golden images.

• Image Cloner - who provisions new, managed servers from golden images.

These roles should be designed so that an Image Policy Setter can modify golden images (to 
apply software, patches, application configuration, and so on); whereas an Image Cloner 
cannot modify the golden image content.

➤ Cloning a Golden Image to Create a New Managed Server

To create a managed server from a golden image:

1 Navigate to the Devices ➤  Virtual Servers view.

2 Find the hypervisor that contains a golden image and open the contained virtual machine 
tree to display the golden image virtual machine.

3 Right-click the golden image virtual machine and then select Clone.

4 Go to step 5 in Cloning Process on page 177.

➤ Converting a VMware Template to a Golden Image

As a best practice, if you have an existing VMware Template and want to use it as a golden 
image (virtual machine) in SA, perform the following tasks:

1 Convert the VMware Template to a managed virtual machine. (SA uses a virtual machine 
as a golden image.)

a Use the VS "Convert to Virtual Machine …" feature to convert the VMware Template 
to a virtual machine.

b Make sure the virtual machine has a valid network configuration and can 
communicate with the SA network.

2 Install or upgrade the SA Agent on the virtual machine. If the converted virtual machine 
contains an SA Agent that pre-dates the SA 9.0 release, you must upgrade the Agent to an 
SA 9.0 Agent.

See Agent Management on page 63 for Agent installation and upgrade instructions.

Cloning Workflow

During the cloning operation, the SA 9.0 Agent uses the UUID field in the SMBIOS to 
determine when a chassis change occurs. When you clone a virtual machine or instantiate a 
VMware Template (that is based on an SA-managed virtual machine), a UUID change is 
detected, and the following actions occur in SA:

• The Agent on the cloned server communicates with the SA core to re-establish Agent 
manageability on the new server.

• The SA core creates a new machine record to represent the new server.
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• The new server inherits the management model of the source server.

These actions ensure that SA management of cloned virtual machines is maintained, 
regardless of whether a clone or VMware Template instantiation operation originates from 
either SA or the VS. This capability allows for efficient datacenter operation in environments 
where SA is the primary management tool. SA supports the following datacenter 
environments where:

• All clones of SA-managed virtual machines are registered in SA, regardless of the tool 
used to perform the clone operation.

• No loss of server management model occurs as a result of cloning with other vendor tools.

• Virtual machine use and proliferation can be tracked and monitored in SA.

The source virtual machine must be managed by SA. The VMware Template must be based on 
a virtual machine that is managed by SA. See Requirements and Limitations on page 176.

Provisioning an OS on a Virtual Machine

An unprovisioned virtual machine does not have an installed operating system. To provision 
an OS on an existing VMware virtual machine, perform the following steps:

1 In the VMware console, boot a new “bare metal” virtual machine with either PXE boot or a 
boot image file. (You can open the console from VMware VI Web Access or VI Client.) In 
the SA Client, the virtual machine appears in the Unprovisioned Servers list.

2 Provision the OS on the virtual machine as if it were a physical server. For instructions, 
see the SA User Guide: Application Automation.

During the OS provisioning process, SA installs an SA Server Agent on the virtual machine. 
After Agent installation, the virtual machine appears in the All Managed Servers list.

Manually Installing an SA Server Agent on an Unmanaged Virtual Machine

Your environment will have unmanaged VMware virtual machines if they have been created 
and OS provisioned using tools other than SA. To bring a virtual machine under management 
by SA, you must install an SA Server Agent on it. 

You can install an Agent on an unmanaged virtual machine with command-line tools or with 
the SA Client. For more information, see the User Guide: Server Automation.

Modifying a Virtual Machine

You can modify the following virtual machine attributes:

• Memory Size

• Virtual Processors

• Network Configuration

• Data Store Configuration

To modify the attributes of a VMware virtual machine, perform the following steps:

1 Power off the virtual machine.
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For instructions, see Powering a Virtual Machine On or Off on page 181.

2 In the SA Client, from the Navigation pane, select the Devices tab.

3 Expand Servers and select Virtual Servers.

4 In the Content pane, expand the VMware ESX Server that hosts the virtual machine you 
want to modify.

5 Right-click the virtual machine and select VMware Virtual Machines ➤  Modify....

The Modify Virtual Machine window appears. In the Virtual Machine Definition dialog, 
change the attributes.

6 Click Next.

7 Continue through the remaining steps of the Modify Virtual Machine window, as 
explained in the following sections:

• Removing/Scheduling/Notification Step for Virtual Servers on page 190.

• Notifications Step for Virtual Servers on page 190.

• Job Status Step for Virtual Servers on page 190

Powering a Virtual Machine On or Off

To power a VMware virtual machine on or off, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the VMware ESX Server that hosts the virtual machine you 
want to power on.

4 Right-click the virtual machine and select VMware Virtual Machines.

5 Select Power On or Power Off.

Suspending a Virtual Machine

The suspending action pauses virtual machine activity. To suspend a VMware virtual 
machine, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the VMware ESX Server that hosts the virtual machine you 
want to suspend.

4 Right-click the virtual machine and select VMware Virtual Machines. 

5 Select Suspend.

Resetting a Virtual Machine

Resetting stops a virtual machine and reboots it. To reset a VMware virtual machine, perform 
the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.
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2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the VMware ESX Server that hosts the virtual machine you 
want to reset.

4 Right-click the virtual machine and select VMware Virtual Machines ➤ Reset.

Removing a Virtual Machine

To remove a VMware virtual machine, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the VMware ESX Server that hosts the virtual machine you 
want to remove.

4 Right-click the virtual machine and select VMware Virtual Machines ➤ Remove.
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Microsoft Hyper-V Partition (Virtual Machine) Management

This section provides step-by-step instructions for managing Microsoft Hyper-V partitions 
(virtual machines) with the SA Client.

Windows Server 2008 Hyper-V partition management, particularly the Shut Down feature, 
requires that Windows Integration Services are installed and running on the server. If 
Windows Integration Services are not present, shut down will fail.

SA only supports Hyper-V servers (hypervisors) running Windows 2008, with or without SP2. 
SA does not currently support Hyper-V servers running Windows 2008 R2.

Creating a Hyper-V Partition (Virtual Machine)

With the SA Client, you can create a virtual machine on a Microsoft Hyper-V server 
(hypervisor). If you specify an OS Sequence during this task, SA also provisions an OS and 
installs an SA Agent on the virtual machine. After Agent installation, the virtual machine 
appears in the All Managed Servers and the Virtual Servers lists in the SA Client.

To create a new partition or virtual machine on a Microsoft Hyper-V server (hypervisor), 
perform the following steps.

You cannot provision the Windows 2003 x64 operating system on a virtual machine using SA 
unless you first integrate the Windows Integration Components with your OS media. For 
details, see Installing Microsoft Integration Components on your OS Media on page 185.

However, SA can manage systems running Windows 2003 x64 and you can provision Windows 
2003 x64 on virtual machines outside of SA. For more information, see the Microsoft Hyper-V 
documentation.

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, select the Hyper-V hypervisor on which you want to create a 
partition.

4 Either select the Actions menu item or right-click the hypervisor server and select 
Windows Hyper-V Partitions ➤  Create... This brings up the Create Virtual Machine 
window where you define the characteristics of the virtual machine to be created, as 
shown below.
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Figure 57 Create a Hyper-V Partition (Virtual Machine)

5 In the Virtual Machine Definition screen, enter the desired values.

— Enter the name of the virtual machine and a description. 

— Enter the location where the vm will be stored on the hypervisor server.

— The memory size must be a minimum of 8 MB.

— To provision an operating system, specify an OS sequence. If you do not specify an OS 
sequence, no operating system will be installed on the vm. For more information, see 
“Operating System Provisioning” in the SA User Guide: Application Automation.

Note that if you provision a vm with the SUSE Linux Enterpriser Server (SLES) OS, 
the vm must have at least 1GB of memory.

Select the Next button to continue or select a step in the navigation bar.

6 In the Network Configuration screen, select the desired Management Network 
connection. The Management Network specifies the network that the network adapter 
will be connected to.

If you specified an OS sequence in the previous step, specify the Build Network. The Build 
Network will be used to provision the operating system on the vm. For more information, 
see “Operating System Provisioning” in the SA User Guide: Application Automation.
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If you specified an OS sequence in the previous step, SA creates a Legacy Network 
Adapter for use in OS provisioning. When you select an external virtual network for the 
Build Network, the Legacy Network Adapter is connected to that virtual network.

If you specified an OS sequence that installs Windows 2003 x64, you must first integrate 
the Windows Integration Components with your OS media. For details, see Installing 
Microsoft Integration Components on your OS Media on page 185.

Select the Next button.

7 In the Storage Configuration screen, specify virtual hard disk parameters. Select the Next 
button.

8 In the Scheduling screen, specify when you want the vm creation job to be run. Select the 
Next button.

9 In the Notifications screen, specify email addresses to receive notification of the success or 
failure of the create vm job. You can also specify a ticket ID to attach to the job for 
tracking purposes. Select the Next button.

10 On the Job Status screen, select Start Job to start the vm creation. Select any of the lines 
under “Action” to display details about each step. The following shows the Job Status 
window after a successful vm creation job.

Figure 58 Job that Creates a Hyper-V Partition (Virtual Machine)

Installing Microsoft Integration Components on your OS Media

This section provides information you need only if you plan to provision Windows 2003 x64 on 
virtual machines. This is not needed to provision other Windows operating systems on vms.

SA uses the following process for provisioning an OS:

1 Install the Legacy Network Adapter on the vm.

2 Provision the OS on the vm.
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3 Install the Integration Components on the vm, which includes a driver for the Network 
Adapter. At this point, the Legacy Network Adapter is no longer needed.

The Legacy Network Adapter is not supported on Windows 2003 x64. To provision Windows 
2003 x64, you must integrate the Windows Integration Components with your OS media. To 
integrate the Windows Integration Components into your OS media, perform the following 
steps.

1 Locate your Windows media on your media server. For SA, this is typically under
/media/opsware/windows/<directory>. For example, it might be at
/media/opsware/windows/wk364r2. 

2 Locate the Windows Integration Components, vmguest.iso, on your Windows Hyper-V 
hypervisor, typically located at C:\Windows\System32.

3 Create a directory on your media server for the Integration Components, under your 
Windows media. For example, it could be similar to the following:

/media/opsware/windows/wk364r2/amd64/$OEM$/$1

$OEM$ is the directory where third party drivers are stored on the Windows media 
server. 

4 Extract the Windows Integration Component iso into this directory. If you list the 
contents of this directory, you should see something like the following:

cs-cz ko-kr WdfCoinstaller01005.dll 
WindowsServer2003.WindowsXP-KB943295-x64-ITA.exe

de-de nl-nl Windows6.0-KB950214-x64.msu 
WindowsServer2003.WindowsXP-KB943295-x64-JPN.exe

en-us pl-pl Windows6.0-KB951634-x64.msu 
WindowsServer2003.WindowsXP-KB943295-x64-KOR.exe

es-es pt-br WindowsServer2003.WindowsXP-KB943295-x64-CHS.exe
WindowsServer2003.WindowsXP-KB943295-x64-PTB.exe

fr-fr pt-pt WindowsServer2003.WindowsXP-KB943295-x64-CHT.exe
WindowsServer2003.WindowsXP-KB943295-x64-RUS.exe

hu-hu ru-ru WindowsServer2003.WindowsXP-KB943295-x64-DEU.exe zh-cn
it-it setup.exe WindowsServer2003.WindowsXP-KB943295-x64-ENU.exe zh-hk
ja-jp sv-se WindowsServer2003.WindowsXP-KB943295-x64-ESN.exe zh-tw
kmdf.inf tr-tr WindowsServer2003.WindowsXP-KB943295-x64-FRA.exe

5 Create the file CMDLINES.TXT in the directory
/media/opsware/windows/win364r2/amd64/$OEM$

6 Place the following lines in the CMDLINES.TXT file:

[Commands]
"\IC\amd64\setup.ext /quiet"

After completing these steps, you can provision Windows 2003 x64 on vms under Hyper-V.

Modifying a Hyper-V Partition (Virtual Machine)

To modify a partition or virtual machine on a Microsoft Hyper-V server (hypervisor), perform 
the following steps.

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the Hyper-V hypervisor that is hosting the vm you want to 
modify.
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4 Select the virtual machine you want to modify.

5 Either select the Actions menu item or right-click the vm and select Windows Hyper-V 
Partitions ➤  Modify... This brings up the Modify Virtual Machine window where you 
can change the settings of the vm, as shown below.

Some of the vm characteristics can only be changed when the vm is stopped.

Figure 59 Modify a Hyper-V Partition (Virtual Machine)

6 In the Virtual Machine Definition screen you can change the vm name and description, 
the amount of memory and the number of virtual processors allocated to the vm. Select 
“Limit Processor Functionality” when you are running an older operating system on the 
vm, such as Windows NT. The BIOS Order specifies the devices the vm will attempt to 
boot from when it is powered on. If the first device fails, it will try to boot from the next 
device, and so on. The Legacy Network Adapter is used for PXE booting and is required if 
a vm needs to boot from the network. Click Next to continue or Start Job to accept the 
remaining settings.
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7 In the Network Configuration screen you can add or remove network adapters. Specify 
the network type, the network name, the VLAN identifier if applicable, and the MAC 
address.

8 In the Storage Configuration screen you can add, remove or modify virtual storage devices 
configured for the vm.

— You can add, remove or modify SCSI controllers.

— On each SCSI controller, you can add, modify or remove virtual hard disks.

— On each IDE controller, you can add, remove or modify virtual hard disks and DVD 
drives.

Note that removing a virtual hard drive from a Hyper-V vm disconnects the virtual disk 
from the vm, but does not delete the .vhd file on the hypervisor.

9 In the Integration Services screen you can select the services you want enabled on the vm.

10 In the Options screen you can specify the directory where snapshots of the vm are stored. 
Also specify the action you want taken when the physical server starts and shuts down.

11 In the Scheduling screen specify when you want the changes to be performed.

12 In the Notifications screen specify one or more email addresses to receive a message when 
the job completes, and an optional ticket number.

13 In the Job Status screen you can view the progress of the job. Select any of the actions to 
see more details.

Deleting a Hyper-V Partition

To delete a partition or virtual machine from a Hyper-V hypervisor, perform the following 
steps.

The virtual machine must be stopped before you can delete it.

Deleting a Hyper-v virtual machine does not remove the virtual hard disk files from the 
hypervisor.

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the Hyper-V hypervisor that is hosting the vm you want to 
delete.

4 Select the vm you want to delete.

5 Either select the Actions menu item or right-click the vm and select Windows Hyper-V 
Partitions ➤  Delete... This brings up the Delete Virtual Machine window.

6 In the Virtual Machine Definition screen, click Start Job to accept the remaining settings, 
or select a step in the navigation bar, or click Next to go to the next step.

7 In the Scheduling screen specify when you want the vm to be removed.

8 In the Notifications screen specify one or more email addresses to receive a message when 
the job completes, and an optional ticket number.
188 Chapter 6



9 In the Job Status screen you can view the progress of the job. Select any of the actions to 
see more details.

Powering a Hyper-V Partition On or Off

You can shut down a partition (virtual machine) by using Shut Down or Turn Off.

• Shut Down performs an orderly termination of the system.

• Turn Off is equivalent to turning off the power to the computer. Use care when specifying 
Turn Off because it could result in data loss.

To power a Hyper-V partition (vm) on or off, perform the following steps.

Windows Server 2008 Hyper-V partition management, particularly the Shut Down feature, 
requires that Windows Integration Services are installed and running on the server. If 
Windows Integration Services are not present, shut down will fail.

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the Hyper-V hypervisor that hosts the vm you want to power 
on.

4 Right-click the vm and select Windows Hyper-V Partitions.

5 Select Start, Turn Off, or Shut Down.

Resetting a Hyper-V Partition

The resetting action stops the partition (vm) and reboots it. The vm must be running. To reset 
a Hyper-V vm, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the Hyper-V hypervisor that hosts the vm you want to reset.

4 Right-click the vm and select Windows Hyper-V Partitions ➤  Reset.

Pausing and Resuming a Hyper-V Partition

Pausing a Hyper-V partition (vm) stops the vm without discarding the contents of the vm’s 
memory. To pause a vm, perform the following steps:

1 In the SA Client, from the Navigation pane, select the Devices tab.

2 Expand Servers and select Virtual Servers.

3 In the Content pane, expand the Hyper-V hypervisor that hosts the vm you want to 
suspend.

4 Select the Actions menu or right-click the vm and select Windows Hyper-V Partitions 
➤ Pause.

5 To resume running the vm, use Actions ➤  Windows Hyper-V Partitions ➤  Resume.
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Common Tasks for Virtual Management

This section describes scheduling, notification, and job status tasks that are not dependent on 
the underlying virtualization technology. You specify the parameters for these tasks in the 
Create Virtual Machine window when you define a job on a virtual server or hypervisor.

Removing/Scheduling/Notification Step for Virtual Servers

The Removing/Scheduling/Notifications screen lets you specify whether the job runs 
immediately or later. To schedule a task, select one of the following:

• Run Task Immediately: This option allows you perform the task when you select 
the Start Job button.

• Start Time and Start Date: These allow you to specify the future date and time 
when the task will start.

Notifications Step for Virtual Servers

The Notifications dialog allows you to have an email message sent to alert users on the 
success or failure of a job. You can also associate a Ticket ID with the job for tracking 
purposes. These settings are optional.

To set email notifications, perform the following steps: 

1 In the Virtual Machine wizard, navigate to the Notifications dialog.

2 Click Add Notifier.

3 Enter the email addresses to be notified in the Notification Email Address field. 

4 To send email to the address if the job succeeds, select the check box under On Success. To 
send email if the job fails, select the check box under On Failure.

5 Enter a ticket identifier to be associated with this job in the Ticket ID field.

Job Status Step for Virtual Servers

The Job Status dialog allows you to start a job, view summary information of the job’s 
progress, and view the status of each action required to complete the job.

To start the job, perform the following steps: 

1 In the Create Virtual Machine wizard, navigate to the Job Status dialog.

2 Click Start Job.

If you selected Run Task Immediately on the Scheduling dialog, the job begins 
immediately. If you scheduled the job for a later time, the job will run when the date and 
time you specified is reached. The job’s progress information also appears in this window.

3 To view the details of each action performed by the job, select a row in the table.

4 Click End Job to cancel a scheduled job that has not yet started. Click Close to exit this 
window.
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You can also view jobs and job status in the Jobs Log window of the SA Client. See Browsing 
Job Logs on page 56 for more information.
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7 Server Tracking in the SAS Web Client
Server Tracking

This section discusses the following topics:

• Ways to Locate, List, and Display Servers

• Tracked Server Properties

• Supported Operating Systems for Managed Servers.

Ways to Locate, List, and Display Servers

You can locate, list, and display servers in the SAS Web Client in the following four ways:

• By searching when you know the name, host name, or IP address of the server you want to 
provision or manage.

• By viewing the Manage Servers list and Server Pool list when you want to see a complete 
list of all your servers. You can refine the lists by using filters.

• By viewing servers sorted by hardware category. (Click Environment ➤  Hardware in the 
navigation panel.) The Servers tab in the Hardware pages shows each manufacturer and 
model that you have running in the operational environment. See Hardware Information 
for Managed Servers on page 223 for more information.

• You can also browse managed servers and server groups using the SA Client. 

Tracked Server Properties

Every server that SA manages has the following properties:

• IP addresses, host name, and the server ID

• All software that is installed on the server. Select the Installed Packages tab from the 
Manage Servers: Server Properties page to display the list of software that is reportedly 
installed on the server.

HP Server Automation is able to determine what software is installed on a server because 
the Server Agent communicates with the SA core and reports the installed hardware and 
software for the server.

In some cases, Solaris packages might only be partially installed. In these cases, the 
partially installed Solaris package does not show up in the installed list.

See Server Information that the Agent Tracks on page 66 for more information about a 
complete list of all the hardware and software information that HP Server Automation tracks 
for managed servers.
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Supported Operating Systems for Managed Servers

This section lists the supported operating systems for agents and the SA Client.  

SA Server Agents

The following table lists the supported operating systems for SA server agents, which run on 
the servers managed by SA.  

Table 15 SA Server Agent Supported Operating Systems

supported Operating 
Systems
for SA server agent Versions Architecture

AIX AIX 4.3
AIX 5.1
AIX 5.2
AIX 5.3

POWER
POWER
POWER
POWER

HP-UX HP-UX 10.20
HP-UX 11.00
HP-UX 11.11
HP-UX 11.23 (11i v2)
HP-UX 11.31 (11i v3)

PA-RISC
PA-RISC
PA-RISC
PA-RISC and Itanium 
PA-RISC and Itanium 

Sun Solaris Solaris 6
Solaris 7
Solaris 8
Solaris 9
Solaris 10 (Update 1, Update 2, 
Update 3, Update 4 and 
Update 5)

Sun SPARC
Sun SPARC
Sun SPARC
Sun SPARC
Sun SPARC, 64 bit x86, 32 
bit x86 and Niagara

Fujitsu Solaris Solaris 8
Solaris 9

Fujitsu SPARC
Fujitsu SPARC

Windows Windows NT 4.0
Windows 2000 Server Family
Windows Server 2003
Windows XP Professional
Windows Server 2008

32 bit x86
32 bit x86
32 bit x86 and 64 bit x86
32 bit x86
32 bit x86 and 64 bit x86
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On Red Hat Enterprise Linux 4 AS, SA does not support SELinux (Security Enhanced Linux). 
By default, SELinux is enabled on Red Hat 4 AS. You must disable the SELinux feature on 
Red Hat 4 AS for the SA agent to function correctly. SA supports SELinux (Security Enhanced 
Linux) on Enterprise Linux 5.

Red Hat Linux Red Hat Enterprise Linux 2.1 AS
Red Hat Enterprise Linux 2.1 ES
Red Hat Enterprise Linux 2.1 WS
Red Hat Enterprise Linux 3 AS

Red Hat Enterprise Linux 3 ES

Red Hat Enterprise Linux 3 WS

Red Hat Enterprise Linux 4 AS
Red Hat Enterprise Linux 4 ES
Red Hat Enterprise Linux 4 WS
Red Hat Enterprise Linux Server 5 
Red Hat Enterprise Linux Desktop 5

32 bit x86 
32 bit x86 
32 bit x86 
32 bit x86 and 64 bit x86
and Itanium
32 bit x86 and 64 bit x86 
and Itanium
32 bit x86 and 64 bit x86 
and Itanium
32 bit x86 and 64 bit x86 32 
bit x86 and 64 bit x86 32 bit 
x86 and 64 bit x86
32 bit x86 and 64 bit x86 32 
bit x86 and 64 bit x86 

SUSE Linux SUSE Linux Enterprise Server 8
SUSE Linux Standard Server 8
SUSE Linux Enterprise Server 9
SUSE Linux Enterprise Server 10

32 bit x86
32 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86

VMware ESX Server 3.0
ESX Server 3.0.1
ESX Server 3.0.2
ESX Server 3.5

32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86
32 bit x86 and 64 bit x86

Table 15 SA Server Agent Supported Operating Systems (cont’d)

supported Operating 
Systems
for SA server agent Versions Architecture
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Required Patches for Agent Installation      

SA Client 

Table 17 lists the operating systems supported for the SA Client.   

Table 16 Required Patches and Packages for Agent Installation

server operating system required patches

AIX 4.3

AIX 5.1

APAR IY39444

APAR IY39429

NOTE:
If AIX 4.3.3.388, 4.4.4.89, or 5.1.0.3 is installed, the Agent 
Installer displays an error message that indicates the correct 
APAR to install on the server.

HP-UX (10.20, 11.00, 11.11/
11i)

For HP-UX 10.20, PHCO_21018 

Additionally, SW-DIST should be upgraded to the HP 
recommended patch level. You should continue to upgrade 
this package when HP recommends new versions. 

Linux AS 3.0

Linux WS 3.0

Linux ES 3.0

Red Hat Enterprise Linux 3 Update 3 

Solaris 10, 9, 8, 7, and 6 SUNWadmc
SUNWcsl
SUNWcslr (If available, depending on version) 
SUNWcsu
SUNWesu
SUNWlibms
SUNlibmsr (If available, depending on version)
SUNWswmt
It is strongly recommended not to remove packages from the 
SUNWCreq minimal required install cluster, since many 
packages are interdependent and operation beyond that of 
basic SAS functionality may be affected.

Windows 2000 Service Pack 4

Windows NT 4.0 Service Pack 6a

Table 17 SA Client Supported Operating Systems

supported Operating 
Systems
for SA Client Versions Architecture

Windows Windows Vista

Windows XP
Windows 2003
Windows 2000

32 bit x86 and 64 bit x86
32 bit x86
32 bit x86
32 bit x86
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Server Lists 

This section discusses the following topics:

• Types of Server Lists

• Server Pool

• Manage Servers List

• Filters on the Manage Servers List

Types of Server Lists

The SAS Web Client displays lists for two types of servers, as Figure 60 shows.

Figure 60 Servers Section in the Navigation Panel   

Server Pool: Servers in the Server Pool have registered their presence with HP Server 
Automation but do not have the target OS installed. An OS Build Agent is running on each 
server so that they can communicate with HP Server Automation.

See SA User Guide: Application Automation on how to use the Server Pool when you install 
the target OS on a server.

Manage Servers: The Manage Servers list contains servers on which HP Server Automation 
can perform management tasks, because Server Agents are installed on them. However, HP 
Server Automation might not have provisioned all software running on the servers.

You begin the OS provisioning process by reviewing the servers in the Server Pool list. From 
the Server Pool, you can install a target OS by selecting a server and clicking Install OS.

Server Pool

The Server Pool provides the following information about each server waiting to be 
provisioned with the target OS:

• The host name set by booting the server for the first time over the network or by using an 
SA Boot Floppy

• The MAC address 

• The manufacturer and model

• The OS that the OS Build Agent is running – DOS (Windows operating systems), Linux, 
or Solaris

You use this information to select the target OS for servers. If the server is in the process 
of installing an OS, this value might change.

• The last date and time that the Server Agent on the server communicated with HP Server 
Automation (by submitting the server’s hardware and software information)
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If the server is in an unreachable state (that is, if the server icon has a red “x” on it), you 
can run a Communication Test to help you troubleshoot why that server is unreachable. 
See Agent Reachability Communication Tests on page 84 for more information.

• The life cycle value, such as whether the server is available to have a target OS installed 
on it

• The facility in which the server is located

• The customer association

• Additional hardware information (Click the server name to open a window that displays 
specific hardware information.)

Manage Servers List

The Manage Servers list contains servers on which HP Server Automation can perform 
management tasks because Server Agents are installed on them. When an existing 
operational server has an Server Agent installed successfully, it appears in the Manage 
Servers list and the server icon indicates that it is fully manageable, as Figure 61 shows.

Figure 61 The Manage Servers List in the SAS Web Client 

See The SA Server Agent on Managed Servers on page 63 for more information. By default, 
servers in the Manage Servers list are sorted by the Name column. However, you can re-sort 
the list based on any of the column headings. For example, you can click the Hostname / IP 
Address column heading to re-sort the list by host name or IP address.

If you have many servers that HP Server Automation manages, the list of servers is grouped 
by pages. Click the page number links or the left arrow at the bottom of the list.

The Manage Servers list provides the following information about each server:

• The name of the server

By default, the server’s host name appears in this field. However, you can edit it so that it 
is more descriptive or useful.

• The host name of the server determined by the Server Agent

• The IP address configured for the server, which users can edit by using the network 
configuration feature in the 

• The reported OS, which is obtained by the Server Agent that is running on the server

• The stage of the server, which specifies the stages of deployment for servers

• The server’s use

• The facility in which the server is located
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• The customer association

• Additional hardware information (Click the server name to open a window that displays 
specific hardware information.)

Filters on the Manage Servers List

The Manage Servers list displays the following filters that you can specify to qualify the 
servers that the SAS Web Client displays, as Figure 62 shows.

Figure 62 Filters in the Manage Servers List 

• Status: Specifies the ability of HP Server Automation to manage servers. HP Server 
Automation automatically detects the status of servers; a server’s status is OK or Not 
Reachable.

• OS: Specifies the operating system on the server, which is obtained by the Server Agent 
that is running on the server.

• Stages: Specifies the stages of deployment for servers; for example, a server is live or 
offline. Users set this property for servers. The values in this list are customizable by the 
SA administrator. 

• Uses: Specifies how an organization is utilizing servers. For example, a server is a staging 
server. Users set this property for servers. The SA administrator can customize the values 
in this list.

• Facilities: Specifies the location of servers. From an SAS Web Client, users can manage 
servers located in any facility. For example, a user could log in to the SAS Web Client 
running in facility A and manage the server located in facility B. 

• Customers: Specifies the customer associated with each server. Your SA administrator 
defines the options for customer selections by using the Administration pages.

• Manufacturers: Specifies the manufacturer for the server as reported by the OS Build 
Agent running on the server.

• Models: Specifies the model of the server as reported by the OS Build Agent running on 
the server.

• Life cycles: Specifies the various SA server life cycle values which include Managed, 
Available, Build Failed, Installing OS, and Deactivated.

You can change the filters displayed in the Manage Servers page. To change the filters you 
want to be displayed on the Manage Servers page, click on the icon as shown in Figure 64 and 
specify the filters from the Edit Filters Menu.

Figure 63 Edit Icon 

Figure 64 shows the filters that are in the Server Pool list.

Figure 64 Filters in the Server Pool List 
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• Manufacturers: Specifies the manufacturer for the server as reported by the OS Build 
Agent running on the server.

• Models: Specifies the model of the server as reported by the OS Build Agent running on 
the server.

• Facilities: Specifies the location of the server. Users can manage servers in any facility 
from an SAS Web Client in any facility.

My Servers

This section contains the following topics:

• Overview of My Servers

• Adding Servers to My Servers

• Removing Servers from My Servers

Overview of My Servers

The My Servers feature provides an efficient way to manage servers when your operational 
environment contains hundreds or thousands of servers.

When you search for servers or browse the server lists, you can add servers to My Servers 
(similar to a shopping cart on an e-commerce site). Using My Servers allows you to view and 
perform actions on selected servers.

When you use the same browser and login to the SAS Web Client running in the same facility, 
servers stay in My Servers for one year or until you explicitly remove them. Each time that 
you login to the SAS Web Client, you see the servers that were in My Servers the last time 
that you logged in. 

The My Servers feature is available only on a per-user basis. You cannot log in as an SA 
administrator to see the servers in the My Servers area of other SA users. 

Adding Servers to My Servers

Perform the following steps to add a server to My Servers:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the servers that you want to add to the My Servers.

Or

Search for the servers that you want to add to My Servers.

See Using the Search Feature on page 202 and Server Searching by IP Address on 
page 214 for more information. 

2 Select the servers that you want to add to My Servers.

3 Choose Resource ➤ Add to My Servers from the menu above the Manage Servers list. 
The Add To My Servers window appears, which indicates that you added the chosen 
number of servers to My Servers. 

4 Click Close to close the window. 
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5 Next, select the My Servers link at the top of the page. You see the selected servers added 
to My Servers, as Figure 65 shows. 

Figure 65 Servers in My Servers 

You can perform the same server management tasks on servers in My Servers as on the 
servers in the Manage Servers list. 

Removing Servers from My Servers

Perform the following steps to remove servers from My Servers:

1 Click the My Servers link in the navigation panel of the SAS Web Client. The My Servers 
page appears that shows the servers currently added to it.

2 Select the servers that you want to remove from My Servers and choose Edit ➤ Remove 
from My Servers from the menu above the Server list. 

The My Servers page refreshes and displays the remaining servers in My Servers. 

Server Search

This section provides information about Server Search and contains the following topics:

• Searching for a Server By Using the Search Box

• Ways to Use Search

• Using the Search Feature

• Rules for Server Search and for Creating Dynamic Groups

• Line Break Workaround for Server Search

• Conditions for Searching with Multiple Rules

• Server Searching by IP Address

• Example: Server Search

• Searching for a Server Group

Searching for a Server By Using the Search Box

Perform the following steps to search for a server using the Search box:

1 On the Home page, click the down arrow in the top navigation panel to open the Search 
box, as Figure 66 shows.
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Figure 66 Search Text Box on the SAS Web Client Home Page 

2 Verify that the Servers option is selected in the list.

3 Type the server’s IP address, host name, or name in the Search box and then click Go.

The search text that you enter can include an asterisk (*) wildcard character. However, 
the search feature automatically prepends and appends an asterisk to the text. 

For example, you can type any of the following search queries:

192.168.68.6
host02.coredev-va1.sample.com
192.168.*.19
host1*.xyz.samplecompany.com

The resulting page contains one or more servers, depending on the type of search query 
that you specified. If no servers are found, the SAS Web Client displays a message that 
indicates that no servers were found that matched your query.

See Using the Search Feature on page 202 for more information on how to formulate 
complex, multiple rule search queries.

Ways to Use Search

By using the SAS Web Client, you can perform searches in the following ways:

• From SA wizards

While using the SA wizards from the Tasks panel, you are prompted to select (by browsing 
or searching) servers or server groups, and operating systems, at specific points in the 
process.

What you can search for in the SA wizards is context sensitive to the type of operation 
that you are performing. 

• From the navigation panel, click Servers ➤ Search.

The Search page allows you to search for managed servers that match specified rules.

• While adding or modifying rules for a dynamic group (By clicking Search on the Rules 
tab for a group).

Using the Search Feature

In the SA wizards, you can browse for servers, operating systems, or use the Search feature to 
search for these items. 
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Perform the following steps to search by using the Search feature:

1 In an SA wizard, select the Search tab. The following Search page appears. See Figure 67. 

Figure 67 Search Tab in the Select Servers Step of an SA Wizard 

You can also use the Search tab at other steps in the wizards to search for operating 
systems, patches, applications, and templates.

Or

From the navigation panel, click Servers ➤ Search. The Search page appears, as 
Figure 68 shows.

Figure 68 Search Page 

By default, one search rule is added to the search.

2 Specify the rule that you want to search for by selecting it from the first list, as Figure 69 
shows.
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Figure 69 Search Rules List in the Search Page 

Depending on the rule that you select, a popup window might appear in the page. For 
example, if you selected Deployment Stage, a popup window showing the stages appears 
in the page as Figure 70 shows:
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Figure 70 Search Popup Window with Values 

You cannot search in Notes that contain line breaks. See Line Break Workaround for 
Server Search on page 212 for more information and a workaround.

If you are searching while using an SA wizard, the first search rule list might not have all 
the options. The list only includes the options that are relevant for the SA wizard that is 
being used. For example, the Install OS Wizard does not include options to search for 
installed patches on the servers. 

3 In the second list, specify how you want HP Server Automation to search by selecting a 
value. The operator selected defines how the search text is treated. Negative operators 
might not be available in all cases.

See Rules for Server Search and for Creating Dynamic Groups on page 206 for more 
information about the operator for each search rule.

4 Enter the text that you want to search for in the text box or choose a value from the list or 
popup window. The search text that you enter can include an asterisk (*) wildcard 
character. The search text is case insensitive. You can also use the SHIFT or CTRL key to 
select multiple values from the list or popup window.

5 (Optional) To add additional rules, click the plus (+) button as Figure 71 shows and repeat 
Steps 2 through 4.
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Figure 71 Multiple Rules in a Search 

6 If you specified multiple rules for the search, select whether you want search results only 
if all rules are met or if any of the rules are met, as Figure 72 shows.

Figure 72 Operator Controlling Search Results 

By default, search results appear for servers that match all the search rules. If you are 
searching from an SA wizard, this field is set to the value if all rules are met; you can 
change the value when searching for servers, but you cannot change it when searching for 
patches, software, operating systems, and so on.

7 Click Search. The list of servers that match your search rules appears in the page, as 
Figure 73 shows.

Figure 73 Displayed Search Results 

The search results include columns for Name, IP Address, OS Version, Facility, and 
Customer. 

When you search for installed software or patches and include an asterisk in the search 
text, HP Server Automation might take several minutes to display the search results.

Rules for Server Search and for Creating Dynamic Groups

The following table describes the rules that you can use to search for servers or to create 
dynamic server groups.
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Note that anywhere you can enter text, you can enter a wildcard (*) character to broaden your 
results.  

Table 18 Rules for Server Search and for Creating Dynamic Groups

Rule Name and Description Operators Value

Properties

Agent Discovery Date: The date 
that the Server Agent was installed.

• Is after

• Is before

Drop-down lists with the day, 
month, and year

• Is within the last User-entered text

• Is today N/A

Agent Reporting: Whether the 
Server Agent is reporting to HP 
Server Automation.

• Is

• Is not

• Has not reported

• OK

• Registration in progress

• Reporting error

Agent Status: Whether the Server 
Agent is reachable by HP Server 
Automation.

• Is

• Is not

• Not reachable

• OK

Agent Version: The version of the 
Server Agent — such as 14.2.3b.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Custom Attribute (any): The name 
of a custom attribute that is 
associated with the server through 
attachment or inheritance.

• Contains

• Is

User-entered text

Custom Attribute (local): The 
name of a custom attribute that is 
locally attached to the server,

• Contains

• Is

User-entered text

Customer: The customer or account 
that the server is associated with.

• Is

• Is not

Popup window of customers

Deployment Stage: The stage the 
server performs within a lifecycle 
environment.

• Is

• Is not

• In Deployment

• Live

• Not Specified

• Offline

The values that appear in 
this list are customizable; in 
addition to the values above, 
values specific to your 
environment might appear. 
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Facility: The collection of servers 
managed by an HP Server 
Automation installation.

• Is

• Is not

Popup window of facilities

When HP Server Automation 
is running multimaster 
mode, the list can contain 
many facilities.

Group Membership: Whether the 
server belongs to a group.

• Is Popup window of groups

Host name: The host name of the 
server — such as 
m004.company.com.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Name (any): This enables searching 
for any name or IP address 
associated with a server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Notes: The contents of the Notes 
field from the Properties tab for a 
server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Opsware Display Name: The 
user-configurable name for the 
server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

By default, HP Server 
Automation uses the 
configured host name of the 
server until a user edits it.

Server Use: How the server is being 
used — such as Development, 
Staging, Production.

• Is

• Is not

• Development

• Not Specified

• Production 

• Staging

You can customize values 
that appear in this list. In 
addition to the values above, 
values specific to your 
environment might appear.

Table 18 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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Service Level: The user-defined 
category that can be used as an 
organizational tool.

• Is

• Is attached here 
or below

Popup window of service lev-
els

Servers can be associated 
with multiple service levels. 

OPSWARE PROPERTIES

Application Configuration: 
Whether the server uses the 
Application Configuration feature.

• Is not used

• Is used

N/A

Code Deployment: Whether the 
server uses the Code Deployment 
feature.

• Is not used

• Is used

N/A

Configuration Tracking: Whether 
the Configuration Tracking feature 
is monitoring or backing up specific 
files or configurations on a server.

• Is off

• Is on

N/A

Lifecycle: The server states that are 
part of bringing a server into HP 
Server Automation.

• Is

• Is not

• Available

• Build Failed

• Deactivated

• Installing OS 

• Managed

Server ID: The internal ID HP 
Server Automation uses to identify 
the server.

• Is

• Is not

User-entered text

In most cases, the Server ID 
is the same as the MID.

SOFTWARE

Attached Software: The software 
that is assigned or modeled through 
the SA installation process.

• Is

• Is attached here 
or below

Popup window of software

Attached Software Policies: The 
software policies that is assigned or 
modeled through the SA installation 
process.

• is Popup window of software 
policies

Table 18 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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Installed Patches: Whether a patch 
is installed on the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Installed Software: The package 
reported installed on the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

A package does not have to 
be installed by HP Server 
Automation to be reported as 
installed on a server.

OS Version: The OS version defined 
by OS definitions in the OS 
Provisioning feature.

• Is

• Is not

Popup window of operating 
systems

Reported OS: For Windows —the 
version reported by the OS, for Unix 
— the version returned by the uname 
command.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Windows Service: The names of 
the Windows services that are 
reported to HP Server Automation.

• Contains

• Does not contain

• Is

• Is not

User-entered text

NETWORK

DNS Search Domains: The 
domains configured to be searched in 
the server’s network settings.

• Contains

• Does not contain

• Is

• Is not

User-entered text

DNS Servers: The IP addresses of 
the DNS servers configured in the 
server’s network settings.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Default Gateway: The IP address 
of the default router.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Table 18 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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IP Address: Any Internet Protocol 
address for the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

MAC Address: Any Media Access 
Control address, which is the 
network interface card's unique 
hardware number.

• Contains

• Does not contain

• Is

• Is not

User-entered text

WINS Servers: The Windows 
Internet Naming Servers configured 
in the server’s network settings.

• Contains

• Does not contain

• Is

• Is not

User-entered text

HARDWARE

CPU Make and Model: The vendor 
name and CPU model for the server 
— such as GENUINEINTEL Intel(R) 
Pentium(R) 4 CPU 2.60GHz.

• Is

• Is not

Popup window of CPU makes 
and models

CPU Speed: The Central Processing 
Unit speed in gigahertz [GHz].

• Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

A 600 Mhz machine should 
be entered as 0.6.

Make and Model: The vendor name 
and server model for the server — 
such as Compaq - DL360.

• Is

• Is not

Popup window of server 
makes and models

Number of CPUs: The number of 
CPUs on the server.

• Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

RAM: The amount of RAM on the 
server in megabytes [MB].

• Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

To enter 1 Gigabyte, type 
1024.

Table 18 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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Line Break Workaround for Server Search

You cannot search in notes that contain line breaks. For example, you cannot search for text in 
a note when it is this type of text:

line1 <line break>

Serial Number: The serial number 
of the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Storage Make and Model: The 
vendor name and storage model for 
the server — such as WDC - 
WD800BB-75DKA0.

• Is

• Is not

Popup window of storage 
makes and models

CUSTOM FIELDS

A Numeric field • Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

A String field • Contains

• Does not contain

• Is

• Is not

User-entered text

A URI field • Contains

• Does not contain

• Is

• Is not

User-entered text

A File field • Contains

• Does not contain

• Is

• Is not

User-entered text

A Date field • Is after

• Is before

Drop-down lists with the day, 
month, and year

• Is within the last User-entered text

• Is today N/A

Table 18 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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line2

For example, the following query does not return any results:

Any/all notes contain line1 <line break> line2

However, the following query does return all servers that have notes:

Any/all notes is not line1 <line break> line2

To work around this limitation, include an asterisk (*) where the line break occurs, as 
Figure 74 shows. For example:

Any/all notes is line1*line2

Figure 74 Line Break Workaround in the Server Search Feature 

Conditions for Searching with Multiple Rules

When you perform a search with multiple rules, the following conditions apply to the way HP 
Server Automation provides search results:

• When it evaluates rules, the Search feature considers each rule individually, finding 
servers (or operating systems, patches, and so forth) that match the individual rule, and 
then the results of each rule are combined. 

• You must select at least one rule, and it must have a value. Default filter rules count as 
rules with a value. 

• Empty rules are ignored in searches. Users do not have to manually remove them for the 
search to proceed.

• You cannot search for empty values. For example, you cannot search for all servers where 
the Notes field is empty. 

At certain steps in the SA wizards, the Search feature provides default values based on 
previous selections in the wizard.

The wizards are flexible; for example, when you select multiple servers and applications, HP 
Server Automation will install the correct applications on the servers, even if you selected 
different OS versions for the servers and applications in the respective steps. HP Server 
Automation also matches the customer association for applications, operating systems, and 
templates with the customer association of servers. 
If HP Server Automation cannot find a match, an error message appears at the end of the 
wizard; therefore, use caution when modifying these default values.
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Server Searching by IP Address

Users can search for servers by entering a specific IP address in the Search box in the top 
navigation or in the Search feature.

HP Server Automation includes support for static Network Address Translation (NAT). This 
feature introduces the concept of a management IP, which might be different from any of the 
local IP addresses that the Server Agent reported for a server. 

When searching for a server based on its IP address, the Search feature searches based on the 
server's primary IP address and based on the IP address for any interface that server has, 
including its management IP address. In the search results, an extra column is shown that 
lists all matching IP addresses for all interfaces. The management IP address is included if 
the server’s networking is configured for static NAT.

See Communication Between Managed Servers and HP Server Automation on page 226 for 
more information on how HP Server Automation handles servers that are affected by static 
NAT.

Example: Server Search

Using the Search feature, a user creates a query with the following conditions:

• Installed Software contains qa

• Installed Software contains man

• If all rules are met is selected

The results of this search will be all servers that have at least one installed package with qa 
somewhere in its name and at least one installed package (not necessarily the same one) with 
man in its name. 

The search results are not limited to packages that contain both qa and man in the package 
name.

Find all servers that have some version of Apache or some version of Java installed:

• Installed Package contains apache

• Installed Package contains java

• If any rules are met is selected
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Searching for a Server Group

1 From the navigation panel, click Servers ➤ Search. The Search page appears. By default, 
the Servers tab is selected. 

Select the Groups tab. The rules for server group search appear as Figure 75 shows. By 
default, one search rule is added to the search.

Figure 75 Rules for Server Group Search 

2 In the second list, specify how you want HP Server Automation to search by selecting 
either “Contains” or “Is”. The operator selected defines how the search text is treated. 

3 Enter the text that you want to search for in the text box. The search text that you enter 
can include an asterisk (*) wildcard character. (The search text is case sensitive. Search 
is not enabled until you enter text in the text box.)

When searching for a server group, you can only specify one rule for Group Name. The plus (+) 
button is disabled.

4 Click Search. The search results appear as Figure 76 shows.

Figure 76 Server Group Search Results 
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Server Identification

This section provides information on server identification within HP Server Automation and 
contains the following topics:

• Overview of Server Identification

• Ways that Servers are Identified by HP Server Automation

• Customer Accounts in HP Server Automation

• Associating Servers with Customers

Overview of Server Identification

HP Server Automation uses the following IDs to track managed servers:

• MID: Machine ID. The unique identifier that HP Server Automation uses to identify the 
server. The MID is usually equal to the server ID.

The MID is stored in a file on a server's disk so that the MID can persist and be read by 
the Server Agent.

The MID follows the hard disk, not the chassis, so system administrators can swap 
chassis for servers without affecting how HP Server Automation tracks those servers. 

See Example: HP Server Automation Swaps a Server’s Hard Disk on page 217 for more 
information about swapping hard disks. 

• Server ID: The primary key in the Model Repository (database) that represents a given 
server. The Server ID is used internally in HP Server Automation. Generally, users do not 
need this value for servers to manage them in HP Server Automation.

• MAC Address: Media Access Control address, which is the network interface card’s 
unique hardware number. The MAC is used as the server’s physical address on the 
network.

• Chassis ID: A unique hardware-based identifier that the Server Agent discovers, 
typically derived from some property of the server's chassis. As a common source for this 
ID, HP Server Automation uses an interface's MAC address or the host ID on Solaris 
servers, or the serial number for one of the interfaces. 

Ways that Servers are Identified by HP Server Automation

Servers in the Manage Servers list are identified in the following ways when they register 
their hardware and software with HP Server Automation:

• HP Server Automation identifies each server by using the MID first.

• If the MID cannot be determined, the chassis ID is used to identify the server.

• If the server cannot be identified with the chassis ID, the MAC addresses are used to 
identify the server. 

In the Server Pool, the MAC Address column displays values by which HP Server Automation 
tracks the servers. The value used varies by platform:

• Intel x86 processor-based servers are identified by the MAC address of the server.

• Sun SPARC processor servers are identified by the host ID of the server. 
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The host ID for Sun SPARC processor servers appears in the MAC Address column in the 
Server Pool list. 

To determine the value in the MAC Address column, HP Server Automation uses the 
hardware address by which the server contacted the SA Build Manager (a component of 
the OS Provisioning feature). 

Example: HP Server Automation Swaps a Server’s Hard Disk

The following steps show how HP Server Automation handles swapping a hard disk for a 
server:

1 A system administrator swaps the hard disk of Server A (MID 1230001, chassis ID AB:08) 
with the hard disk of Server B (MID 98730001, chassis ID XY:96).

2 The Server Agent on Server A registers its hardware with HP Server Automation. The 
MID for Server A equals 1230001 and the chassis ID equals XY:96. 

3 HP Server Automation locates Server A by using the MID. 

4 HP Server Automation updates the data it has for Server A in the Model Repository. It 
sets the chassis ID equal to XY:96. 

5 The Server Agent on Server B registers its hardware with HP Server Automation. The 
MID for Server B equals 98730001 and the chassis ID equals AB:08. 

6 HP Server Automation locates Server B by using the MID. 

7 HP Server Automation updates the data it has for Server B in the Model Repository. It 
sets the chassis ID equal to AB:08.

Customer Accounts in HP Server Automation

Many enterprise customers have consolidated disparate IT operations into a single operation, 
yet they still need separate reporting, billing, and management for different business units or 
groups (for example, West Coast Office, East Coast Office, and London Office).

HP Server Automation accommodates these requirements with customer accounts created by 
your SA administrator. 

When your SA administrator creates a customer in HP Server Automation, a value for that 
customer is automatically added to the customer filter in the Manage Servers list, as 
Figure 77 shows.
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Figure 77 Customer Filter in the Manage Servers List 

By using customer accounts in the SAS Web Client, you can segregate servers that belong to 
different business units. By segregating servers, you can have separate accounting for each 
customer or different levels of security for different customers. You might want to segregate 
the servers based on the department or business unit.

By default, HP Server Automation is shipped with the following two customers: 

• Customer Independent: A global customer in HP Server Automation. Resources that 
are associated with “Customer Independent” can be installed on any managed server, no 
matter what customer it is associated with. 

• Not Assigned: The servers are not associated with a customer. You can install resources 
that are Customer Independent on Not Assigned servers. However, you cannot install or 
use any resources associated with a customer on a server that is not assigned to a 
customer. 

When you install an Server Agent in a server, the server is associated with the Not Assigned 
customer if IP ranges were not created to automatically associate HP Server Automation 
managed servers with customers. See Figure 78.

Hewlett Packard recommends that you associate servers with customers, if necessary, by 
using the Server Properties pages.

Figure 78 Customers List Under Environment in the SAS Web Client 
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Associating Servers with Customers

An SA user or an SA administrator can set up an IP range group so that servers are 
automatically associated with customers when users perform the following server 
management tasks:

• Install Server Agents on the servers.

See Agent Reachability Communication Tests on page 84 for more information. 

• Use the OS Provisioning feature to install operating systems on bare-metal servers.

See SA User Guide: Application Automation for more information. 

To set up this automatic customer association, you must create IP range groups for customers 
and specify the ranges of IP addresses that the groups contain. 

In the SAS Web Client, an IP range group is both a physical and logical list – an accounting 
way to group ranges of IP address and assign them to a particular customer. An IP range 
identifies a range of IP addresses within an IP range group. 

When you set this up, IP addresses get their customer association through the IP range, 
which, in turn, gets its customer association from the IP range group. 

See the SA Policy Setter Guide for more information. 

The loose relationship between server and IP address means that you can associate a server 
with a different customer from its IP address. 

Even when IP range groups are set up for a customer, a server's IP address does not 
necessarily determine the customer to which the server is associated because a user can 
change the customer association in the Server Properties page. 

See Editing the Properties of a Server on page 259 for more information about how to change 
the customer association for a server.

The customer association for a server is based on the management IP address of the server 
and not the primary IP address.

See Communication Between Managed Servers and HP Server Automation on page 226 for 
more information about how HP Server Automation uses management IP addresses for 
servers. 

However, a server always belongs to the same facility (data center or server room) as its 
primary IP address. HP Server Automation enforces the relationship between server and 
facility at hardware registration. See Figure 79.

IP Address > IP Range > IP Range Group
>
>

Customer

Facility (data center

or server room)
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Figure 79 Primary IP Addresses in HP Server Automation 

In this illustration, the following conditions apply:

• Server 1 belongs to Customer A. 

• Server 2 belongs to Customer A but has IP addresses in Network A and Network B.

• Server 3 belongs to Customer B.

• The Router belongs to the Core Network but has IP addresses in Network A and Network 
B.

Server 1 Server 2 Server 3

Switch A Switch B

Router

"Network A" "Network B"

Customer A Customer B

"Core Network""Loopback Network"

10.1.2.0/24 10.2.2.0/24

10.200.0.0/24

Loopback Address

  = 10.200.0.1

Primary IP Address

10.2.2.2010.1.2.10

10.1.2.11
Primary IP
Address

10.2.2.21

10.1.2.1 10.2.2.1
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Server Histories and Reports

This section provides information on server histories and reporting with HP Server 
Automation and contains the following topics:

• Overview of Server History

• Viewing Server History

• Time Stamp for Server Operations

Overview of Server History

By using the SAS Web Client, you can view the history of changes made to a server. Each 
action performed on a managed server is logged in the history with the associated user who 
performed the action and the time of the action. You can view the history at any time, but you 
cannot change it. History is read-only.

Each History entry contains three pieces of information, as Table 19 shows.  

Time Stamps Used in History

Data is maintained for servers in HP Server Automation for the following periods of time:

• The SAS Web Client maintains the history of changes for the last three-month interval.

• Command Engine session logs are retained for 30 days, except for the last remediate 
session for a server, which is retained indefinitely.

The Command Engine is the HP Server Automation component that enables distributed 
programs to run across many servers.

• Server history is retained for 6 months.

If longer periods of time are required, Hewlett Packard recommends regular backups to 
enable offline storage of HP Server Automation data.

HP Server Automation deletes old data from the Model Repository, and does not copy the data 
before it removes it. However, you can retain information for longer periods of time, by using 
Oracle commands to manipulate the scheduled jobs. Contact your Hewlett Packard support 
representative for assistance in changing these retention periods. 

Table 19 Description of the Entries in the Server History Tab

History Entry Description

Event Description Description of the operation performed, for example:

Run ISM Control: ad-hoc script (Job ID: 26190040) 
executed successfully.

Modified By The name of the SA user who made the change.

Date Modified The date and time the change was made, for example:
Mon Aug 06 18:14:41 GMT+00:00 2001)
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Viewing Server History

Perform the following steps to view the server history:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server whose history you want to view.

Or

Search for the server whose history you want to view. 

See Using the Search Feature on page 202 for more information. See Server Searching by 
IP Address on page 214 for mor information.

2 Click the name of the server whose information you want to see. The Manage Servers: 
Properties page appears for that server.

3 Select the History tab.

By default, the view shows changes made within the past week.

Time Stamp for Server Operations

HP Server Automation maintains a comprehensive audit trail of the software that the SA 
users install, configure, and remove from a server. By using the SAS Web Client, you can view 
the history of the changes made to a server. Entries are generated when actions are performed 
for managed servers in the SAS Web Client. The history is read-only. See Server Histories and 
Reports on page 221 for more information.

The time stamps for system events are determined based on the system clocks of the servers 
running the SA core components. To obtain accurate time stamps in server histories 
(displayed in the SAS Web Client) and SA component logs, you must:

• Synchronize the system clocks on all servers running SA components so that all the 
servers are running with a common time.

• Set the time zone for all servers running SA components to Coordinated Universal Time 
(UTC).

See the SA Simple/Advanced Installation Guide for more information on facility time 
requirements.

Additionally, Hewlett Packard recommends that after installing an Server Agent on the 
server (so that it becomes managed by HP Server Automation), you should synchronize the 
system clock on the server with the system clocks of the servers running the SA core 
components. 

The time stamps appearing in the SAS Web Client server History tab and the Server Agent 
logs are obtained from the SA core; however, you might need to review the server’s logs (such 
as, stdout). Having a consistent time stamp in the server’s logs and HP Server Automation is 
essential for effective troubleshooting.
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Hardware Information for Managed Servers

The Hardware link of the SAS Web Client provides a read-only view of all servers in your 
managed environment categorized by hardware manufacturer and model. The Hardware link 
provides hardware related information for each server, such as:

• Manufacturer

• Model number

• MAC ID

• Serial number 

• CPUs used on the server 

• Memory 

• Storage capacity

See Server Information that the Agent Tracks on page 66 for more information.

Viewing Managed Server Hardware Information

Viewing hardware information allows you to see all the servers in your managed environment 
by hardware vendor, and view such information as MAC ID, CPUs, memory, and so on.

To view hardware of managed servers: 

1 From the navigation panel, click Environment ➤ Hardware. You see the top level of the 
Hardware category in the managed environment, as shown in Figure 80.

Figure 80 Top Level Hardware 

2 To view the servers in your managed environment, click the Servers link.

3 Drill down to the type of server you want to look at. For example, you might want to look 
at all Dell POWEREDGE 650s, as shown in Figure 81.
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Figure 81 Hardware Home Page for Dell POWEREDGE 650s 

4 Next, select the Members tab. You will see a list of all the Dell POWEREDGE 650s in your 
managed environment. 

5 To view specific hardware information, from the View menu, choose Hardware. You now 
see more detailed information about all the Dell POWEREDGE 650s computers being 
managed by HP Server Automation.
224 Chapter 7



8 Server Management in the SAS Web Client
This section does not document how to install operating systems, patches, or applications on 
servers. However, it does discuss how those tasks fit into the overall server life cycle, and it 
does provide cross-references to the appropriate topics in other sections.

Overview of Server Management

HP Server Automation manages servers in an operational environment in the following ways:

• Provisioning servers with Microsoft Windows, Red Hat Linux, and Sun Solaris operating 
systems by using vendor-provided operating system bootstrapping technologies. 
Additionally, HP Server Automation integrates with AIX NIM and HP-UX Ignite 
installation technologies to provide a uniform method for OS provisioning across a 
heterogeneous environment.

See SA User Guide: Application Automation for information about how HP Server 
Automation provisions Microsoft Windows, Red Hat Linux, Sun Solaris, and VMware ESX 
operating systems on managed servers.

See the SA Administration Guide for information about how HP Server Automation 
integrates with AIX NIM and HP-UX Ignite installation technologies.

• Providing configuration tracking, which allows users to monitor selected configuration 
files and databases and to take certain actions when change is detected.

See Configuration Tracking on page 331 for more information. 

• Automating the management and execution of server scripts. 

See Script Execution on page 41 for more information.

To manage servers with HP Server Automation, you do not need root access on Unix or 
administrator access on Windows. However, you will need permissions to use specific HP 
Server Automation features, as well as permissions for customers and facilities associated 
with servers. To obtain these permissions, contact your SA administrator. For more 
information, see the Permissions Reference appendix in the SA Administration Guide.
225



Communication Between Managed Servers and HP Server 
Automation

This section provides information about communication between managed servers and HP 
Server Automation and contains the following topics:

• Network Address Translation (NAT) for Managed Servers

• Key Terms of SA Managed Server Communication

• Locating the Management IP Address of a Managed Server

• Code Deployment and Static NAT

• Setting the Primary IP Address of a Server

• NAT Table Mapping and Managed Servers

Network Address Translation (NAT) for Managed Servers

To manage a server, HP Server Automation requires that the server have a unique IP address 
that is routable from HP Server Automation. However, in a large operational environment, all 
servers might not have unique IP addresses. In this case, HP Server Automation supports 
static Network Address Translation (NAT) for managed servers. 

Static NAT maps public IP addresses to hosts inside the internal network, which allows HP 
Server Automation to manage all servers in the environment. 

Unlike dynamic NAT, the mapping between HP Server Automation and the servers under 
management is set ahead of time, not dynamically at runtime. 

Key Terms of SA Managed Server Communication

To understand how HP Server Automation communicates with managed servers, you must 
understand these three terms:

• Management IP: The IP address that HP Server Automation uses to communicate with 
the Server Agent on the server. 

During hardware registration for a server, the Server Agent opens a TCP/IP connection to 
HP Server Automation. The connection contains the source IP (called peer IP) address of 
the server. By default, HP Server Automation uses this peer IP address as the 
management IP for the server. 

• Management Interface: When a server has more than one network interface, you can 
designate one of them as the management interface. 

• Primary IP: The IP address of the management interface. When you change the 
management interface, the primary IP changes to the IP address of that interface. The 
primary IP address is a locally-configured IP address. 

During synchronizations, the Code Deployment & Rollback feature uses the primary IP 
address to communicate with the server. See Code Deployment and Static NAT on 
page 228 for more information.

The Server Agents on servers communicate with each other by using the primary IP 
addresses, even though HP Server Automation uses management IP addresses to 
communicate with the servers. 
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HP Server Automation does not support managed servers that have IPv6 addresses.

When static NAT is being used, the management IP address for a server will not be the same 
as the primary IP address. When static NAT is being used, the management IP is the 
NAT-translated IP address for the server. When static NAT is not being used, the 
management IP address is always the same as the primary IP address. 

Locating the Management IP Address of a Managed Server

In the SAS Web Client, you can find the management IP address of a server and check 
whether it is using static NAT. You might need this information for troubleshooting any 
servers marked Not Reachable and to determine whether your NAT configuration is correct. 
The SAS Web Client displays the management IP address of a managed server in the 
following two places:

• The Network tab of the Server Details page 

• The Hardware view of the Manage Servers list

The Network tab shows (and allows the user to set) the management interface for the server 
by selecting it from a drop-down list, as Figure 82 shows.

Figure 82 Management IP Address Information in the Network Tab   
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Figure 83 shows the Hardware view in the Manage Servers list, which displays the 
management interface for the server in the Network Info column. (To access the Hardware 
view, choose Hardware from the View menu.)

Figure 83 Hardware Tab in the Manage Servers List   

The Network Info column shows the IP addresses and interfaces configured for each server in 
the list. If a server is using static NAT, the management IP is the first entry in this list and 
(NAT) appears after the IP address. If it is not using static NAT, the management IP is the 
same as the management interface, so it is already shown.

Code Deployment and Static NAT

Code Deployment and Rollback (CDR) synchronizations can only occur between Server 
Agents in the same NAT domain. Synchronizations cannot be performed between Server 
Agents in different NAT domains.

HP Server Automation uses the primary IP address (instead of the management IP address) 
during synchronization because it is assumed that static NAT is not occurring between the 
servers in the synchronization. During CDR synchronizations, two Server Agents must 
communicate directly. Users can override the IP address that HP Server Automation 
determined and designate a specific network interface as the management interface.

For more information, see Code Deployment and Rollback on page 309.

Setting the Primary IP Address of a Server

When a server has more than one network interface, users can specify one of them as the 
management interface and the IP address for this interface is designated the primary IP 
address. The primary IP address is used for Server Agent-to-Server Agent communication.

If static NAT is not being used, the management and primary IP addresses are the same. If 
static NAT is being used, the management IP is unaffected when a user changes the 
management interface.

Perform the following steps to set the primary IP address of a server:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server whose management IP address you want to 
view.

Or

Search for the server whose management IP address you want to view. 

2 Click the server name. The Manage Servers: Properties page appears.

3 Select the Network tab. The network information for the server appears. 
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The Network tab shows (and allows you to set) the server’s management interface. 

4 Set the management interface by selecting it from the Management Interface field. The IP 
address for this interface is designated the primary IP address.

5 Click Update. 

See Using the Search Feature on page 202 and Server Searching by IP Address on page 214 
for more information.

NAT Table Mapping and Managed Servers

Static, one-to-one NAT tables map routable IP addresses between HP Server Automation and 
managed servers. Network administrators configure and maintain these NAT tables. After 
the static NAT tables are configured, you do not have to perform any additional setup for HP 
Server Automation.

HP Server Automation does not control these NAT tables and errors can occur if they are 
modified after SA-managed servers register their hardware information. The following errors 
can occur if the IP address mapping of a server changes:

• If the IP address on the HP Server Automation side of the NAT mapping is modified, the 
server becomes unmanageable and might be marked Not Reachable on the Manage 
Servers: Status page. It stays in this state until the Server Agent requests another 
hardware registration and the server's management IP is updated.

• If an IP address mapped to a particular server is mapped to a different server, both 
servers become unmanageable and might be marked Not Reachable on the Manage 
Servers: Status page. This problem is resolved when one of the two servers reports its IP 
address during hardware registration. The other server remains unmanageable until the 
server registers with the Server Agent. Both servers eventually become manageable.

Server Groups

This section provides information on server groups within HP Server Automation and 
discusses the following topics:

• Overview of Server Groups

• Types of Server Groups

• Public Group Modeling

• Ways to Create Server Groups

• Adding a Server to Static Groups, Both Public and Private

• Removing Servers from Static Groups, Both Public and Private

• Duplicating Server Groups

• Rules for Deleting Server Groups
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Overview of Server Groups

The Server Groups feature is useful for gathering servers into collections. These groups can be 
used as a shortcut for performing the same action on all of the servers simultaneously, instead 
of performing the action on each individual server, one at a time. Server groups can also be 
used to simply organize groups of servers. 

Server groups can be comprised of individual servers as well as other server groups.

The My Servers feature can also be used to gather servers and server groups, but it has 
different functionality than the Server Groups feature. You can add individual servers, server 
groups, and nested groups that you access frequently to My Servers. See My Servers on 
page 200 for more information.

Uses for Server Groups

Some recommended uses for server groups include:

• Grouping servers by OS version

• Grouping servers by customer

• Grouping servers by facility

• Grouping servers by deployment stage

• Grouping servers by use (Server Use in the Server Properties page)

• Grouping servers by operational boundaries, for example, grouping together all servers 
that require identical application configuration

• Grouping servers by access control boundaries, for example, creating server groups that 
are associated with a specific User Group

Permissions Required for Working with Server Groups

Users must have the permissions shown in Table 20 in order to perform specific tasks related 
to server groups. Only administrators can set permissions.  

Table 20 Permissions Required for Working with Server Groups

Name Of Permission Where Selected Enables You To:

Manage Servers Create, edit, and delete private 
server groups, both static and 
dynamic.
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Characteristics of Server Groups

When using server groups, groups have the following characteristics:

• Individual servers can be included in as many groups as you want, or not included in any 
groups.

• Adding servers to a group does not remove those servers from the list of all servers that 
appears when you click Servers ➤  Manage Servers in the navigation panel.

• Groups can contain servers and subgroups.

• Server groups are hierarchical (they can be nested) with these caveats:

— Private and public groups cannot be mixed in a hierarchy, but static and dynamic 
groups can.

See Types of Server Groups on page 231 for more information about private and 
public groups.

— The rules for a dynamic group are not inherited from a parent dynamic group to a 
dynamic subgroup.

See Dynamic Groups on page 232 for more information about the characteristics of 
dynamic groups. 

— Groups do not inherit modeling data from their parents, including custom attributes.

— When you run an operation on a group that contains nested groups, the operation also 
applies to all the servers in the nested groups below the current group.

— When an Application Configuration operation within the SA Client is applied to 
groups, and those groups contain subgroups, the operation does not apply to all the 
servers in the subgroups. It only applies to the group upon which the operation was 
directly applied.

Types of Server Groups

There are private groups and public groups, and each can be either static or dynamic.

Manage Public Server 
Groups 

The Manage Servers Permis-
sions section on the Other tab 
in Users and Groups

Create, edit, and delete public 
server groups, both static and 
dynamic.

Model Public Server 
Groups 

The Manage Servers Permis-
sions section on the Other tab 
in Users and Groups

Model public server groups. See 
Public Group Modeling on 
page 233 for more information.

Allow Run Refresh Jobs The Manage Servers Permis-
sions section on the Other tab 
in Users and Groups

Add or remove servers from 
groups before a scheduled job is 
run. This permission gives you 
the option to refresh group 
membership before a job is run 
so that it is only run on the serv-
ers that belong to the group 
when the job is actually run.

Table 20 Permissions Required for Working with Server Groups (cont’d)

Name Of Permission Where Selected Enables You To:
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Private Groups

If you belong to a user group that has access to the Manage Servers list, you can create groups 
that you alone can see and work with. Only you see your private groups. Other SA users can-
not see them. Private groups behave the same way as public groups, with the exception that 
modeling is not available for private groups. See Public Group Modeling on page 233 for infor-
mation how the SA model affects groups.

When you create your first group, the default type will be Private Static, which can be 
changed to Private Dynamic, Public Static, or Public Dynamic. When you create a subgroup, 
the type of group is private if you are in a private group when you create the new group, and 
the type is public if you are in a public group when you create the new group. Public and pri-
vate groups cannot be mixed in a hierarchy. In other words, if the parent group is public, the 
subgroups must be public, and if the parent group is private, the subgroups are also private.

Public Groups

Public groups can be created, edited, or deleted by anybody who has Manage Public Server 
Groups permissions. Public groups are visible to all users, and can be used by anybody, 
regardless of who created them, but only users with the Manage Public Server Groups per-
missions can change the rules that govern dynamic groups. 

A link called Public Groups appears at the top of server lists. Clicking that link displays a list 
of available public groups.

Only public groups can be used for modeling.

Static Groups

Static groups can be either public or private, and no specific permissions are required for 
static groups. A static group has servers that are added to and removed from the group 
manually. When using static groups, you first create the group, and then select the servers to 
populate it.

Dynamic Groups

Dynamic groups contain servers that are added to or removed from the group based on a set of 
user-defined rules. If the rules are changed or the servers in the environment change, servers 
will be added to or removed from the group automatically. Rules apply only to the group being 
created or modified, not to any subgroups.

Once the rules have been created, HP Server Automation will search for servers that match 
the criteria of that specific group, and add them to the group. When the rules are changed, HP 
Server Automation will search again, and the resulting group members reflect the changed 
criteria. Consequently, as servers are added to or removed from management using HP Server 
Automation, the members of the group will change automatically.

HP Server Automation calculates server group membership each time any of the following 
actions occur: 

• After users add, delete, or change the rules for dynamic server groups.

• When attributes of servers change such that dynamic group membership could change.

Additionally, HP Server Automation automatically recalculates dynamic group membership 
every hour.

When a user schedules a job to run, dynamic group membership can be determined in either 
of the following ways: 
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• Based on the servers in the dynamic group when the job was scheduled. 

• Based on the set of servers in the dynamic group when the job actually runs. The 
membership is recalculated at that time. 

Public Group Modeling

With SA modeling, the desired state of a server is defined and then applied to servers. In the 
case of public server groups — static and dynamic — you can define a model consisting of 
applications, patches, service levels, and custom attributes, which will be applied to all 
servers in the group. The modeling information is attached to the group, but not to any 
subgroups.

If the modeling information changes, the servers in the group are not affected until the 
remediate operation runs on those servers. If the model has already been remediated on that 
server when it is removed from the group, the installed material will be removed at the next 
remediate process.

Manage Servers Display for Public and Private Groups

As Figure 84 shows, server groups appear at the top of the Manage Server list. Public Groups 
appear as a link at the top of the list. Private groups, if any have been created, appear next, 
followed by the list of individual servers.

Figure 84 Manage Servers Displaying Public and Private Groups — Servers and 
Group View 

Manage Servers List - Groups Only

When you select View ➤  Groups Only from the menu, information about the number of 
servers in a group, the number of groups in a group, and whether the group is static or 
dynamic appears in the list of groups, as Figure 85 shows.

Figure 85 Manage Servers List — Group Only View 
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You can modify your views of servers and server groups by selecting Summary, Hardware, 
Software, and Communications from the View menu. You can also elect to further modify 
your view by selecting Servers and Groups, Servers Only, or Groups Only. 

Operations on Server Groups

Any operation that can be done to a server can be done to a server group, because the group 
acts as a container for a collection of servers, and so provides a shortcut to avoid having to 
repeat the same operation on each individual server. 

When any of the following operations are performed on a group, they are actually performed 
on the servers within the group, not on the group itself.

• Run

— Script

— Custom Extension

— Communication Test

• Customer

• Usage

• SA Client operations

— Configure Application

— Audit Application Configurations

— Perform Server Audit

— Create Server Snapshot

— Install Patch

— Install software

Also, some operations allow users to refresh the list of servers in the group (if the user has the 
Allow Run Refresh Jobs permissions). Users with the correct permissions schedule a job, and 
before the job is run, HP Server Automation will update the members of the server groups 
upon which the operation is performed. The following actions allow refresh when scheduling a 
job:

• Run Script

• Run Custom Extension

Server Groups Tabs

When you view group properties, the information for the group appears in the page, as 
Figure 86 shows.

You can view group properties in either of the following ways: 

• By clicking the This Group link at the top of each server group list. 

• By selecting a group in the list and choosing Resource ➤  Properties from the menu.
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Figure 86 Tabs Available for Server Groups 

You can use these tabs to perform the following actions for a server group. 

To perform any of these actions, you must have the correct HP Server Automation 
permissions. See Permissions Required for Working with Server Groups on page 230 for more 
information.

• Properties: This displays information about the group, such as the type of group, the 
number of servers in the group, and the status of the group. Clicking Edit allows you to 
change the group name and description, and to convert a dynamic group to a static group. 

A created static group without servers added yet — an empty static group — can be converted 
to a dynamic group. Conversely, a static group that has servers cannot be converted to a 
dynamic group.

• Rules: This appears when you are viewing a dynamic group. The rules tab displays the 
rules used by the dynamic group to determine group membership. The rules apply to the 
current group only and do not apply to subgroups. Click Edit to change the rules for the 
group.

See Creating Groups by Using Search on page 239 for more information about specifying 
rules for a dynamic group.

• Custom Attributes: This allows you to set custom attributes for a server group. Click 
New to add an attribute and then click Edit to change existing attributes. Custom 
attributes are not inherited by subgroups within a group hierarchy. 

See Custom Attributes for Servers on page 270 for more information about how custom 
attributes affect SA-managed servers.

• Service Levels: This allows you to attach service levels to a group.

See Service Levels on page 273 for more information.

• History: This allows you to view the changes to groups. For each action on the group (but 
not group members), the history displays a description, the date the action occurred, and 
the user who performed the action (if the group is public).
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Ways to Create Server Groups

Server Groups can be created by:

• Using the New Group option from the Resource pull down menu on the Manage Servers 
page

• Clicking the Create Server Groups icon in the upper right corner of the Copy to Group 
dialog

• Performing a server search, and saving the resulting list of servers or the rules as a group

Creating Static Groups by Using the New Group Option

Static server groups require servers to be added to them manually. The servers in a static 
group also must be removed manually.

A created static group without servers added yet — an empty static group — can be converted 
to a dynamic group. Conversely, a static group that has servers cannot be converted to a 
dynamic group.

To create static server groups, perform the following steps:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears.

2 From the Resource menu, choose New Group. The New Private Static Group dialog 
appears, as shown in Figure 87.

Figure 87 Default New Private Static Group Dialog 

3 To create a Private Static group in the top level of Manage Servers, perform the following 
steps:

a Enter the name of the group in the Save As text box.
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b Click Save.

4 To create a Private Static group below another group, perform the following steps:

a Navigate to the group below which you want to create a new group.

b Enter the name of the group in the Save As text box.

c Click Save.

5 To create a Public Static Group, perform the following steps:

a Click the Public Groups link in the Name and Type window, and navigate to the 
location in the group hierarchy where you want to create the group.

b Enter the name of the group in the Save As text box.

c Click Save.

The Save In drop down list is populated according to the location you drill down to in order to 
create your group. You can use the Save In drop down list to verify that you are in the correct 
location in the group hierarchy, and you can move to a different location in the hierarchy by 
selecting it from the Save In list.

Creating Static Groups by Using the Copy to Group Dialog

To create new server groups by copying existing server groups, perform the following actions: 

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears.

2 Navigate to the servers and groups that you want to copy and click the check boxes next to 
the servers and groups you want to copy. 

3 From the Edit menu, choose Copy to Group. The Copy to Group dialog box appears.

4 Navigate to the place in the group hierarchy where you want to copy the servers and 
group then by clicking the group links displayed in the Name and Type field.

5 In the Options field, select either of the following options: 

• Maintain Hierarchy: Select this option to copy any server groups exactly as they 
are.

• Expand to a Flat List: Select this option to copy only the servers within the group to 
the new group.

Each of those options displays the result of choosing that option by showing the numbers 
of servers and groups in the new group’s hierarchy, or the number of unique servers in the 
flat list.

If you select the Expand to a Flat List option, and a server is a member of more than one 
group, that server will only appear in the list once.

6 (Optional) You can also create an entirely new group for the copied servers and groups by 
clicking the Create New Group icon in the upper right corner of the dialog. 

A new dialog appears, prompting you to name your new group.

7 Enter the name of your newly-created group.

8 Click OK. The name dialog closes, and the Copy to Group dialog reappears.
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9 Click OK on the Copy to Group dialog.

Creating Dynamic Groups by Using the New Group Option

Dynamic Server Groups are rule-based, and the servers in dynamic groups will be added or 
removed automatically based on the rules that you define.

The method for creating dynamic server groups is the same as for creating static server 
groups. The difference is that when dynamic is selected, you are presented with a page that 
allows you to define the rules for the group.

Dynamic groups can be converted to static groups, and all servers remain in the group, but all 
rules will be lost when they are converted.

To create dynamic groups using the New Groups Option, perform the following steps:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears.

2 From the Resource menu, choose New Group. The New Private Static Group dialog 
appears.

3 To create a private dynamic group, navigate to the place in the group hierarchy where you 
want to create the group by clicking the group links displayed in the Name and Type field.

Or

To create a public dynamic group, click the Public Groups link in the Name and Type field, 
and navigate to the location in the group hierarchy where you want to create the group.

The Save In drop down list is populated according to the location you drill down to in order to 
create your group. You can use the Save In drop-down list to verify that you are in the correct 
location in the group hierarchy, and you can move to a different location in the hierarchy by 
selecting it from the Save In list.

4 Enter the name of the group in the Save As text box.

5 In the Options field, select Dynamic.

6 Click Create Rules. The Manage Servers Properties page appears, with the Rules tab 
selected, as Figure 88 shows.

Figure 88 Manage Servers Properties Page with Rules Tab Selected 

7 Select the criteria that apply to the servers you would like the group to include. 
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Create as many lines of criteria as required to adequately describe your server group rules by 
clicking the plus button to add a new line. Conversely, to remove lines of criteria, click the 
minus button next to the line you want to remove.

8 From the Match drop down list select either “If all rules are met” or “If any rules are met.”

9 (Optional) Click Search to apply the rules to a server search to validate the results.

10 Click Save to save the rules that apply to your group.

Creating Groups by Using Search

To create groups by using search, perform the following steps:

1 From the navigation panel, click Servers ➤ Search. The Search Rules page appears with 
the Servers tab displayed.

To search for servers, use this tab. To search for groups, select the Groups tab.

2 Use the criteria to create the rules used for a server search and to identify servers for 
dynamic groups. The options in the user interface for specifying dynamic group rules and 
for using Search are the same. See Criteria for Search and Dynamic Group Rules on 
page 239 for more information.

Create as many lines of criteria as required to adequately describe your server search or your 
server group rules by clicking the plus button to add a new line. Conversely, to remove lines of 
criteria, click minus button next to the line you want to remove.

3 If you are defining dynamic server group rules, click Save to save your rules. You can also 
click Search to use your rules to perform a server search.

Or

If you are doing a server search, click Search to perform the server search, or click Save 
to save the search as the rules for a dynamic group. 

The New Dynamic Group dialog appears. 

Criteria for Search and Dynamic Group Rules

The following table describes the rules that you can use to search for servers or to create 
dynamic server groups.

Note that anywhere you can enter text, you can enter a wildcard (*) character to broaden your 
results.  

Table 21 Rules for Server Search and for Creating Dynamic Groups

Rule Name and Description Operators Value

Properties

Agent Discovery Date: The date 
that the Server Agent was installed.

• Is after

• Is before

Drop-down lists with the day, 
month, and year

• Is within the last User-entered text
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• Is today N/A

Agent Reporting: Whether the 
Server Agent is reporting to HP 
Server Automation.

• Is

• Is not

• Has not reported

• OK

• Registration in progress

• Reporting error

Agent Status: Whether the Server 
Agent is reachable by HP Server 
Automation.

• Is

• Is not

• Not reachable

• OK

Agent Version: The version of the 
Server Agent — such as 14.2.3b.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Custom Attribute (any): The name 
of a custom attribute that is 
associated with the server through 
attachment or inheritance.

• Contains

• Is

User-entered text

Custom Attribute (local): The 
name of a custom attribute that is 
locally attached to the server,

• Contains

• Is

User-entered text

Customer: The customer or account 
that the server is associated with.

• Is

• Is not

Popup window of customers

Deployment Stage: The stage the 
server performs within a lifecycle 
environment.

• Is

• Is not

• In Deployment

• Live

• Not Specified

• Offline

The values that appear in 
this list are customizable; in 
addition to the values above, 
values specific to your 
environment might appear. 

Facility: The collection of servers 
managed by an HP Server 
Automation installation.

• Is

• Is not

Popup window of facilities

When HP Server Automation 
is running multimaster 
mode, the list can contain 
many facilities.

Table 21 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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Group Membership: Whether the 
server belongs to a group.

• Is Popup window of groups

Host name: The host name of the 
server — such as 
m004.company.com.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Name (any): This enables searching 
for any name or IP address 
associated with a server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Notes: The contents of the Notes 
field from the Properties tab for a 
server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Opsware Display Name: The 
user-configurable name for the 
server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

By default, HP Server 
Automation uses the 
configured host name of the 
server until a user edits it.

Server Use: How the server is being 
used — such as Development, 
Staging, Production.

• Is

• Is not

• Development

• Not Specified

• Production 

• Staging

You can customize values 
that appear in this list. In 
addition to the values above, 
values specific to your 
environment might appear.

Service Level: The user-defined 
category that can be used as an 
organizational tool. 

• Is

• Is attached here 
or below

Popup window of service lev-
els

Servers can be associated 
with multiple service levels. 

Table 21 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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OPSWARE PROPERTIES

Application Configuration: 
Whether the server uses the 
Application Configuration feature.

• Is not used

• Is used

N/A

Code Deployment: Whether the 
server uses the Code Deployment 
feature.

• Is not used

• Is used

N/A

Configuration Tracking: Whether 
the Configuration Tracking feature 
is monitoring or backing up specific 
files or configurations on a server.

• Is off

• Is on

N/A

Lifecycle: The server states that are 
part of bringing a server into HP 
Server Automation.

• Is

• Is not

• Available

• Build Failed

• Deactivated

• Installing OS 

• Managed

Server ID: The internal ID HP 
Server Automation uses to identify 
the server.

• Is

• Is not

User-entered text

In most cases, the Server ID 
is the same as the MID.

SOFTWARE

Attached Software: The software 
that is assigned or modeled through 
the SA remediate operation — the 
installation process.

• Is

• Is attached here 
or below

Popup window of software

Attached Software Policies: The 
software policies that is assigned or 
modeled through the SA installation 
process.

• is Popup window of software 
policies

Installed Patches: Whether a patch 
is installed on the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Table 21 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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Installed Software: The package 
reported installed on the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

A package does not have to 
be installed by HP Server 
Automation to be reported as 
installed on a server.

OS Version: The OS version defined 
by OS definitions in the OS 
Provisioning feature.

• Is

• Is not

Popup window of operating 
systems

Reported OS: For Windows —the 
version reported by the OS, for Unix 
— the version returned by the uname 
command.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Windows Service: The names of 
the Windows services that are 
reported to HP Server Automation. 

• Contains

• Does not contain

• Is

• Is not

User-entered text

NETWORK

DNS Search Domains: The 
domains configured to be searched in 
the server’s network settings.

• Contains

• Does not contain

• Is

• Is not

User-entered text

DNS Servers: The IP addresses of 
the DNS servers configured in the 
server’s network settings.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Default Gateway: The IP address 
of the default router.

• Contains

• Does not contain

• Is

• Is not

User-entered text

IP Address: Any Internet Protocol 
address for the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Table 21 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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MAC Address: Any Media Access 
Control address, which is the 
network interface card's unique 
hardware number.

• Contains

• Does not contain

• Is

• Is not

User-entered text

WINS Servers: The Windows 
Internet Naming Servers configured 
in the server’s network settings.

• Contains

• Does not contain

• Is

• Is not

User-entered text

HARDWARE

CPU Make and Model: The vendor 
name and CPU model for the server 
— such as GENUINEINTEL Intel(R) 
Pentium(R) 4 CPU 2.60GHz.

• Is

• Is not

Popup window of CPU makes 
and models

CPU Speed: The Central Processing 
Unit speed in gigahertz [GHz].

• Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

A 600 Mhz machine should 
be entered as 0.6.

Make and Model: The vendor name 
and server model for the server — 
such as Compaq - DL360.

• Is

• Is not

Popup window of server 
makes and models

Number of CPUs: The number of 
CPUs on the server.

• Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

RAM: The amount of RAM on the 
server in megabytes [MB].

• Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

To enter 1 Gigabyte, type 
1024.

Serial Number: The serial number 
of the server.

• Contains

• Does not contain

• Is

• Is not

User-entered text

Storage Make and Model: The 
vendor name and storage model for 
the server — such as WDC - 
WD800BB-75DKA0.

• Is

• Is not

Popup window of storage 
makes and models

Table 21 Rules for Server Search and for Creating Dynamic Groups (cont’d)
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Adding a Server to Static Groups, Both Public and Private

To add a server or a server group to a static group, perform the following steps:

1 From the navigation panel, click Servers ➤  Manage Servers. The Manage Servers page 
appears.

2 Navigate to the static group that you want to add servers and server groups to.

3 Click the check box next to the group and select Edit ➤ Add Servers. The Select Servers 
and Groups to Add to [group name] window opens. The window is populated with the 
same servers and groups visible on the Manage Servers page. You can use the Status, OS, 
and Customer filters to change the servers and groups that appear on the list. 

When you select Edit ➤ Add Servers and then select a group, the servers in the group are 
added. The group itself is not added. If you want to add a group to a group, select Edit ➤ 
Copy to Group from the menu.

CUSTOM FIELDS

A Numeric field • Does not equal

• Equals

• Is greater than

• Is less than

User-entered text

A String field • Contains

• Does not contain

• Is

• Is not

User-entered text

A URI field • Contains

• Does not contain

• Is

• Is not

User-entered text

A File field • Contains

• Does not contain

• Is

• Is not

User-entered text

A Date field • Is after

• Is before

Drop-down lists with the day, 
month, and year

• Is within the last User-entered text

• Is today N/A

Table 21 Rules for Server Search and for Creating Dynamic Groups (cont’d)

Rule Name and Description Operators Value
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4 Click the check box next to the servers and groups you want to add, and click Add at the 
bottom of the window.

Adding a Server to Dynamic Groups, Both Public and Private

Servers are added to dynamic server groups automatically, based on the rules created for the 
group. To change the membership of a dynamic group, add, delete, or update the dynamic 
group rules. 

To update the rules for a dynamic group, perform the following steps:

1 From the navigation panel, click Servers ➤  Manage Servers. The Manage Servers page 
appears.

2 Navigate to the Properties page of the dynamic group that you want to update rules for; 
navigate by clicking the group links in Manage Server list. 

3 Select the Rules tab.

4 Click Edit.

5 To add criteria to the existing rules, click the plus (+) button next to existing criteria. The 
fields for the criteria appear. Enter the values for the rule. 

6 To delete criteria, click the minus (-) button next to the criteria you want to delete from 
the rules. The criteria are removed from the page. 

7 Click Save. 

Groups can be added manually to a dynamic group, in either of the following two ways:

1 Click the check box next to the name of the server group to which you want to add a server 
group, and select Edit ➤  Copy to Group. Then follow the steps for creating a new group, 
either static or dynamic. See Ways to Create Server Groups on page 236 for more 
information.

Or

Navigate to the server group that you want to add a server group to.

2 Click the check box next to “This Group” and select Resource ➤ New Group. Then 
follow the steps for creating a new group, either static or dynamic. See Ways to Create 
Server Groups on page 236 for more information.

Removing Servers from Static Groups, Both Public and Private

To remove a server from a static server group, perform the following steps: 

A server does not need to be deactivated to be removed from a group. You can remove a server 
from a Static group at any time. The Membership tab for a server displays all the server 
groups of which the server is a member.

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears.

2 Navigate to the static server group that you want to remove servers from until you reach 
the level where the servers in question are located.
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Servers can belong to more than one group, so if you want to remove a server from each group 
it belongs to, you must locate and remove each instance of the server from all groups.

3 Click the check box next to the servers you want to remove and select Edit ➤  Remove 
from Group.

As soon as you select that menu option, the server is removed and the screen refreshes to 
display the current members of the group.

Removing Servers from Dynamic Groups, Both Public and Private

Servers are removed from dynamic server groups automatically, based on the rules created for 
the group. To remove servers, you can create or update rules. To add rules to an existing 
server group, perform the following steps:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears.

2 Navigate to the Properties page of the dynamic group that you want to add rules to, by 
drilling down into the group and clicking the “This Group” link.

3 Select the Rules tab.

4 Click Edit.

5 Add one or more lines of criteria to the existing rules by following the procedure described 
in the “Creating Dynamic Server Groups by Using the New Group Option” topic, step 3 on 
page 239.

Moving Servers from One Static Group to Another

The process of moving servers from one group to another is similar to copying servers from 
one group to another with the exception that with a move, the servers do not remain in the 
original group.

The Edit ➤ Move menu option is disabled when you select servers in a dynamic group. To 
move servers in a dynamic group, chose the Edit ➤  Copy to Group menu command. This 
menu command is also disabled for public groups when you do not have permission to manage 
public groups. 

To move servers from one group to another, perform the following steps:

1 From the navigation panel, click Servers ➤  Manage Servers. The Manage Servers page 
appears.

2 Navigate to the group containing the servers you want to move and select those servers. 

3 From the Edit menu, choose Move. The Move [group name] Group dialog box appears. 

4 Navigate to the place in the group hierarchy where you want to create the group by 
clicking the group links displayed in the Name and Type field.

5 Click Move. 
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Duplicating Server Groups

Duplicating a group is similar to copying a group. To duplicate an existing group, perform the 
following steps:

1 Navigate to the group that you want to duplicate.

2 Click the check box next to the group name. 

You can only select one group at a time to duplicate. 

3 From the Edit menu, choose Duplicate Group. The Duplicate [group name] Group 
dialog appears as shown in Figure 89. 

Figure 89 Duplicate Group Dialog Box 

4 Select the location for the newly-duplicated group using the Duplicate In drop down list.

The Duplicate In drop down list’s default location is the location of the group you select to 
duplicate. Navigate through the hierarchy of groups to find the location where you want the 
newly-duplicated group to reside.

5 Enter the name of the new group.

6 The values on the Options field will vary depending on whether the group duplicated is 
static or dynamic.
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7 If the group is static, select one of the following options: 

• Maintain Static group and <number> subgroups: Selecting this option copies the 
group and its hierarchy as is.

• Convert group and <number> subgroups to a static flat list: Selecting this 
option copies the group and flattens the hierarchy.

8 If the group is dynamic, select one of the following options: 

• Maintain rules & group hierarchy: Selecting this option copies the group and 
leaves it as a dynamic group, it also copies any subgroups.

• Convert to static group, maintain hierarchy: Selecting this option copies the 
group, but turns it into a static group with the current servers defined by the rules 
and also copies any subgroups.

• Convert group and <number> subgroups to a static flat list: Selecting this 
option copies the group, and turns it into a static group and flattens any hierarchy.

9 Click Duplicate. The newly-duplicated group appears in the selected destination.

Rules for Deleting Server Groups

It’s important to note the distinction between removing servers from a group, deleting a 
server, and deleting a group.

Removing servers from a group only removes the server from the selected static group, but the 
server itself remains in the global list of servers and is still managed by HP Server 
Automation.

Deleting a server can only be performed on a server whose status is deactivated. Selecting the 
Delete Server option completely removes the server from within HP Server Automation, 
although its history remains.

Deleting a server group removes the group, but the servers in the group still remain in the list 
of servers and in any other groups for which they are members.

A group cannot be deleted when any of the following conditions apply:

• Software is attached to the group or a subgroup of the group.

• Access control boundaries are attached to the groups or a subgroup of the group. 

• Servers and groups are selected together for deletion.

Deleting a Server Group

To delete a server group, perform the following steps:

1 Click the check box next to the server group you want to delete.

2 From the Edit menu, choose Delete Group. A confirmation message appears, detailing 
the number of servers and server groups in the server group that you want to delete.

3 Click OK to complete the deletion of the server group.

The screen refreshes, showing the list of servers and groups without the deleted server 
group.
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Server Life Cycle

This section provides information on the server life cycle within HP Server Automation and 
contains the following topics:

• OS Provisioning and the Server Life Cycle

• Server Properties

• Server Management Tasks Related to the Server Life Cycle

• Changing the Use and Stage Values for Servers

• Editing the Properties of a Server

• Tasks Associated with Deactivating a Server

• Deactivating a Server

• Deleting a Server from HP Server Automation

• Server Management Jobs

OS Provisioning and the Server Life Cycle

HP Server Automation is designed to enable multiple teams to work together to provision 
servers. The OS Provisioning feature allows IT teams to separate the tasks of readying 
servers for provisioning (such as mounting servers in racks and connecting them to a 
network) from provisioning the servers with operating systems and applications. 

For example, someone mounts a new server in a rack and connects it to the SA build network. 
Next, they boot the server for the first time by using an SA Boot Floppy or CD or by using the 
network. 

At a later time, a different system administrator can select the available server from the 
Server Pool list and provision it with an OS. In the available state, servers do not have the 
target OS installed and might not have access to disk resources. 

During OS provisioning, servers progress through the HP Server Automation life cycle state 
changes:

Unprovisioned (No OS Build Agent) ➤  Available ➤  Installing OS ➤ Managed
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Table 22 describes the HP Server Automation server life cycle values.  

Table 22 HP Server Automation Life Cycle Values for Servers

Managed Server 
Life Cycle Value Description

Server Pool Values

Planned Indicates that a device record has been created for the server, but an 
SA build agent has not yet been installed. Servers in this stage cannot 
be provisioned until an OS build agent is installed. 

For more information on this unprovisioned lifecycle value, see your 
SA Administrator.

Available Indicates a server on which the OS Build Agent was installed and is 
running, but the target OS has not been installed on the server.

The OS Build Agent is a small agent that can run in the memory of 
the bare-metal server. 

See SA User Guide: Application Automation for more information 
about Operating System Provisioning.

Installing OS Indicates that a user is installing the target OS on the server.

The server stays in the Server Pool list until the installation process 
finishes successfully. Then the server moves to the Manage Servers 
list.

See SA User Guide: Application Automation for more information 
about installing OS.

Build Failed Indicates a server on which the OS Build Agent was installed and is 
running, but the installation of the target OS failed.

The server remains in the Server Pool list with this status for 7 days 
before HP Server Automation deletes the entry.

See SA User Guide: Application Automation for more information 
about Operating System Provisioning. 
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Table 23 describes server states in SA in regard to the server life cycle.

Managed Server Values

Managed Indicates a server that HP Server Automation is managing. HP 
Server Automation performs periodic reachability checks on managed 
servers. 

After a server reaches this life cycle state, the entry for the server 
moves from the Server Pool list to the Manage Servers list. On 
managed servers, you can use HP Server Automation to install 
applications and patches. 

Deactivated Indicates an SA-managed server that was removed from service. 
However, the server’s history still exists in HP Server Automation. 
Deactivated servers are not reachable.

Table 22 HP Server Automation Life Cycle Values for Servers (cont’d)

Managed Server 
Life Cycle Value Description
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Server Properties  

Table 23 Server Status Icons in SA 

Server Icon Description

Planned

Indicates that a device record has been created for the server, but an SA 
OS Build Agent has not yet been installed on it. Servers in this stage 
cannot be provisioned until the OS Build Agent is installed. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Unprovisioned — Unreachable

Indicates a server that has been registered with the core via the SA OS 
Build Agent, but has not reported as ready for provisioning recently. This 
may be due to networking problems between the server and the SA core 
or the server having been disconnected or powered off.

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Unprovisioned — Reachable

Indicates a server that has been registered with the core via the SA OS 
Build Agent and is available to have a target OS installed on it. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Provisioning — Unreachable

Indicates a server on which the OS Provisioning feature was in the 
process of installing the target OS, but for some reason stopped because 
the server is unable to communicate with the SA core. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Provisioning — Reachable

Indicates a server on which the OS Provisioning feature is in the process 
of installing the target OS. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 
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Provisioning Failed — Unreachable

Indicates an available server on which an error occurred while the OS 
Provisioning Subsystem was installing a target OS, and that the server is 
not able to communicate with the SA core. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Provisioning Failed — Reachable

Indicates an available server on which an error occurred while the OS 
Provisioning Subsystem was installing a target OS. 

In the SA Client, appears in the Unprovisioned Server list. 

In the SAS Web Client, appears in the My Jobs panel home page, in the 
My Jobs page, and in the Server Pool list. 

Managed — Reachable

Indicates a server has an An Server Agent is running on it and that it is 
able to communicate with the SA core. 

In the SA Client, appears in the All Managed Servers list and Virtual 
Servers list.

In the SAS Web Client, appears in the My Jobs panel in the home page, 
in the list in the My Jobs page, in the Manage Servers list, and in the 
server lists in the SA wizards. 

Managed — Unreachable

Indicates a managed server cannot communicate with the SA core (it is 
Not Reachable). 

If you want to discover reasons why the managed server is unreachable, 
you can run a Communication Test. See Agent Reachability 
Communication Tests on page 84 for more information.

In the SA Client, appears in the All Managed Servers list and Virtual 
Servers list.

In the SAS Web Client, appears in the My Jobs panel in the home page, 
in the list in the My Jobs page, in the Manage Servers list, and in the 
server lists in the SA wizards. 

Table 23 Server Status Icons in SA  (cont’d)

Server Icon Description
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Unmanaged 

Indicates the server is unmanaged, which means it does not have an 
Server Agent installed on it. 

For unmanaged virtual servers, this means that someone created a 
VMware Virtual Machine (VM) or Solaris local zone outside of SA and 
thus does not have an Server Agent installed on it. 

For virtual servers, this state could also mean that the VMware VM is 
has not yet been provisioned, or that your user belongs to a group that 
does not have permissions to perform operations on this virtual server. 

For more information on installing an Server Agent on an unmanaged 
server, see See Agent Management on page 63.

Deactivated

Indicates a server that was deactivated in HP Server Automation so that 
it is currently not managed and is no longer reachable.

Appears in the Manage Servers list and in the server lists in the SA 
wizards (however, it is not selectable in the wizards).

Scheduled

Indicates a server that is scheduled for an operation (install software, 
uninstall software, and so forth).

In the SA Client, appears in the Job Logs list. 

In the SAS Web Client, appears in the My Jobs panel in the home page 
and in the list in the My Jobs page.

Error

Indicates a managed server on which an error occurred while HP Server 
Automation was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the My 
Jobs page.

Warning

Indicates a managed server on which a warning occurred while HP 
Server Automation was installing or uninstalling software.

Appears in the My Jobs panel in the home page and in the list in the My 
Jobs page. 

Application Configuration Out of Sync

Indicates a managed server on which the configuration file on the server 
is out of sync with the Application Configuration Template (SA model).

Appears only in the Application Configuration feature and the server list 
in the SA Client.

Table 23 Server Status Icons in SA  (cont’d)

Server Icon Description
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Figure 90 shows the Server Properties columns. Table 24, Table 25, and Table 26 describe the 
Status, Stage, and Use properties for managed servers.

Figure 90 Server Properties Columns in the Manage Servers List 

The Status property is represented by an icon in the first column in the Manage Servers list. 

Status (short for Agent Status) is set automatically by HP Server Automation.

HP Server Automation toggles each server between OK and Not Reachable by reachability 
checks.

Static Device Group

Indicates a static server group. The same states that apply to single 
servers apply to groups. 

See Server Groups on page 229 for more information about the different 
types of server groups.

Dynamic Device Group

Indicates a dynamic server group. The same states that apply to single 
servers apply to groups. 

Public Static Device Group

Indicates a public and static server group. The same states that apply to 
single servers apply to groups. 

Public Dynamic Device Group

Indicates a public and dynamic server group. The same states that apply 
to single servers apply to groups. 

Table 23 Server Status Icons in SA  (cont’d)

Server Icon Description
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The Status value specifies the ability of HP Server Automation to manage servers. HP Server 
Automation automatically detects the status of servers. To verify the current status of a 
server, click Update in the Server Properties page for that server.  

Stage (short for Deployment Stage) is set by a user. 

The Stage value specifies the stages of deployment for servers; for example, a server is live or 
offline.

Your SA administrator can change the values for the Stage property. By default, HP Server 
Automation is installed with the following Stage values.  

Use (short for Server Use) is set by a user. 

The Use value specifies how an organization is utilizing servers. For example, a server is a 
staging server. Users set this property for servers.

Table 24 Values for the Status Property for Managed Servers

Status Value Description

OK Server is manageable by HP Server Automation. Represented as text 
(OK) in the properties page for a server. Represented as an icon in the 
Manage Servers and Server Pool lists: 

Not Reachable Server is unreachable by HP Server Automation due to an error (for 
example, it cannot connect to the SA core); automatically set by HP 
Server Automation. Represented as text (Not Reachable) in the 
properties page for a server. Represented as an icon in the Manage 
Servers list: 

If you want to discover reasons why the managed server is unreachable, 
you can run a Communication Test. See Agent Reachability 
Communication Tests on page 84 for more information.

Table 25 Values for the Stage Property for Managed Servers

Stage Value Description

In Deployment Initial stage after being fully initialized. 

Live Your organization defines the meaning of this stage.

Not Specified The default value for a server. Cannot be changed by the SA 
administrator. 

Offline Your organization defines the meaning of this stage.

Ops Ready Your organization defines the meaning of this stage.
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By default, HP Server Automation is installed with the following Use values. Except for the 
Staging, Production, and Not Specified values, an SA administrator can change the default 
values. The CDR feature depends on the Staging and Production values. Therefore, these 
default values cannot be changed or deleted.  

Server Management Tasks Related to the Server Life Cycle 

Managing servers in HP Server Automation involves the following standard tasks:

• Bringing a new server into HP Server Automation so that it appears in the Server Pool

See SA User Guide: Application Automation for more information about OS Provisioning. 

• Installing an operating system on a server

See SA User Guide: Application Automation for more information about OS Provisioning. 

• Installing a patch

See SA User Guide: Application Automation for more information on installing patches.

• Installing a software

See SA User Guide: Application Automation for more information on installing software.

• Reprovisioning a server with a new OS

See SA User Guide: Application Automation for more information about OS Provisioning.

You can reprovision Solaris and Linux servers so that they are running another version of 
the same OS so long as the hardware supports that new version of the OS. 

You can reprovision servers built by HP Server Automation and SA-managed servers by 
using this feature. 

You cannot reprovision a Linux server so that it runs a Windows OS. 

• Deactivating a managed server so that HP Server Automation no longer manages it.

See Tasks Associated with Deactivating a Server on page 260 for more information.

You accomplish server management tasks by using the following menus in the Manage 
Servers list:

— Resource: Allows to create new server groups, view properties of servers.

— Edit: Allows you to add servers to a group, delete server groups, remove servers from a 
group, deactivate servers.

— View: Allows you to view the summary, hardware, and software information of servers 
and server groups.

Table 26 Values for the Use Property for Managed Servers

Use Value Description

Development A server that is not being used in production.

Not Specified The default value.

Production Fully live in-use servers (includes SA core servers).

Staging A staging server for production.
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— Tasks: Allows you perform tasks such as running scripts, custom extensions and 
running communication tests.

— Configuration Tracking: Allows you to edit, and reconcile tracking policies.l

Changing the Use and Stage Values for Servers

Perform the following steps to change the Use and Stage values for multiple servers 
simultaneously:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server that you want to deactivate.

Or

Search for the server that you want to deactivate.

See Using the Search Feature on page 202 and Server Searching by IP Address on 
page 214 for more information.

2 Select the servers that you want different Use or Stage values for.

3 Choose Edit ➤ Usage from the menu above the Manage Servers list. A window prompts 
you to select different values, as Figure 91 shows.

Figure 91 Edit Server Popup Window 

4 Select the Use and Stage values from the lists. 

5 Click Save Changes. The window closes and the Manage Servers list refreshes with the 
updated values. 

Editing the Properties of a Server

You can edit a server only if you have permission in the SAS Web Client to access the 
customer to whom the server is associated.

When you edit the properties of a server, the server itself does not change; how HP Server 
Automation views it changes. Perform the following steps to edit the properties of a server:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server whose properties you want to edit. 

Or

Search for the server that you want to edit.

See Using the Search Feature on page 202 and Server Searching by IP Address on 
page 214 for more information. 

2 Click the Server Display name. The Properties page for the server appears. 

3 Change any of the following properties for the server:
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• To change the name that appears in the SAS Web Client, edit the text in the Name 
field. 

• To change the description of the server, edit the Notes field. 

• To change the customer associated with the server, select a different customer from 
the list. Your SA administrator defines the options for customer selections. Contact 
your SA administrator if the list does not contain the customer that you want to 
associate with this server. 

You cannot change the customer associated with a server when the server is part of a CDR 
service, synchronization, or sequence. See the SA Policy Setter Guide for more information. 

• To change the Use or Stage of the server, make your changes in either of those lists. 

See Server Properties on page 253 for more information.

• To change whether configuration tracking is enabled or disabled for the server, select 
a value from the list. 

See Configuration Tracking on page 331 for more information.

4 To save your changes, click Save.

To change the custom attributes of the server, select the Custom Attributes tab. The Manage 
Servers: Custom Attributes page appears. See Managing Custom Attributes on page 270 for 
more information. 

Tasks Associated with Deactivating a Server

You will want to deactivate a server when HP Server Automation removes the server from 
management. For example, you are moving the server to a warehouse for storage. 
Additionally, you might choose to deactivate a server when you need to rebuild it from scratch, 
without using the OS Provisioning feature. 

When you deactivate a server, information about the server remains in the SA Model 
Repository for auditing purposes.

After you deactivate a server, you can reactivate it by re-installing an Server Agent with the 
Server Agent Installer and the --clean command line option. 

See Agent Reachability Communication Tests on page 84 for more information.

When you deactivate a server, you accomplish the following tasks:

• Remove custom attributes from the server.

• Delete any configuration tracking policies from the server that are associated with 
backups. 

• Set the server life cycle value to Deactivated.

You cannot deactivate a server when it is part of a CDR service, synchronization, or sequence. 
See the SA Policy Setter Guide for more information. 
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Deactivating a Server

Perform the following steps to deactivate a server:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server that you want to deactivate.

Or

Search for the server that you want to deactivate.

See Using the Search Feature on page 202 and Server Searching by IP Address on 
page 214 for more information. 

2 Select the servers that you want to deactivate.

3 Choose Edit ➤ Deactivate Server from the menu above the Manage Servers list. A 
confirmation dialog box prompts you to confirm the deactivation. 

4 Click OK. The Manage Servers list refreshes and the server appears with a deactivated 
icon. 

Deleting a Server from HP Server Automation

When you want to remove all record of a server from HP Server Automation, you can delete it. 

You must deactivate a server before you can delete it from HP Server Automation. 

When you delete a server from HP Server Automation, it has these effects:

• Deletes all job information in the My Jobs feature

• Deletes the server from the Model Repository

Perform the following steps to delete a server:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server that you want to delete.

Or

Search for the server that you want to delete.

See Using the Search Feature on page 202 and Server Searching by IP Address on 
page 214 for more information.

2 Select the servers that you want to delete.

3 Choose Edit ➤ Delete Server from the menu above the Manage Servers list. A 
confirmation dialog box prompts you to confirm the deletion. 

4 Click OK. The Manage Servers list refreshes and the server disappears from the list. 
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Server Management Jobs

This section provides information about server management jobs within HP Server 
Automation and contains the following topics:

• My Jobs

• My Jobs Display Information

• My Jobs in the SAS Web Client

• Jobs in SA Client

• Viewing Job Details in the SAS Web Client

• Viewing My Job Details from inside the SA Client

My Jobs 

The My Jobs information is available only on a per-user basis. You cannot log in as an SA 
administrator to see the jobs that other SA users have run. The My Jobs information appears 
in two places in the SAS Web Client:

• A panel on the SAS Web Client home page that lists your most recent six jobs 

• A page (accessed by clicking My Jobs in the navigation panel) that lists all the jobs that 
you have run

HP Server Automation maintains information about the server operations that you have 
run for the last 30 days in the My Jobs list. By default, the jobs are deleted from the SA 
Model Repository after 30 days. (The bottom of the My Jobs page indicates how long this 
interval is set for the HP Server Automation installation at your organization.)

My Jobs Display Information

For each job, the My Jobs lists display the following information:

• The name of the job, which is a link to a page that displays more detailed information 
about the job

• The date and time the job started or is scheduled to start (using your preference for time 
display) 

• The number of servers that the job affects

• The status of the job: 

— Scheduled 

— In Progress 

— Completed 

— Completed with errors 

— Completed with warnings
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• You can search for an existing Job by the Job’s ID. On the Home page, select Job from the 
drop-down list and enter a Job ID and click Go. 

My Jobs in the SAS Web Client

The My Jobs feature in the SAS Web Client provides information about the following 
Command Engine scripts: 

• OS provisioning 

• CDR requests 

• Distributed script execution

• Custom Extensions

Jobs in SA Client

Jobs feature in the SA Client displays job logs about the following SA Client jobs: 

• Creating snapshots

• Pushing or Auditing an Application Configuration

• Auditing Servers

• Creating Server Snapshots

• Remediating policies

• Running OS Sequence

• Any jobs scheduled to be run at a future date

Jobs in the SA Client appear in the Jobs Logs feature window.

Viewing Job Details in the SAS Web Client

Perform the following steps to view the job details:

1 From the SAS Web Client home page, click the link in the My Jobs panel for the job that 
you want to view, as Figure 92 shows.

Figure 92 My Jobs Panel in the SAS Web Client Home Page 

Or

From the navigation panel, click My Jobs and then click the link for the job to open a 
window that shows the details of the job, as Figure 93 shows.
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Figure 93 My Jobs Page Accessed from the Navigation Panel   

The My Jobs page displays the operations that you performed.

2 Click View Details to see detailed information about the job. The My Jobs information 
contains a build log for the job. This build log contains any error messages that HP Server 
Automation generates. See Figure 94.

Figure 94 Communication Test Details Page in the My Job Window 
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Viewing My Job Details from inside the SA Client

You can also view job details from inside the SA Client. If the job was run from inside the 
SA Client, you will see a link next to the job named Launch SA Client, as shown in 
Figure 95. 

Figure 95 My Jobs with link to SA Client 

To launch the SA Client and view the job details, click the link. 

Server Management Scheduling and Notification

This section contains the following topics:

• Scheduling a Job

• Sending Email Notification

The time used for the scheduled job is specified in the user's preferred time zone (which can be 
modified in My Profile). If the user does not have a preferred time zone set, the time zone is 
derived from the SA core server (usually UTC).

Scheduling a Job

Perform the following steps to schedule server management tasks:

1 In the Schedule and Notify page of an SA Wizard, choose the Run Now option to execute 
the operation immediately or choose the Specify Time Option to schedule the operation at 
a later date and time. See Figure 96

The time used for the scheduled job is specified in your preferred time zone which can be 
modified in My Profile. If you do not have the preferred time zone set, the time zone is derived 
from the SA core server (usually UTC).

2 When you schedule a job for a server group, you can specify how the members of the group 
are determined. The membership of a dynamic server group changes based on the changes 
in your operational environment. If you have “Allow Run Refresh Jobs” permissions, you 
will see additional options. Select either of the following options: 

• Option 1: Membership is determined based on the “Time of Confirm Selection.” Select 
this option to run the job on the servers that were in the group when you scheduled 
the job. Changes to the group membership do not affect the list of the servers that the 
job will run on. 
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• Option 2: Membership is updated when the job runs. Select this option to recalculate 
the group membership prior to running the job. Changes to group membership are 
reflected in the list of servers that the job will run on.

Figure 96 Scheduling a Job in an SA Wizard 

3 Additionally, you can view a scheduled job in the My Jobs page and change the date and 
time for the job to run, or cancel the job entirely. (Click the name of a scheduled job to open 
a window to change the date or time that the job will run or cancel it.) 

Sending Email Notification

The email notification feature provides you with an option to receive an email summarizing 
the job details when a job is over, and to notify others at the address they have registered with 
HP Server Automation. 

You have the option of sending the notification 

• On the job success only

• On the job failure only 

• On any result 

You can also send notification to various people based on the condition of the job. For example, 
you can select to send the notification to your manager only on the job success, select to send 
the notification to yourself on any result of the job, and select to send the notification to 
support only on the job failure.

To send an email about the job details, choose the Condition option on the Schedule and Notify 
page and set the parameters to send an email when the operation is completed. You can 
choose to have an email sent on any result, if the operation fails, or if the operation is 
successful. To add another email recipient, click the plus (+) button next to the Recipients 
field. See Figure 97.
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Figure 97 Notifying about a Job in the SAS Web Client 

Time-Outs for Server Management Jobs

Table 27 describes the time-out values that apply to the server management operations in HP 
Server Automation. 

Table 27 Time-Outs in HP Server Automation

Time Out 
(Minutes) HP Server Automation Operation

420
(7 hours) 

Reconciling software (installation and uninstallation).

2 Starting Command Engine sessions in response to a command. If the 
Server Agent does not start executing the command within this time, the 
command will time out and the Command Engine script will continue.

30 Responding to a command (for example, after a reboot, the maximum 
time to wait until a server responds) or sending a message to the 
Command Engine from the Server Agent. 

If the Server Agent does not respond to the Command Engine at least 
once during this interval, the command will time out and the Command 
Engine script will continue.

HP Server Automation polls the Server Agent every 15 minutes and if 
the Server Agent fails to respond two consecutive times, the command 
will time out. 
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Customizing the Monitor Time-Out Duration

If you would like to set a different monitor time-out duration, you can create a custom 
attribute named OPSW_reconcile_monitor_timeout and change the number of minutes 
before a time out occurs. For each type of hardware running in your operational environment, 
you can set a custom attribute with the time-out duration that you want. To set a time-out 
duration for a type of hardware, click Environment ➤ Hardware in the navigation panel. 
Then, navigate to the type of hardware that you want to add a custom attribute for. 

During remediate, a periodic heartbeat occurs between the Server Agent and the Command 
Engine to ensure that the agent is still responsive. This setting controls the maximum 
amount of time that can pass between these heartbeat messages. Typically, you only need to 
increase this setting if you install software that reboots the server, and the time that it takes 
for the server to reboot and for the agent to restart exceeds the default value.

Custom Fields for Servers

This section provides information on custom fields for servers within HP Server Automation 
and discusses the following topics:

• Overview of Custom Fields for Servers

• Changing the Value for a Custom Field

Overview of Custom Fields for Servers

In HP Server Automation, you can store custom server data that is specific to your 
operational environment. These fields were created specifically for your HP Server 
Automation installation — all servers in an HP Server Automation installation contain the 
same number and type of custom fields. Custom fields can contain files, URLs, text strings, 
numbers, and dates.

In addition to adding files, URLs, text strings, numbers, and dates, you can use custom fields 
to search for servers based on a value stored in a custom field. You can also use a custom field 
as criteria to create a dynamic server group. 

In order for the custom fields to appear in the Manage Server: Properties page, you will have 
to initially create a custom field. To create a custom field, you will need to install the 
custFields.py Custom Extension which is available only from the Content Starter Pack. 
Contact SA Technical Support for assistance in installing the custFields.py Custom Extension 
in SA.

Typed Data Supported for Custom Fields

The custom fields designated for your operational environment will vary. However, the custom 
fields created for your environment support values with the following data types:

• Number: The value provided must be a long integer.

• Short String: A text string that must be less than or equal to 4000 characters.

• Long String: A text string with no length restrictions. Custom fields with this type 
cannot be used in search or in the rules for dynamic server groups.
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• Date: The value will be verified for correctness.

• File: Indicates a file attachment.

• URI: A Uniform Resource Identifier string, which is validated as a URI.

HP Server Automation validates the value you enter in a custom field based on the data type 
specified for the field.

Uses of Custom Fields

The custom fields designated for your operational environment will vary. However, you can 
use custom fields to accomplish any of the following goals:

• To store the date of patch installation

• To assign a severity rating between 1 and 10 to a Hotfix

• To store an ID from an internal bug tracking system with its associated patch 

• To store a JPEG image of the back of a server and have that JPEG associated with that 
server 

• To store a Microsoft Word document describing the disaster recovery steps for a server or 
group of servers

• To search for a server based on the value of a custom field

Changing the Value for a Custom Field

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server whose custom fields you want to change.

Or

Search for the server whose custom fields you want to change. 

2 Click the server name. The Manage Servers: Properties page appears. Scroll to the 
Custom Fields section of the page. The custom fields that appear in the properties page 
are specific to your operational environment. Figure 98 shows an example of the types of 
custom fields that can appear for a server. 

Figure 98 Custom Fields That Appear for a Server 

3 To change a value in a field requires a number or text, enter the value in the field.

4 To add a file, click Browse and select the file from the dialog box.

5 To remove a file, click Remove.

6 To specify a URL, enter the URL in the field or click Edit to change an existing URL.
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7 To add or change a date, click the  icon and select the date or enter the date in the field 
by selecting the appropriate day, month, and year from the drop-down lists. 

8 Click Save. 

Custom Attributes for Servers

This section provides information on custom attributes for servers within HP Server 
Automation and contains the following topics:

• Overview of Custom Attributes for Servers

• Managing Custom Attributes

• Adding Server Custom Attributes

• Editing Server Custom Attributes

• Deleting Server Custom Attributes

Overview of Custom Attributes for Servers

Users often need to store specific miscellaneous information in the SA Model Repository to 
facilitate server or application installation and configuration, scripting, or other purposes. 

The SAS Web Client provides a data management function by allowing users to set custom 
attributes for servers. These custom attributes include setting miscellaneous parameters and 
named data values. Users can write scripts that use these parameters and values when 
performing a variety of functions, including network and server configuration, notifications, 
and CRON script configuration.

Custom attributes can be accessed by software packages at installation time to configure 
settings that might be unique to the installation. 

For information about how to set custom attributes required by the software running on a 
specific server, contact the group responsible for packaging your applications, as Figure 99 
shows.

Figure 99 Custom Attributes Set for a Server   

Managing Custom Attributes

Do not edit or remove custom attributes without verifying that the change you are making 
does not impact other users or critical SA operations.
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To set custom attributes that affect a specific server, use the Manage Servers list. After 
locating the server and displaying the server properties, select the Custom Attributes tab. The 
SAS Web Client displays the currently defined custom attributes for the selected server. 

When you add or edit server custom attributes using the SAS Web Client, SA removes leading 
and trailing white space characters from custom attribute values.

See Adding Server Custom Attributes on page 271 for more information.

You can also set custom attributes to a software policy. See the SA Policy Setter Guide for more 
information.

Additionally, you can set custom attributes that affect every server associated with a specific 
customer or for every server in a facility. Navigate to the customer or facility where you want 
to set attributes. Select Environment ➤ Customers or Facilities in the navigation panel, and 
click the correct name in the list. Select the Custom Attributes tab, and add attributes for all 
the servers associated with the customer or located in the facility. When you use this option, 
you define custom attributes at a customer-specific or facility-specific level. The procedure to 
add custom attributes to a customer or facility is the same as adding custom attributes to 
individual servers. 

Additionally, you can add custom attributes for a server group by viewing a server group, and 
then selecting the Custom Attributes tab for that group. The procedure to add custom 
attributes to a server group is the same as adding custom attributes to individual servers.

Adding Server Custom Attributes

For information about how to set custom attributes required by the software running on a 
specific server, contact the group responsible for packaging your applications.

Perform the following steps to add a custom attribute for a server:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server for which you want to add custom attributes.

Or

Search for the server for which you want to add custom attributes.

2 Click the display name of the server. The Manage Servers: Server Properties page 
appears. 

3 Select the Custom Attributes tab. The Manage Servers: Custom Attributes page appears.

4 Click New.

5 Enter the name and value for the custom attribute that you want to add. 

6 Click Save.

See Using the Search Feature on page 202 and Server Searching by IP Address on page 214 
for more information.

Editing Server Custom Attributes

If you want to change the name of a custom attribute entry, you need to create a new custom 
attribute and delete the old custom attribute.
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Perform the following steps to edit custom attributes for a server:

1 From the navigation panel, click Servers ➤ Manage Servers or Server Pool. The Manage 
Servers page appears. Browse the list to find the server for which you want to edit custom 
attributes.

Or

Search for the server for which you want to edit custom attributes.

2 Click the display name of the server. The Manage Servers: Server Properties page 
appears. 

3 Select the Custom Attributes tab to change the custom attributes of the server. The 
Manage Servers: Custom Attributes page appears.

4 Click the attribute name link for the custom attribute that you want to change.

5 Update the value of the custom attribute. 

6 Click Save to save your changes. The Manage Servers: Custom Attributes page reappears 
with the updated value. 

See Using the Search Feature on page 202 and Server Searching by IP Address on page 214 
for more information.

Deleting Server Custom Attributes

Perform the following steps to delete custom attributes for a server:

1 From the navigation panel, click Servers ➤ Manage Servers or Server Pool. The Manage 
Servers page appears. Browse the list to find the server from which you want to remove 
custom attributes.

Or

Search for the server from which you want to remove custom attributes.

See Using the Search Feature on page 202 and Server Searching by IP Address on 
page 214 for more information.

2 Click the display name of the server. The Manage Servers: Server Properties page 
appears. 

3 Select the Custom Attributes tab. The Manage Servers: Custom Attributes page appears.

4 Select the check box for the custom attribute that you want to delete. 

5 Click Delete. The SAS Web Client displays a confirmation page.

6 Click OK to delete the custom attribute.

See Using the Search Feature on page 202 and Server Searching by IP Address on page 214 
for more information.
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Service Levels

This section provides information about service levels within HP Server Automation and 
contains the following topics:

• Overview of Service Levels

• Adding a Service Level to the SAS Web Client 

• Editing a Service Level

• Ways to View the Service Level for Servers

• Assigning a Server to a Service Level

• Removing a Server from a Service Level

Overview of Service Levels

Service levels are user-defined categories that enable you to group servers in an arbitrary way 
and design your own organizational schemes. For example, you can organize your servers by 
functionality (finance, engineering, and so forth) or tier (Web, application, and database) or by 
ontogeny (development, staging, and production). 

You can also create service levels to indicate the Service Level Agreement (SLA) for the 
servers that your IT organization manages. For example, you might create service levels to 
denote Silver, Gold, and Platinum services. 

Please note that assigning servers to service levels does not cause SA to operate any 
differently with respect to those servers. When you first use service levels, the categories will 
be fairly empty and by default, when an Server Agent is installed on a server in the 
operational environment, the server will be added to the UNKNOWN Service Level.

Adding a Service Level to the SAS Web Client

Perform the following steps to add a service level to the SAS Web Client:

1 From the navigation panel, click Environment ➤ Service Levels. The Service Levels page 
appears. 

2 Navigate the hierarchy of service levels until you reach the point in the hierarchy where 
you want to add a new service level, as Figure 100 shows.
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Figure 100 Service Level Hierarchy 

3 Click Add. The Service Levels page refreshes and the ADD SUB-NODE TO Service 
Levels form appears in the page. 

4 Enter a name for the service level (required), and (optionally) enter notes and a 
description for the service level. 

5 Click Save. The service level is added to the hierarchy of service levels. The Edit Service 
Level page appears, where you can change the properties of the service level, such as the 
customer association. 

Editing a Service Level

Perform the following steps to edit a service level:

1 From the navigation panel, click Environment ➤ Service Levels. The Service Levels page 
appears. 

2 Navigate the hierarchy of service levels until you reach the point in the hierarchy where 
you want to edit an existing service level.

3 Click Edit in the Properties tab. The page refreshes and an editable form appears for the 
service level properties. 

4 Make changes to the service level name, description, notes, whether servers are allowed to 
be assigned to the service level, the associated customers and operating systems. 

5 Click Save. 

Ways to View the Service Level for Servers

Find the server whose service levels you want to view by searching or browsing the Manage 
Servers list.
274 Chapter 8



• If you are browsing the Manage Server list, you can find the service level for a server by 
locating the value in the Environment column, as Figure 101 shows.

Figure 101 Service Level Node Appearing in the Software Tab of the Server List     

• If you searched for the server, click the server name and then select the Attached Nodes 
tab. You can find the service levels, as Figure 102 shows.

Figure 102 Nodes Tab That Shows the Service Level to Which a Server is Assigned 

• To view all the servers assigned to a particular service level, click Environment ➤ Service 
Levels in the navigation panel. Navigate the hierarchy of service levels until you reach the 
one for which you want to see which servers are assigned. Select the Members tab, as 
Figure 103 shows.

Figure 103 Manage Server Assigned to a Service Level 
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Assigning a Server to a Service Level 

Perform the following steps to assign a server to a service level:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server you want to assign to a service level.

Or

Search for the server that you want to assign to a service level.

2 Select the servers that you want to assign to a service level.

3 Choose Tasks ➤ Assign Node from the menu above the Manage Servers list. A window 
displays the categories of nodes, as Figure 104 shows.

Figure 104 Assign Nodes Popup Window 

4 Click the Service Levels link. The window refreshes to show the service levels created for 
your operational environment. 

5 Navigate to the service level to which you want to assign the server.

6 Click Assign. The window closes and you are returned to the Manage Servers list.

Removing a Server from a Service Level

Perform the following steps to remove a server from a service level:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server that you want to remove from a service level.

Or

Search for the server that you want to remove from a service level.

2 Select the server that you want to remove from a service level.

3 Choose Tasks ➤  Remove Node from the menu above the Manage Servers list. A window 
displays the nodes to which the server is assigned, as Figure 105 shows.
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Figure 105 Remove Nodes Popup Window 

4 Select the service level node from which you want to remove the server and click Remove. 
You are prompted to confirm that you want to remove the server from the service level.

5 Click Confirm Remove. The window closes and you are returned to the Manage Servers 
list.

Network Configuration

This section provides information about network configuration within HP Server Automation 
and contains the following topics:

• Overview of the Server Network Configuration

• Configuring Networking for an SA Managed Server

Overview of the Server Network Configuration

You can use HP Server Automation to automatically configure network settings for a server 
after you install the OS. 

The OS Provisioning feature provisions servers with an OS by using DHCP addresses. 
Because DHCP servers often assign temporary IP addresses to servers that boot over a 
network, system administrators typically need to assign static IP addresses (and other 
network properties) before the servers can be put into service. HP Server Automation enables 
system administrators to do this through the SAS Web Client rather than logging onto the 
server manually after OS provisioning is complete.

HP Server Automation does not support managed servers that have IPv6 addresses.

The Server Network Configuration feature allows you to configure the following settings on a 
server that are related to its network configuration: 

• Host Name 

• Domain Name System (DNS) servers 
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• Management interface (the interface that HP Server Automation should use when 
managing the server) 

See Locating the Management IP Address of a Managed Server on page 227 for more 
information. 

• Gateway (the IP address of the default router)

• DNS search domains 

• WINS (Windows Internet Naming Service) Servers

• Configuration for each network interface, including whether the interface is configured 
statically or with a Dynamic Host Configuration Protocol (DHCP) IP address, host name, 
and subnet mask

You can alter any of these options and then apply the settings to the managed server. HP 
Server Automation updates the server and reboots it to cause the new settings to take effect.

Configuring Networking for an SA Managed Server

You can only use the Network Configuration feature for servers running Sun Solaris, Red Hat 
Linux, and Microsoft Windows operating systems. 

Perform the following steps to configure networking for an SA managed server:

1 From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers page 
appears. Browse the list to find the server that you want to configure networking on.

Or

Search for the server that you want to configure networking on.

See Using the Search Feature on page 202 and Server Searching by IP Address on 
page 214 for more information.

2 Click the name of the server that you want to configure networking for. The Manage 
Servers: Properties page appears for that server. 

3 Select the Network tab. The network information for the server displays.

4 Modify any of the following settings to configure the server networking. 

For all fields, the default value is the one currently configured on the server.

• Host Name: The host name configured on the managed server. This field only sets the 
name by which the server knows itself and does not update DNS records for the 
server. 

• Management Interface: Instructs HP Server Automation to use a particular 
network interface when contacting the server. This is useful, for example, when a 
server has multiple network interfaces, but not all of them are reachable by the SA 
core. Designating a particular interface as the management interface allows HP 
Server Automation to know which interface to use for managing the server. 

• Gateway: The IP address of the default router

• DNS Servers: A list of DNS name server IP addresses

• Search Domains: A list of DNS domains to search when attempting to resolve host 
names

• WINS Servers: Set for Windows only; a list of WINS server IP addresses 

• Interface Configuration (for each network interface in the system): 
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— DHCP: If DHCP is enabled for an interface, the system uses DHCP to configure 
this network interface. In this case, static configuration settings (IP address, host 
name, and subnet mask) are not relevant for this interface, and the SAS Web 
Client makes those fields not editable. If DHCP is not enabled, then static settings 
are required. 

— IP Address: The IP address for this interface (unless DHCP is enabled). 

— Host Name: The local host name for the server. This item is only required for 
servers running Solaris. Like the Computer Name field, this setting only affects 
the name by which the managed server knows itself, and does not update DNS 
records. 

— Subnet Mask: The IP network mask to use for this interface.

In addition, HP Server Automation displays the management IP address and MAC 
address for the server; however, you cannot change these values reported by the Server 
Agent. 

5 Click Update Server at the bottom of the page. 

(If you click Revert, it causes any changes that you made to the fields to be discarded.)

A confirmation dialog box appears that shows the changes that will be made to the server. 
The confirmation dialog box includes a check box that allows you to indicate that the 
server should revert to its old network configuration when it cannot contact the SA core 
after you save the new network configuration. By default, the Revert check box is selected. 

The SAS Web Client does not validate the network configuration changes that you make 
in the Network tab. Therefore, it is possible to provide a malformed IP address in the IP 
address field for an interface.

6 To have the server revert to its previous network configuration if an error occurs, ensure 
that the check box is selected in the confirmation dialog box.

7 Click OK to proceed with the configuration changes. 

A progress dialog box appears that shows the progress of the operation. The process of 
setting a new network configuration involves rebooting the managed server. The 
operation might take several minutes. 

You can wait for the operation to complete or close the progress dialog box and perform other 
work in the SAS Web Client. The status of the task is available in the My Jobs user interface 
if you want to check the status of the network configuration update. 

Details About Changing the Domain for Windows Servers

You cannot use the DNS Domain field to change the domain name for a Windows server. 

HP Server Automation does not change the domain name of a Windows server because 
changing the domain name of a server requires password authentication. Changing the 
domain name of a Windows server is a manual operation. See Figure 106.
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Figure 106 DNS Domain Field Displays in the Network Tab for a Server 
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9 SA Global Shell
Overview of the Global Shell

The Global Shell is a command-line interface to the Global File System (OGFS). The 
command-line interface is a Unix shell such as bash that runs in a terminal window. The 
OGFS unifies the SA data model and the contents of managed servers, including files, into a 
single, virtual file system. You open a Global Shell session from within the SA Client Client or 
from a direct ssh connection in a terminal client on your desktop. With the Global Shell, you 
can automate repetitive system administration tasks by running scripts across multiple 
servers in a secure environment.

SA Global File System (OGFS)

The OGFS represents the SA data model as a hierarchical structure of file directories and text 
files. For example, in the OGFS, the /opsw/Customer directory contains details about SA 
customers and the /opsw/Server directory has information about managed servers. The /
opsw/Server directory also contains subdirectories that reflect the contents (such as file 
systems and registries) of the managed servers. If you have the required permissions, in the 
Global Shell, you can view and even modify the file systems of managed servers.

Remote SA Shell (rosh) Utility

The Remote SA Shell (rosh) utility enables you to log on to managed servers and run native 
commands. You invoke rosh from within a Global Shell session. You can run rosh and enter 
native commands interactively, or you can specify the native commands as an option of rosh. 

Benefits of the Global Shell

The Global Shell, OGFS, and rosh utility, offer the following benefits:

• Security: Logging on to managed servers is controlled by the HP Server Automation 
security framework. 

• Auditing: Logins and commands on managed servers are recorded in audit log files.

• Re-use of existing scripts: Existing native scripts can run on managed servers with the 
rosh utility. For example, you can run .BAT, .vbs, and .sh scripts on managed servers. 
Scripts written in Unix shells will run within the Global Shell, which supports bash, csh, 
and other common shells.

• Routine maintenance tasks on multiple servers: By accessing the global view of the 
OGFS, system administration scripts can run iteratively on groups of servers.

• Access to the HP Server Automation data model: Global shell scripts can access 
information about managed servers, including custom attributes.
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Commands Available in the Global Shell

The Global Shell offers the following types of Unix shells:

bash (default) 
csh 
ksh 
sh 
tcsh

Many common Unix commands (too numerous to list here) are available within the Global 
Shell. To display these commands, in a Global Shell session, list (ls) the contents of the 
following directories:

/bin /usr/bin 
/opsw/bin

The /opsw/bin directory contains utilities (such as rosh) which are specific to SA. For more 
information, see Global Shell Utilities Syntax on page 401.

Differences Between the Global Shell and Unix Shells

The Global Shell is different from native Unix shells in the following ways:

• Restricted command set: Some Unix commands (such as cron) are unavailable in the 
Global Shell. To find out if a command is available, use the which command.

• Limited recursion: Commands cannot use recursion with the file systems of managed 
servers. Examples of recursive commands are find, ls -r, and rm -r.

• SA user: You log on to the Global Shell as an SA user, not as a Unix user.

• SA permissions: The operations that you can perform and the servers that you can 
access are limited by the SA permissions of your SA user group.

• Private directories: The following directories are accessible only by your SA user:

/tmp
/var/tmp
/usr/tmp

For example, the /tmp directory seen by the jdoe SA user is different than the 
/tmp seen by tjones.

• SA data model in the OGFS: Stored in the Model Repository, the data model consists of 
objects such as customers, facilities, and servers. End users manipulate these objects with 
the SA Client. The OGFS represents the data model in a file system that resembles a 
Unix file system. Changes to the data model appear as changes in the OGFS, and vice 
versa.

• Axis (@) symbol in directory names: In the OGFS, for example, this symbol appears in 
the following directories:

/opsw/Server/@
/opsw/Server/@Group
/opsw/Group/Public/group-name/@

The axis (@) symbol represents the end of the filtering criteria for managed servers.
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Server Filtering in the OGFS

As you navigate down the OGFS tree, the path grows longer and more specific as fewer 
servers are visible in the Server directory. In the OGFS, the /opsw directory contains 
subdirectories for several types of objects in the SA model space, such as Server, Group, 
Facility, OS, Application, Customer, and so on.

In the Global Shell interface, you can filter your view of these object types in the Server 
directory by specifying an axis (@) in the path. A path in the SA model space can be a list of 
filtering criteria that selects objects of a given type. This path begins with the desired object 
type, such as /Server, and each filtering criteria begins with an @, such as @Customer. An 
ending @ denotes the end of the filtering criteria.

Figure 107 is graphical representation of related objects (customers and facilities) in a 
hierarchical Server directory. The small boxes represent managed servers. Examples of ways 
that you can filter this directory immediately follow the diagram.

Figure 107 Filtering in the Server Directory 

Based on Figure 107, the following examples illustrate ways to narrow your search for 
servers:

• To find all 16 servers, specify the following path:

ls /opsw/Server/@

• To find servers in the Atlanta facility, specify the following path:

ls /opsw/Server/@Facility/Atlanta/@

• To find servers that belong to customer Alpha, specify the following path:

$ ls /opsw/Server/@Customer/Alpha/@

• To find servers in the Atlanta facility that belong to customer Alpha, specify either of the 
following paths:

ls /opsw/Server/@Facility/Atlanta/@Customer/Alpha/@
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ls /opsw/Server/@Customer/Alpha/@Facility/Atlanta/@

The following paths are filtered away by the OGFS, because they would yield a dead-end. 
There are no servers belonging to customer Gamma in the Atlanta facility.

ls /opsw/Server/@Facility/Atlanta/@Customer/Gamma/@
ls /opsw/Server/@Customer/Gamma/@Facility/Atlanta/@

This same filtering logic can be applied to @Realm, @Group, and @Application.

Global Shell Tutorial

This tutorial covers just a few of the highlights of the OGFS and the Global Shell. After 
completing this tutorial, you will know how to navigate the directories of the OGFS and how 
to run commands on managed servers from within the Global Shell. Although the tutorial is 
organized into steps, after performing step 1, you can perform the remaining steps in any 
order.

Before starting the tutorial, you need the following capabilities:

• You can log on to the SA Client. As you work through this tutorial, you might find it 
helpful to compare the stdout of the Global Shell with information displayed by the SA 
Client.

• Your SA user has Read & Write permissions on at least one managed server. Typically 
assigned by a security administrator, permissions are discussed in the SA Administration 
Guide.

• Your SA user has all Global Shell permissions on the same managed server. For 
information on these permissions, see aaa Utility on page 401.

The example commands in this tutorial operate on a Windows server named 
abc.opsware.com. This server belongs to a device group named All Windows Servers. When 
trying out these commands, substitute abc.opsware.com with the host name of the managed 
server you have permission to access. Also, replace jdoe with your SA user name. If you wish 
to run the commands on a Unix managed server, replace ipconfig with ifconfig; and 
replace Administrator with root.

Now, let’s get started with the tutorial:

1 Open a Global Shell session.

You can open a Global Shell session from within the SA Client. From the Actions menu, 
select Global Shell. You can also open a Global Shell session from a terminal client 
running on your desk top. For instructions, see Opening a Global Shell Session on page 
289.

2 Check your session.

First, enter the whoami command, which displays the SA user name for this session:

$ whoami 
jdoe

You can enter the ps command to view the process status of your Global Shell session. The 
following ps command shows the session is running the default bash shell:
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$ ps
PID TTY          TIME CMD
 7033 ?        00:00:00 bash
13712 ?        00:00:00 ps

Enter the uname command, which displays information about the server running the 
OGFS component of SA:

$ uname -a 
Linux m171.dev.opsware.com 2.4.21-32.ELsmp #1 SMP Fri Apr 15 21:17:59 EDT 
20 05 i686 GNU/Linux

If you log on to a Unix managed server with rosh, uname displays information about that 
managed server, not the server running the OGFS component. Run the uname command 
when you are not sure if you are interacting with the Global Shell or with the shell of a 
managed server accessed with rosh.

3 Confirm your home directory.

Every SA user has a home directory in the OGFS. The home directory has a public/bin 
subdirectory where you can store scripts to be executed by other users running Global 
Shell sessions. Each SA user also has a personal /tmp directory for temporary files. You 
cannot view or modify the /tmp directories of other users.

The following commands show some information about the directories of the jdoe user: 

$ cd
$ pwd
/home/jdoe
$ ls -ld /home/jdoe/public/bin
drwxr-xr-x 2 jdoe jdoe 4096 2006-05-17 17:12 /home/jdoe/
public/bin
$ ls -ld /tmp
drwxrwxrwx 3 root root 4096 2006-06-09 23:37 /tmp

4 List all managed servers.

The /opsw/Server directory of the OGFS contains information about the servers 
managed by SA. This directory is an example of how the OGFS represents objects (in this 
case servers) of the SAdata model. Behind the scenes, SA stores this information in a 
database referred to as the Model Repository.

To view the names of the servers managed by SA, enter the following command:

$ ls /opsw/Server/@
abc.ospware.com m33.opsware.com  gist.opsware.com 
pal.opsware.com  hare.opsware.com qv55.opsware.com
. . .

5 Examine server information.

Each managed server has a directory structure containing information about that server. 
The attr subdirectory contains text files that describe the server’s attributes. The 
attribute name matches the file name and the attribute value is the file contents. The 
following cat command lists the OS version of the managed server named 
abc.opsware.com:

$ cd /opsw/Server/@/abc.opsware.com 
$ cat attr/osVersion 
Microsoft Windows 2000 Advanced Server Service Pack 4 Build 2195 
(05-02-2006
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The Interface subdirectory has information about the server’s network interfaces. Here’s 
an example:

$ cat “Interface/Local Area Connection/info”
AdminEnabledFlg:  no
CardIndex:
CardSerialNum:
CircuitId:
Collisions:
ConfiguredDuplex: AUTO
ConfiguredSpeed:  AUTO
. . .

6 List the files of a managed server.

In addition to information about managed servers, /opsw/Server contains directories 
that correspond to the file systems of those servers. If you have the necessary permissions, 
in a Global Shell session you can access multiple servers from a single virtual file system, 
the OGFS.

The following command navigates to file system of the abc.opsware.com server: 

$ cd /opsw/Server/@/abc.opsware.com/files

The next ls command displays OGFS subdirectories that correspond to native users of the 
managed server. Your security administrator specified these users (login names) when 
adding OGFS permissions. These are not SA users.

$ ls 
Administrator LocalSystem

Native users might have different views of the managed server’s file system. Therefore, 
under each user, the OGFS presents different file systems for each user. The following cd 
command drills down to the Program Files directory as seen by the Administrator 
user on the Windows server.

$ cd "Administrator/C/Program Files"
$ pwd
/opsw/Server/@/abc.opsware.com/files/Administrator/C/Program Files

Next, list the files in the Program Files directory:

$ ls -1 
Accessories 
Common Files 
ComPlus Applications 
Internet Explorer 
Messenger
. . .

Although these files reside in a directory on the managed server’s file system, you are in 
the OGFS, as shown by the preceding pwd command. To verify that you are in a Global 
Shell session (and not in a session running on the managed server), enter the following 
commands:

$ whoami jdoe 
$ uname -a 
Linux m171.dev.opsware.com 2.4.21-32.ELsmp #1 SMP Fri Apr 15 21:17:59 EDT 
2005 i686 GNU/Linux

7 Copy a file from the OGFS to a managed server.

By entering the cd command, go to your home directory in the OGFS, for example:
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$ cd 
$ pwd 
/home/jdoe

Next, create a simple text file in your home directory:

$ echo “this is text” > myfile.txt 
$ cat myfile.txt 
this is text

Copy the file that you just created to a directory in the file system of a managed server. 
The following command copies myfile.txt to the C:\temp directory of the 
abc.opsware.com server:

$ cp myfile.txt \
/opsw/Server/@/abc.opsware.com\
/files/Administrator/C/temp/afile.txt

Do not copy large files between the OGFS and managed servers. Copy only small files, 
such as configuration files.

8 Log on to a managed server with rosh.

In the preceding steps, you accessed the file system of a managed server from within a 
Global Shell session. In this step, from the Global Shell you log on to a managed server 
with rosh. After you log in, you interact with the command-line environment (MSDOS or 
Unix shell) of the managed server.

The following rosh command logs in as Administrator to a Windows managed server 
named abc.opwsare.com:

$ cd /opsw/Server/@/abc.opsware.com
$ rosh -l Administrator 
Microsoft Windows 2000 [Version 5.00.2195] 
(C) Copyright 1985-2000 Microsoft Corp.

The prompt indicates that you are now in the command-line environment of the managed 
server. Enter the ipconfig and hostname commands:

C:\WINNT\system32>ipconfig
ipconfig

Windows 2000 IP Configuration

Ethernet adapter Local Area Connection:

        Connection-specific DNS Suffix  . : opsware.com
        IP Address. . . . . . . . . . . . : 192.168.8.217
        Subnet Mask . . . . . . . . . . . : 255.255.254.0
        Default Gateway . . . . . . . . . : 192.168.8.1

C:\WINNT\system32>hostname
hostname
abc

Terminate the remote login with the exit command:

C:\WINNT\system32>exit

Enter the uname command to verify that you have returned to the Global Shell session:

$ uname -a 
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Linux m171.dev.opsware.com 2.4.21-32.ELsmp #1 SMP Fri Apr 15 21:17:59 EDT 
2005 i686 GNU/Linux

9 Create a script that runs across servers.

A Global Shell script can iterate within the OGFS and run the rosh command to execute 
native commands on multiple servers. The example script shown in this step iterates 
through the servers of the public device group named All Windows Servers. On each 
server, the script runs the ipconfig command with the rosh command. In this example, 
substitute your SA user name for jdoe.

First, return to your home directory in the OGFS:

$ cd 
$ cd public/bin
$ pwd 
/home/jdoe/public/bin

Next, run the vi editor:

$ vi

In vi, insert the following lines to create a bash script:

#!/bin/bash
# This is simple_iterate.sh.
# Change jdoe to your user name.

OUTFILE="/home/jdoe/public/bin/ipconfig_all.txt"
rm -f $OUTFILE

cd "/opsw/Group/Public/All Windows Servers/@/Server"

for SERVER_NAME in *
do
   echo ---- $SERVER_NAME
   echo ---- $SERVER_NAME >> $OUTFILE
   rosh -n $SERVER_NAME -l Administrator \

"ipconfig" >> $OUTFILE
done
# Last line in simple_iterate.sh.

Save the file in vi, naming it simple_iterate.sh. Quit vi.

Change the permissions of simple_iterate.sh with chmod, and then run it:

$ chmod 755 simple_iterate.sh
$ ./simple_iterate.sh
---- abc.ospware.com
---- gist.opsware.com
---- hare.opsware.com
---- m33.opsware.com
. . .

As the script runs, it echoes the name of each server to stdout, and redirects the output of 
the ipconfig command to the ipconfig_all.txt file. Enter the more command to view 
the contents of ipconfig_all.txt:

$ more ipconfig_all.txt 
---- abc.ospware.com 
Windows 2000 IP Configuration
Ethernet adapter Local Area Connection: . . .
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10 Learn more.

Here are a few suggested tasks for learning more about the OGFS and the Global Shell:

– Explore the folders and contents under /opsw/Library, comparing them with the 
Library windows of the SA Client.

– If you have NA installed, navigate to the /opsw/Net* (network) directories. For 
descriptions of these directories, see Network Directories on page 421.

– On Windows servers, examine the registry and complus directories under 
/opsw/Server/@/server-name.

– List the files in the method directory, also under /opsw/Server/@/server-name. 
These files are the executables of the SA Command-Line Interface (OCLI), which 
enables you to perform SA functions from within the Global Shell. To learn how to 
run the CLI methods, see the SA Platform Developer’s Guide.

Global Shell Examples

The examples in this section use bash, the default shell of a Global Shell session. These are 
relatively simple examples. For more complex examples, including those with method 
invocations and search filters, see the SA Platform Developer’s Guide.

Opening a Global Shell Session

You can open a Global Shell session with an ssh client or from within the SA Client. When 
you open a session, the working directory is /home/user-name.

To open a Global Shell session with an ssh client, perform the following steps:

1 On a host that is not an SA core server or a managed server, open a terminal window.

2 In the terminal window, enter an ssh command with the following syntax:

ssh -p 2222 user-name@ogfs-host

To use this command, port 2222 must be open on the firewall that protects the OGFS 
server. The user-name is your SA user (login) and the ogfs-host is the host name (or IP 
address) of the core server running the OGFS. The SA user name is not case sensitive. 
After you enter the ssh command, the OGFS prompts for the password of the SA user.

To open a Global Shell session from within the SA Client, from the Actions menu, select 
Global Shell.

Finding Servers in the OGFS

List the names of all servers that you can manage with SA:

ls /opsw/Server/@

List the IDs of the servers:

ls -a /opsw/.Server.ID

Find all servers in the .opsware.com domain by specifying the wildcard character (*):

ls -d  /opsw/Server/@/*.opsware.com
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List all servers in the Atlanta facility:

ls /opsw/Server/@Facility/Atlanta/@

List the servers in the public device group named Alpha:

ls /opsw/Group/Public/Alpha/@/Server

List the servers in the All Windows Servers group, first with backlashes to escape the spaces 
in the group name, then by enclosing the option in single quotes:

ls /opsw/Group/Public/All\ Windows\ Servers/@/Server
ls '/opsw/Group/Public/All Windows Servers/@/Server'

List the servers of the Widget customer:

ls /opsw/Customer/Widget@/Server

The following two commands display the same output, the servers in the Atlanta facility that 
belong to the Green customer:

ls /opsw/Server/@Facility/Atlanta/@Customer/Green/@
ls /opsw/Server/@Customer/Green/@Facility/Atlanta/@

Getting Server Information from the OGFS

List the Object ID and of the server named m256.opsware.com:

cd /opsw/Server/@/m256.opsware.com
cat self:i ; echo

(The preceding echo command is optional. It generates a new line character, which makes the 
output easier to read. The semicolon separates bash statements entered on the same line.) 

List the name of the server with an Object ID of 340039:

cat  /opsw/.Server.ID/340039/self

By iterating through the server names with a for loop in bash, display the platform 
(operating system) name for each server:

cd /opsw/Server/@
for SERVER_NAME in *
do

cat $SERVER_NAME/attr/platform
done

Display the amount of RAM in the server named abc.opsware.com:

cd /opsw/Server/@/abc.opsware.com
grep Quantity Memory/RAM/info

Display the network interfaces of a the server named blizzard.opsware.com:

cd /opsw/Server/@/glengarriff.snv1.dev.opsware.com/Interface
for INTERFACE_NAME in *  
do 
   echo ............. $INTERFACE_NAME ............
   grep  Interface "$INTERFACE_NAME/info"
   echo ""
done
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Browsing a Server’s File System or Registry

List all of the files the C:\ Program Files directory of the Windows server named 
abc.opsware.com:

cd /opsw/Server/@/abc.opsware.com/files/Administrator
ls C/Program\ Files

List the registry keys of the abc.opsware.com server:

cd /opsw/Server/@/abc.opsware.com/registry/\ Administrator/
ls *

List the contents of the /var directory on the Unix server named m256.opsware.com:

/opsw/Server/@/m256.opsware.com/files/root
ls var

Managing Custom Attributes

On the server abc.opsware.com, create a custom attribute named MyGreeting with the value 
hello there:

cd /opsw/Server/@/abc.opsware.com/CustAttr
echo -n "hello there" > MyGreeting
cat MyGreeting

Execute runit.bat on the abc.opsware.com server, passing the value of the My Test custom 
attribute as a command-line parameter for runit.bat:

cd /opsw/Server/@/abc.opsware.com
TESTPARAM=`cat CustAttr/"My Test"`
rosh -l Administrator "C:\temp\runit.bat $TESTPARAM"

When you create or edit custom attributes within the OGFS, HP Server Automation preserves 
leading and trailing white space characters in custom attribute values.

Copying Files Within the OGFS

Do not use the techniques in this section to copy large files. The OGFS is not designed 
distribute large amounts of data. However, you can use these techniques for copying small 
files (such as configuration files) to and from managed servers. 

Copy myfile.txt from the home directory in the OGFS of the jdoe user to the C:\temp 
directory of the Windows server named abc.opsware.com:

cp  /home/jdoe/myfile.txt \
/opsw/Server/@/abc.opsware.com/files/Administrator/C/temp

Copy myfile.txt from the home directory in the OGFS of the jdoe user to the /tmp directory 
of the Unix server named m25.opsware.com6:

cp /home/jdoe/myfile.txt \
/opsw/Server/@/m256.opsware.com/files/root/tmp

Copy the C:\temp\myfile.txt file from the abc.opsware.com server to the 
m344.opsware.com server:

cp /opsw/Server/@/abc.opsware.com/files/\
Administrator/C/temp/myfile.txt \
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/opsw/Server/@/m344.opsware.com/files/\
Administrator/C/temp/myfile.txt

Copying Files Between the OGFS and a Development Server

You can securely copy files between the OGFS and a server that is not part of HP Server 
Automation. To copy the files, perform the following steps:

1 On a host that is not an SA core server or a managed server, open a terminal window.

2 In the terminal window, enter either the scp, sftp, or rsync command and specify port 
2222, your SA user name, and the host running the OGFS.

The following three scp examples perform the same operation: They copy the file 
myscript.sh from the local machine to the file /home/jdoe/myscript.sh in the OGFS. The 
SA user is jdoe and the host running the OGFS is 192.168.166.178.

scp -P 2222 myscript.sh jdoe@192.168.166.178:myscript.sh
scp -P 2222 myscript.sh jdoe@192.168.166.178:/home/jdoe
scp -P 2222 myscript.sh jdoe@192.168.166.178:

The following example copies myscript.sh from the home directory of jdoe in the OGFS to 
the local machine:

scp -P 2222 jdoe@192.168.166.178:myscript.sh myscript.sh

The following sftp example copies myscript.sh from the local machine to the OGFS:

sftp -oPort=2222 jdoe@192.168.166.178
Connecting to 192.168.166.178...

Global Shell

jdoe@opsware's password:
sftp> put myscript.sh
. . . .

The following rsync example transfers files from /path on the local machine to 
/other/path in the OGFS:

rsync -av -e "ssh -p 2222" /path \
jdoe@192.168.166.178:/other/path

Logging on to a Managed Server With rosh

The next three rosh commands perform the same operation: logging on to the Windows server 
named abc.opsware.com as the Administrator user. After logging on, the current working 
directory on the remote shell is the default working directory of the Administrator Windows 
user. These rosh commands require different options, depending on the current working 
directory in the OGFS. For example, the first rosh command does not require the -n (server 
name) and -l (user) options because the option values can be inferred from the current 
working directory of OGFS. The options of the following three rosh commands differ because 
of the current working directory:

cd /opsw/Server/@/abc.opsware.com/files/Administrator
rosh
. . .
exit
. . .
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cd /opsw/Server/@/abc.opsware.com
rosh -l Administrator
...
exit
. . .
cd /home/jdoe
rosh -n abc.opsware.com -l Administrator
...
exit

The next rosh command logs into the Unix server named m256.opsware.com as the root user 
with the current working directory of /tmp:

rosh -n m256.opsware.com -l root -d /tmp

Running OGFS Scripts on Managed Servers With rosh

The next sequence of commands create a .BAT script in the OGFS and then run the script on 
a Windows managed server. Created with echo statements, the myfile.bat script resides in 
the OGFS under /home/jdoe/public/bin. (Note that myfile.bat does not reside in the file 
system of the managed server.) The myfile.bat script contains three commands: ipconfig, 
cd, and dir. The rosh command runs myfile.bat on the server named abc.opsware.com as 
the Administrator Windows user. The following commands create a local .BAT script and 
run it remotely with rosh:

cd /home/jdoe/public/bin

echo ipconfig > myfile.bat
echo "cd c:\temp" >> myfile.bat
echo dir >> myfile.bat

rosh -n abc.opsware.com -l Administrator -s ./myfile.bat

Create a script named who.sh in the /home/jdoe/public/bin directory of the OGFS and 
then run who.sh on the server named m256.opsware.com:

cd /home/jdoe/public/bin

echo \#\!\/bin\/sh > who.sh
echo "uname -n" >> who.sh
echo id >> who.sh
echo pwd >> who.sh

rosh -n m256.opsware.com -l root -s ./who.sh

Running Native Programs on Managed Servers With rosh

The next two rosh commands run the dir and ipconfig MSDOS commands on the Windows 
server named abc.opsware.com. Note that the native MSDOS commands are enclosed in 
quotes. Because the server name and user (login) can be inferred from the current working 
directory, the first rosh command omits the -n and -l options, as shown in the following code:

cd /opsw/Server/@/abc.opsware.com/files/Administrator
rosh "dir & ipconfig"
. . .
cd /home/jdoe
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rosh -n abc.opsware.com -l Administrator "dir & ipconfig"

Run the ipconfig command on abc.opsware.com and redirect the output to a file in home 
directory of jdoe in the OGFS:

rosh -n abc.opsware.com -l Administrator "ipconfig" \
> /home/jdoe/ipconfig_ouptput.txt

On the Unix server named m256.opsware.com, run the uname and ls commands as root:

rosh -n m256.opsware.com -l root "uname -a; ls /tmp"

Within a for loop in bash, run the MSDOS ipconfig command on each server in the All 
Windows device group:

cd /opsw/Group/Public/All\ Windows\ Servers/@/Server

for SERVER_NAME in *
do
   echo ............. $SERVER_NAME ............
   rosh -n $SERVER_NAME -l Administrator "ipconfig"
   echo ""
done

Character Encoding for the OGFS

To support international environments, the OGFS can display information in different 
character encodings such as Shift-JIS (Japanese) and EUC-KR (Korean). You can control the 
encoding of Global Sessions in the following ways:

• To specify the encoding of your Global Shell sessions, in the Terminal and Shell 
Preferences of the SA Client, select an item from the Encoding drop-down list.

• To change the encoding of an active Global Shell session, run the swenc command with 
the -e option.

If you change the encoding of an active session, you must also change the encoding of the 
terminal application for that session. This procedure varies according to the terminal 
application.

Terminal Application Configuration

The terminal application that is hosting a Global Shell or Remote Terminal session must be 
configured to use the same encoding expected by the session. If the encodings do not match, 
the data might be displayed incorrectly. 

When the SA Client launches the terminal application, it composes the command specified by 
the Terminal Client field in the Terminal and Shell Preferences. If the Terminal Client field 
includes the %e substitution variable, the SA Client replaces %e with an encoding name. For 
Global Shell sessions, this encoding name is specified by the Encoding field of the Terminal 
and Shell Preferences. For Remote Terminal sessions, this encoding name is the value of the 
Encoding field in the Properties section of the Device Explorer. If the terminal application 
does not support the encoding that replaces the %e variable, or if the %e variable is not 
specified, you must change the encoding manually in the terminal application after it starts. 
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Data that Cannot Be Displayed

Data that cannot be displayed might be from a managed server (such as the contents of files) 
or it might be the name of an object in the SA model. If the session’s encoding does not support 
the data to be displayed, the data often appears as question marks. (However, it might appear 
as other characters such as exclamation points.) The session attempts to display this data 
with the current encoding. Usually, this data cannot be accessed. To access this data, select a 
compatible encoding for the session. 

Objects in the SA model, such as Facility and Server, appear as file names in the OGFS. If 
these file names contain characters that cannot be represented by the encoding of the session, 
they are displayed as question marks, appended by the Object ID of the object. In the 
following example, the IDs are 10002 and 11002:

New York
Paris
Montr?al~10002
??~11002

If the model object does not have an ID, such as a custom attribute, then the session attempts 
to display the name with the current encoding.

LANG and LC_CTYPE Environment Variables

Many Unix commands (such as ls) rely on the character encoding, which is determined by the 
LANG or LC_CTYPE environment variables. In a Global Session, if the encoding is changed with 
the swenc command, the system attempts to reset these variables. 

HP Server Automation determines the new value of the LANG variable with the following 
process:

1 The value of LANG is generated by combining the language of the user’s profile in the SAS 
Web Client with the current session encoding. For example, if the language is English and 
the session encoding is UTF-8, LANG is set to en_US.utf8.

2 The value determined by the preceding step is compared with the set of valid locales on 
the OGFS server (according to the output of locale -a). If the value is a valid locale, LANG 
is set to this value.

3 If the value is not a valid locale, the system attempts to find a valid locale that specifies 
the user’s language without the encoding. For example, if the user’s language is English 
and the session encoding is EUC-JP, and this combination does not form a valid locale, 
LANG is set to en_US. If no matching locale is found, LANG is left unspecified.

The new value of the LC_CTYPE variable is determined in the following order: 

1 HP Server Automation attempts to find a valid locale that matches the session encoding, 
regardless of the language. 

2 If a valid locale is found, LC_CTYPE is set to this locale. For example, if the session 
encoding is EUC-JP, the LC_CTYPE variable is set to ja_JP.eucjp. 

3 If no matching locale is found, LC_CTYPE is left unspecified.

4 If HP Server Automation cannot set the LANG or LC_CTYPE variables with the preceding 
process, you should set them manually.
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Transcoded Data in a Managed Server

Transcoding is the conversion of data from one character encoding to another. HP Server 
Automation automatically transcodes some of the data between Global Shell sessions and 
other sources of data. For example, the file names of managed servers are transcoded, but the 
contents of the files are not. To see which data is transcoded, see Table 28. To display the 
transcoding mode of the current Global Shell session, enter the swenc command with no 
options.  

Disabling the Transcoding of Managed Server Data

On Unix servers, file and directory names can contain characters in arbitrary encodings. 
When accessed through the OGFS, file and directory names are transcoded by HP Server 
Automation. If the encoding of the names does not match the default encoding of the managed 
server, the transcoded data might be unusable.

You can disable transcoding with the swenc command. To turn transcoding on or off, use the 
-T option:

 swenc -T {on | off}

If transcoding is disabled, file and directory names are passed unmodified from the managed 
servers. Therefore, you must manually configure the encoding of the terminal application to 
display the names correctly.

Table 28 Data Transcoded for Global Shell Sessions

Data Transcoding

Objects in the SA model space, such as Facility, 
Customer, and Server. These objects are stored in 
the SA Model Repository (database) in UTF-8.

Between UTF-8 and the session 
encoding.

File and directory names of managed servers. Between the managed server encod-
ing and the session encoding.

Metadata of managed servers, such as user names 
and registry key names.

Between the managed server encod-
ing and the session encoding.

File contents of managed servers. None

Contents of Windows registries, services, COM 
objects, and IIS metabases.

None

rosh: Contents of saved scripts executed on managed 
servers (a rosh push operation).

None

rosh: Ad-hoc scripts executed on managed servers. None

rosh: Command-line arguments to programs exe-
cuted on managed servers.

None

rosh: Data streams (such as stdin and stdout) of pro-
grams executed on managed servers.

None

rosh: Data streams of rosh jump operations. None

OGFS home, tmp, and var/tmp directories. None
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Windows servers store their file system data internally in the UTF-16 encoding. Because the 
encoding is known, transcoding is performed correctly and does not need to be disabled. 
Therefore, the -T option of the swenc command has no effect on Windows servers. For more 
information, see swenc Syntax on page 410.

Global Shell Error Messages

The Global Shell feature provides the file system error messages that are described in 
Table 29.  

Remote Terminal

With HP Server Automation, you can log on to a managed server in a terminal window in two 
ways:

• The Remote Terminal feature, as described in this section.

• The rosh command, entered in a Global Shell session.

The Remote Terminal feature opens a terminal window for Unix servers or an RDP client 
window for Windows servers. Unlike a Global Shell session, a Remote Terminal session does 
not provide access to the OGFS.

Table 29 Global Shell Errors

Error Description Action

Input/output error Your session has exceeded the 
time-out limit or the Agent is 
not running.

Start a new session or check 
the status of the Agent.

Operation not permitted. No password was found. Verify that you have a valid 
password.

Permission denied. You are not allowed to view a 
directory. This does not mean 
that the directory does not exist 
on a given server. See the SA 
Administration Guide for more 
information.

Verify that you have 
readFileSystem permissions.

RFS Specific error You do not have permissions on 
the managed server. For 
example, this error will occur if 
you are trying to perform an 
operation on a managed server 
and you do not belong to the 
Administrators group that has 
the required permissions 
assigned to it.

You must have a set of 
permissions to perform 
operations on managed serv-
ers. To obtain these permis-
sions, 
contact your SA 
administrator. See the SA 
Administration Guide for more 
information.
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You can specify your terminal and RDP client preferences for Remote Terminal and Global 
Shell sessions in the Set Preferences window. See Terminal and Shell Settings on page 52 for 
more information.

Prerequisite for a Remote Terminal

This feature requires SA login permissions on the managed server. See the SA Administration 
Guide for more information. You cannot log into a remote terminal with a user name or 
password that contains multi-byte characters. 

In order to open a Remote Terminal session on a Windows managed server running Windows 
Firewall, you must set an exception that is not enabled by default. On the managed server, 
run Windows Security Center, then select Windows Firewall ➤  Exceptions ➤  Remote 
Desktop. 

This feature must be able to establish a loopback connection on the machine running the SA 
Client. Some firewall and VPN utilities have settings that prevent loopback connections.

Opening a Remote Terminal

In the Device Explorer of the SA Client, perform the following steps:

1 Select a managed server.

2 Open the managed server.

3 From the Actions menu, select Remote Terminal.
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10 OCLI 1.0
Overview of OCLI 1.0

The SA Command Line Interface 1.0 consists of two tools:

• oupload – Uploads files into the Software Repository

• odownload – Downloads files from the Software Repository

These commands help to automate the setup tasks for package management in HP Server 
Automation. For a list of supported package types, see the HP SA Policy Setter Guide.

OCLI runs on a server managed by SA. The operating system of this server can be one of the 
following: Solaris, Linux, AIX, HP-UX, Windows NT, Windows 2000, or Windows 2003.

Permissions and Customers

When installing OCLI, you download the OCLI package to a managed server. To perform this 
download, you must have read permission on the customer named Opsware. To run oupload 
or odownload, you must have permissions on the customer associated with the server where 
you run OCLI. For more information on permissions, see the SA Administration Guide.

For oupload, you must have read permission on the customer associated with the server 
where you run OCLI. For odownload, you need write permssion on this customer.

You can only upload or download packages for the customer associated with the server from 
which you are running the OCLI. Contact your SA Administrator to obtain the necessary 
access rights. If you must upload or download a package for a different customer, use the SAS 
Web Client to change the customer association for the server. See the HP SA User Guide: 
Server Automation for more information about editing the properties of a server.

Servers cannot be associated with Customer Independent; therefore, if you need to upload a 
package associated with Customer Independent, you must upload it from a server associated 
with the SA customer. Associating a server with the SA customer can be a security issue; 
therefore, you should control the access to this server while it is associated with the SA 
customer.

Upload Verification

After you upload a package with OCLI, verify that the upload has been successful by locating 
the package with the SA Client. Typically, you add the uploaded package to a folder or a 
policy.
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Encoding Options for OCLI

The oupload and odownload commands include options for specifying the encoding scheme of 
packages or customer display names. These options are required only when you want to 
override the default setting in the LANG environment variable of your shell.

RPM Uploads

For RPM packages, always remember to upload the source files after uploading a package. 
Uploading the source files is important from a maintenance perspective because it allows 
users to modify packages at a later date.

Passwords and Environment Variables

The oupload and odownload commands prompt for the SA user name and password when 
needed. Alternatively, you can set the ISMTOOLUSERNAME and ISMTOOLPASSWORD environment 
variables.

Upload Examples

To upload mytoolkit.rpm into the /Kit Apps/Services folder, enter the following command 
on a single line:

$ oupload --pkgtype RPM --os "Red Hat Enterprise Linux AS 3" 
--folder "/Kit Apps/Services" mytoolkit.rpm

To upload iPlanet_Web_Server-4.1sp19-LC~0.sparc64.rpm for the customer Opsware and 
the operating system Solaris 5.8, enter the following command on a single line:

$ oupload --pkgtype RPM --old --customer Opsware 
--os "SunOS 5.8" iPlanet_Web_Server-4.1sp19-LC~0.sparc64.rpm 

Be sure to enclose values containing spaces, such as SunOS 5.8, in quotes.

Installing OCLI 1.0

OCLI is shipped as a package in the Software Repository of SA. You must install the Server 
Agent and OCLI package on the host from where you will run OCLI. (The OCLI package 
contains the oupload and odownload commands.) See the HP SA User Guide: Server 
Automation for instructions on how to install a Server Agent or download a package from the 
SAS Web Client.

Installing the OCLI Package

Perform the following steps to install OCLI:

1 Install a Server Agent on the managed server where you will run OCLI.

2 Verify that you have the required permissions. See Permissions and Customers on page 
299.
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3 In the SA Client, search for the OCLI package that matches the platform of the managed 
server where you will run OCLI.

The file name of the package begins with ocli. The remainder of the name matches the 
version of OCLI and the operating system of the managed server, for example: 
ocli-32.1.1.6-win32-5.2.exe.

4 In the SA Client, export the OCLI package to your local file system.

5 Copy the OCLI package from your file system to the host where you will run OCLI.

Perform the following steps, which vary by operating system:

For Unix 

a The file downloads as a non-executable file. Change the file mode to executable. 

b Execute the package as root by entering the following command:

<package_name> -d <installation_directory>

Specifying the installation directory is optional. By default, OCLI is installed in the 
current directory.

c Include the file login.csh or login.sh in your environment, depending upon which 
shell you use.

— For the shells csh, tcsh, and similar variants, enter the following command:

source <installation_directory>/ocli/login.csh 

— For the shells sh, bash, ksh, and similar variants, enter the following command at 
the command line:

source <installation_directory>/ocli/login.sh

d Include /opt/opsware/agent/bin in your PATH.

— For the shells csh, tcsh, and similar variants, enter the following command at the 
prompt:

setenv PATH /opt/opsware/agent/bin:${PATH}

— For the shells sh, bash, ksh, and similar variants, enter the following command at 
the command line:

export PATH=/opt/opsware/agent/bin:${PATH}

For Windows

a Execute the package as Administrator.

<package_name> -d <installation_directory>

b Launch a command window and enter the following command at the prompt:

set PATH=%PATH%;<installation.dir>\ocli\scripts

c In the command window, enter the following command on a single line:

set PATH=%PATH%;%SYSTEMDRIVE%\Program Files\Loudcloud\lcpython15
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OCLI Command Syntax

The oupload and odownload commands have the following syntax. The filenames and 
localpath can contain a relative or absolute local file or directory path. If an option value 
contains spaces, enclose the value in quotes.

oupload [options] filenames

odownload [options] filenames [localpath]

Options Common to oupload and odownload

  

Table 1 Options Common to Both Commands

arguments values description

--customer 
(-C)
<value>

String (customer name, wildcards 
accepted) or integer (customer ID)

Specifies the customer of the file. 

Do not use the 
--customer option with the 
--folder option. To use 
--customer, the --old option is 
also required.

If you specify --old, specifying 
--customer is required unless you 
are using 
--patchtype in oupload.

When you upload an AIX LPP file, 
or an HP-UX Depot that contains 
patches, it is associated with 
“Customer Independent” and this 
option is ignored. 

When you upload an AIX 
Maintenance Level set of LPPs, you 
must associate them with 
“Customer Independent” so that all 
base filesets and update filesets 
contained in it are associated with 
the same customer.

--feedback 
(-Q)

N/A Displays feedback while the 
command runs. By default, this 
option is enabled.

Cannot specify this option with –q

--fr 
(-F)
<value> 

• Alphanumeric 

• Period 

• Hyphen

• Default = theword

Specifies the host name or IP 
address of the Software Repository.
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--frport 
(-F)
<port>

Integer

Default = 1003

Specifies the port of the Software 
Repository.

--fullhelp 
(-H)

N/A Displays full help information.

Cannot specify this option with -h 
or –V

--help 
(-h)

N/A Displays abbreviated help 
information.

Cannot specify this option with -H 
or –V

--nofeedback
(-q)

N/A Does not display feedback while the 
command runs.

Cannot specify this option with –Q

--os 
(-O)
<type>

String (OS name, wildcards 
accepted)

See Allowable Strings and Integer 
Values for -os Option on page 304 
in this chapter for more 
information

Specifies the operating system of 
the package.

Specifying this option is required.

If a value has a space in the name, 
enclose the entire name in quotes.

For Fujitsu Solaris 2.8, use the 
value for Solaris 8. For Fujitsu 
Solaris 2.9, use the value for Solaris 
9.

--timeout
(-z)
<value> 

Integer

Default = 60

Sets the timeout to the server in 
seconds.

--truthgw
(-g)
<value>

• Alphanumeric 

• Period 

• Hyphen

• Default = spin

Specifies the host name or IP 
address of the Data Access Engine.

--truthgwport
(-G)
<port>

Integer

Default = 1004

Specifies the port of the Data 
Access Engine.

--verbose 
(-v)

N/A Displays debug information.

--version 
(-V)

N/A Displays version information for 
the OCLI.

Cannot specify this option with -h 
or –H.

Table 1 Options Common to Both Commands (cont’d)

arguments values description
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Allowable Strings and Integer Values of -os Option

Table 2 Allowable Strings and Integer Values for -os Option

String name (OS name) Integer Value (opsware id)

AIX 4.3 870007

AIX 5.1 10001

AIX 5.2 260007

AIX 5.3 40007

HP-UX 10.20 230007

HP-UX 11.00 1070007

HP-UX 11.11 1080007

OS Independent 1

Red Hat Enterprise Linux AS 2.1 960007

Red Hat Enterprise Linux AS 3.0 430007

Red Hat Enterprise Linux ES 2.1 10730013

Red Hat Enterprise Linux ES 3.0 10720013

Red Hat Enterprise Linux WS 3.0 270022

Red Hat Enterprise Linux 6.2 140000

Red Hat Enterprise Linux 7.1 210022

Red Hat Enterprise Linux 7.2 950007

Red Hat Enterprise Linux 7.3 410007

Red Hat Enterprise Linux 8.0 420007

SUSE Linux Standard Server 8.0 20007

SUSE Linux Enterprise Server 8.0 10030

SUSE Linux Enterprise Server 9.0 20032

SunOS 5.6 130000

SunOS 5.7 90000

SunOS 5.8 150001

SunOS 5.9 920007

Windows 2000 120000

Windows 2003 10007

Windows NT 4.0 8000
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Unique Options for the oupload Command

The following table lists options that apply only to the oupload command.   

Table 3 Unique Options for the oupload Command

arguments values description

--filename-encoding 
(-e)
<encoding>

String Specifies the character set of the file name.

See also Encoding Options for OCLI on page 
300.

When specifying non-ASCII characters in the 
value for the --customer argument, include the 
-e argument on the command line to tell HP 
Server Automation which character set to use 
when communicating with the Model 
Repository. 

--folder 
(-d)
<folderpath>

String Specifies the folder ID or folder path into which 
the package is uploaded. Wildcards in a folder 
path are allowed. For example, if the 
destination folder is myfolder4pkgs, you can 
specify myfolder4*. 

Do not specify --folder with --customer.

--metainfo-encoding 
(-E)
<encoding>

String Specifies the character set of the 
meta-information in the package.
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--old 
(-o)

N/A Specifies that the operation behaves as in HP 
Server Automation 5.x. The file is not uploaded 
into a folder. The --old option is required if you 
specify --customer.

--patchtype 
(-a)
<type>

• AIX LPP

• HP-UX 
Depot

• Windows 
Hotfix

• Windows 
Service 
Pack

• Solaris 
Patch

• Solaris 
Patch 
Cluster

Cannot specify this option with -C.

Table 3 Unique Options for the oupload Command (cont’d)

arguments values description
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--pkgtype
(-t)
<type>

• AIX LPP

• HP-UX 
Depot

• RPM

• Windows 
Hotfix

• Windows 
MSI

• Windows 
Service 
Pack

• Solaris 
Package

• Solaris 
Patch

• Solaris 
Patch 
Cluster

• Microsoft 
Patch 
Database

• OS 
Provision
ing 
Install 
Hooks

• ZIP

Specifies the type of file. 

Specifying either this option or the -patchtype 
option is required.

Wildcards are accepted.

The OCLI does not support uploading response 
files for the Solaris Package package type. Use 
SAS Web Client to associate a response file with 
a Solaris Package.

If a value contains spaces, you must enclose the 
value in quotation marks.

Table 3 Unique Options for the oupload Command (cont’d)

arguments values description
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Unique Options for the odownload Command

The following table lists options that apply only to the odownload command.   

Table 4 Unique Options for the odownload Command

argument value description

--filename-encoding 
(-e)
<encoding>

String Specifies the character set encoding in which 
to save the file name. See also Encoding 
Options for OCLI on page 300.
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11 Code Deployment and Rollback
To manage and deploy your own custom multi-tier software applications to target servers in 
your data centers, use SA Application Deployment. For complete information, see the SA 
Application Deployment User Guide.

You must have specific permissions to deploy code and content by using the SAS Web Client. 
Contact your SA administrator to obtain the necessary access rights. For more information, 
see the Permissions Reference appendix in the SA Administration Guide.

The Code Deployment and Rollback (CDR) feature is not supported on a VMware ESX 
Hypervisor.

Code Deployment Process

This section provides information on the code deployment process within HP Server 
Automation and contains the following topics:

• Deploying Code

• Uploading Code and Content to Staging

• CDR Operations and Directories

• CDR Features

• CDR Permissions

• Accessing CDR

Deploying Code

The Code Deployment & Rollback (CDR) feature in the SAS Web Client provides tools for 
deploying new and updated code and content to your operational environment.

The following figure shows the architecture and process for updating a typical server hosted 
in an SA managed environment.
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Figure 1 Typical Code and Content Update in the SA Managed Environment  

The deployment process involves performing the following high-level tasks: 

1 Determining your application code and content deployment requirements and defining 
the CDR services, synchronizations, and sequences that you need to support them.

• Services are defined for each different type of web server or application server 
applications (for example, WebLogic Server) that is installed on the staging and 
production hosts in your environment.

• Synchronizations are defined for each service so that you can update files between the 
source location and one or more destination production hosts that are running the 
same service.

• Sequences are optional but can simplify deployment by grouping a collection of service 
operations and synchronizations that can be performed as a single task.

2 Uploading new or updated code and content to your staging environment.

3 After performing any necessary testing, cutting over to the changed code and content on 
the staging environment.

4 As necessary, performing CDR service operations, such as backing up code and content 
from your live site.

5 Performing CDR operations available to synchronize the updated code and content to your 
production hosts in the SA managed environment.

6 To simplify subsequent deployments of new code and content, defining sequences that 
specify a series of service operations and synchronizations you want to perform as a single 
action.

The code and content deployment process that you follow might be different depending on the 
architecture of your operational environment and your deployment requirements.
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Uploading Code and Content to Staging

Before you use CDR to push code and content, you must upload new or updated files to your 
SA staging environment. You can use content management tools, such as OpenDeploy, scp, or 
rsync over SSH, to do that.

The following figure shows an example of a typical development environment and how your 
uploaded code and content move to the staging environment.

Figure 2 How Code and Content Move to the Staging Environment  

After you upload the files and test your changes, you can synchronize updates to the 
production hosts running your managed environment. You can run specific synchronizations 
and perform other service deployment operations by selecting CDR menu options available 
from the SAS Web Client navigation panel.

CDR Operations and Directories

After you upload updated code and content to your SA-managed staging environment, you can 
use the CDR operations to cutover to new code and content, perform host synchronizations, 
and perform other service operations. 

CDR uses the following directories to synchronize and cutover code and content for specified 
hosts:

• Live directory: The directory that stores the actual code and content required to run a 
live site.

• Update directory: The directory written to by CDR synchronizations. Stores only the 
files that changed between the source host Live directory and the Live directories of the 
destination hosts.
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• Site Previous directory: This directory holds all the changes necessary to revert the 
Live directory back to the state it was in before the last cutover. Like the Update directory, 
the Site Previous directory only stores the files that changed between the current Live 
directory contents and its previous state.

• Site Backup directory: This directory stores a complete backup of the site. The 
directory is populated when the user issues a Backup service operation.

When you cutover to new code and content, CDR determines the differences between the new 
code and content in the current Update directory and the Live directory for your site. The files 
that are different are synchronized to the Live directory. When you synchronize source and 
destination hosts, CDR moves modified files from the Live directory on a source host to a 
directory on a destination host.

You cannot use CDR to automate database pushes. However, you can configure CDR so that 
you can synchronize modified database script files on different hosts.

CDR Features

CDR offers the following features:

• Provides a single tool for deploying code (such as ASP, JSP, and JAR files) and site content 
(such as HTML, JPEG, GIF, and PDF files). Using a single tool is helpful when the code 
and content for your site are intermingled.

• Provides direct control over code and content pushes by making it possible to decide what 
information to update and determine when and how to perform updates.

• Provides flexibility to accommodate frequent updates to staging and production hosts by 
enabling more frequent pushes in a shorter period of time.

• Allows verification of file changes between staging and production host directories by 
creating a manifest of updated files. You can verify changes before cutting over to new 
code and content.

• Provides administrative service operations, including starting and stopping services, and 
backing up, restoring, and rolling back code and content to return your site to the previous 
version.

• Lets you push incremental updates to your site so that only files that have changed are 
pushed to specified locations on staging or production hosts.

• CDR uses the same authentication and navigation that you use in accessing other 
information and performing other site operations from the SAS Web Client.

CDR Permissions

As with all other features in HP Server Automation, the links that you see on the SAS Web 
Client Home page and the links that you see in the navigation panel are based on the 
permissions that you have in combination with the customer you are associated with.

If you do not have permissions for CDR, you cannot see the Code Deployment links on the 
navigation panel, the link called Deploy Code in the Tasks panel of the SAS Web Client home 
page appears in italics, and it is not an active link.
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If you have CDR permissions to no more than one customer, when you expand the Code 
Deployment section in the navigation panel, you can see a link called Set Customer. Click that 
link to view the links to the specific Code Deployment functions that you have permissions for 
in combination with that single customer.

If you have CDR permissions to more than one customer, you can see a link called Select 
Customer. Click that link to display a page that shows the customers you are associated with. 
Select the customer you want to work with. The CDR Home Page appears, with links to the 
specific Code Deployment functions that you have permissions for. These links are the same 
functions that you can find in the navigation panel under Code Deployment.

The navigation instructions and screen captures in this chapter show what a user with 
permissions to all code deployment functions and access to only one customer can see. 
Consequently, because your permissions and customers might be different, the available 
menu selections and features that you see might likewise differ.

Accessing CDR

Perform the following steps to access CDR:

1 If necessary, click the Code Deployment link in the navigation panel to expand the list of 
CDR options. 

2 Click the CDR Home link. The CDR Home Page for [customer name] appears, as the 
following figure shows.
Code Deployment and Rollback 313



Figure 3 Code Deployment Home Page  

Depending on your access permissions, the following CDR options appear:

• Service Management: Create, modify, or delete service definitions that define the 
location and commands to manipulate an application on hosts associated with each 
application instance running in your operational environment.

• Run Service: Perform a service operation or request that one be performed. 

• Sync Management: Create, modify, or delete synchronization definitions associated 
with code pushes.

• Synchronize: Perform a synchronization or request that one be performed.

• Sequence Management: Create, modify, or delete sequences of operations. 

• Run Sequences: Perform a selected sequence or request that one be performed.

• View History: View information stored in an operations log to determine the status 
of particular deployment operations, and whether they completed successfully.

3 Choose the CDR operations that you want to perform, selecting options from the 
navigation panel or from the CDR home page.  
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Services, Synchronizations, and Sequences

This section provides information on performing services, synchronizations, and sequences 
within HP Server Automation and contains the following topics:

• Overview of Performing Services, Synchronizations, and Sequences

• Synchronization of Site Code and Content

• Performing Synchronizations

• CDR Cutover Operation

• CDR Service Operations

• Starting and Stopping Host Services

• Backing Up Code and Content

• Restoring Code and Content from a Previous Version

• Rolling Back Code and Content to the Previous Version

• Accessing Service Operations in CDR

• Performing Service Operations by Service Name

• Performing Service Operations by Host Name

• Performing Sequences

• Processing Code Deployment Requests from Users

• Status View of Previous Operations

Overview of Performing Services, Synchronizations, and Sequences

After you upload updated code and content to your HP Server Automation staging 
environment, you use CDR to cutover to new code and content, perform host synchronizations, 
and perform other service operations. 

When you cutover to new code and content, CDR determines the differences between the new 
code and content in the current Update directory and the Live directory. The files that are 
different are synchronized to the Live directory. When you synchronize source and destination 
hosts, CDR moves modified files from the Live directory on a source host to a directory on a 
destination host.

The code and content footprint that CDR maintains on a host is larger than the storage space 
for the code and content files of the live site. The amount of storage used beyond the actual 
size of your site increases with the number of files that you modify and back up.

Synchronization of Site Code and Content

CDR uses the following directories to synchronize and cutover code and content for specified 
hosts:

• Live directory: The directory that stores the actual code and content required to run a 
live site.
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• Update directory: The directory written to by CDR synchronizations. Stores only the 
files that changed between the source host Live directory and the Live directories of the 
destination hosts. 

• Site Previous directory: This directory holds all the changes necessary to revert the 
Live directory back to the state it was in before the last cutover. Like the Update directory, 
the Previous directory only stores the files that changed between the current Live 
directory contents and its previous state.

• Site Backup directory: This directory stores a complete backup of the site. The 
directory is populated when the user issues a Backup service operation.

CDR can synchronize updates from the Live directory of a source host to either the Update or 
Live directories on destination hosts. Decide whether you want to synchronize changed files 
on the source host to Update or Live directories on the destination hosts: 

• Synchronize to Update directories: CDR determines files that have changed by 
comparing files in the destination host Live directory and the source host Live directory. 
Updated files are stored in the Update directories of destination hosts.

• Synchronize to Live directories: CDR updates changed files to the Live directory on 
destination hosts bypassing the Update directory. 

If you choose to synchronize directly to Live directories, the Rollback operation does not 
function properly. Therefore, choose this option only for synchronizations that are not likely to 
impact site stability.

When you choose to synchronize to Live directories, back up the Live directories first and run 
the Restore operation to return your site to the previous version. See Rolling Back Code and 
Content to the Previous Version on page 322 for more information. 

Figure 4 shows an example of synchronization between hosts and how you synchronize 
updates for each service.
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Figure 4 Service Synchronization of Hosts Using CDR   

Contact your SA administrator for a description of services and synchronizations set up for 
your site and the specific operations that you need to run when updating code or content for a 
particular host service.

Performing Synchronizations

Perform the following steps to synchronize updated code and content from one source host to 
one or more destination hosts:

1 Click the Code Deployment link in the navigation panel to expand the list of CDR options 
and select a customer, if necessary.

2 Click the Synchronize link. 

A page appears that displays the synchronizations that you can perform.

3 Select the synchronization that you want to perform by clicking the link. The CDR 
Synchronize for [customer name] page appears, as Figure 5 shows.
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Figure 5 The CDR Synchronize Page    

4 Select one or more of the displayed host names on which you want to perform 
synchronization. The hosts that you select are the destination hosts. 

Choose the Select/Deselect All option to select all or clear all host names.

5 (Optional) To view a list of files that will be created, modified, and deleted on the 
destination hosts, click Preview. 

Or

(Optional) To view a list of all the files on the destination hosts, click List.

6 Select the Perform Operation option to directly perform a selected synchronization.

Or

Select the Submit Request To option to send a request to users specified to receive email 
notification for service and synchronization requests. When you submit a request, specify 
any additional instructions that you want to include for the requested synchronization. 
For example, these might be instructions such as the time that you want the 
synchronization performed, verification, or other related services to perform. 

The Perform Operation option is only visible when you are a member of an SAS Web Client 
user group allowed to directly perform a synchronization.

7 Choose the type of synchronization that you want performed from the drop-down list:

• Synchronize To Update

• Synchronize To Live
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See Synchronization of Site Code and Content on page 315 for more information about  
these options. 

8 To initiate the synchronization or send the request, click Run.

CDR Cutover Operation

Perform the cutover operation to make the Update directory and the current live site 
identical.

When you cutover, CDR performs the following actions: 

• Updates the Site Previous directory with files from the Live directory. CDR saves modified 
files and files-to-be-deleted to the Site Previous directory. The Site Previous directory 
contains the files necessary to restore the live site to the previous version.

• Determines the differences between the Update directory and the current Live directory. 
The files that are different are synchronized from the Update directory to the Live 
directory. See Figure 6.

Figure 6 Directory and File Updates for Cutover Operations Using CDR 

CDR determines file differences between source and destination directories based on file size, 
modification date and time, ownership, group attributes, and permissions attributes.

By using the cutover process, CDR ensures your ability to rollback to the previous version of 
your code and content if you experience a problem.

Your SA administrator can configure a CDR service to run scripts before and after cutting 
over to updated code and content. For example, before and after cutting over, you might 
distribute content on geographically disperse servers.

See Synchronization of Site Code and Content on page 315 for a description of these 
directories. See CDR Service Operations on page 320 for how to rollback code and content to 
the previous version.

Directory and File Updates for Cutover Operations using CDR
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CDR Service Operations

In addition to the Cutover operation, CDR provides a number of service operations:

• Starting and stopping host services

• Backing up code and content

• Restoring code and content from a previous version

• Rolling back code and content to the previous version

Performing these operations might be required depending on the type of code and content 
changes made or the host services that are affected. 

The operations that you need to perform are specific to the service (for example, Web server or 
application server instance) for which you are updating code or content and the particular 
host.

Starting and Stopping Host Services

Stopping and starting services might be required depending on the type of code and content 
changes made or the host services that are affected. Discuss your requirements with your SA 
administrator.

Typically, you only stop and start host services for the hosts in your staging environment. 
Select members of your staff, or other individuals in your operations center, can stop and start 
host services for the hosts in your production environment.

Start: Launch a defined service; for example, starting a web or application server instance 
that is running on a specific host.

Stop: Shut down a defined service; for example, shutting down a web or application server 
instance before cutting over to new or changed code and content on a specific host. 

Backing Up Code and Content

When you use CDR to back up your site, CDR saves the entire contents of the current Live 
directory for a specific service in the Backup directory. CDR saves the backup copy to the local 
disk for the host on which you ran the Backup operation. See Figure 7.

You can use CDR to keep only one backup copy at a time for a service.
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Figure 7 Update Directory to Site Backup Directory for Backup Using CDR    

When you run the Restore operation, CDR replaces the Live directory contents with files 
stored in the Backup directory. 

When you reach a high level of site stability, backing up your site is recommended, especially 
if you plan to make changes to site code and content.

Restoring Code and Content from a Previous Version

The Restore operation restores the previous Live directory by copying the contents of the 
Backup directory to the Live directory. Restoring code and content from the Backup directory 
does not change files that are stored in the Update directory. See Figure 8.

Figure 8 Site Backup Directory to Update Directory for Restoring Using CDR    
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Before you restore code and content, you must have backed up the contents in the Live 
directory to the Backup directory by performing a Backup operation.

Rolling Back Code and Content to the Previous Version

If you experience a problem after cutting over updated code and content to your production 
site, you can rollback to the previous version.

Rolling back returns the site to the state it was in prior to the last cutover that you performed. 
See Figure 9.

Figure 9 Directory and File Updates for Rollback Operations Using CDR 

During cutover, CDR updates the Site Previous directory with files from the Live directory. 
CDR saves modified files and files-to-be-deleted to the Site Previous directory. The Site 
Previous directory contains the files necessary to restore the live site to the previous version.

During rollback, CDR restores the set of different files (modified files and files that were 
deleted during cutover) to the Live directory.

If you upload files directly to the Live directory or choose to synchronize directly to Live 
directories, the rollback operation does not function properly. Under these conditions, back up 
your Live directory and run the Restore operation to return your site to the previous version.

Accessing Service Operations in CDR

The Service Management option provides a number of service or administrative operations, 
including starting and stopping host services, backing up, restoring, or rolling back code and 
content, and cutting over to new site code and content.

To access CDR, your SA administrator must add you as a member of a user group authorized 
to use CDR.

Directory and File Updates for RollBack Operations Using CDR
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You have the option of initiating a service either by selecting a service name or by selecting 
host names. You must select both a service to perform and the hosts on which to perform the 
service. See Figure 10.

Figure 10 Run Service Page 

• Initiate a service by selecting the “Perform service operations by service name” option first 
when you want to perform a service on multiple hosts at the same time. Selecting the 
service name first shows you all the hosts for which that service is defined.

• Initiate a service by selecting the “Perform service operations by host name” option first 
when you want to perform a service on a single host or on a specific host where you know 
the host name. Selecting the host name first shows you all the services that are defined 
for that host.

Performing Service Operations by Service Name

Perform the following steps to perform service operations by service name:

1 Click the Code Deployment link in the navigation panel to expand the list of CDR options 
and select a customer, if necessary.

2 Select the Service Management option.

3 From the Service Management page, select the “Perform service operations by service 
name” link.

4 Select a service from a list of services defined for your site. A page that prompts you to 
select the hosts and the operation that you want to perform appears, as Figure 11 shows.
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Figure 11 Perform Service Operations by Service Name Page    

5 Select one or more of the displayed host names. You can choose the Select/Deselect All 
option to select all or clear all host names for the operation that you want to perform.

6 Select the Perform Operation option to directly perform a selected operation. 

The Perform Operation option is visible only when you are a member of the CDR user group 
that allows users to directly perform a service operation.

Or

Select the Submit Request To option to send a request for authorized individuals to 
perform the operation for you. When you submit a request, specify any additional 
instructions that might be required to perform the requested operation. 

7 Choose the type of operation that you want performed from the drop-down list:

• Start

• Stop

• Cutover

• Rollback

• Backup

• Restore

See CDR Service Operations on page 320 for more information about these operations.

8 To initiate the operation or send the request, click Run.
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Performing Service Operations by Host Name

Perform the following steps to perform service operations by host name:

1 Click the Code Deployment link in the navigation panel to expand the list of CDR options 
and select a customer, if necessary.

2 Select the Service Management option. 

3 From the Service Management page, select the “Perform service operations by hostname” 
link.

4 Select a host name from the list of staging and production hosts available for your site. A 
page that prompts you to select the service and the operation that you want to perform 
appears, as Figure 12 shows.

Figure 12 Perform Service Operations by Host Name Page    

5 Select the service for which you want to perform an operation.

6 Select the Perform Operation option to directly perform a selected operation or select the 
Submit Request To option to send a request to have authorized individuals perform the 
operation for you. When you submit a request, specify any additional instructions that 
might be required to perform the requested operation.

The Perform Operation option is visible only when you are a member of the user group that 
allows users to directly perform a service operation.

7 Choose the type of operation that you want performed from the drop-down list:

• Start

• Stop

• Cutover

• Rollback

• Backup
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• Restore

See CDR Service Operations on page 320 for more information these operations.

8 To initiate the operation or send the request, click Run.

Performing Sequences

CDR also allows you to perform service operations and synchronizations that have been set up 
as a sequence of operations. 

Perform the following steps to perform CDR sequences set up for your site:

1 Click the Code Deployment link in the navigation panel to expand the list of CDR options 
and select a customer, if necessary.

2 Click the Run Sequence link. 

The CDR Run Sequence for [customer name] page appears that shows the sequences that 
you can run. See Figure 13.

Figure 13 CDR Run Sequence Page    

3 Select the sequence that you want to perform by clicking the link. The Run Sequence page 
appears, as Figure 14 shows.

Figure 14 Run Sequence Page That Shows Details of a Specific Sequence 
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4 Select the Perform Operation radio button to directly perform the selected sequence.

Or

Select the Submit Request To Perform radio button to send a request to the users specified 
to receive email notification for service, synchronization, and sequence requests. When 
you submit a request, specify any additional instructions that you want to include for the 
requested sequence. For example, you might want to include instructions such as the time 
that you want the sequence to run, verification, or other related services to perform. 

The Perform Operation option is visible only when you are a member of a user group allowed 
to directly perform a sequence.

5 To initiate the sequence or send the request, click Run.

Processing Code Deployment Requests from Users

When CDR users request that a service operation or synchronization be performed on their 
behalf, an email notification is sent to the individuals assigned to perform the requested 
service operation or synchronization. 

The following message is a typical example of an email notification request.

From:    CDR-tool@opsware.com
To:      opscenter@opsware.com
Date:    Tue, 10 Jul 2001 11:25:13 -0700
Subject: Request To Perform Start operation for opsware.com

Please perform the following request

Requestor: jhancock/opsware.com
Request Time: Jul 10, 2001 11:25:13 AM PDT
Requested Service: Demo Apache
Requested action: Start
Perform on the following hosts:
host1.opsware.com
host2.opsware.com

Extra Instructions:

In this case, the email message specifies a request from a user, jhancock, to perform a Start 
operation on two hosts running the Demo Apache service. The subject line provides a 
summary of the request. In addition, the email indicates the time that the request was sent.

Perform the following steps to process the request:

1 Identify any special instructions that might need to be carried out for the specific request.

2 Log into the SAS Web Client, choose the CDR option, and then select the particular option 
within CDR to perform the requested operation.

3 When you successfully complete the CDR request, you might want to notify the individual 
user making the request, and all other involved parties, that the requested operation was 
completed.
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If you encounter problems in completing a request and cannot resolve them, contact your SA 
administrator for any specific remedies and follow normal escalation procedures defined for 
your operational environment. 

See the SA Policy Setter Guide for more information about troubleshooting tips.

Status View of Previous Operations

CDR maintains a log of operations (service operations, synchronizations and sequences) that 
were executed. You can view this information to determine the status of particular 
deployment operations, and whether they have completed successfully. You can also use the 
My Jobs task area of the SAS Web Client Home page, or the My Jobs link to view this 
information.

Accessing the Log

Perform the following steps to access the log:

1 Click the Code Deployment link in the navigation panel to expand the list of CDR options 
and select a customer, if necessary.

2 Select the View History option.

CDR displays a page providing a list, most recent to oldest, of operations that are either in 
progress or those that have been completed. This information displays only for the past 60 
days. Each page is limited to a list of 10 operations. A Next link displays at the end of the page 
if there are more than 10 operations to view. Click the Next link to view subsequent 
operations. A Previous link is available to return to previous pages.

You need to refresh the page to view the status of any operations initiated after you selected 
the View History link.

A similar page displays after you select the View History link. See Figure 15.

Figure 15 CDR View History Page 

The individual headings of column information included in the table are: 

• Session ID: A session is created each time a CDR operation is performed. Click the 
Session ID to view detailed results of the operation.

• Operation Name: The name of the service, synchronization or sequence as specified 
when they were first defined.

• User Name: The user ID of the user that initiated the operation. 
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• Status: This describes the state of the operation at the end of the sequence. The status 
message varies depending on the type of operation. Single step operations always result in 
Success/Failure messages while multiple step operations (Sequence operations) could 
result in Complete with Error, Incomplete, or Success messages. Table 5 describes the 
possible status messages.    

Table 5 CDR History Status Messages

Status Type Description

Abort This message displays only if a CDR specific script that is executed in 
order to complete service, synchronization or sequences fails. Such issues 
should be escalated to your SA Support Representative.

Active This message displays if an operation is still in progress.

Complete with 
error 

The sequence completed successfully but there were errors reported 
while the operation was in progress and the user opted to continue rather 
than cancel the operation.

Failure The operation (service, sequence or synchronization) did not complete 
successfully. 

Incomplete The sequence resulted in an error and the user opted to cancel the 
sequence rather than continue.

Success The operation (service, synchronization or sequence) was completed 
successfully and no errors were reported. In the case of a sequence, this 
message means that all the steps were completed successfully.

Initiated Date The date on which the operation was initiated.
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12 Configuration Tracking
Overview of Configuration Tracking

The Configuration Tracking feature of HP Server Automation allows you to monitor critical 
configuration files and configuration databases. When SA detects a change in a tracked 
configuration file or configuration database, the system can perform a number of actions, 
including backing up the configuration file or sending an email to a designated individual or 
group. You use configuration tracking policies to identify the files to be tracked and actions to 
be taken when change is detected. A configuration tracking policy consists of one or more 
configuration tracking policy entries that specifies the configuration file, the directory of 
configuration files, or the configuration database that you want to track. 

The Configuration Tracking feature is designed for flexibility. For example, you can set 
configuration tracking defaults for a particular software application, and all attached servers 
automatically get those defaults. You can also quickly deploy the common configuration 
tracking defaults to a large number of servers in your SA managed environment or create a 
specific policy for a single server.

Configuration Tracking allows you to recover from many problems caused by changes to 
configuration files. Using Automated Configuration Tracking, you can identify which tracked 
configuration files have changed, thus helping you identify the potential source of a problem. 
If you back up your configuration files with the Configuration Tracking feature, you can 
quickly restore the changed configuration files to a previous version.

You can also view a detailed history of all backup activity. This history includes a list of all 
tracked files that have been backed up and what types of backups occurred. If the backed up 
configuration files are text-based, you can download the files from the backup history and 
compare them to determine what specific changes have been made. 

The Configuration Tracking feature is not a general-purpose backup solution. Configuration 
Tracking is designed to monitor text-based configuration files and specific types of 
configuration databases. The number and size of files that can be monitored on any managed 
server is limited.

File Types Supported

You can use the Configuration Tracking feature with the following types of files:

• Text-based configuration files

• The COM + Registration Database (Windows 2000)

• The IIS Metabase

• Windows Registry keys
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Configuration Tracking Operations

This section discusses the following topics:

• Change Detection

• Types of Actions Performed

• Types of Backups Performed

• Email Automated Configuration Tracking and Logging Actions

• Creating the Email Notification List

Change Detection

All servers that HP Server Automation manages have an Server Agent installed on them. On 
servers that use Configuration Tracking, every four hours the Server Agent inspects the 
configuration files and databases that you select to track.

The Server Agent computes an MD5 checksum to determine if the contents of a tracked file 
have changed. (Any change to the contents of the file results in a change to the MD5 
checksum.) If the contents of the file have changed, the action that you specify in the tracking 
policy is performed. For example, if you create an entry in your tracking policy for the /etc/
passwd file and select backup as the action to be taken, the file is backed up when the Server 
Agent discovers a change in the /etc/passwd file.

The creation or deletion of a tracked file (or files inside a tracked directory) also counts as 
change and triggers a policy’s action. (There are some exceptions; see the SA Policy Setter 
Guide for more information.)

Changes to the properties of a tracked file or directory (such as changes to permissions or time 
stamps) do not count as a change. When a file or directory is backed up, however, its 
properties are backed up as well.

The first time that a tracking policy is deployed, all targets are considered changed. The 
Server Agent is encountering the files for the first time, and all of the policy's actions are 
triggered.

Types of Actions Performed

HP Server Automation can perform the following actions when change is detected in a tracked 
configuration file or configuration database:

• Back up

• Send email to addresses specified in the policy entry

• Send email to a designated notification group specified by a custom attribute

• Create an entry in the server’s standard system log, (the syslog on Unix servers and the 
event log on Windows servers)

Types of Backups Performed

If you selected backup as the action for a tracked configuration file, the two general types of 
backups that can occur are incremental backups and full backups. 
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Incremental Backups

During an incremental backup, only targets that have changed since the last backup (and 
that have been selected to be backed up) are backed up.

An incremental backup occurs automatically when the Server Agent detects change in a 
tracked file that is selected to be backed up. (The Server Agent checks for change every four 
hours.)

Incremental backups also occur before and after you restore a previous version of a backed up 
configuration file to a server. These backups allow you to rollback the restored files.

Full Backups

During a full backup, all tracked configuration files that were selected to be backed up are 
backed up, not just the files that have changed. 

Once a week, the Server Agent on a server checks to see if any files have changed since the 
last full backup. If any files have changed, HP Server Automation performs a new full backup. 
If no files have changed, the full backup does not take place. 

You can also force HP Server Automation to perform a full backup on a server by selecting the 
Perform Manual Backup option. (See Manual Backups on page 341 for more information.) 

See Backup History on page 342 for more information about Backup types.

Backups are stored in the Software Repository until you delete them. You should delete old 
backups periodically, especially if you are backing up a large number of files that change 
frequently. See Deleting Backups on page 347 for more information about the procedure for 
deleting backups.

Email Automated Configuration Tracking and Logging Actions

You can choose to have email sent when a monitored target changes. The following example 
shows the text of an email generated when a tracked file changed.

From: <configurationtracking@yourcompany.com>
Date: Thu Jan 16, 2003  5:40:11 PM US/Pacific
To: <joe@yourcompany.com>
Subject: athena.cust.com: Configuration Tracking CHANGE notification
Configuration Tracking has detected a CHANGE event
Host: athena.cust.com
Object: /db/file1l1

The email specifies the name of the server and the name of the object that changed. The object 
can be a file, a directory, or a configuration database.

If you are monitoring a directory target, you receive email about the directory itself and about 
changes to the files in the directory (except when a file is deleted.) For example, if three new 
files are created in a directory, you would receive four emails, one for the directory and three 
for the new files.

If you selected the logging action, an entry is made to the server's standard system log when a 
change is detected. You select the type of log entry that you want to have written. HP Server 
Automation uses the following three standard entry types:

• Info
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• Warning

• Error

How the entry types are identified is system-dependent. For example, on most systems, 
Warning entries are identified by the word warning. In some systems, however, a number is 
used to identify the log entry type. 

The following example shows a warning log entry written on a Solaris Server:

Jan  8 00:05:25 athena.cust.com Configuration Tracking: [ID702911
local0.warning] Configuration Tracking: /other/otherfile1 : Event CHANGE 
occurred
Jan  8 00:05:25 athena.cust.com Configuration Tracking: [ID 702911
local0.warning] Configuration Tracking: /other/otherfile1 : Event CHANGE 
occurred

Creating the Email Notification List

Sending email to a server’s backup notification list is one of the actions that you can select in 
a tracking policy entry. The email notification list is a list of email addresses that you define 
for the following custom attribute: 

backup_notification_email

This attribute can be set on the server itself or on the customer to which the server is 
attached. Setting the attribute at the customer level allows you to use the same email 
notification list for all servers that belong to the same customer (assuming that these servers 
have all been attached to the same customer and do not have the 
backup_notification_list set on the servers themselves). See the SA Policy Setter Guide 
for more information about setting custom attributes for customers.

Search Order for Email Notification List Attribute

On a server that has a policy that includes the Email Notification List for Server action 
selected, the server searches for the backup_notification_email attribute in the following 
order:

• Server 

• Customer 

After the custom attribute is found, its value is used (for example, the email address of the 
notification list) and the search is concluded. If, for example, the backup_notification_email 
attribute is set on a server, the server’s email notification list is used, even if the server is 
assigned to a customer that has a different backup_notification_email attribute. 

Format of Email Notification List

The notification list can contain multiple email addresses. The email address must be 
formatted as a comma-separated list.
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Customized Configuration Tracking Policies

This section provides information on customizing configuration tracking policies within HP 
Server Automation and contains the following topics:

• Server-Based Entries

• Policies for Customizing Multiple Servers

• Adding or Editing Customized Tracking Policy Entries

• Disabling Customized Tracking Policy Entries

• Enabling Customized Tracking Policy Entries

• Viewing a Server’s Tracking Policy

• Reconciling Customized Tracking Policies

• Enabling and Disabling Configuration Tracking on Servers

You can customize the tracking policy for a server or selected group of servers. Ordinarily, a 
server gets its tracking policy from the policy to which it is attached. In some cases, however, 
you might need to customize the tracking policy for a particular server or set of servers. If, for 
example, an application on one server is using an optional configuration file, you can 
customize the tracking policy for that server so that the optional configuration file is 
monitored. 

Server-Based Entries

A tracking policy entry created for a specific server or selected group of servers is called a 
server-based tracking policy entry. 

Table 6 shows the actions that you can perform on server-based tracking policy entries.  

To determine if a tracking policy entry server-based, check the Source column in the Track 
Configurations: Customize Tracking Policies page. Figure 16 shows the policy entries for a 
single selected server.

Figure 16 Viewing Configuration Tracking Policy 

Table 6 Entry Types

Entry type Edit Delete Enable/Disable

Server-based Yes Yes No
Configuration Tracking 335



Policies for Customizing Multiple Servers

When you customize a tracking policy, you can select one or multiple servers. Here are some 
considerations when you customize the policies of multiple servers.

• When you select a group of servers that contain both Unix-based (for example, Solaris, 
HP-UX, Linux, and so forth) and Windows-based servers, you cannot add tracking policy 
entries. (You can always add entries when you select a single server.) 

• When you select a group of servers made up entirely of either Unix-based servers or 
entirely of Windows-based servers, you have the option of making new tracking policy 
entries. The policy entries are added to all servers that you select. 

• When you select a group of servers made up entirely of either Unix-based servers or of 
Windows-based servers, you have the option of editing a tracking policy entry. Any policy 
entry that can be edited can also be added to all selected servers (if it is not already 
common to all of them). 

It can take 20 seconds or longer to customize polices when you select six or more servers.

Adding or Editing Customized Tracking Policy Entries

Use the following procedure to add or edit tracking policy entries for a server or set of servers 
running the same general type of operating system. If you select a set of servers running both 
Windows and Unix operating systems, you cannot add tracking policy entries. 

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the server whose policy you want to edit. 
(Alternatively, you can click Manage Servers and then select the server from the server 
list.) 

3 Select the server or set of servers that you want to add server-based tracking policy 
entries to, as Figure 17 shows.

Figure 17 Selecting Servers    

4 From the Configuration Tracking drop-down menu, select Edit Tracking Policies. The 
Configuration Tracking: Edit Tracking Policies page appears, as Figure 18 shows.
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Figure 18 Configuration Tracking: Edit Tracking Policies Page 

5 Click Add Entry to create a new policy entry. To edit an existing entry, click the link for 
the entry in the Target field.

6 Define the target, select the type, and select the actions to be performed on the target.
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Table 7 describes each of the selections that you must make.  

7 Click Save to add the entry to the tracking policy. 

Table 7 Editing Configuration Tracking Policies

Field Description

Type File: Monitor the file specified in the target field.

Directory: Monitor all the files in the directory specified in the target 
field. 

The following types are available only for Windows servers:

Windows Registry: Specify key in target field.

IIS Metabase: Entire Metabase is monitored; do not specify target.

COM + Registration Database: Entire Registry is monitored; do not 
specify target.

Target If you selected the file type, specify the full path (including the drive letter 
on Windows servers) of the file that you want to monitor.

If you selected the directory type, specify the full path of the directory 
(including the drive letter on Windows machines) that you want to monitor. 
You also have the option of monitoring subdirectories. (Select the include 
subdirectories check box.)

If you select the file or directory type, you can use wildcards in the target. 
(See the SA Policy Setter Guide for more information about Configuration 
Tracking Policy Targets and Wildcards.)

If you selected the Windows Registry type, specify the Windows registry 
key. This key and all its subkeys are backed up. Use standard syntax for 
Windows Registry keys (For example, HKEY_LOCAL_MACHINE\SOFTWARE)

If you selected the IIS Metabase or COM + Registration Database type, you 
do not specify the target. 

Actions (you 
can select 
multiple 
options)

Backup: Back up the specified file, directory, COM + Registration 
Database, Windows Registry keys, or IIS Metabase.

Email Backup Notification List for Server: Send an email to the 
backup notification list for the selected server. (Not available for Windows 
Registry.) See Creating the Email Notification List on page 334 for more 
information.

Email: Send an email to the address or addresses specified in this field 
when a change is detected. Use a comma-separated list for multiple email 
addresses. (Not available for Windows Registry.) 

Log: Add an entry to the server’s system log when a change is detected. 
(Not available for Windows Registry.) 

You can choose to write the following types of log entries to the server’s 
system log: 

Info

Warning

Error
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8 If you want continue to add entries to the tracking policy, click Add Entry and repeat this 
procedure. 

Changes do not take effect until you perform a Configuration Tracking policy reconcile. 

Disabling Customized Tracking Policy Entries

Perform the following steps to disable customized tracking policy entries:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 From the Configuration Tracking drop-down menu, select Edit Tracking Policies.

The Configuration Tracking: Edit Tracking Policies page appears.

4 Select the tracking policy entry or entries that you want to disable. 

5 Click Disable to disable the tracking policy entries that you selected.

Changes do not take effect until you perform a Configuration Tracking policy reconcile.

Enabling Customized Tracking Policy Entries

Perform the following steps to re-enable tracking policies:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 From the Configuration Tracking drop-down menu, select Edit Tracking Policies.

The Configuration Tracking: Edit Tracking Policies page appears.

4 From the View menu, select Disabled Entries and then click Update.

5 Select the tracking policy entry or entries that you want to disable. 

6 Click Enable to disable the tracking policy entries that you select.

Changes do not take effect until you perform a Configuration Tracking policy reconcile.

Viewing a Server’s Tracking Policy

Perform the following steps to view a server’s tracking policy:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 From the Configuration Tracking drop-down menu, select Edit Tracking Policies. The 
tracking policy entries display. 
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4 Click the Tracking Policy link to display the server’s tracking policy.

Reconciling Customized Tracking Policies

When you create or edit any customized tracking policy entries, the entries are not deployed 
to your servers until you perform a configuration tracking reconcile. 

A configuration tracking reconcile is not the same as a standard HP Server Automation 
remediate. Performing a standard remediate does not deploy your tracking policies to your 
servers.

A configuration tracking reconcile deploys all configuration polices, not just the customized 
policies. 

Perform the following steps to reconcile the tracking policy to the servers whose policies you 
customized:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 From the Configuration Tracking drop-down menu, select Reconcile Tracking Policies.

The Track Configurations: Preview Reconcile page appears and displays the progress of 
the test reconcile. 

4 After the test reconcile completes successfully, click Reconcile to perform the actual 
reconcile operation.

The Track Configurations: Reconcile page appears.

5 If you want to see more information about the changes made during the reconcile 
operation, click View Details. Otherwise, click Done.

Enabling and Disabling Configuration Tracking on Servers

You can enable or disable Configuration Tracking on any server or set of servers in your 
SA-managed environment. 

Disabling Configuration Tracking is not the same as disabling an individual tracking policy 
entry (See Disabling Customized Tracking Policy Entries on page 339 for more information.) 
Disabling Configuration Tracking stops all configuration tracking activity on the selected 
server. 

Disabling configuration tracking, however, does not change a server’s tracking policy in any 
way. If you later re-enabled configuration tracking on the server, the server still has the same 
tracking policy that it did before you disabled it. 

By default, Configuration Tracking is disabled on all managed servers. It is not necessary, 
however, to manually enable configuration tracking in order to turn on the Configuration 
Tracking feature. Configuration Tracking is automatically enabled on a server when you 
reconcile its configuration tracking policies, and you must perform a reconcile in order to 
deploy tracking policies. 
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If you want configuration tracking to remain disabled on a server, be careful not to perform a 
configuration tracking reconcile on the server. (You can, however, still perform a regular 
reconcile.)

Perform the following steps to enable or disable configuration tracking:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 Under the Configuration Tracking drop-down menu, select Enable/Disable. A list that 
displays the state (Enabled/Disabled) of the servers that you selected, as Figure 19 shows.

Figure 19 Enable/Disable Configuration Tracking Page 

4 Under the Tracking field, select Enabled or Disabled to enable or disable configuration 
tracking on the selected server.

5 Click Save to commit the changes. 

Manual Backups

On a server or set of servers, you can perform a manual backup of all tracked configuration 
files and databases for which you have selected the backup action. Manual backups can be 
useful as a precaution before making changes to configuration files. If a problem arises, you 
can then immediately restore a backed-up configuration file or database to its previous state.

Manual backups are full backups. All tracked configuration files and databases for which the 
backup action has been selected are backed up, not just the files that have changed.

Performing Manual Backups

Perform the following steps to perform a manual backup:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 
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3 From the Configuration Tracking drop-down menu, select Perform Backup Now.

4 If you do not want to use the default backup name (Manual Backup), type a new name in 
the backup name field. If you provide a backup name, you can later perform a search for 
backup names to find this backup point. Backup names do not have to be unique. 

5 Click Start Backup. The backup progress displays.

6 When the backup is completed, you can click View Details to review the list of 
configuration files or configuration databases that have been backed up.

Backup History

HP Server Automation provides a detailed history of backup activity as well as search 
capabilities to find backup points by backup name and to find backed up files by file name. 
This section contains the following topics: 

• Viewing the Backup History

• Viewing the List of Backup Events

• Types of Backup Events

• Backup History Search Options

• Backup Info and Backup Manifest

• File Information and File Versions

• Deleting Backups

Viewing the Backup History

Perform the following steps to view the backup history:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 From the Configuration Tracking drop-down menu, select View Backup History.

The Track Configurations: View Group Backup History page displays. This page displays 
the backup activity for the servers that you select. Figure 20 shows a sample backup 
history.

Figure 20 Backup History 
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The number of backups that occurred on a particular date displays as a link in the server's 
date column. 

The number of backups refers to the number of backup events (or backup points) when a 
particular type of backup took place. It does not refer to the number of files backed up. For 
example, if a server displays 3 backups in a date column, it could refer to the following three 
backup events:

• A scheduled incremental backup that backed up four files

• A second scheduled incremental backup that backed up 10 files

• A manual backup that backed up 30 files

Viewing the List of Backup Events

To view the list of individual backup events, click the link that displays the number of 
backups in the desired date column. Figure 21 shows a page with a list of backup events.

Figure 21 Backup Events 
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Types of Backup Events

In addition to information such as the date and time the backup occurred, the list of backup 
events indicates the type of backup. Table 8 describes the type of backup events that can 
occur.  

Backup History Search Options

By default, you see the backup history for the past week for the servers that you selected. 

If you want to display a different date range, you have the following options:

• Display the backup history for different date range by selecting a different option in the 
“View Backup History for a” box. 

• Use the “starting from” field to search for backup history from a past date until the 
current date. 

You can use the matching field to search for a backup name within the selected date range. 
Wildcards are allowed (the * and ? characters). If you do not type the full name of the backup, 
you must use a wildcard for any missing parts of the name.

The results of this search show the date and number of backup names on that date that match 
the * pattern. When you click the link for the number of backups, a list of the matching 
backup names displays.

Backup Info and Backup Manifest

When you click a backup name (such as Scheduled Backup) anywhere in the backup history, 
the Backup Info and Backup Manifest tabs display.

Backup Info Tab

The Backup Info tab displays general information about a backup event. This information 
includes the name of the backup, the date and time of the backup, and the policies that 
triggered the backup event.

All customized policies are identified as Server Policy, as Figure 22 shows.

Table 8 Types of Backup Events

Type Description

Triggered Full The automatic weekly backup of all tracked files for which the 
backup option was selected. This takes places only if any relevant 
files have changed since the last full backup.

Manual Incremental A backup of all changed files (for which the backup option was 
selected) that occurs before and after a restoration or a rollback. 

Triggered 
Incremental

An automatic backup that occurs when the Server Agent detects a 
change to a tracked file for which the backup option was selected. 
Only changed files are backed up. 

Manual Full A full backup initiated by the user of all tracked files for which the 
backup option was selected.
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Figure 22 Track Configurations: View Backup Triggered Backup Page 

From the Backup Info tab, you can also place the files that were backed up into the Restore 
Queue. See Restoring Backups on page 350 for information about how to use this feature. 

Backup Manifest Tab

The Backup Manifest tab displays the list of files that were backed up during the selected 
backup event, as Figure 23 shows.

Figure 23 Backup Manifest Tab 

Two types of objects are backed up, as seen in the File Type field. 

• File Object in the File Type field indicates that a file has been backed up. You can use the 
entry to restore the file. 

• Directory Contents in the File Type field indicates that a directory object has been backed 
up. The directory object is the directory itself, and not the contents of the directory. You 
can use this entry to restore the directory, but you must select the files inside the directory 
to restore the contents of the directory.

The Entry Type field can have three possible values. The Entry Type identifies the target type 
in the policy entry that caused the file or directory object to be backed up. 

• File Object in the Entry Type field indicates that the file was backed up as the result of a 
file target type.
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• Directory Contents in the Entry Type field indicates that the file or directory object was 
backed up as result of a directory target type. 

• Directory Tree in the Entry Type field indicates that the file or directory object was 
backed up as a result of a directory target type with the include subdirectories option 
selected.

File Information and File Versions

When you click a file or directory name anywhere in the backup history (such as in the 
Backup Info tab), the File Information and File Versions tabs display, as Figure 24 shows.

Figure 24 File Information and File Versions    

The File Info tab displays information about the specific file that you selected. The Policy 
Name refers to the policy that caused the file to be backed up. The Policy Name is the Server 
Policy if the server’s customized tracking policy caused the file to be backed up.

You can place the file that you selected in the Restore Queue by clicking Restore. See 
Restoration of Backed Up Files on page 348 for more information. 

The File Versions tab displays a list of the backed up versions of the file, as Figure 25 shows.
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Figure 25 File Versions 

It displays the backup name and backup type of the file. If you click any of the files, the File 
Info for the file is displayed. You can therefore use the File Versions tab to select a different 
version of the file, and then restore it or download it from the File History.

Deleting Backups

Backups remain in the backup history until you delete them or the server is deactivated. 
Backups are stored in the Software Repository. You should delete old backup events 
periodically to reclaim disk storage from the Software Repository. 

You can delete entire backup events (identified by a backup name); you cannot delete 
individual files from the backup history. 

See the SA Administration Guide for more information about mass deletion of backup files.

Perform the following steps to delete backup points from your backup history:

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 Select the server or set of servers that have backup points that you want to delete.

4 Search for a date that contains the backup points that you want to delete. Click the link 
with the number of backup events that occurred on that date.

5 Select the check boxes for the backup events that you want to delete from the backup 
history.

6 Click Delete. 

The Delete Backup Confirmation page appears.

7 Click Delete Backups. The backups are now deleted.
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Restoration of Backed Up Files

You can use the Configuration Tracking feature to restore configuration files or databases 
that have been backed up. You can restore all files that were backed up during a backup point, 
or you can select and restore individual files from a backup point. HP Server Automation 
allows you to rollback a restoration (for example, return your server's tracked files to the state 
immediately before the restoration).

Overview of Procedures Used to Restore Backed Up Files

This section presents an overview of the procedures you use to restore backed-up 
configuration files and databases. See Restoring Backups on page 350 for information abgout 
the step-by-step procedure.

To restore backed-up configuration files and databases, view the backup history for a server or 
set of servers. The backup history displays entries for each date when a backup occurred. As 
Figure 26 shows, the entry for the date displays how many backup points occurred on that 
date.

Figure 26 Backup Points 

You select the desired backup date, and you can then select one or more backup points that 
occurred on that date. Before you restore the backups, you can review all files that were 
backed up at your selected backup points. You can either choose to restore all backed up files 
from your selected backup points, or you can select the files individually. 

To select the backup, click on the link in the date field that displays the number of backups 
that were performed on that date. 

Restore Queue

This section provides information on the restore queue within HP Server Automation and 
contains the following topics:

• Storing files in the Restore Queue

• Incremental Backups for Restoration and Rollbacks

• Entries for Directories in the Backup History

• File Not Found Entries

• Restoring Backups

• Rolling Back Restored Files
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Storing files in the Restore Queue

When you click Restore, the files that you selected are placed in the Restore Queue and the 
View Restore Queue and Perform Restore page appears. You can then review and select files 
from all the backup points that you selected.

If you do not want to restore the files at this time, you can perform other actions and the files 
will remain in the Restore Queue as long as your session is active (even if you leave this page). 
You can also return to the backup history and select other files to put in the Restore Queue. 

When you are ready to restore the backups, return to the Track Configurations: Select a Task 
page and click the View Restore Queue and the Perform Restore link. 

Incremental Backups for Restoration and Rollbacks

To make rollbacks possible, HP Server Automation performs two automatic incremental 
backups. The first backup occurs immediately before the restoration, and the second occurs 
immediately after the restoration. Similarly, in order to undo a rollback, HP Server 
Automation performs two automatic incremental backups, one before and one after a rollback. 

These backups do not occur if all the files you have selected to restore are identical to the files 
already on the server. In such a case, the restoration does not in fact change any files on the 
server, and the rollback option is not available (there are no changes to rollback). 

Entries for Directories in the Backup History

As discussed in the “Special Considerations for Directory and Wildcard Targets” in the SA 
Policy Setter Guide, if you are tracking a directory and the contents of the directory change, 
the action that you selected is triggered for the directory object itself and for the files that 
changed. The only exception occurs when a file is deleted from the directory. In that case, the 
action is triggered for the directory object alone. 

If you selected the backup action for the directory target, when the directory contents change, 
the directory object is backed up as well as the changed files. When a file is deleted, however, 
only the directory object is backed up.

If you restore files contained in a directory without selecting the entry for the directory object, 
the directory is re-created on the server if it does not already exist. If you do select the entry 
for the directory object, however, you can ensure that the directory object is restored with the 
same properties (such as permissions and time stamp) it had at the selected backup event.

File Not Found Entries

If you are monitoring specific files (as opposed to files monitored in tracked directories and 
files monitored as the result of wildcard targets), the backup history can contain entries 
noting “file not found” if the file does not exist on the server, or if the file is later deleted on the 
server. Similarly, if you are monitoring specific directories (opposed to monitoring directories 
through wildcard targets), the backup directory can contain “file not found” entries if the 
directory does not exist on the server, or if the directory is later deleted. 

If you select and restore “file not found” entry and the file exists on the server, the file is 
deleted (it is reverted to the state of the backup event that you selected.) 
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Exercise caution in restoring entries for deleted directories. If the directory exists on your 
server and the directory contains files, both the directory and its contents will be deleted.

Restoring Backups

Perform the following steps to restore backed-up configuration files: 

1 From the navigation panel in the SAS Web Client, click Servers.

2 Click Server Search to search for the desired servers. (Alternatively, you can click 
Manage Servers and then select the server from the server list.) 

3 Under the Configuration Tracking drop-down menu, select View Backup History.

4 Find the date and server that has the backup points that contain the files that you want to 
restore. See Backup History on page 342 for more information about finding backup 
points, viewing backup point details, and viewing lists of backed up files. 

5 Select the check box for the backup points that have files that you want to restore. 

6 Click Restore. 

The files or collection of files from the backup points you selected are placed in the Restore 
Queue. If you do not want to perform a restore now, you can click the Return to Select a 
Task link to leave this page. While your session is active, the files remain in the Restore 
Queue. You can also continue to add more files to the Restore Queue. To return later to the 
Restore Queue, click the View Restore Queue and Perform Restore from the Track 
Configurations: Select a Task page. 

7 If you are ready to restore files, first review the files in the Restore Queue. If you want to 
restore all the files in the queue, you can select the check box at the top of the list. If you 
do not want to restore all of the files in the queue, select the check boxes for the files that 
you want to restore. 

8 Click Restore (or Restore All if you want to restore all of the files in the queue). 

9 After the restoration is complete, you can click View Details for more information about 
the restored files.

Rolling Back Restored Files

You can rollback any files that you selected to restore. By rolling back the files, you revert the 
file to the version that was on the server before you performed the restoration. (In other 
words, you undo the restoration.)

The rollback option is not available if you restored any files that are no longer being 
monitored by the Configuration Tracking feature. You can choose to restore all changed files 
or select the files individually.

Perform the following steps to rollback restored files:

1 After you restore the backups, click Rollback.

The Track Configurations: Restore Queue page appears, which contains the list of files 
that you need to revert in order to rollback the tracked configuration files to their previous 
state. 

This list might not contain all the files that you selected for your original restore. If any of 
the files that you selected during your original restore are identical to the files already on 
the server, they do not need to be rolled back. Only the files that changed display.
350 Chapter 12



2 If you want to rollback all the changed files, click Restore All. Otherwise, you can select 
the individual files that you want to rollback and click Restore. 

The Track Configurations: Restore Progress page appears.

Exercise caution in restoring entries for deleted directories. If the directory exists on your 
server and the directory contains files, both the directory and its contents will be deleted.
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A Communication Test Troubleshooting
Overview of Agent Communication Tests

The Communication Test performs the following diagnostic tests to determine if an Agent is 
reachable: 

• Command Engine to Agent (AGT): Determines if the Command Engine can communicate 
with the Agent. The Command Engine is the HP Server Automation component that 
enables distributed programs to run across many servers. The Command Engine handles 
the entry of scripts into the SA Model Repository (the script storage location in HP Server 
Automation) and the versioning of stored scripts.

• Crypto Match (CRP): Checks that the SSL cryptographic files that the Agent uses are 
valid.

• Agent to Command Engine (CE): Verifies that the Agent can connect to the Command 
Engine and retrieve a command for execution.

• Agent to Data Access Engine (DAE): Checks whether or not the Agent can connect to the 
Data Access Engine and retrieve its device record. The Data Access Engine provides an 
XML-RPC interface to the Model Repository that simplifies interaction with various 
clients such as the SAS Web Client, system data collection, and monitoring agents on 
servers.

• Agent to Software Repository (SWR): Determines if the Agent can establish an SSL 
connection to the Software Repository. The Software Repository is the central repository 
for all software that the SA system technology manages. It contains software packages for 
operating systems, applications, databases, customer code, and software configuration 
information.

• Machine ID Match (MID): Checks that the Machine ID (MID) on the server matches the 
MID registered in the Model Repository for the Agent. 

When the test run finishes, it returns results that show either success or failure for each test 
run on each server. For each failed test, the nature of failure is listed by error type in the error 
details column of the Communication Test window. In some cases, the failure of one test might 
prevent other tests from being executed. 

See Agent Reachability Communication Tests on page 84 for information about how to run a 
Communication Test. 

Command Engine to Agent (AGT)

The Command Engine to Agent (AGT) communications test system checks that the Command 
Engine can initiate an SSL connection to the Agent and execute an XML/RPC request.

The thirteen possible results are:
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— AGT – OK

— AGT – Untested

— AGT – Unexpected error

— AGT – Connection refused

— AGT – Connection time-out

— AGT – Request time-out

— AGT – Server never registered

— AGT – Realm is unreachable

— AGT — Tunnel setup error

— AGT — Gateway denied access

— AGT — Internal Gateway error

— AGT — Gateway could not connect to server

— AGT — Gateway time-out

AGT – OK

No troubleshooting necessary.

AGT – Untested

This result is returned when a functional area cannot be tested because of a previous failure 
that prevents further testing. For example, if the Command Engine cannot contact the Agent, 
then no other tests are possible.

What Can I Do If a Test Is Not Run During an AGT Test?

First resolve all tests that failed, and then run the Communication Test again.

AGT – Unexpected error

This result indicates that the test encountered an unexpected error.

What Can I Do If I Get an Unexpected Error? 

First resolve all tests that failed, and then run the Communication Test again. If the 
unexpected error recurs, check to see if any additional details in the error message indicate 
the problem. If the error cannot be resolved, contact Hewlett Packard Customer Support.

AGT – Connection refused

This result indicates that the Command Engine is receiving a TCP reset packet when it 
attempts to connect to the Agent on port 1002. The likely cause is that the Agent is not 
running. A firewall might also be blocking the connection.
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What Can I Do If the Connection is Refused During an AGT Test?

1 Log into the server and confirm that the Agent is running. See Verifying that an Agent is 
Running on page 374 in this appendix for more information.

2 If the Agent is not running, restart the Agent. See Restarting a Server Agent on page 375 
in this appendix for more information.

3 From the managed server, use netstat to confirm that a socket is in listen mode on port 
1002. If not, stop and restart the Agent.

4 From the server itself, use Telnet to connect to the IP address of the server where the 
Agent is installed and port (1002) that the Agent is listening on. If this does not succeed, 
stop and restart the Agent.

5 Verify that the Management IP address that HP Server Automation is using to reach the 
server is the correct address. See Checking Management IP of a Managed Server on 
page 375 in this appendix for more information. If the IP addresses do not match, stop and 
restart the Agent, then rerun the test.

6 If the previous steps are performed and the test still fails, the problem is likely caused by 
either a software-based firewall on the server itself or an external firewall blocking the 
connection.

AGT – Connection time-out

This result indicates that the Command Engine is not receiving any reply packets when it 
attempts to initiate a TCP connection to the Agent on port 1002. The likely cause is that the 
server is not running, or that the IP address that HP Server Automation is using to reach the 
Agent is incorrect. (A firewall might also be blocking the connection.) To check the IP address 
that HP Server Automation is using to reach the Agent, see Checking Management IP of a 
Managed Server on page 375.

What Can I Do If the Connection Times Out During an AGT Test?

Follow the same steps used to resolve this issue specified in What Can I Do If the Connection 
is Refused During an AGT Test? on page 355. 

AGT – Request time-out

This result indicates that the Command Engine is able to successfully complete a TCP 
connection to the Agent on port 1002, but no response is received from the Agent in response 
to the XML-RPC request. The likely cause is that the Agent is hung.

What Can I Do If the Request Times Out During an AGT Test?

1 Log into the server and restart the Agent. See Restarting a Server Agent on page 375 in 
this appendix for more information.

2 Check to see whether or not some other process is consistently utilizing an excessive 
amount of the CPU on the server where the Agent is installed. Also check to see if the 
system is performing slowly due to a lack of available memory and/or excessive file IO. In 
any of these cases, the system might be performing too slowly to permit the Agent to 
respond to the test in a timely manner.
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AGT – Server never registered

This test indicates that the server being tested has neither been registered with the 
Command Engine, nor can it communicate with the Command Engine. The cause of this could 
be any number of reasons similar to those in the Agent to Command Engine (CE) test. It is 
also possible (but unlikely) that the Agent was installed but never started.

What Can I Do If the Server Has Not Been Registered with the Command Engine During an 
AGT Test? 

To troubleshoot this error, use the following procedures: 

1 Ensure that the Agent is running. For these instructions, See Verifying that an Agent is 
Running on page 374 in this appendix for more information.

2 Ensure that the Agent can contact the Command Engine. 

3 If the Agent is in a Satellite facility, ensure that its Gateways are properly configured and 
that it is properly configured to use those Gateways. See Checking Network Gateway 
Configuration on page 375 in this appendix for more information.

4 If the Agent is not in a Satellite:

• Ensure the host name “way” (no quotes) resolves to its valid IP address. See Resolving 
Host Name on page 376 in this appendix for more information. 

• Verify that a connection can be established to port 1018 of way. Use the command 
“telnet way 1018" (or equivalent).

One (or more) of the above checks will fail. To solve that failure, refer to the corresponding 
error code for the Agent to Command Engine (CE) test on page 359, or to the realm 
connectivity and configuration test. 

AGT – Realm is unreachable

The Satellite realm where the managed server is located is unreachable. This means that a 
path of tunnels between the Gateways in the SA core and the realm of the managed server 
cannot be established. 

What Can I Do If the Realm Is Unreachable During an AGT Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a 
Gateway misconfiguration. Contact Hewlett Packard Customer Support for assistance in 
troubleshooting the Gateway network.

AGT — Tunnel setup error

The Command Engine could not establish a connection through any of its defined Gateways. 
This could be due to a network problem, a malfunctioning or failed Gateway, or a Gateway 
misconfiguration. 

What Can I Do If I Get a Tunnel Setup Error During an AGT Test?

Contact your SA administrator.
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AGT — Gateway denied access

The Gateway is working but refused to proxy the connection on behalf of the Agent. This error 
most likely means that the Gateway is misconfigured such that the Gateway will not allow 
the Command Engine access to the Agent. 

What Can I Do If the Gateway is Denied Access During an AGT Test?

Contact your SA administrator.

AGT — Internal Gateway error

Due to an internal error, the Gateway was unable to proxy the connection. This typically 
occurs when the Gateway is overloaded. 

What Can I Do If There is an Internal Gateway Error During an AGT Test?

Contact your SA administrator.

AGT — Gateway could not connect to server

The Gateway could not establish a connection to the Agent. This might be because the Agent 
is not running, or because a firewall might be blocking the connection. 

What Can I Do If the Gateway Couldn’t Connect to the Server During an AGT Test?

If you suspect the Agent is not running, see Verifying that an Agent is Running on page 374. 
To make sure that the Gateway can establish a connection to the IP address of the server 
where the Agent is installed, try to ping the IP address of the server where the Agent is 
installed. 

AGT — Gateway time-out

The Gateways on the two ends of a tunnel could not communicate with each other, most likely 
due to a network connectivity problem. 

What Can I Do If the Gateway Times Out During an AGT Test

Ensure that network connectivity is available between the Gateways in the path between the 
realm of the managed server and the SA core. 

Crypto Match (CRP)

This test checks that the SSL cryptographic files that the Agent uses are valid.

The five possible results are: 

— CRP – OK
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— CRP – Untested

— CRP – Unexpected error

— CRP – Agent certificate mismatch

— CRP – SSL negotiation failure

CRP – OK

No troubleshooting necessary.

CRP – Untested

This result is returned when a functional area cannot be tested because of a previous failure 
that prevents further testing. For example, if the Agent cannot be reached, then no other tests 
are possible.

What Can I Do If a Test Is Not Run During a CRP Test?

First resolve all tests that failed, and then run the Communication Test again.

CRP – Unexpected error

This result indicates that the test encountered an unexpected error.

What Can I Do If I Get an Unexpected Error During a CRP Test? 

First resolve all tests that failed, and then run the Communication Test again. If the 
unexpected error recurs, check to see if any additional details in the error message indicate 
the problem. If the error cannot be resolved, contact Hewlett Packard Customer Support.

CRP – Agent certificate mismatch

This result indicates that the SSL certificate that the Agent is using (cogbot.srv) does not 
match the SSL certificate that is registered with HP Server Automation for that Agent. 

What Can I Do If I Get a Certificate CN Mismatch During a CRP Test?

Use the Recert Agent Custom Extension to issue a new certificate to the Agent.

CRP – SSL negotiation failure

This result indicates that the Agent is not accepting SSL connections for the SA core. (The SA 
core is the entire collection of servers and services that provide HP Server Automation 
services.) The likely cause of this error is that one or more files in the Agent crypto directory 
are missing or are invalid.
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What Can I Do If I Get an SSL Negotiation Failure During an CRP Test?

Run the Server Recert custom extension in the “set allow recert flag only” mode on the server, 
and then Run the Server Agent Installer with the “-c” switch.

Reinstalling the Agent with the “-c” option (“c” stands for “clean”) removes all certs on the 
server and also removes the MID file, which forces the Agent to retrieve a new MID from the 
Data Access Engine. 

• See Agent Reachability Communication Tests on page 84 for more information about how 
to install an Server Agent using the “-c” switch.

After you reinstall the Agent, run the test again to check if the Agent is now reachable. 

Agent to Command Engine (CE)

This test checks that the Agent can connect to the Command Engine and retrieve a command 
for execution.

The sixteen possible results are:

— CE – OK

— CE — Untested

— CE – Unexpected error

— CE – Connection refused

— CE – Connection time-out

— CE – DNS does not resolve

— CE — Old Agent version

— CE – Realm is unreachable

— CE – No Gateway defined

— CE – Tunnel setup error

— CE – Gateway denied access

— CE – Gateway name resolution error

— CE – Internal Gateway error

— CE – Gateway could not connect to server

— CE – Gateway time-out

— CE — No callback from Agent

CE – OK

No troubleshooting necessary.
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CE — Untested

This result is returned when a functional area cannot be tested because of a previous failure 
that prevents further testing. For example, if the Agent cannot reach the Command Engine, 
then no other tests are possible.

What Can I Do If a Test Is Not Run During a CE Test?

First resolve all tests that failed, and then run the Communication Test again.

CE – Unexpected error

This result indicates that the test encountered an unexpected condition.

What Can I Do If I Get an Unexpected Error During a CE Test? 

First resolve all tests that failed, and then run the Communication Test again. If the 
unexpected error recurs, check to see if any additional details in the error message indicate 
the problem. If the error cannot be resolved, contact Hewlett Packard Customer Support.

CE – Connection refused

This result indicates that the Agent is receiving a TCP reset packet when attempting to 
connect to the Command Engine on port 1018. The likely cause is that the Agent is connecting 
to the wrong IP address. In other words, the Agent does not know the correct IP address of the 
Command Engine. It is also possible that a firewall might be blocking the connection.

What Can I Do If the Connection is Refused During a CE Test? 

1 Check that the name “way” resolves to its correct IP address. For instructions on how to do 
this, see Resolving Host Name on page 376.

2 Check to make sure there isn't a firewall refusing the connection to this IP address. 

CE – Connection time-out

This result indicates that the Agent is not receiving any reply packets when it attempts to 
initiate a TCP connection to the Command Engine on port 1018. The likely cause is that the 
Agent is connecting to the “wrong” IP address. In other words, the Agent doesn’t know the 
correct IP address of the Command Engine. A firewall might also be blocking the connection.

What Can I Do If the Connection Times Out During a CE Test?

Follow the same steps specified in What Can I Do If the Connection is Refused During a CE 
Test?.

CE – DNS does not resolve

This result indicates that the Agent cannot resolve the host name “way” to a valid IP address. 
In other words, the Agent does not know the correct IP address of the Command Engine.
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What Can I Do If the Command Engine Name Does Not Resolve During a CE Test? 

Log into the server and use a command such as Telnet to confirm that the host name “way” 
can resolve (for example: “telnet way 1018”). If not, check the DNS configuration of the server 
to make sure that the host name “way” is configured to its correct IP address. See Resolving 
Host Name on page 376 in this appendix for more information.

CE — Old Agent version

This result indicates that the Agent was unable to contact the Command Engine, but the test 
was unable to determine the exact cause because the Agent is out of date. 

What Can I Do If the Agent is Out of Date During a CE Test?

If this error occurs, it will likely be for one of two reasons: either the host name of the 
Command Engine (“way”) did not resolve, or the connection was refused.

• If you believe that the host name of the Command Engine (“way”) did not resolve, then 
See CE – DNS does not resolve on page 360 in this appendix for more information. 

• If you determine that the connection was refused, See CE – Connection refused on 
page 360 in this appendix for more information.

Alternatively, you can upgrade the Agent to the latest version (contact Hewlett Packard 
Customer Support) and re-run the test. See Agent Reachability Communication Tests on 
page 84 for more information about how to install an agent.

CE – Realm is unreachable 

The Satellite realm where the managed server is located is unreachable. This error means 
that a path of tunnels between the Gateways in the SA core and the realm of the managed 
server cannot be established. 

What Can I Do if the Realm is Unreachable During a CE Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a 
Gateway misconfiguration. Contact your SA administrator for assistance in troubleshooting 
the Gateway network. 

CE – No Gateway defined

The managed server is in a Satellite realm, but its Agent is not properly configured to use a 
Gateway. Agents located in satellites must use a Gateway to contact the core. 

What Can I Do If No Gateway is Defined During a CE Test?

To troubleshoot this error, try the following: 

1 Create or open the opswgw.args file on the managed server. The opswgw.args file is 
located on the managed server at: 

• Unix/Linux: /etc/opt/opsware/agent

• Windows: %SystemDrive%\Program Files\Common Files\Opsware\etc\agent
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2 Make sure that this file contains a single line as shown: 

opswgw.gw_list: <gw_ip_address>:<gw_port>,<gw_up_address>:<gw_port> 

CE – Tunnel setup error

The Command Engine could not establish a connection through any of its defined Gateways. 
This could be due to a network problem, a malfunctioning or failed Gateway, or a Gateway 
misconfiguration. 

What Can I Do If A Tunnel Setup Occurs Error During a CE Test?

Contact your SA administrator.

CE – Gateway denied access

The Gateway is working, but refused to proxy the connection on behalf of the Agent. This 
error most likely means that the Gateway is misconfigured such that the Gateway will not 
allow the Agent to access the Command Engine. 

What Can I Do if the Gateway is Denied Access During a CE Test?

Contact your SA administrator.

CE – Gateway name resolution error

The server running the Gateway in the SA core was unable to resolve the host name “way”. It 
must be able to do this in order to proxy connections on behalf of managed servers in Satellite 
realms.

What Can I Do if a Name Resolution Error Occurs on the Gateway During a CE Test?

Log into the server where the core Gateway is located and use a command such as ping or host 
to confirm that the host name “way” can be resolved (for example: “host way”).

If you cannot connect, contact your SA administrator so that you can check the DNS 
configuration of the core Gateway server. 

CE – Internal Gateway error

Due to an internal error, the Gateway was unable to proxy the connection. This typically 
occurs when the Gateway is overloaded. 

What Can I Do if an Internal Gateway Error Occurs During a CE Test?

Contact your SA administrator.
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CE – Gateway could not connect to server

The Gateway could not establish a connection to the Command Engine. The situation might 
be because the Command Engine is not running, or because the Gateway is resolving the 
Command Engine host name (“way”) to the wrong IP address. It is also possible that a firewall 
might be blocking the connection. 

What Can I Do if the Gateway Can’t Connect to Server During a CE Test?

Check that the name “way” resolves to the correct IP address and that the Gateway can 
establish a connection to port 1018 at that IP. See Resolving Host Name on page 376 and 
Verifying that a Port is Open on a Managed Server on page 374 in this appendix.

CE – Gateway time-out

The Gateways on the two ends of a tunnel could not communicate with each other, most likely 
due to a network connectivity problem. 

What Can I Do if the Gateway Times Out During a CE Test?

Ensure that network connectivity is available between the Gateways in the path between the 
realm of the managed server and the SA core. 

CE — No callback from Agent

The Command Engine was able to contact the Agent, but the Agent did not call back to 
retrieve its command. However, the Agent reports that it can connect to a Command Engine. 
This most likely means that the managed server's name resolution mechanism (such as DNS) 
is not configured to point the server to a different SA core facility than is currently stored for 
the server by HP Server Automation.

What Can I Do if There is No Callback from Agent?

It is possible that the MID file is missing. If the MID file is missing, it can be recreated easily 
by creating a file called 'mid' in the correct location which contains the value of the “Server 
ID” from the Server’s Properties page in the SAS Web Client. 

If the MID file is not missing, then ensure that the server's name resolution mechanism (DNS, 
NIS, and so on) is properly configured so that the host names “spin” and “way” resolve to the 
appropriate IP addresses or SA core services in the same core, and that those hosts can be 
reached from the server on ports 1004 and 1018, respectively. If this is the case, it is likely 
that the server has been redirected to a different core recently, and the Agent has not yet 
registered, which will cause HP Server Automation to update its records. It this issue remains 
unresolved for more than 12 hours, contact Hewlett Packard Customer Support.

Agent to Data Access Engine (DAE)

This test checks that the Agent can retrieve its device record from Data Access Engine. The 
fifteen possible results are:
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— DAE – OK

— DAE – Untested

— DAE – Unexpected error

— DAE – Connection refused

— DAE – Connection time-out

— DAE – DNS does not resolve

— DAE – Old Agent version

— DAE – Realm is unreachable

— DAE – No Gateway defined

— DAE – Tunnel setup error

— DAE – Gateway denied access

— DAE – Gateway name resolution error

— DAE – Internal Gateway error

— DAE – Gateway could not connect to server

— DAE – Gateway time-out

DAE – OK

No troubleshooting necessary.

DAE – Untested

This result is returned when a functional area cannot be tested, because of a previous failure 
that prevents further testing. For example, if the Agent cannot reach the Data Access Engine 
then no other tests are possible.

What Can I Do If a Test Is Not Run During a DAE Test?

First resolve all tests that failed, and then run the Communication Test again.

DAE – Unexpected error

This result indicates that the test encountered an unexpected condition.

What Can I Do If I Get an Unexpected Error During a DAE Test? 

First resolve all tests that failed, and then run the Communication Test again. If the 
unexpected error recurs, check to see if any additional details in the error message indicate 
the problem. If the error cannot be resolved, contact Hewlett Packard Customer Support.
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DAE – Connection refused

This result indicates that the Agent is receiving a TCP reset packet when attempting to 
connect to the Data Access Engine on port 1004. The likely cause is that the Agent is 
connecting to the wrong IP address. A firewall might also be blocking the connection. 

What Can I Do If the Connection is Refused During a DAE Test?

1 Check that the name “spin” resolves to its correct IP address. See Resolving Host Name on 
page 376 in this appendix for more information. 

2 Check to make sure that a firewall is not refusing the connection to this IP address.

DAE – Connection time-out

This result indicates that the Agent is not receiving any reply packets when it attempts to 
initiate a TCP connection to the Data Access Engine on port 1004. The likely cause is that the 
Agent is connecting to the wrong IP address. In other words, the Agent does not know the 
correct IP address of the Command Engine. A firewall might also be blocking the connection.

What Can I Do If the Connection Times Out During a DAE Test?

Follow the same steps specified in What Can I Do If the Connection is Refused During a DAE 
Test? on page 365.

DAE – DNS does not resolve

This result indicates that the Agent cannot resolve the host name “spin” to a valid IP address. 
In other words, the Agent does not know the correct IP address of the Data Access Engine.

What Can I Do If the Data Access Engine Name Does Not Resolve During a DAE Test? 

Log into the server and use a command such as Telnet to confirm that the host name “spin” 
can be resolved (for example: telnet spin 1004”). If not, check the DNS configuration of the 
server to make sure that the host name “spin” is configured to its correct IP address. See 
Resolving Host Name on page 376 in this appendix for more information.

DAE – Old Agent version

This result indicates that the Agent was unable to contact the Data Access Engine, and the 
test is unable to determine the exact cause, because the Agent is out of date. 

What Can I Do If the Agent is Out of Date During an DAE Test?

If this error occurs, it will likely be for one of two reasons: either the host name of the Data 
Access Engine (“spin”) did not resolve, or the connection was refused. 

• If you believe that the host name of the Data Access Engine (“way”) did not resolve, then 
see DAE – DNS does not resolve on page 365. 

• If you determine that the connection was refused, see DAE – Connection refused on page 
365.
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Alternatively, you can upgrade the Agent to the latest version (contact Hewlett Packard 
Customer Support) and re-run the test. See Agent Reachability Communication Tests on 
page 84 for information about how to install an agent. 

DAE – Realm is unreachable

The Satellite realm where the managed server is located is unreachable. This error means 
that a path of tunnels between the gateways in the SA core and the realm of the managed 
server cannot be established. 

What Can I Do if the Realm is Unreachable During a DAE Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a 
Gateway misconfiguration. Contact your SA administrator for assistance in troubleshooting 
the Gateway network

DAE – No Gateway defined

The managed server is in a Satellite realm, but its Agent is not properly configured to use a 
Gateway. Agents located in satellites must use a Gateway to contact the core. 

What Can I Do If No Gateway is Defined During a DAE Test?

To troubleshoot this error, try the following: 

1 Create or open the opswgw.args file on the managed server. The opswgw.args file is 
located on the managed server at: 

• Unix/Linux: /etc/opt/opsware/agent 

• Windows: %SystemDrive%\Program Files\Common Files\Opsware\etc\agent 

2 Make sure this file contains a single line as shown: 

opswgw.gw_list: <gw_ip_address>:<gw_port>,<gw_up_address>:<gw_port> 

DAE – Tunnel setup error

The Data Access Engine could not establish a connection through any of its defined Gateways. 
This could be due to a network problem, a malfunctioning or failed Gateway, or a Gateway 
misconfiguration. 

What Can I Do if a Tunnel Setup Error Occurs During a DAE Test?

Contact your SA administrator.

DAE – Gateway denied access

The Gateway is working, but refused to proxy the connection on behalf of the Agent. This 
error most likely means that the Gateway is misconfigured such that the Gateway will not 
allow the Agent to access the Data Access Engine. 
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What Can I Do if the Gateway is Denied Access During a DAE Test?

Contact your SA administrator.

DAE – Gateway name resolution error 

The server running the Gateway in the SA core was unable to resolve the host name “spin”. It 
must be able to do this in order to proxy connections on behalf of managed servers in Satellite 
realms.

What Can I Do if There is a Name Resolution Error on the Gateway During a DAE Test?

Log into the server where the core Gateway is located and use a command such as ping or host 
to confirm that the host name “spin” can be resolved (for example: “host spin”).

If you cannot connect, contact your SA administrator so that you can check the DNS 
configuration of the core Gateway server. 

DAE – Internal Gateway error

Due to an internal error, the Gateway was unable to proxy the connection. This typically 
occurs when the Gateway is overloaded. 

What Can I Do if an Internal Gateway Error Occurs During a DAE Test?

Contact your SA administrator.

DAE – Gateway could not connect to server

The Gateway could not establish a connection to the Data Access Engine. This might be 
because the Data Access Engine is not running, or because the Gateway is resolving the Data 
Access Engine host name (“spin”) to the wrong IP address. It is also possible that a firewall 
might be blocking the connection. 

What Can I Do if the Gateway Can’t Connect to Server During a DAE Test?

Check that the name “spin” resolves to the correct IP address and that the Gateway can 
establish a connection to port 1018 at that IP. See Resolving Host Name on page 376 in this 
appendix for more information and See Verifying that a Port is Open on a Managed Server on 
page 374 in this appendix for more information.

DAE – Gateway time-out

The Gateways on the two ends of a tunnel could not communicate with each other, most likely 
due to a network connectivity problem. 

What Can I Do if the Gateway Times Out During a DAE Test?

Ensure that network connectivity is available between the Gateways in the path between the 
managed server's realm and the SA core. 
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Agent to Software Repository (SWR)

This test checks that the Agent can establish an SSL connection to the Software Repository. 

There 16 possible results are: 

— SWR – OK

— SWR – Untested

— SWR – Unexpected error

— SWR – Connection refused

— SWR – Connection time-out

— SWR – DNS does not resolve

— SWR – Old Agent version

— SWR - Server identification error

— SWR – Realm is unreachable

— SWR – No Gateway defined

— SWR – Tunnel setup error

— SWR – Gateway denied access

— SWR – Gateway name resolution error

— SWR – Internal Gateway error

— SWR – Gateway Could not connect to server

— SWR – Gateway time-out

SWR – OK

No troubleshooting necessary.

SWR – Untested

This result is returned when a functional area cannot be tested because of a previous failure 
that prevents further testing. For example, if the Agent cannot reach the Software Repository, 
then no other tests are possible.

What Can I Do If a Test Is Not Run During a SWR Test?

First resolve all tests that failed, and then run the Communication Test again.

SWR – Unexpected error

This result indicates that the test encountered an unexpected condition.
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What Can I Do If I Get an Unexpected Error During a SWR Test? 

First resolve all tests that failed, and then run the Communication Test again. If the 
unexpected error recurs, check to see if any additional details in the error message indicate 
the problem. If the error cannot be resolved, contact Hewlett Packard Customer Support.

SWR – Connection refused

This result indicates that the Agent is receiving a TCP reset packet when attempting to 
connect to the Software Repository on port 1003. The likely cause is that the Agent is trying to 
connect to the wrong IP address. A firewall might also be blocking the connection.

What Can I Do If the Connection is Refused During an SWR Test? 

1 Check that the name “theword” resolves to the correct IP address. For this information, 
see Resolving Host Name on page 376. 

2 Check to make sure that a firewall isn’t refusing the connection to this IP address.

SWR – Connection time-out

This result indicates that the Agent is receiving a TCP reset packet when attempting to 
connect to the Software Repository on port 1003. The likely cause is that the Agent is 
connecting to the wrong IP address. In other words, the Agent does not know the correct IP 
address of the Software Repository. A firewall might also be blocking the connection.

What Can I Do If the Connection Times Out During an SWR Test?

Follow the same steps specified in What Can I Do If the Connection is Refused During an 
SWR Test? on page 369.

SWR – DNS does not resolve

This result indicates that the Agent cannot resolve the host name “theword” to a valid IP 
address. In other words, the Agent does not know the correct IP address of the Software 
Repository.

What Can I Do If the Software Repository Name (“theword”) Does Not Resolve During an 
SWR Test? 

Log into the server and use a command such as Telnet to confirm that the host name 
“theword” can be resolved (for example: “telnet theword 1003"). If not, contact your SA 
administrator so that you can check the DNS configuration of the server. 

SWR – Old Agent version

This result indicates that the Agent was unable to contact the Software Repository, and the 
test is unable to determine the exact cause because the Agent is out of date. 
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What Can I Do If the Agent is Out of Date During an SWR Test?

If this error occurs, it will likely be for one of two reasons: either the host name of the 
Software Repository (“theword”) did not resolve, or the connection was refused. 

• If you think that the host name of the Software Repository (“theword”) did not resolve, 
then see SWR – DNS does not resolve on page 369. 

• If you determine that the connection was refused, see SWR – Connection refused on page 
369.

Alternatively, you can upgrade the Agent to the latest version (contact Hewlett Packard 
Customer Support) and re-run the test. See Agent Installation Using ODAD on page 76 for 
information how to install a server agent. 

SWR - Server identification error

Whenever an Agent makes a request of the Software Repository, the identity of the server is 
validated to confirm that the server should be allowed access to the information requested. 
This error indicates that the Software Repository was unable to identify the server being 
tested, or incorrectly identified that server.

What Can I Do If I Get a Server Identification Error?

The Software Repository identifies servers based on the incoming IP address of the request. 
To troubleshoot this error, try the following: 

1 Check the Device Properties tab for the server in the SAS Web Client to see if Network 
Address Translation (NAT) is in use. If it is, make sure that NAT is statically configured, 
and that only one server is using the NAT address. If multiple servers are using the same 
IP address, you will need to reconfigure the NAT device. See Network Address 
Translation (NAT) for Managed Servers on page 226 for more information.

2 If the Agent is installed on a cluster, check that each node in the cluster has a unique IP 
address at which it can be reached. You might have to add static routes to the server to 
ensure that connections made from that server to the SA core use the unique IP. If NAT is 
not in use, you can alternately mark the correct interface as the “primary” interface 
through the Network Configuration tab for the server in the SAS Web Client. See 
Network Address Translation (NAT) for Managed Servers on page 226 for more 
information.

3 The server's IP address might have changed recently. If this is the case, stop and restart 
the Agent. For instructions on how to stop and start an Agent, see Restarting a Server 
Agent on page 375.

SWR – Realm is unreachable

The Satellite realm where the managed server is located is unreachable. This error means 
that a path of tunnels between the gateways in the SA core and the realm of the managed 
server cannot be established. 
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What Can I Do if the Realm is Unreachable During a SWR Test?

This error could be due to a network problem, a malfunctioning or failed Gateway, or a 
Gateway misconfiguration. Contact your SA administrator for assistance in troubleshooting 
the Gateway network.

SWR – No Gateway defined

The managed server is in a Satellite realm, but its Agent is not properly configured to use a 
Gateway. Agents located in satellites must use a Gateway to contact the core. 

What Can I Do If No Gateway is Defined During a SWR Test?

To troubleshoot this error, try the following: 

1 Create or open the opswgw.args file on the managed server. The opswgw.args file is 
located on the managed server at: 

• Unix/Linux: /etc/opt/opsware/agent

• Windows: %SystemDrive%\Program Files\Common Files\Opsware\etc\agent 

2 Make sure that this file contains a single line as shown: 

opswgw.gw_list: <gw_ip_address>:<gw_port>,<gw_up_address>:<gw_port> 

SWR – Tunnel setup error

The Data Access Engine could not establish a connection through any of its defined Gateways. 
This could be due to a network problem, a malfunctioning or failed Gateway, or a Gateway 
misconfiguration. 

What Can I Do If a Tunnel Setup Error Occurs During a SWR Test?

Contact your SA administrator.

SWR – Gateway denied access

The Gateway is working but refused to proxy the connection on behalf of the Agent. This error 
most likely means that the Gateway is misconfigured such that the Gateway will not allow 
the Agent to access the Software Repository. 

What Can I Do if the Gateway is Denied Access During a SWR Test?

Contact your SA administrator.

SWR – Gateway name resolution error

The server running the Gateway in the SA core was unable to resolve the host name 
“theword”. It must be able to do this in order to proxy connections on behalf of managed 
servers in Satellite realms.
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What Can I Do if a Name Resolution Error Occurs on the Gateway During a SWR Test?

Log into the server where the core Gateway is located and use a command such as ping or host 
to confirm that the host name “theword” can be resolved (for example: “host theword”).

If you cannot connect, contact your SA administrator so that you can check the DNS 
configuration of the core Gateway server. 

SWR – Internal Gateway error

Due to an internal error, the Gateway was unable to proxy the connection. This typically 
occurs when the Gateway is overloaded. 

What Can I Do if an Internal Gateway Error Occurs During a SWR Test?

Contact your SA administrator.

SWR – Gateway Could not connect to server

The Gateway couldn't establish a connection to the Software Repository. This error might be 
because the Software Repository is not running, or because the Gateway is resolving the 
Software Repository host name (“theword”) to the wrong IP address. It is also possible that a 
firewall might be blocking the connection. 

What Can I Do if the Gateway Can’t Connect to Server During a SWR Test?

Check that the name “theword” resolves to the correct IP address and that the Gateway can 
establish a connection to port 1018 at that IP address. For more information, see Resolving 
Host Name on page 376 and Verifying that a Port is Open on a Managed Server on page 374.

SWR – Gateway time-out

The Gateways on the two ends of a tunnel could not communicate with each other, most likely 
due to a network connectivity problem.

What Can I Do if the Gateway Times Out During a SWR Test?

Ensure that network connectivity is available between the Gateways in the path between the 
realm of the managed server and the SA core. 

Machine ID Match (MID)

This test checks whether the MID that the Agent reported matches that recorded in the Model 
Repository (SA data repository). 

You can receive four possible errors from the Machine ID (MID) Communication Test:

— MID – OK

— MID – Untested
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— MID – Unexpected error

— MID – MID mismatch

MID – OK

No troubleshooting necessary.

MID – Untested

This result is returned when a functional area cannot be tested, because of a previous failure 
that prevents further testing. For example, if the Agent cannot reach the Model Repository, 
then no other tests are possible.

What Can I Do If a Test Is Not Run During an MID Test?

First resolve all tests that failed, and then run the Communication Test again.

MID – Unexpected error

This result indicates that the test encountered an unexpected condition.

What Can I Do If I Get an Unexpected Error During an MID Test? 

First resolve all tests that failed, and then run the Communication Test again. If the 
unexpected error recurs, check to see if any additional details in the error message indicate 
the problem. If the error cannot be resolved, contact Hewlett Packard Customer Support.

MID – MID mismatch

This result indicates that the MID that the Agent reported does not match the recorded MID 
in the Model Repository for that Agent. The likely cause is that the Command Engine is 
running the test against the wrong Agent.

What Can I Do If the MID is Mismatched During an MID Test?

To troubleshoot this error, try the following: 

1 Check the Device Properties tab for the server in the SAS Web Client to see if NAT is in 
use for this server. If it is, make sure that static, 1-to-1 NAT is being used. HP Server 
Automation requires that all managed servers be reachable on a distinct, consistent IP 
address, so configurations that assign addresses dynamically or use port-based 
translation are not supported. 

2 If the Agent is installed on a cluster, check that each node in the cluster has a unique IP 
address at which it can be reached. You might have to add static routes to the server to 
ensure that connections made from that server to the SA core use the unique IP. If NAT is 
not in use, you can alternately mark the correct interface as the “primary” interface via 
the Network Configuration tab for the server in the SAS Web Client.

3 The IP address might have changed recently. If this is the case, stop and restart the 
Agent. For these instructions, see Restarting a Server Agent on page 375.
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Common Troubleshooting Tasks

The following list of troubleshooting tasks are common to more than one Communication Test 
error: 

• Verifying that an Agent is Running

• Verifying that a Port is Open on a Managed Server

• Restarting a Server Agent

• Checking Management IP of a Managed Server

• Checking Network Gateway Configuration

• Resolving Host Name

Verifying that an Agent is Running

To verify that an Agent is running on a server, perform the following steps: 

1 On Solaris, HP-UX, or AIX, enter this command: 

/usr/ucb/ps auxwww | grep opsware

You should get this result if the Agent is running: 

/opt/opsware/agent/bin/python /opt/opsware/agent/pylibs/shadowbot/
daemonbot.pyc --conf /etc/opt/opsware/agent/agent.args

2 On Linux, enter this command:

ps auxwww | grep opsware

You should get the same result as the preceding step.

3 On Windows, from the Administrative Tools | Services, check to make sure that the 
opswareagent service is running. 

Verifying that a Port is Open on a Managed Server

For some errors, you will need to verify that the port is open on the server where the Agent is 
installed. To do this, perform the following steps: 

1 Check if the port is open. 

2 On Solaris, HP-UX, AIX, or Linux enter: 

netstat -an | grep 1002 | grep LISTEN

If the port is open on the box, you should get back the following:

*.1002 *.* 0      0 24576      0 LISTEN

3 On Windows, at the command prompt enter: 

netstat -an | find "1002" | find "LISTEN"

If the port is open on the box, you should get back the following result:

TCP0.0.0.0:10020.0.0.0:0LISTENING
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4 Confirm that the port is actually open. To do this, from the computer where the Agent is 
installed, Telnet to port 1002 by using both localhost and the external IP address of the 
server. Performing the Telnet will help you confirm that a connection refused message is 
being caused by the lack of an open port on the managed server rather than a problem 
with networking hardware between the core and the managed server.

Restarting a Server Agent

To restart a Server Agent, log onto the managed server and enter the following commands:

Unix:

/etc/init.d/opsware-agent restart

HP-UX: 

/sbin/init.d/opsware-agent restart

AIX: 

/etc/rc.d/init.d/opsware-agent restart

Windows:

net stop opswareagent
net start opswareagent

Checking Management IP of a Managed Server

To check the Management IP of a managed server, perform the following steps: 

1 To view the management IP of the managed server, log into the SAS Web Client.

2 From the Navigation panel, click Servers ➤ Manage Servers. 

3 From the Manage Servers list, click the display name of the server for which you want to 
check the Management IP. 

4 Select the Network tab of the server’s properties. 

5 Check to make sure that the Management IP address matches the IP address of the 
managed server.

Checking Network Gateway Configuration

To check the network Gateway configuration, perform the following steps: 

1 On Solaris, enter this command to check routing table:

netstat -rn

Your results should look like this:

default              192.168.8.1         UG       1   5904

where 192.168.8.1 is the IP of the Gateway.

2 On Linux, enter this command to check routing table:

route -n

Your results should look like this:
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0.0.0.0         192.168.8.1     0.0.0.0         UG    0      0        0 eth0

where 192.168.8.1 is the IP of the Gateway.

3 On Windows, enter this command to check routing table:

route print

Your results should look something like this:

0.0.0.00.0.0.0192.168.8.1192.168.8.12020

where 192.168.8.1 is the IP of the Gateway.

4 In each case, you should also ping 192.168.8.1 (IP) to confirm that you can actually reach 
the Gateway.

Resolving Host Name

All managed servers (those with agents) must be able to resolve unqualified HP Server 
Automation service names for the following components: 

• spin (Data Access Engine)

• way (Command Engine)

• theword (Software Repository)

If you need to ensure that one of these host names resolves correctly, contact your SA 
administrator to find out what qualified host name or IP address these service names should 
resolve to. 

1 Try to ping the host. For example, execute the following command if you wanted to resolve 
the host name, way: 

ping way

2 If the host name cannot resolve, you will get the following errors: 

Linux/Solaris/AIX/HP-UX:

ping: unknown host way

Windows: 

Ping request could not find host way. Please check the name and try again.

3 If the host name can resolve, you might get back various permutations of these types of 
messages (OS independent): 

way is alive

or

pinging way (ip) with 32 bytes of data
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B Agent Utilities
Agent Installation Using the CLI

This section provides information on Agent installation using the Agent Installer CLI and 
contains the following topics:

• Overview of Agent Installation Using the CLI

• Preparation for Agent Installation

• Preassimilation Checklist

• Installing an Agent by using the Agent Installer CLI

• Agent Installer Options

• Example: Agent Installer Command and Options

• Starting an Agent After Installation

• Verifying Agent Functionality

• Augmenting the Information for a Managed Server

• Uninstalling an Agent on Unix and Windows

• Uninstalling Earlier Versions of Agents on Unix

• Uninstalling Earlier Versions of Agents on Windows

Overview of Agent Installation Using the CLI

When you install Agents on existing operational servers, you should synchronize the local 
time on the servers with an external time-server that uses a network time protocol (NTP). 

Installing Agents on servers makes existing operational servers known to HP Server 
Automation so that they can be managed. Assimilating servers into HP Server Automation is 
appropriate when many servers are already functioning in the operational environment and 
need to be managed (for example, when SA technology is initially deployed in a facility). 

Installing an Agent on a server with a pre-built OS into HP Server Automation enables:

• Baseline discovery of the operating system on the server.

• Managing the baseline operating system, including patch management, when the 
operating system is defined in HP Server Automation with the Prepare Operating System 
Wizard.

• Full provisioning and management capabilities for any new applications deployed on the 
server.
377



When installed, the Agent registers the server with the Model Repository. HP Server 
Automation assigns the server to a generic operating system that corresponds to the 
operating system that the Agent discovered during the installation. The server is assigned to 
a placeholder OS node. For each operating system, the SAS Web Client contains a node 
<operating_system_version>/Not Assigned.

The Agent Installer can install Agents when a core is not available to a server. If a 
newly-installed Agent cannot contact a core, the Agent runs in a dormant mode. While 
dormant, it periodically attempts to contact the core. When the core becomes available, the 
Agent performs the initialization tasks, such as hardware and software registration, that 
usually take place when the Agent is first installed.

The server is tracked in the SAS Web Client. However, the server operating system cannot be 
managed while the server is assigned to the generic operating system node. You must 
reassign the server to the operating system that was defined with the OS Provisioning 
feature. 

The server is associated with the default facility for the local instance of HP Server 
Automation.

If the managed server’s IP address does not fall within a specified IP range, the server is 
associated with the default IP range group (Default). The default group is associated with the 
customer Not Assigned. 

See the SA Policy Setter Guide for information about how servers are associated with 
customers.

Users install an Agent on each server. Running an Agent on a server allows HP Server 
Automation to manage the server. To install an Agent, run the Agent Installer.

The Agent Installer is an application that has the following features:

• Can be invoked from the command line or within a script.

• Installs an Agent.

• Logs its decisions and actions.

• Can be operated unattended because user interaction is not required.

The Agent Installer installs the Agent, retrieves cryptographic material, retrieves 
configuration information, and writes a configuration file.

Preparation for Agent Installation

It is recommended that you set up a Windows file share to make the Agent Installer for 
various operating systems available from one place. Setting up a file share allows you to 
install Agents on servers quickly and easily. If this is not possible, the Agent Installer needs to 
be moved by using an alternate file transfer mechanism, such as SFTP. 

At the completion of the Agent installation process, a managed server is assimilated and the 
hardware and software data that the Agent discovered is stored in the Model Repository. 

To use the Patch Management features on Windows NT 4.0 and Windows 2000 servers, you 
must install Internet Explorer (IE) 6.0 or later on the server first because a patch utility 
depends on it. If you do not install IE 6.0 on the server first, the Agent Installer warns you 
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that the Patch Management feature does not work as expected because it checks for IE 6.0 on 
all Window servers. This prerequisite is not required for Windows 2003, because IE 6.0 is 
pre-installed for this operating system.

Preassimilation Checklist

Prior to installation, you should perform the following tasks on the server where the Agent is 
to be installed. Performing these tasks is vital to installing the Agent quickly within 
maintenance windows. 

1 For the Code Deployment & Rollback feature, verify that the following port is accessible 
between the server you will push code from and the server where you will push code to:

– telnet <staging_server> 1002

– telnet <production_server> 1002

2 Because the Agent runs on port 1002, verify that no other applications are using this port. 

– On a Unix server, enter this command from a terminal window:

netstat -an | grep 1002 | grep LISTEN 

– On a Windows server, enter this command from a terminal window:

netstat -an | find "1002" | find "LISTEN"

3 Check for sufficient disk space for Agent installation on the server. 

The Installer checks for the following amounts of free disk space in these directories: 

– 30MB in /opt/opsware (Unix) 

– 100MB in /var/opt/opsware (Unix)

– 30MB in %SystemDrive%\\Program Files\Opsware (Windows)

– 100MB in %SystemDrive%\Program Files\Common Files\Opsware (Windows)

(These default directories can be overridden with parameters at installation time.)

These space requirements might not be enough. The vardir directory is used for dynamic 
content like logs and downloaded packages. If there is not enough disk space for the 
packages during remediation, it will fail.

4 On the Solaris operating system, check for legacy sun4m architecture. Currently, the 
Agent works only for sun4u architecture.

5 For Windows, check the following items:

– At a minimum, NT 4.0 Service Pack 6a must be installed on the server.

– Verify that the Windows Registry has the correct settings:

a Start regedit and locate the following registry key: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control \FileSystem 

b Select the NtfsDisable8dot3NameCreation entry.

c On the Edit menu, click DWORD and verify that the value is set to 0. The value must 
be set to 0. If necessary (because the value is set to 1), change the value by following 
your organization’s IT policies and reboot the server.

6 To install an Agent on a server running Solaris, you must also install the following Solaris 
packages:
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For Python:

SUNWtoo
SUNWtoox

For showrev:

SUNCadm
SUNWlibC
SUNWlibCx
SUNWadmfw

Before you install an Agent on a server, the server must meet certain package and patch 
requirements that vary by operating system, as Table 9 shows.    

Installing an Agent by using the Agent Installer CLI 

The Agent needs administrator-level privileges (root on Unix servers and Local System on 
Windows servers) to manage a server. Therefore, Agent installation needs to be performed as 
root on Unix operating systems and as administrator on Windows operating systems. 

Table 9 Required Patches and Packages for Agent Installation

server operating system required patches

AIX 4.3

AIX 5.1

APAR IY39444

APAR IY39429

NOTE:
If AIX 4.3.3.388, 4.4.4.89, or 5.1.0.3 is installed, the Agent 
Installer displays an error message that indicates the correct 
APAR to install on the server.

HP-UX (10.20, 11.00, 11.11/
11i)

For HP-UX 10.20, PHCO_21018 

Additionally, SW-DIST should be upgraded to the HP 
recommended patch level. You should continue to upgrade 
this package when HP recommends new versions. 

Linux AS 3.0

Linux WS 3.0

Linux ES 3.0

Red Hat Enterprise Linux 3 Update 3 

Solaris 10, 9, 8, 7, and 6 SUNWadmc
SUNWcsl
SUNWcslr (If available, depending on version) 
SUNWcsu
SUNWesu
SUNWlibms
SUNlibmsr (If available, depending on version)
SUNWswmt
It is strongly recommended not to remove packages from the 
SUNWCreq minimal required install cluster, since many 
packages are interdependent and operation beyond that of 
basic SAS functionality may be affected.

Windows 2000 Service Pack 4

Windows NT 4.0 Service Pack 6a
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You can install an Agent on any server listed in “Supported Operating Systems for Managed 
Servers” in User Guide: Server Automation.

Perform the following steps to install an Agent on a server:

1 Log into the server that you want to assimilate by using a remote shell. 

2 For Unix operating systems, change the user login to root (su - root) and for Windows 
operating systems, log in as administrator.

3 From the CLI, download the package that contains the Agent Installer from the:

/var/opt/opsware/agent_installers

directory in the Core to a directory on the server you want to assimilate.

4 Locate the package opsware-agent. 

Each operating system and operating system version has different packages for the Agent 
Installer.

Unix:

opsware-agent-<version>-<system_name>-<system_version>

Red Hat Linux:

opsware-agent-<version>-<system_name>-5CLIENT-<system_version>

Note that Red Hat may use the terms Client and Desktop interchangeably.

Windows:

opsware-agent-<version>-<system_name>-<system_version>.exe

d Click the package name for the Agent Installer that you want to download. From the 
Actions menu, select Export Software. The Browse window appears.

e In the Browse window, provide the location to download the package and Click 
Export. The package is exported to the specified location.

5 From the directory where the Agent Installer was copied, run the Installer by entering the 
correct executable and options for the installation environment.

See Example: Agent Installer Command and Options on page 385 in this appendix for 
more information.
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Agent Installer Options

When you use the Agent Installer CLI, you can include the options that the following table 
shows to control the way that the Agent is installed on a server.   

Table 10 Agent Installer Options

Option Description

-f Forces Agent installation and removes the target 
installation directory if it exists. 

REQUIREMENT:
When using the -f option, you must run the Agent Installer 
as root on Unix operating systems and as the administrator 
on Windows operating systems.

--fingerprint Specifies the fingerprint of the core certificate.

If you specify a value for this option, the agent installer will 
verify that the Certificate Authority certificate used to sign 
the core's SSL certificate matches the value you provided. 
Specifying a value for this option increases security during 
the agent installation process by ensuring that the agent 
attaches itself to the correct core.

To obtain the correct value for the core certificate fingerprint 
option, log on to the core as root (you may need to have an SA 
System Administrator perform this task for you) and run the 
following command:

/opt/opsware/bin/openssl x509 -in /var/opt/
opsware/crypto/agent/opsware-ca.crt -fingerprint 
-noout

The output looks like the following:

SHA1 Fingerprint=D2:3B:F8:72:B9:55:0D: 
DE:97:04:D5:C2:A5:6B:B2:09:5C:0A:0D:7F

The fingerprint is the string of hexadecimal numbers 
following the equal sign:

D2:3B:F8:72:B9:55:0D:DE:97:04:D5:C2:A5:6B:B2:09:5C
:0A:0D:7F

--logfile Specifies the path to the Agent Installer log file. By default, 
the current directory is set as the path.

By default, the log file has the following filename: 

opsware-agent-installer-<date>.log

--loglevel <level> Sets the log level for log messages. 

With this option, specify one of the following levels: error, 
warn, info, trace, or none.

The level error logs the least detail. The level trace logs all 
messages. By default, the log level is set to the log level info. 
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--no_anonymous_ssl 
(-A)

Disables anonymous SSL. This option applies to dormant 
Agents only. This option configures the Agent so that 
browsers cannot connect without a valid certificate.

-o Logs all output to stdout instead of a log file. This option is 
invoked automatically if the default log file or the log file 
passed with the --logfile option cannot be created, for 
example, when running the Agent Installer from 
non-writeable media, such as a DVD.

--opsw_gw-addr-list Specifies the Gateways used during Agent installation.

--reboot During Agent Installation on a Windows server, the Agent 
Installer copies the ogshcap.dll file to the following location: 

%SystemRoot%\system32\ogshcap.dll 

If the file is open or is in use, the Agent Installer is unable to 
copy the ogshcap.dll file. The Agent Installer then informs 
the user whether to restart the machine and copies the file 
after restart. 

You can specify the --reboot Installer option in the 
command line to initiate the reboot at the end of the Agent 
installation. 

--reconcile <type> Reconciles the server against any nodes assigned to the 
server. The <type> can be full or addonly.

full – All nodes in a category are selected and reconcile 
removes software that HP Server Automation did not install. 

addonly – Software installed outside of HP Server 
Automation is not removed.

WARNING:
When assimilating a server that is already functioning in 
the operational environment, use caution when specifying 
the option --reconcile. If you specify this option, you might 
inadvertently uninstall software from the server. 

--remediate Remediates the server against any software policies 
attached to the server.

--resetconf(-r) Resets Agent configuration file to default the settings.

--rpmbin <path> Specifies the path to the RPM binary to use for RPM 
operations. Use this option, when RPM is already installed 
on the server, to point the Agent at the RPM binary.

Use the --withrpm option to install RPM if a usable instance 
of RPM is not already installed. 

NOTE:
It is unnecessary to use this option with the 
--withrpm option.

Table 10 Agent Installer Options (cont’d)

Option Description
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-s Starts the Agent after installing it. By default, the Agent 
Installer does not start the Agent.

--software_policy <id> Attaches server to the software policy <ID>.

--template <ID> Assigns the nodes contained in the template to the server. 
<ID> can be an ID or a full name of a template. 

If this option is specified with the --reconcile option, HP 
Server Automation assigns the nodes in the template to the 
server before reconciling the server.

WARNING:
When assimilating a server that is already functioning in 
the operational environment, use caution when you specify 
the option --template. If you specify this option, you might 
inadvertently uninstall software from the server. 

--withmsi Installs MSI 2.0 along with the Agent. If MSI 2.0 is already 
installed, this option has no effect. Works with Windows NT 
4.0 Service Pack 6a, Windows 2000, and Windows 2003.

--withwmi Installs WMI 1.5 along with the Agent. If WMI 1.5 is already 
installed, this option has no effect. Works with Windows NT 
4.0 Service Pack 6a.

--withrpm Installs the RPM handler with the Agent. By default, an 
Agent is not installed with this option. It is recommended 
that you always include the --withrpm option when you 
install Agents on Solaris servers. 

NOTE:
Use the --withrpm option only with the Agent Installers for 
these operating systems: Solaris 5.6, 5.7, 5.8, and 5.9, and 
AIX 4.3 and AIX 5.1.

On Solaris, RPM 3.0.6 is installed in the directory /opt/
OPSWrpm and the RPM database is installed in the directory 
/var/opt/OPSWrpm/lib/rpm. 

On AIX, RPM 3.0.5 is installed in the directory /opt/
freeware and the RPM database is installed in the directory 
/var/opt/freeware/lib/rpm.

--workdir <path> Specifies the path to the Agent Installer temporary working 
directory. Use this option if the default working directory 
causes problems with installation.

Table 10 Agent Installer Options (cont’d)

Option Description
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Example: Agent Installer Command and Options 

Enter the following command and options to install the Agent for Solaris 5.7 in the default 
directories and log the results of the installation in the log file:

% opsware-agent-14.2.12.5-solaris-5.7 --logfile opsware-agent-installer.log 
--loglevel info

Enter the following command and options to install the Agent for Windows NT 4.0 in the 
default directories and log the results of the installation in the log file:

% opsware-agent-14.2.12.5-win32-4.0.exe --logfile opsware-agent-installer.log 
--loglevel info

Starting an Agent After Installation

If you do not include the -s option on the command line when you install an Agent, you have 
to start the Agent on the server manually.

Unix:

/etc/init.d/opsware-agent start

HP-UX:

/sbin/init.d/opsware-agent start

--installdir <path> Allows you to specify the directory where the Agent will be 
installed. By default, the Agent is installed in /opt/opsware/
agent on UNIX, and %ProgramFiles%\Opsware\agent on 
Windows.

--no_open_fw By default, the Agent Installer will modify the Windows 
Firewall configuration on Windows XP and Windows 2003 
(r2) servers to allow the core to contact the managed server 
on port 1002. If you specify this option, the firewall 
configuration will not be modified. The server may not be 
manageable by SA in this case.

--settime (-t) Synchronizes the time on the server on which the Agent is 
installed with that of the core.

NOTE:
If the server on which the Agent is being installed is 
significantly ahead of the clock on the core, then the clock on 
the managed server is set back in time. Since this can cause 
problems, do not use the --settime option unless you are sure 
that this scenario is not a problem in your environment. 

If a managed server’s clock is significantly behind of the 
clock on the core, the Agent installation might fail. To install 
an Agent successfully, use the 

--settime option or manually set the time and date on the 
managed server before retrying the Agent installation.

Table 10 Agent Installer Options (cont’d)

Option Description
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AIX: 

/etc/rc.d/init.d/opsware-agent start

Windows:

net start opswareagent

Verifying Agent Functionality

Perform the following steps to verify Agent functionality:

1 From the navigation panel in the SAS Web Client, click Servers ➤  Manage Servers. The 
Manage Servers page appears. Browse the list to find the server whose Agent installation 
you want to verify. If necessary, select the correct customer and facility for the server and 
click Update.

Or

Search for the server whose Agent installation you want to verify. 

2 Verify that the server appears in the Manage Servers list and has the correct properties. 

See “Using the Search Feature” and “Server Searching by IP Address” in User Guide: 
Server Automation for more information. 

3 If you want to discover reasons why a server is unreachable, you can run a 
Communication Test. See Agent Reachability Communication Tests on page 84 for more 
information. 

Augmenting the Information for a Managed Server

Use caution when you augment the discovery process for a managed server that is functioning 
in the operational environment. You might inadvertently install or uninstall software from 
the server. During the test remediate, verify what software will be uninstalled from the server 
before you perform the actual remediate operation.

Perform the following steps to augment the information for a managed server:

1 Model the OS and other applications running on the server in HP Server Automation by 
defining the OS with the Prepare Operating System Wizard and by creating nodes and 
templates for applications running on the assimilated server. 

See the SA Policy Setter Guide for more information about Operating System Definitions.

2 Move the server to the appropriate nodes for the OS and installed applications. 

The server is tracked in the SAS Web Client; however, the server operating system cannot 
be managed while the server is assigned to the generic operating system node. You must 
reassign the server to the operating system that was defined with the OS Provisioning 
feature. 

3 Remediate the server.

4 If an IP range group was set up, servers are automatically associated with customers 
when users install an Agent on the servers. Otherwise, the servers are associated with the 
Not Assigned customer. To change the customer associated with a server, see Editing the 
Properties of a Server on page 259. 
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5 To specify the server’s use, stage, and state, edit the server’s properties. See Editing the 
Properties of a Server on page 259 for more information. 

Discovery is complete. HP Server Automation assumes that the server should always be 
running the specific OS build it has been associated with. Any changes to the OS outside of 
HP Server Automation are not captured in the model.

Users can deploy and manage new applications on the server, just as if HP Server Automation 
initially provisioned the server. Users can also deploy OS level patches on the server, or 
rebuild the OS by using the OS build with which the server was associated.

Uninstalling an Agent on Unix and Windows

To uninstall Agents on Windows NT, Windows Scripting Host 5.1 or Internet Explorer 5.5 
must be installed on Windows NT. 

Perform the following steps to uninstall an Agent on Unix or Windows:

1 Log into Unix as root user. Log into Windows as Administrator. 

2 Change directories to any directory other than the Agent's installation directory. 

3 On Unix, enter the following command: 

<installation_directory>/bin/agent_uninstall.sh 

By default, for Solaris and AIX, the Agent Uninstaller will not remove the SA RPM 
package. For command line options for the agent uninstaller, including how to activate 
removal of the SA RPM package, See Agent Uninstaller Options on page 387 in this 
appendix for more information. 

4 On Windows, enter the following command:

msiexec /x <installation_directory>\bin\agent_uninstall.msi

You can also use the Windows Control Panel’s Add or Remove Programs option to remove 
the Agent.

5 As the uninstall proceeds, the Unix platform stdout shows the uninstallation progress. 
The Windows uninstall does not show uninstallation progress. 

Agent Uninstaller Options

When you use the Agent Uninstaller, you can include the options that Table 11 and Table 12 
show.     

Table 11 Agent Uninstallation Unix Options

Option Description

--uninstallerVersion Show the uninstaller version.

--help Show this help.
Agent Utilities 387



During Agent Uninstallation on a Windows server, the Agent Installer removes the 
ogshcap.dll file from the following location: 

%SystemRoot%\system32\ogshcap.dll 

If the file is open or is in use, the Agent Installer is unable to remove the ogshcap.dll file. The 
Agent Installer then prompts the user to restart the machine and removes the file after 
restart. 

Uninstalling Earlier Versions of Agents on Unix

Perform the following steps to uninstall Agents versions 5.1 and earlier: 

1 Stop the Agent on the server by running the following command as root:

Linux:

/etc/rc.d/init.d/cogbot stop

Solaris:

/etc/init.d/cogbot stop

HP-UX:

/sbin/init.d/cogbot stop

AIX:

/etc/rc.d/init.d/cogbot stop

2 Deactivate or delete the server by using the SAS Web Client Server menu.

3 For Linux servers only, run chkconfig to de-register the Agent initialization script:

% /sbin/chkconfig -del cogbot

4 As root, delete the following files and directories to remove the Agent files from the server:

--no_deactivate Do not deactivate the server; by default, the server is 
deactivated.

--force Do not prompt for confirmation before deactivating the server.

--delete_opsw_rpm Remove the OPSW RPM package (AIX, Solaris only). Use the 
following commands to remove the RPM package:

Solaris: pkgrm -n OPSWrpm

AIX: installp -u rpm.rte

Table 12 Agent Uninstallation Windows Options

Option Description

NO_DEACTIVATE="1" Do not deactivate the server; by default the server is 
deactivated.

FORCE="1" Do not prompt for confirmation before deactivating the server.

Table 11 Agent Uninstallation Unix Options (cont’d)

Option Description
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Linux:

/etc/rc.d/init.d/cogbot 

Solaris:

/etc/init.d/cogbot

/etc/rc2.d/S79cogbot

/etc/rc0.d/K44cogbot

HP-UX:

/sbin/init.d/cogbot

/sbin/rc2.d/cogbot

AIX:

/etc/rc2.d/init.d/cogbot

/etc/rc.d/S79cogbot

All Unix:

/opt/OPSW

/var/lc

Uninstalling Earlier Versions of Agents on Windows

Perform the following steps to uninstall earlier versions of Agents on Windows:

1 Stop the Agent by running the following command as administrator:

C:\> net stop shadowbot

2 Deactivate or delete the server by using the SAS Web Client Server menu.

3 Deregister the Agent service by running the following command as administrator:

C:\> "%SystemDrive%\Program 
Files\Loudcloud\blackshadow\watchdog\watchdog.exe" -x

4 As administrator, delete the following directories to remove the Agent:

"%SystemDrive%\Program Files\Loudcloud"

"%SystemDrive%\Program Files\Common Files\Loudcloud"

Agent Upgrade Tool 

This section contains the following topics:

• Ways to Upgrade Agents

• Prerequisites for Using the Agent Upgrade Tool

• Upgrading the Agent on Managed Servers

• Commands for the Agent Upgrade Tool

• Options for the Agent Upgrade Tool
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• Example: Options for the Agent Upgrade Tool

• Example: Commands and Output for Agent Upgrade Tool

Ways to Upgrade Agents

After you upgrade HP Server Automation running in a facility, you should upgrade the Agents 
on every managed server to the new version, so that you can utilize the new features in the 
newly-upgraded core. 

HP Server Automation features continue to work on a managed server even when it is 
running an older Agent. However, new features in the new versions might not be available for 
that server. 

Refer to the Release Notes for the new version for information about the compatibility of new 
features with older agents.

You can upgrade the Agents on managed servers in the following ways:

• Use the Agent Installer (a command line interface) to install a new Agent on one server at 
a time. 

See “Agent Installation Using the CLI” on page 377 in this appendix for information about 
how to use the Agent Installer.

• Use the Agent Upgrade Tool to upgrade Agents on groups of servers. Running the tool 
upgrades deployed Agents on managed servers. You can run the script simultaneously on 
many servers to upgrade large groups of Agents.

The Agent Upgrade Tool has the following characteristics: 

• It is a command line interface that provides a flexible mechanism for selecting servers to 
upgrade, and for monitoring and reviewing upgrade operations.

• You can use it to upgrade many Agents on managed servers simultaneously.

• It runs within your preferred Unix shell, allowing it to leverage the power of standard 
Unix shells and text processing tools.

• You can use it to upgrade a server in any facility running HP Server Automation. You can 
run it from an OPSH shell attached to any HP Server Automation in any facility.

The OPSH shell is a program that authenticates users in HP Server Automation, starts the 
user’s normal Unix shell (as specified in the standard password database). Using the OPSH 
shell allows the user to run the Agent Upgrade Tool in this facility. 

Prerequisites for Using the Agent Upgrade Tool

• On a core server of the facility being upgraded, install the OPSH Shell RPM by 
downloading the opsh package from the SAS Web Client. See “Multimaster Mesh 
Administration” in the SA Administration Guide for instructions on downloading a 
package.

Installing the opsh RPM places the OGFS shell and the Agent Upgrade Tool in the 
directory /opt/OPSWopsh/bin. 

• You need the correct permissions to upgrade Agents. Run the OPSH shell by specifying 
the SA admin user and password to ensure that you have the appropriate permissions. 
(Contact your SA administrator to obtain the password.) 
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When you start an OPSH shell to run the Agent Upgrade Tool, the user name and 
password are authenticated by HP Server Automation

• The server where you install the opsh RPM must be able to resolve the name 
way.<facility-domain> to the host running the Command Engine in the facility’s core. 
For example, if the Command Engine runs on a host in the prod.opsware.com domain, 
the servers must resolve the name way.prod.opsware.com. You specified the 
facility-domain when you installed the core. 

Upgrading the Agent on Managed Servers

To upgrade the Agent, perform the following steps:

1 After you install the opsh RPM on a core server, enter the following command as root to 
start the OPSH shell: 

opsh [username@]facility-domain 

For example:

opsh admin@prod.opsware.com

See the preceding section for the name resolution requirement for facility-domain. See 
Commands for the Agent Upgrade Tool on page 391 for more information on opsh. 

2 (Optional) To obtain information about the current Agents running on the managed 
servers before you upgrade them, enter any of the following commands and options:

opsh_agent query server-options 

(Enter this command if you want to view a report of the Agent versions running on the 
servers before you upgrade them.) 

opsh_agent verify server-options schedule-options \

agent-version 

(Enter this command if you want to verify the versions of the Agents running on the 
managed servers before you upgrade them.)

3 To upgrade Agents on specified servers, enter the following Agent Upgrade Tool 
commands and options:

opsh_agent stage server-options schedule-options \

[--always] agent-version 

(Enter this command if you want to download the package for the Agent to the managed 
server before you run the upgrade.) 

opsh_agent upgrade server-options schedule-options \

[--always] agent-version

4 (Optional) To review the status of the Agent upgrade, enter the following command and 
option:

opsh_agent review session-id

Commands for the Agent Upgrade Tool

• opsh [username@]facility-domain 
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This command starts an OPSH shell and authenticates the user name against the SA 
facility running at the specified domain. 

If you do not specify a user name, the currently logged in user name is used. The OPSH 
shell prompts for a password. 

A new Unix shell (which is attached to the specified SA core-domain) is started. (The 
password database for the user specifies which Unix shell to use.)

• opsh_agent query server-options

This command must be run from an OPSH shell started with the opsh command.

This command queries the reported version of Agents and any staging status for the 
specified servers by examining data in the Model Repository. 

One line is printed to stdout for each server that shows device ID, IP address, current 
Agent version, and any staging status.

You can specify the servers by using the --device, --customer, --facility, and 
--os options.

• opsh_agent stage server-options schedule-options \

[--always] agent-version

You must run this command from an OPSH shell started with the opsh command.

This command contacts the Agent on each specified server and instructs it to download 
the package for the specified version of the Agent from the Software Repository.

If the download is successful, the staging status is written to the Model Repository for the 
server. 

To download the package to the server even when this command was entered previously 
(recorded in the Model Repository), specify the --always option.

One line is printed to stdout for each server that shows the device ID, IP address, and a 
success or failure indicator. 

You can specify the servers by using the --server, --customer, --facility and --os 
options.

A session is started and the session ID displays for later review. After the session ID 
displays, you can type CTRL-C and review the session later using the opsh_agent review 
command.

• opsh_agent upgrade server-options schedule-options \

[--always] agent-version

You must run this command from an OPSH shell started with the opsh command.

This command contacts the Agent on each specified server and instructs it to upgrade to 
the specified version. If the necessary package has not been downloaded on the server 
already (the opsh_agent stage command was entered), the package is downloaded from 
the Software Repository. 

If the upgrade is successful, the package is removed from the server and the staging 
status is deleted from the Model Repository. 

To upgrade the Agent even when the specified version of the Agent was already installed 
on the managed servers, enter the --always option. (The Model Repository records when 
Agents are upgraded on servers.) 

One line is printed to stdout for each server that shows the device ID, IP address, and a 
success or failure indicator. 
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You can specify the servers by using the --server, --customer, --facility, and 
--os options.

A session is started and the session ID displays for later review. After the session ID 
displays, you can type CTRL-C and review the session later by using the opsh_agent 
review command.

• opsh_agent verify server-options schedule-options \

agent-version

You must run this command from an OPSH shell started with the opsh command.

This command contacts the Agent on each specified server to verify that it is running the 
specified version.

One line is printed to stdout for each server that shows the device ID, IP address, the word 
OLD, NEW, or CURRENT and the actual Agent version running on the server.

You can specify the servers by using the --server, --customer, --facility, and 
--os options.

A session is started and the session ID displays for later review. After the session ID 
displays, you can enter CTRL-C and review the session later by using the opsh_agent 
review command.

• opsh_agent review session-id

You must run this command from an OPSH shell started with the opsh command; 
although, not necessarily the same OPSH shell from which the original command was 
started.

This command attaches to a running opsh_agent stage, opsh_agent upgrade or 
opsh_agent verify session running on the Command Engine. It prints the same output 
to stdout that the original command would have printed if the user had not typed CTRL-C 
and terminated the command. If the session is complete, it shows the same results that 
were shown when the session completed.

Options for the Agent Upgrade Tool

Server-options: --server|-S <svr-spec> --customer|-C <cust-spec> 

--facility|-F <fac-spec> --os|-O <os-spec> 

If more than one of the --customer, --facility, or --os options is specified, only servers that 
match all options are selected. Any servers specified by using the --server option are added 
to (or subtracted from) the list specified by combining the
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--customer, --facility, and --os options.  

Schedule-options: --when|-W when-time --until|-U until-time   

Table 13 Options for the Agent Upgrade Tool

Long 
Option

Short 
Option Value Meaning

--server -S <svr-spec> Server by device ID, IP address, or system 
name

--customer -C <cust-spec> All servers associated with the customer 
specified by the customer ID or name

--facility -F <fac-spec> All servers in the facility specified by the 
facility ID or name

--os -O <os-spec> All servers running the operating system 
specified by the OS name

Table 14 Schedule Options

Long 
Option

Short 
Option Value Meaning

--when -W <when-time> Start time for a stage, upgrade, verify, or test 
operation in the format:

MM/DD/YYY-HH:MM

If the --when option is used, the operation 
starts at the specified time, but the command 
displays a session ID and returns immediately. 

When you schedule an operation, you use the 
review command to review the results after 
the operation has run.

If the --when option is not specified, the 
operation starts immediately and the 
command displays the output of the command.

--until -U <until-time> End time for a stage, upgrade, verify or test 
operation in the format: 

MM/DD/YYY-HH:MM

If the --until option is specified, the 
operation stops processing servers at the 
specified time. Any servers that are not 
complete are left in a consistent state; this 
might require that the session run past the 
specified time.
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Miscellaneous options: --ip|-I --always|-A --parallel|-P --theword|-T  

Example: Options for the Agent Upgrade Tool 

The following table provides examples for running the Agent Upgrade Tool.  

Example: Commands and Output for Agent Upgrade Tool

# cd /opt/OPSWopsh/bin

# ./opsh admin@prod.opsware.com

admin@prod.opsware.com's password:

#

# ./opsh_agent verify --os "SunOS*" 14a.2.12.18

Session 37802500101L

Table 15 Miscellaneous Options

Long Option
Short 
Option Value Meaning

--ip -I (N/A) Display IP addresses instead of host 
names.

--always -A (N/A) Always stage or upgrade servers even if 
the current version is staged or upgraded.

--parallel -P <Concurrency> The maximum of concurrent commands.

(Recommended default = 10)

--theword -T <hostname> The host name or IP address to use when 
contacting the Software Repository from a 
server.

Table 16 Examples of Options for the Agent Upgrade Option

Example Description

--server 1,2 Selects servers 1 and 2.

--facility Y,Z Selects all servers (for all customers) in facilities 
Y and Z.

--customer -A,-B --facility Z Selects all servers in facility Z except those owned 
by customers A and B.

--server 1,2,-3,-4 --customer A,B 
--facility Y,Z

Select servers 1 and 2 as well as all servers owned 
by customers A or B which are in facilities Y or Z 
except servers 3 and 4.

--server 1,-2 --customer A,B 
--facility -Y,-Z --os SunOS 5.8

Select server 1 and all servers owned by 
customers A or B, except those in facilities Y or Z 
and which are Solaris 5.8 machines excluding 
server 2.
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Device ID Name/IP address Version Result Status Reason

410101L core2-1.prod.opsware.com  14a.2.12.18 CURRENT SUCCESS

^C

Interrupted review of running session 37802500101L

Use review 37802500101L command anytime to review session status

#

# ./opsh_agent review 37802500101L

Session 37802500101L

Device ID Name/IP address Version Result Status Reason

410101L d033.prod.opsware.com 14a.2.12.18 CURRENT SUCCESS

670101L dhcp-174.prod.opsware.com 14a.2.12.16 OLDER SUCCESS

1460100L emb218-37.manu.opsware.com 14a.2.12.18 CURRENT SUCCESS

20100L f001.manu.opsware.com 14a.2.12.18 CURRENT SUCCESS

10100L f002.manu.opsware.com 14a.2.12.21 NEWER SUCCESS

210100L m022.manu.opsware.com 14a.2.12.18 CURRENT SUCCESS

Session 37802500101L completed.

Agent Upgrade Custom Extension

SA includes a custom extension (AgentUpgrade) that you can use to upgrade Agents from the 
previous three versions. 

The Custom Extension feature is accessed through the Run Custom Extension Wizard. This 
Wizard allows a user to choose a custom extension to run, specify necessary input data for the 
extension, validate the data required to run the extension, run the extension, and view or 
download the results from the job. When a user runs a custom extension, the job shows up in 
My Jobs. 

To access the Run Custom Extension Wizard, users must be assigned to a user group that has 
the permission Wizard: Opsware Extension. When users have this permission, they can run 
any custom extensions on the servers they have access to in the SAS Web Client.

Any user who has the ability to run custom extensions can run the Agent Upgrade Custom 
Extension. 

The Agent Upgrade custom extension only upgrades agents that are not up-to-date. 
Therefore, rerunning the custom extension on a group of servers will not affect servers that 
are already running the most recent version of the Agent. 

Upgrading Agents with the Agent Upgrade Custom Extension

To run the Agent Upgrade custom extension, perform the following steps:

1 From the SAS Web Client home page, click the Run Custom Extensions link in the Tasks 
panel.

Or
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From the navigation panel, click Servers ➤ Manage Servers. The Manage Servers list 
appears. Select the servers on which you want to run a custom extension and choose Run 
Extension from the Tasks menu.

The Run Custom Extension Wizard appears.

2 Select the "AgentUpgrade" custom extension and click Next. 

If you have not already selected servers from the Manage Servers list, the Select Servers 
page appears.

3 If prompted, select the servers or groups on which you want to run the custom extension 
and click Next. You can find the servers that you want to run a custom extension on by 
browsing the list or by searching. 

The Agent Upgrade Settings page appears as shown in Figure 27:

Figure 27 Specify Settings Page for the Agent Upgrade Custom Extension    

4 Specify the settings for the custom extension and click Next. 

• Select the Agent Upgrade action you want to perform: 

— Stage Package: Downloads the Agent Installer package (the binaries) but does 
not upgrade the Agent. 

— Perform Upgrade: Upgrades the servers to the specified Agent version by 
downloading the Agent Installer package (binaries) if not previously staged. If the 
Agent Installer package was already staged, upgrades the Agent version by using 
the staged version of package on the server.

— Verify Upgrade: Check whether all the servers are running the selected Agent 
version.

• Select the Agent version to upgrade to. All agent versions available in the Software 
Repository are displayed in the list. By default, the latest version available in the 
Software Repository is selected. 

• Enter additional parameters to pass to the Agent Installer. The Agent Upgrade 
custom extension does not validate the parameters you enter. See Agent Installer 
Options on page 382 for information about the parameters you can enter in this field.

• Specify whether the custom extension should upgrade Agents even if the version of 
the currently running agent is equal to or greater than the version being upgraded to. 
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The Confirm Settings Screen appears and displays the selected options. 

5 Review the values that you entered and the servers that you selected on which to run the 
Agent Upgrade custom extension. (You can remove servers from the list by deselecting 
their check boxes. Click the “Show remaining servers” link to display the complete list of 
selected servers.)

6 Click Next. 

7 On the Schedule and Notify page, you have the following options: 

• Notify: Choose the Condition option and set the parameters to send an email when 
the operation is completed. You can choose to have an email sent on any result, if the 
operation fails, or if the operation is successful. To add another email recipient, click 
the plus (+) button next to the Recipients field. 

• Schedule: Choose either Run Now to execute the operation immediately, or choose 
Specify Time to schedule the operation for a later time. 

When you schedule a job for a server group, you can specify how the members of 
the group are determined. The membership of a dynamic server group changes 
based on the changes in your operational environment. If you have “Allow Run 
Refresh Jobs” permissions, you will see additional options. Select either of the 
following options: 

— Option 1: Membership is determined based on the “Time of Confirm Selection.” 
Select this option to run the job on the servers that were in the group when you 
scheduled the job. Changes to the group membership do not affect the list of the 
servers that the job will run on. 

— Option 2: Membership is updated when the job runs. Select this option to 
recalculate the group membership prior to running the job. Changes to group 
membership are reflected in the list of servers that the job will run on.

The time used for the scheduled job is specified in your preferred time zone which can be 
modified in My Profile. If you do not have the preferred time zone set, the time zone is derived 
from the SA core server (usually UTC).

8 Click Run to start the Custom Extension Wizard.

If you selected to run the job at that time, a progress bar appears for the servers on which 
the extension is running that shows the progress of the job. 

9 When the custom extension finishes running, you can click View Details to see the 
results. The Custom Extension Results window appears. The results window contains a 
tab for the operation summary and a tab for the operation details. 

By default, the Summary tab is displayed.
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Figure 28 Summary Tab in the Details Window of the Agent Upgrade Custom 
Extension 

The Details tab contains a table with one row for each server selected. The table in each 
tab includes the following columns: 

• Name: The name of the server 

• Agent Version: The agent version running on the server after the custom extension 
completes

• Reason: If an operation failed, a text description of the reason the operation failed

• Result: (Only shown for Verify operations) Shows the result of the verification:

— OLDER: The agent on the server is older than the selected version

— UP TO DATE: The agent on the server is up to date

• Status: The exit status of the command SUCCESS or FAILURE
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Figure 29 Details tab in Results Window for the Agent Upgrade Custom Extension 

10 When you are done viewing the results, click Close to close the window. 

After you close the wizard, you can view the progress of the custom extension by viewing 
My Jobs (accessible from the Home page or the navigation panel). Each custom extension 
job is identified with the name Run Custom Extension. Click the name link to identify 
which extension was run. 

See Server Management Scheduling and Notification on page 265 for information about 
the My Jobs feature.
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C Global Shell Utilities Syntax
aaa Utility

The aaa utility grants and revokes permissions for operations that use the OGFS. For 
example, the aaa utility grants permission for the readServerFilesystem operation, 
allowing you to browse a server’s file system in the SA Client. To run the aaa utility, you must 
belong to the Administrators user group.

The permissions granted and revoked by the aaa utility are stored in the /opsw/Permissions 
directory of the OGFS. For details on the contents of the directory, see
/opsw/Permissions Directory on page 419. 

aaa Syntax

The aaa utility has the following syntax:

aaa shell-perm (grant | revoke) -o operation [-u user-group]
[-f facility | -c customer | -g device-group [-s | -l login]]

Table 17 describes the command options and Table 18 lists the operations that can be granted 
or revoked the aaa utility.  

Table 17 AAA Options

Option Description

-o operation The operation on which to grant or revoke the permission. 
For a list of allowed values, see the Operation column in 
Table 18.

-u user-group The SA user group that is assigned the permission. This 
value is inferred from the current working directory if it 
corresponds to a user group. If it cannot be inferred, specify a 
user group.

-f facility The name, ID, or path to a facility, such as:
/opsw/Facility/Chicago
Permission will be granted to all servers in this facility.

-c customer The name, ID, or path to a customer, such as:
/opsw/Customer/Alpha
Permission will be granted to all servers that belong to this 
customer.
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aaa Usage Rules

The following usage rules and recommendations apply to the aaa utility:

• For operations that are performed on a server, one of the -f, -c, or -g options is required.

• As a best practice, when you are granting permissions, use care when you select servers so 
that you do not capture more servers than you intend. This is particularly important 
when using the -c or -f option. For example, if you want to grant permission to the 
loginToServer operation for all servers in the Chicago facility as root, you could use the 
-f option to select all servers in a particular facility. However, this may also select 
Windows servers, which is probably not desired since the root user does not typically 
exist on Windows servers. In this case, you should define a public device group that only 
includes servers in the Chicago facility which are running a Unix operating system.

• If you specify the -f, -c, or -g option, you must also specify either the -s or -l option. The 
choice of the -s or -l option depends on the policies of your organization. If users log into 
managed servers with generic user names (such as root), then you should specify the -l 
option. If users log into managed servers with individual user names, which are the same 
as their SA user names, they should specify the -s option.

• The -f and -c options are provided as a convenience; however, in general, it is 
recommended that you define permissions based on device groups instead.

• The revoke command can only remove a permission that was previously granted. If the 
permission was not previously granted, the revoke command has no effect.

• The revoke command only removes a permission for a specific user group. If a user has 
overlapping permissions, revoking permissions from a single user group will not prevent 
the user from performing that operation. For example, suppose a user belongs to two user 
groups that both have the launchGlobalShell permission. If this permission is revoked 
from only one of those user groups, the user still has the launchGlobalShell permission.

aaa Examples

The following example gives all members of the Advanced Users group permission to open a 
Global Shell session:

-g device-group The name, ID, or path to a public device group, such as: 
/opsw/Group/Public/Unix Servers
Permission will be granted to all servers that belong to this 
group. To specify the device group by name, omit the 
following:
/opsw/Group/ 

-l login A login account on the servers that are specified by the -f, 
-c, or -g option. On a Unix server, for example, the login is 
the Unix user name. Login accounts with multi-byte 
characters are not supported.

-s The login account on the servers (specified by -f, -c, or -g) is 
the same as the SA user name. (Use of -s is also referred to 
as defining a reflexive permission.)

Table 17 AAA Options (cont’d)

Option Description
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aaa shell-perm grant -o launchGlobalShell \
-u ‘Advanced Users’

The following command allows members of the Advanced Users group to view the file 
systems as root of all Unix servers:

aaa shell-perm grant -o readServerFilesystem \
-u 'Advanced Users' -g 'Public/All Unix Servers' -l root

The next example gives all members of the Unix Admin user group permission to log in as 
root to all servers in the Public/Trading Servers device group:

aaa shell-perm grant -o loginToServer -u ‘Unix Admin’\
-g ‘Public/Trading Servers’ -l root

The following example allows the Advanced Users group to run commands as root on servers 
associated with the Acme Inc customer.

aaa shell-perm grant -o runCommandOnServer \
-u ‘Advanced Users’ -c ‘Acme Inc’ -l root

The next example removes the permission for the Unix Admin user group to log into servers 
that belong to the device group named Public/Unix Servers. The command applies to any 
login, because the -l option is not specified. 

aaa shell-perm revoke -o loginToServer -u ‘Unix Admin’\
-g ‘Public/Unix Servers’

The following example allows the Oracle Users group to log into servers that belong to the 
device group Oracle Servers as the login oracle. For instance, if the SA user joe belongs to 
the Oracle Users group, he can log into the servers as the server user oracle.

aaa shell-perm grant -u ‘Oracle Administrators’ \
-o loginToServer -g ‘/opsw/Group/Public/Oracle Servers’ \
-l oracle

Instead of the -l option, the next example has the -s option, which allows the Oracle Users 
group to log into servers that belong to the device group Oracle Servers as the login that 
matches the SA user name. For instance, if the SA user joe belongs to the Oracle Users 
group, he can log into the servers as the server user joe.

aaa shell-perm grant -u ‘Oracle Administrators’ \
-o loginToServer -g ‘/opsw/Group/Public/Oracle Servers’ -s

Global Shell Operations (Permissions)

The actions that an SA user can perform within the Global Shell are determined by the 
operations specified by the aaa utility. Most of these operations, such as 
readServerFilesystem, can be granted on both managed servers and on a login basis. The 
login is the user name on the managed server, such as the Administrator user on Windows or 
root on Unix.

A login is not specific to a particular platform (operating system). For example, if the 
permissions specify that a user can read the file system as root, then root will appear under 
the files subdirectory, regardless of the platform. The Server Explorer of the SA Client 
displays the login names that you have been authorized to access that server's file system.

The operations are listed in the /opsw/Permissions directory of the OGFS.
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Table 18 identifies and describes the server operations in Global Shell. In the table, the On 
Server column identifies which operations can be granted for a set of managed servers, and 
the On Login column identifies the operations that can be granted for specific logins (users). 

Table 18 Global Shell Operations

Operation
(Permission) Description

On 
Server

On 
Login

launchGlobalShell Launches the Global Shell. No No

loginToServer Opens a shell session on a Unix server. 
In the SA Client, this is the Remote Ter-
minal feature that opens a terminal win-
dow for a Unix server.

Yes Yes

readServerComplus Reads COM Plus objects as a specific 
login. In the SA Client, use the Server 
Explorer to browse these objects on a 
Windows server.

Yes Yes

readServerFilesystem Reads a managed server as a specific 
login. In the SA Client, use the Server 
Explorer to browse the file system of a 
managed server.

Yes Yes

readServerMetabase Reads IIS Metabase objects as a specific 
login. In the SA Client, use the Server 
Explorer to browse these objects on a 
Windows server.

Yes Yes

readServerRegistry Reads registry files as a specific login. In 
the SA Client, use the Server Explorer to 
view the Windows Registry.

Yes Yes

relayRdpToServer Opens an RDP session on a Windows 
server. In the SA Client, this is the 
Remote Terminal feature that opens an 
RDP client window for a Windows 
server.

Yes No
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runCommandOnServer Runs a command or script on a 
managed server using a rosh 
operation, where that command or script 
already exist. In the SA Client, this is 
used for Windows Services when you use 
the Server Explorer.

Yes Yes

runTrustedOnServer Only for internal use by HP Server Auto-
mation. Do not use this operation. HP 
Server Automation uses this operation 
for scripts in /opsw/Script/Shared, 
which implement certain HP Server 
Automation features. These scripts are 
provided with HP Server Automation 
and cannot be created or modified by 
users. 

Yes Yes

writeServerFilesystem Modifies files on a managed server as a 
specific login. In the SA Client, use the 
Server Explorer to modify the file sys-
tem of a managed server.

Yes Yes

Table 18 Global Shell Operations (cont’d)

Operation
(Permission) Description

On 
Server

On 
Login
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rosh Utility

The Remote SA Shell (rosh) command makes a client connection that enables you to remotely 
run programs on managed servers. You invoke the rosh command from within a Global Shell 
session. 

rosh Syntax

For servers, the rosh command has the following syntax:

rosh (-n server-name | -i server-id)[-d dir] [-l login-name]
[-s] [-t | -T] [command [arg ...]]

For network devices, the rosh command has the following syntax:

rosh (-n device-name | -i device-id) [-N] [-C comment]
[-L] [-P parameters] [-s] -[-V variables] [command [arg ...]]

Table 19 describes the rosh options of the preceding syntax statements.     

Table 19 Rosh Options and Commands

Option Description

-C comment A comment for the log of a network script invocation.

-d dir Sets the working directory (path) on the remote server. The default is 
the remote user’s home directory.

-i server-id Specifies the server by its ID, which must already exist in the 
/opsw/.Server.ID directory.

-l login-name Specifies the login name of the remote user who performs operations 
on a remote server, which must already exist in the 
/opsw/Server directory.

-L The network script should be run line-by-line.

-m Network device mode.

-n server-name Specifies the server by its name, which must already exist in the /
opsw/Server directory.

-N The -i or -n option refers to a network device instead of a server.

-P parameters Parameters for a network advanced script.

-r Relays RDP data to a managed server (on Windows).

-s script-name Treats a command as the name of a saved script that will be sent to 
and run on the remote server.

-t Forces the remote session to run in a pseudo terminal (for Unix serv-
ers only).

-T Forces the remote session to run without a pseudo terminal (for Unix 
servers only).

-V variables Variables for a network command or advanced script.
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rosh Usage Rules

The following usage rules apply to the rosh program:

• Specify either the -n or -i option to log into or run programs on a managed server. These 
options are mutually exclusive, but if both are specified the -i option has precedence.

• If neither the -n, -i, and id options are specified, the managed server can be inferred if 
your working directory is at or below: 

/opsw/Server/.../server-name/

Or

/opsw/.Server.ID/server-id/

• If -r is specified, no other option (excluding -n or -i) can be specified.

• If -l is not specified, the login-name can be inferred if your working directory is at or 
below:

/opsw/Server/.../server-name/files/login-name/

Or

/opsw/.Server.ID/server-id/files/login-name/

• If -s is specified and command is a saved shared script with a setuid policy, the 
login-name specified by the -l option will be overridden. In this case, the -l option may 
be omitted. These scripts are stored in /opsw/Script/Shared.

• If your working directory is not below server/files/login-name and -d is not 
specified, the cwdpath defaults to the home directory for login-name. To default to the 
home directory, you must specify -l.

• For network scripts, if your current working directory is below a network device directory 
in the OFGS, you do not need to specify the device with -N, -n or -i. The network device is 
implied by the current working directory.

• For network scripts, if the full path of the script is not specified, rosh uses the search path 
indicated by the NETWORK_SCRIPT_PATH environment variable. If this variable is not set, 
rosh searches for the script in these directories:

/opsw/Script/Network/Command/
/opsw/Script/Network/Diagnostic/
/opsw/Script/Network/Advanced/

•  swenc Utility

-w seconds Inactivity timeout.

-W seconds Overall timeout.

command 
[args . . .]

Runs a program or saved script.

Table 19 Rosh Options and Commands (cont’d)

Option Description
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rosh Operations

The rosh command establishes a client connection which enables you to remotely run 
programs on managed servers. The SA Global Shell feature provides the following modes of 
operation for rosh:

• jump: This operation starts a shell session in a pseudo-terminal on a managed server. 
This mode operates when you do not use the -s option and when you do not specify a 
command or a script. You must have the loginToServer permission on the managed 
server to jump.

• reach: This is a remote execution of commands that are native to the platform (operating 
system) of the managed server. This mode operates when you specify a command. You 
must have the runCommandOnServer permission on the managed server to reach.

• push: This is a remote execution of a script on a managed server. The script is stored in 
the OGFS and is sent to the managed server by rosh. You must have the 
runCommandOnServer permission on the managed server.

rosh Examples

The following examples illustrate what these operations look like for an SA user named psi at 
this path:

/opsw/Server/@/salish.snv1.corp.opsware.com/files/root/etc

[psi@m168 etc](538) $ uname -n; id; pwd
m168.dev.opsware.com
uid=59796(psi) gid=59796(psi) groups=59796(psi) 
/opsw/Server/@/salish.snv1.corp.opsware.com/files/root/etc

The rosh jump command would display the following information about the managed server:

[psi@m168 etc](539) $ rosh
[root@salish etc]# uname -n; id; pwd 
salish.snv1.corp.opsware.com
uid=0(root) gid=0(root) 
groups=0(root),1(bin),2(daemon),3(sys),4(adm),6(disk),10(wheel),12(mail),7(lp
),4(adm),9(kmem),6(disk),5(tty),3(sys),2(daemon),8(mem)
/etc
[root@salish etc]# logout

The rosh reach command displays the following information about the managed server:

[psi@m168 etc](541) $ rosh "uname -n; id; pwd" 
salish.snv1.corp.opsware.com
uid=0(root) gid=0(root) 
groups=0(root),1(bin),2(daemon),3(sys),4(adm),6(disk),10(wheel),12(mail),7(lp
),4(adm),9(kmem),6(disk),5(tty),3(sys),2(daemon),8(mem)
/etc

The rosh push command displays the following information about the managed server:

[psi@m168 etc](544) $ cat /tmp/who.sh
#!/bin/sh
uname -n
id
pwd
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[psi@m168 etc](543) $ rosh -s /tmp/who.sh 
salish.snv1.corp.opsware.com
uid=0(root) gid=0(root) 
groups=0(root),1(bin),2(daemon),3(sys),4(adm),6(disk),10(wheel),12(mail),7(lp
),4(adm),9(kmem),6(disk),5(tty),3(sys),2(daemon),8(mem)
/etc

The following example runs a script on a network device:

$ cd /opsw/Network/@/sw-ee-1-2b
$ rosh -s -C 'Updating device location' \
-V 'Location=Opsware - Sunnyvale' 'Set Location'
run script task 8725081 completed successfully.
Results:
Script 'Set Location for Cisco IOS configuration (for drivers:  Cisco 
switches, Catalyst 2950, 3550, 3750 & 8500 series, IOS version 12.x)' 
completed.
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swenc Utility

The swenc command enables you to switch the character encoding within a Global Shell 
session. 

swenc Syntax

The swenc command has the following syntax:

swenc [-e encoding] [-T {on | off}] [-E] [-x] [-c command]

Table 20 describes the swenc options.  

swenc Usage Rules

The following usage rules apply to the swenc utility:

• If you specify no options, swenc displays the character encoding and transcoding mode of 
the current session.

• Unless you specify the -x option, swenc starts a new sub-shell, which uses the encoding 
specified with the -e option. To leave the sub-shell and revert to the previous encoding, 
enter exit.

• Changing the encoding with swenc affects all processes in the current session, including 
background processes. If you change the encoding while background processes are 
running, the background processes might encounter errors.

• The swenc command affects only the current Global Shell session. For example, if you run 
the rosh command after the swenc -e command, the rosh command does not inherit the 
encoding that you changed with the swenc command.

• The swenc command does not change the working directory of the session, unless the 
working directory contains path names that cannot be represented in the new encoding. 
In this case, the working directory is the user’s home directory.

• If you change the character encoding, make sure that the encoding of the terminal 
application that hosts the Global Shell and Remote Terminal sessions is set properly. To 
view or change the terminal client, go to the Terminal and Shell Preferences of the SA 
Client.

Table 20 Swenc Options

Option Description

-c command Executes command and exits, reverting the session encoding to its 
previous state.

-E Lists the valid character encodings.

-e encoding Changes the character encoding of the current session.

-T {on | off} Turns on or off the transcoding of data from the Unix managed 
server. (Data from Windows servers does not need to be transcoded.) 
See Transcoded Data in a Managed Server on page 296.

-x Prevents the launching of a sub-shell.
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D OGFS Directories
Directories in the OGFS

The SA Global File System (OGFS) is accessible from within a Global Shell session. 

Many directories contain similar files. The id file contains the HP Server Automation unique 
identifier (primary key) for the object represented by the directory. The attr directory 
contains text files that describe the attributes of the managed server. The info file is 
deprecated in HP Server Automation 6. Instead of the info file, use the files in the attr 
directory. The self file represents this specific server object (instance). The method directory 
contains executables that invoke the methods in the SA API. For details on the executables in 
the method directory, see the Server Automation Platform Developer’s Guide. 

In the directory listings that follow, the italicized text represents variable paths (specific 
instances of objects in the data model). For example, server-1 is the name of a specific 
managed server. The italicized text in parentheses contains comments.

root (/) Directory

At the root level of the OGFS is a directory for each SA user. Each user directory and all files 
and directories under it are visible only to processes in an authenticated session.

Each SA user has the following private directories: 

• A home directory which is at /home/user-name (SA user name)

• Temporary directories located at /tmp, /var/tmp and /usr/tmp

Each user's home directory contains a public directory (/home/user-name/public) which is 
readable by all other SA users and can be used to share files with other SA users.

The root directory has the following structure:

/. (root)
   bin/
   dev/
   etc/
   home/
   lc/
   lib/
   opsw/
   opt/
   proc/
   sys/
   tmp/
   usr/
   var/
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/opsw Directory

The opsw directory represents the data model of HP Server Automation. For example, the 
/opsw/Customer directory represents customer objects in the data model. Global Shell scripts 
and other client applications can navigate within the data model in the OGFS. Except for the 
api and bin directories, all of the directories under the opsw directory represent objects. The 
api directory contains executables that invoke methods on the HP Server Automation API. 
The bin directory contains Global Shell utilities such as rosh and aaa.

For HP Server Automation, the top level of the opsw directory has the following structure:

/opsw/
api/

      Application/
      .Application.ID/
      bin/
      Customer/
      .Customer.ID/
      Facility/
      .Facility.ID/
      Group/
      .Group.ID/
      Hardware/
      .Hardware.ID/

Library/
.Library.ID/

      NetModel/
      NetOS/
      NetType/
      Network/
      .Network.ID/
      OS/
      .OS.ID/
      Realm/
      .Realm.ID/
      Script/
      Server/
      .Server.ID/
      ServiceLevel/
      .ServiceLevel.ID/

The ID directories organize objects by their unique SA identifier. These directories are 
equivalent to those organized by name. For example, if a server with an ID 10043 is named 
m44.opsware.com, then the following directories contain the same information:

/opsw/.Server.ID/10043
/opsw/Server/@/m44.opsware.com

If the NA is installed, the /opsw directory also contains several network directories. See 
Network Directories on page 421.
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/opsw/Server Directory

The Server directory not only contains information about managed servers, but also 
organizes the servers by their associated objects. For example, the /opsw/Server/@Group 
directory organizes servers by device group. 

At the top level, the /opsw/Server directory has the following structure:

/opsw/Server/
             @/
                server-1/
                server-2/
                . . .
             @Application/
                Application Servers/
                Database Servers/
                . . .
             @Customer/
                customer-1/
                customer-2/
                . . .
             @Facility/
                facility-1/
                facility-2/
                . . .
             @Group/
                Private/
                  private-group-1/
                  private-group-2/
                . . .
                Public/
                  public-group-1/
                  public-group-2/
                . . .
             @Hardware/
             @OS/
             @ServiceLevel/

The sections that follow list some of the directory structures under /opsw/Server.

/opsw/Server/@ Directory

This directory contains all managed servers. The files directory reflects the file system of 
the managed server. When you modify the file system beneath the files directory, you do so 
as a specific user (such as login-1) of the managed server. 

The Interface directory contains information about the network interface of the server. This 
directory might contain symbolic links to a network device. See /opsw/Network Directory on 
page 421 for more information on these links.

The paths in the following directory structure are under /opsw/Server/@. For example, the 
full path name of server-1 in the following structure is
 /opsw/Server/@/server-1/.

server-1/
   attr
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   ChangeLog
   complus
   CPU/
       0
       1
       . . .
   CustAttr/
      custom-attribute-1
      custom-attribute-2/
      . . .

files/
      login-1/
         (file system as seen by login-1)
      login-2/
         (file system as seen by login-2)
      . . .
   info
   Interface/
      network-interface-1/
      . . .
   Memory/
      RAM
      SWAP
   metabase/
      login-1/
         (metabase as seen by login-1)
      login-2/
         (metabase as seen by login-2)
      . . .
   method/
   registry/
      login-1/
         (registry as seen by login-1)
      login-2/
         (registry as seen by login-2)
      . . .
   self
   Storage/
      storage-device-1/ 
      . . .
server-2/ 
   . . .
server-3/
   . . . 

/opsw/Server/@Facility Directory

This directory filters servers according to their facility:

facility-1/
   @ /(all servers in facility-1)
      server-1/
      server-2/
      . . .
      @Group/
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         group-1/
            @/ (all servers in both facility-1 and group-1)
               server-1/
               . . .
         group-2/
         . . .
facility-2/
. . .

/opsw/Server/@Group Directory

This directory does not contain network devices. This directory filters servers according to 
their device groups: 

group-1/
   @/ (all servers in group-1)
      server-1/
      . . .
   child-group-1/
      @ (all servers in child-group-1)
         server-1/
         . . .
   child-group-2/
   . . .
   @Facility/
      facility-1/
         @ (all servers in both group-1 and facility-1)
            server-1/
   . . .
group-2/
   @/ (all servers in group-2)
   . . .

/opsw/Library Directory

The Library directory contains information about folders and the objects within folders: 
application policies, OS sequences, and packages. This directory has the following structure:

/opsw/folder-path-1/@/
                      AppPolicy/
                               app-policy-1/
                                           attr/
                                           method/
                                           self
                               app-policy-2/
                               . . .
                      attr/
                      method/
                      OSSequence/
                               os-sequence-1/
                                           attr/
                                           method/
                                           self
                               os-sequence-2/
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                               . . .
                      Package/
                               package-1/
                                           attr/
                                           method/
                                           self
                               package-2/
                               . . .
                      self
/opsw/folder-path-2/
. . .

Other Directories Under /opsw

This section lists, in alphabetical order, the object directories under /opsw other than the 
Server, Library, and Net* (network) directories.

/opsw/Application Directory

This directory is deprecated in HP Server Automation 6.0.

This directory represents the SA Software Tree, a hierarchical structure for organizing 
applications:

/opsw/Application/
                  Application Servers/
                     application-1/
                        @/
                          CustAttr/
                             custom-attribute-1
                             custom-attribute-2
                             . . .
                          .id
                          info
                         child-application-1/
                            @/
                             . . .
                             grandchild-application-1/
                                @/
                              . . .
                             grandchild-application-2/
                              . . .
                         child-application-2/
                         . . .
                     application-2/
                     . . .
                  Database Servers/
                     application-1/
                     . . .
                  Operating System Extras/
                     application-1/
                     . . .
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                  Other Applications/
                     application-1/
                     . . .
                  System Utilities/
                     application-1/
                     . . .
                  Web Servers/
                     application-1/
                     . . .

/opsw/Facility Directory

Typically, a facility identifies the geographical location of a data center, such as a city or 
building. This directory contains information about facilities and the servers they manage:

/opsw/Facility/
               facility-1/
                  @/
                    attr
                    CustAttr/
                       custom-attribute-1
                       custom-attribute-2
                       . . .
                    info
                    method
                    self
                    Server/
                       server-1/
                       server-2/
                       . . .
               facility-2/
                   . . .

/opsw/Group Directory

This directory represents device groups. This directory also contains groups for network 
devices under the following conditions:

• NA is installed.

• The SA group has the NA-associated attribute set.

• The SA and NA group names are the same.

In the following structure, the child-group and grandchild-group reflect nested device 
groups:

/opsw/Group/ 
            Public/
               group-1/
                  @/
                    CustAttr/
                       custom-attribute-1
                       custom-attribute-2
                        . . .
                  info
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                  Server
                      server-1/
                      server-2/
                      . . .
                  child-group-1/
                     @/
                       . . .
                       grandchild-group-1/
                          @/
                          . . .
                       grandchild-group-2/
                     . . .
                  child-group-2/
                  . . .
               group-2/
               . . .
            Private/
               group-1/
               . . .
               group-2/
               . . .

/opsw/Library

This directory corresponds to the Library of folders displayed by the SA Client.

/opsw/Library/ct 
             folder-1/
               @/
                 attr
                 method
                 OSSequence
                 self
                 Software
                 SoftwarePolicy
               subfolder-1/
                 @/
                 . . .
               subfolder-2/
                 . . .
             folder-2/
               @/
               . . .

/opsw/OS Directory

This directory contains information about the operating systems defined in SA. It does not 
contain the actual bits for the operating systems, which are stored in the OS Provisioning 
Media Server. The /opsw/OS directory has the following structure:

/opsw/OS/
         os-name-1/
            Not Assigned/
             @/
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                CustAttr/
                   custom-attribute-1
                   custom-attribute-2
                   . . .
                info
                Server-1/
                    server-1/
                    server-2/
                      . . .
            os-name-2/
               . . .

/opsw/Permissions Directory

This directory contains information about the Global Shell permissions. The info directory 
contains a file for each operation (permission) that can be granted with the aaa utility. For 
each user group, the operations subdirectory contains a text file corresponding to an 
operation (such as launchGlobalShell) that have been granted to the group by aaa. The 
contents of these text files summarize the parameters of the permissions for that operation 
and user group. 

For example, the readServerFilesystem text file is in the operations directory of the 
Advanced Users group:

/opsw/Permissions/UserGroups/Advanced Users/operations/
readServerFilesystem

The readServerFilesystem text file contains the following information:

Facility: C40(40) Login: sysadmin
Group: Unix Servers (2880040) Login: root

In this example, all members of the Advanced Users group can read the file system as user 
sysadmin on servers that belong to Facility C40 (with ID 40), and as user root on servers 
that belong to the device group Unix Servers (with ID 2880040).

If a user group directory does not contain a text file for an operation, then the group does not 
have permission to perform that operation. If the text file is empty, the user group has 
permission to perform the operation, but the operation has no parameters. The 
launchGlobalShell operation, for example, has no parameters. 

The /opsw/Permissions directory has the following structure:

/opsw/Permissions/
                 info/
                      launchGlobalShell
                      loginToServer
                      readServerComplus
                      readServerFilesystem
                      readServerMetabase
                      readServerRegistry
                      relayRdpToServer
                      runCommandOnServer
                      runTrustedOnServer
                      writeServerFilesystem
                 UserGroups/
                            user-group-1/
                               description
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                               operations/
                                          launchGlobalShell
                                          loginToServer
                                          . . .
                            user-group-2/
                            . . .

/opsw/Realm Directory

A realm is a logical name for a group of IP addresses that can be contacted by a particular set 
of SA Gateways. Typically, each Satellite and Facility has one or more distinct realms. To find 
out which managed servers belong to a realm, note the server names below the realm/@/
Server subdirectory.

The Realm directory has the following structure:

/opsw/Realm/
            realm-1/
              @/
                info
                Server/
                   server-1/
                   server-2/
                   . . .
            realm-2/
               . . .

/opsw/Script/Shared Directory

This directory contains utility scripts that are included with HP Server Automation. These 
scripts are not the same as the DSE shared scripts that are accessible with the SAS Web 
Client. The contents of this directory cannot be changed by end users.

/opsw/Script/
             Shared/
                    script-1/
                       description
                       policy
                       source
                       version
                    script-2/
                    . . .

/opsw/ServiceLevel Directory

This directory is deprecated in HP Server Automation 6.0.

Service levels are user-defined categories such as Silver, Gold, and Platinum. The 
/opsw/ServiceLevel directory has the following structure:

/opsw/ServiceLevel/
                   service-level-1/
                      @/
                        CustAttr/
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                           custom-attribute-1
                           custom-attribute-2
                           . . .
                        .id
                        inf-1/o
                            . . .
                      child-service-level-1/
                        @/
                         . . .
                        grandchild-service-level-1/
                            @/
                            . . .
                     child-service-level-2/
                      . . .

Server/
@/
. . .

service-level-2/
                   . . .

Network Directories

For NA, the top level of the opsw directory includes the following subdirectories:

/opsw/
      . . .
      NetModel/
      NetOS/
      NetType/
      Network/

.Network.ID/
      . . .

Script/Network

/opsw/Network Directory

This directory organizes the devices by their model, OS, type, and group. All network devices 
are in the /opsw/Network/@ directory. The Changelog directory contains time-stamped 
events for the device. The Config directory contains time-stamped configuration files.

At the top level, the /opsw/Network directory has the following structure:

/opsw/Network/
             @/
                device-1/

attr/
                   ChangeLog/
                   Config/
                   info

method/
                   Module/
                   Port/
                       port-1/
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                          .id
                           info
                           Link/
                       port-2/
                       . . .

self
                   Vlan/
                device-2/
                . . .
             @Group/
             @NetModel/
             @NetOS/
             @NetType/

The Port and VLAN directories contain Layer 2 information. Within each subdirectory of the 
Port directory, an info file contains duplex information and other data for a specific network 
port. The Link directory contains a symbolic link to a server interface or a port on another 
network device (if the MAC address to the interface or port is available). In the following 
example, the eth0 under Network is a symbolic link to eth0 under Server:

/opsw/Network/@/sw-ee-1-2b/Port/FastEthernet0_1/Link/eth0
symbolic link to -->

/opsw/Server/@/m180.mycomp.com/Interface/eth0

Similarly, the Server directory can have a symbolic link to the corresponding entry under 
Network:

/opsw/Server/@/x.mycomp.com/Interface/eth0/Link/FastEthernet0_7
symbolic link to -->

/opsw/Network/@/sw-ee-2-4a/Port/FastEthernet0_7/eth0

/opsw/Network/@Group Directory

This directory does not contain groups for managed servers. This directory filters network 
devices according to their groups: 

group-1/
   @/ (all devices in group-1)
      device-1/
      . . .
   @NetModel/
   @NetOS/
   @NetType/
   child-group-1/
      @ (all devices in child-group-1)
         device-1/
         . . .
   child-group-2/
   . . .
group-2/
   @/ (all devices in group-2)
   . . .
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/opsw/NetModel Directory

This directory contains subdirectories for vendors, for example,
 /opsw/NetModel/Cisco. The /opsw/NetModel directory has the following structure:

vendor-1/
          model-1/
             @/
             @Group/
             @NetOS/
             @NetType/
          model-2/
. . .
vendor-2/
. . .

/opsw/NetOS Directory

This directory organizes devices by their operating system. The /opsw/NetModel directory 
has the following structure:

family-1/
     os-1/
        @/
        @Group/
        @NetOS/
        @NetType/
     os-2/
      . . .
. . .
family-2/
. .

/opsw/NetType Directory

This directory organizes network devices by the following types:

Firewall
L3Switch
L4to7Switch
Proxy
Router
Switch
unknown
VPN
Wireless Access Point
WirelessAP

The /opsw/NetType directory has the following structure:

type-1/
      
      @/
      @Group/
      @NetOS/
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      @NetType/
type-2/
. . .

/opsw/Script/Network Directory

This directory contains utility scripts for network devices. For information about these scripts, 
see the NA documentation.

/opsw/Script/Network/
Advanced/
Command/
Diagnostic/
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CDR. See code deployment.

changing
custom field values, 269
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See encoding, 294
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code deployment
accessing, 312
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performing, 326
services

accessing, 322
overview, 320
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commands, command options for, 302
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375
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restarting, an Server Agent, 375
verify that agent is running, 374
verify that port is open on managed sever, 374

Communication Test
about, 84
errors, 86
exporting, unreachable server status list, 94
running, multiple servers on, 90
searching, unreachable servers for, 92
types of, 85
unexpected error, 88

components
Device Explorer of, 100

configuration tracking
backed up files, restoring, 348
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creating, 334
file info and file versions, 346
manual backups, 341
overview, 331
policies

reconciling customized, 340
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Agent to Command Engine (CE), 360
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Agent to Software Repository (SWR), 369
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Connection Time-out
Agent to Command Engine (CE), 360
Agent to Data Access Engine (DAE), 365
Agent to Software Repository (SWR), 369
Command Engine to Agent (AGT), 355
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files, Device Explorer’s File System of, 118

creating
Communication Test, 89
configuration template, 119
configuration tracking email notification list, 

334
device groups using search, 141
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package, 119
reports, agent installation status on, 82
server groups, 236

dynamic groups, 238
static groups, 236, 237

Solaris zone, 170
static device groups, 131

creating VMware virtual machine, 173

Crypto Match (CRP)
certificate mismatch, 358
OK, 358
SSL negotiation failure, 358
unexpected error, 358
untested, 358
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adding, for servers, 271
deleting, for servers, 272
editing, for servers, 271
managing, overview, 270
overview, 26
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association with servers, 219
Customer Independent, definition of, 218
Not Assigned customer, definition of, 218
overview, 217

custom fields
changing value, 269

cutting over
code and content for CDR, 319

D
deactivating a server, 126

deleting
backups for configuration tracking, 347
custom attributes, for servers, 272
device groups, 144

files, Device Explorer’s File System of, 119
servers, 261

Device Explorer
accessing, 100
compliance, overview, 106
creating, configuration template, 119
creating, package, 119
File System

copying, files, 118
deleting, files, 119
renaming, files, 119
viewing, contents, 117
working with, 117

installed patches, overview, 119
main components, 100
opening, remote terminal, 102, 127
overview, 99
server properties, overview, 103, 147
server summary, overview, 103
services, overview, 120
Software Policies, overview, 108
viewing

packages, 114
Windows IIS Metabase, overview, 121
Windows Registry, overview, 120

device group
creating, 131, 135, 141

device groups
about, 128
accessing, 146
adding servers, 131
deleting, 144
device group explorer, 144
Device Groups Explorer, overview, 146
duplicating, 143
dynamic, 130
members, overview, 147
moving, 142
private, 130
public, 129
removing servers, 134
static, 130

DHCP
configuring for servers, 279

directories
synchronization for CDR, overview, 315

disabling, custom configuration tracking policies, 
339

Discovery and Agent Deployment
creating reports, 82
installing, Server Agents, 76
opening remote terminal sessions, unmanaged 

server to, 82
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deployment actions, 71
login settings, 71

viewing
history, unmanaged server of, 81

DNS, configuring for servers, 278

DNS Does Not Resolve
Agent to Command Engine (CE), 360
Agent to Data Access Engine (DAE), 365
Agent to Software Repository (SWR), 369

domains, changing for Windows servers, 279

duplicating
device groups, 143

duplicating, server groups, 248

dynamic, server groups, 232

dynamic device group, 130

E
editing

custom attributes, for server, 271
customized configuration tracking policies, 336
server properties, 259
service levels, 274

email
configuration tracking and logging actions, 333
configuration tracking notification list, format, 

334
notification list attribute, search order for, 334

enabling, custom configuration tracking policies, 339

encoding
Global Shell and Remote Terminal, 55
managed server, 104
multi-byte characters, 298, 402
OGFS, 294
Terminal and RDP preferences, 54
transcoding, 296
viewing file contents, 117

errors
Communication Test, 86

examples
Agent Installer, commands & options, 385
searching, ways to, 214
swapping servers’ disks, 217

exporting
unreachable server list to CSV, 94

F
Fair Share Scheduler, 171

File System
copying, files, 118
deleting, files, 119
overview, 117
renaming, files, 119
viewing, contents, 117

firewall, 289

G
Gateway Could Not Connect to Server

Agent to Command Engine (CE), 363
Agent to Data Access Engine (DAE), 367
Agent to Software Repository (SWR), 372
Command Engine to Agent (AGT), 357

Gateway Denied Access
Agent to Command Engine (CE), 362
Agent to Data Access Engine (DAE), 366
Agent to Software Repository (SWR), 371
Command Engine to Agent (AGT), 357

Gateway Time-out
Agent to Command Engine (CE), 363
Agent to Data Access Engine (DAE), 367
Agent to Software Repository (SWR), 372
Command Engine to Agent (AGT), 357

Global File System
accessing with ssh, 289
copying files to, 292

Global Shell
error messages, 297
overview, 281
remote shell, 406
remote terminal, 297
server operations in, 404
setting, permissions, 401

global zone, 157

guest operating system, 157

H
hard disks, swapping for servers, 217

histories
CDR operations, viewing previous status, 328
viewing, for servers, 222

Hyper-V, 155

hypervisor
definition of, 156

Hyper-V Partition
power on or off, 189

Hyper-V partition
resetting, 189

Hyper-V partition management, 183
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IIS Metabase

browsing, Device Explorer, 120

installing
Agents

augmenting for servers, 386
checklist for, 379
commands and options, examples, 385
preparing for, 378
using CLI, 380
verification of, 386

SA command line interface, 300
Server Agent on VMware virtual machine, 180
Server Agents

using ODAD, 76

Internal Gateway Error
Agent to Command Engine (CE), 362
Agent to Data Access Engine (DAE), 367
Agent to Software Repository (SWR), 372
Command Engine to Agent (AGT), 357

IP addresses
configuring for servers, 278
management IP

definition of, 226
viewing, 227

primary for servers, setting, 228
primary IP, definition of, 226
searching for servers by, 214
setting for servers, 228

IP ranges
overview, 277

J
jobs

scheduling for servers, 265
time outs for, 267

jump, 408

L
LANG environment variable, 295

LC_CTYPE environment variable, 295

local zone. See Solaris zone

loginToServer, 408

M
Machine ID Match (MID)

MID mismatch, 373
OK, 373
unexpected error, 373
untested, 373

management IP
definition of, 226

managing
custom attributes, 270

Microsoft Hyper-V/VMM, 155

Microsoft Terminal Services, 54

modeling, public server groups, 233

moving
device groups, 142

My Customers, overview, 23

My Jobs
Browsing job logs in the SA Client, 56
Communication Test, 93
overview, 22

My Profile, overview, 26

My Servers
overview, 27
servers, adding to, 200
servers, removing from, 201

N
Name Resolution Error On Gateway

Agent to Command Engine (CE), 362
Agent to Data Access Engine (DAE), 367
Agent to Software Repository (SWR), 371

NAT tables
changing, affects of, 229
See also static NAT.

navigating
SA Client, 35
SAS Web Client, 23

navigation panel, overview, 26

network
configuring for servers

overview, 278

network scripts, 406, 407, 409

no callback from Agent, Agent to Command Engine 
(CE), 363

nodes
configuration tracking policies for, 331
entries for configuration tracking, overview, 335

No Gateway Defined
Agent to Command Engine (CE), 361
Agent to Data Access Engine (DAE), 366
Agent to Software Repository (SWR), 371

non-global zone, 157

notifying, jobs, 266
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OK

Agent to Command Engine (CE), 359
Agent to Data Access Engine (DAE), 364
Agent to Software Repository (SWR), 368
Command Engine to Agent (AGT), 354
Crypto Match (CRP), 358
Machine ID Match (MID), 373

Old Agent Version
Agent to Command Engine (CE), 361
Agent to Data Access Engine (DAE), 365
Agent to Software Repository (SWR), 369

opening
remote terminal, 102, 127
remote terminal, managed server to, 298
remote terminal session, unmanaged server, 82

options
SA Client, accessing, 49
unmanaged servers, SA Client, 50

OS provisioning
during virtual machine creation, 174
VMware virtual machine, 180

P
packages

viewing
installed packages, 114

passwords, selecting, 20

performing
manual backups of tracked configurations, 341
sequences for CDR, 326
services, synchronizations, and sequences, 

overview, 315
services by hostname for CDR, 325
services by service name for CDR, 323
synchronizations for CDR, 317

permissions
ODAD, required for, 76
server groups, required for, 230
setting

Global Shell permissions, 401

physical server, 156

port open on managed server, verifying, 374

preferences
general options, SA Client, 49
terminal and shell, SA Client, 52

preparing, installing Agents, for, 378

primary IP, definition of, 226

private, server groups, 232

private device groups, 130

properties
editing for servers, 259
servers, overview, 253

public, server groups, 232

public device group, 129

push, 408

PuTTY, 53

Q
QNumber, 115, 116, 148

R
RDP, 53

reach, 408

Realm is Unreachable
Agent to Command Engine (CE), 361
Agent to Data Access Engine (DAE), 366
Agent to Software Repository (SWR), 370
Command Engine to Agent (AGT), 356

rebooting a server, 126

reconciling, customized tracking policies, 340

registry (Windows), browsing, Device Explorer, 120

remote shell
modes of operation, 408
options and commands, 406
overview, 406

remote terminal
opening

managed server for, 298
overview, 102, 127
unmanaged servers to, 82

overview, 297

removing
Agent, UNIX and Windows, 387
earlier versions of Agents from servers

UNIX, 388
Windows, 389

servers
from My Servers, 201
from server groups, 246, 247
from service levels, 276

servers from a device group, 134
Solaris zone, 173
VMware virtual machine, 182

renaming files, Device Explorer’s File System of, 119

reports
overview, 221

Request Time-out, (AGT), 355
430



resolving
hostname, 376

restarting, an Server Agent, 375

restoring
backed up files for configuration tracking, 348
code and content from old version for CDR, 321
tracked configurations, 348

rolling back
code and content to previous version for CDR, 

322
restored files for configuration tracking, 350

rosh. See remote shell.

rsync, 292

RunCommandOnServer, 408

running
Communication Test

individual server, 89
multiple servers, 90

S
SA

Code Deployment & Rollback, features, 312
supported operating systems, 194

SA Client
accessing, 35
general options, 49
Hyper-V partition management, 183
options, accessing, 49
overview, 29
terminal and shell preferences, 52
unmanaged servers options, 50

SA model space, 283

SAS Web Client
accessing, 21
administration features, 25
Code Deployment, in navigation, 25
Environment, in navigation, 25
Home page, overview, 24
icons for servers, defined, 96, 253
icon tooltips, 27
My Customers, overview, 23
My Jobs

in navigation, 24
overview, 22

My Servers, overview, 27
navigating, overview, 26
navigation panel, overview, 23
Reports, in navigation, 25
server lists, filtering, 199
Servers, in navigation, 24
Software, in navigation, 24

tasks, overview, 22
ways to search, 202

SAS Web Client. See SAS Web Client.

scan timeout (SAV), 56

scheduling
server jobs, 265
time outs affecting, 267

scp, 292

searching
details, 212
examples of, 214
IP addresses, 214
overview, search feature of, 27
Search box, 201
search feature, 202, 212
unreachable servers, 92
ways to, 202

security
Server Agents, on servers, 65
server management, 65

selecting, passwords, 20

sequences
performing for CDR, 326

server
deactivating, 126
rebooting, 126

Server Agent
Communication Test, 84
installing, using ODAD, 76
installing on Solaris zone, 171
installing on VMware virtual machine, 180
limits of functionality on servers, 65
overview, 63
restarting, 375
server data tracked by, 66
starting and stopping, 70

server groups
adding, servers and server groups to, 245
characteristics, 231
creating, 236

dynamic groups, 238
static groups, 236, 237

criteria for search, 239
duplicating, 248
modeling, public groups, 233
overview, 230
permissions, required, 230
removing, servers and server groups to, 246, 247
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types
dynamic, 232
private, 232
public, 232
static, 232

using, server search, 239

server life cycle, SA, 250

server lists
filtering, 199
overview, 197

server management
functions, 225
notifying, jobs, 266
scheduling, tasks, 265
server life cycle tasks, 258

Server Not Registered, Command Engine to Agent 
(AGT), 356

Server Pool
overview, 197

servers
asset tracking, overview, 193
assigning to service levels, 276
association with customers, 219
changing, use and stage values, 259
changing value, custom field for, 269
cloning, 262
configuration tracking, entries for, 335
configuration tracking policies, customizing, 336
configuration tracking policy, 331
custom attributes, deleting, 272
data tracked by Server Agents, 66
deactivating, 260
deleting from SA, 261
DHCP, configuring, 279
domains for Windows servers, changing, 279
filtering in server lists, 199
histories, viewing, 221
history, unmanaged server of, 81
identifying, 216
installing Agents

augmenting, 386
verifying, 386

jobs
scheduling, 265

management of, 197
My Servers, removing from, 201
network configuration

configuring, 278
overview, 277

opening, remote terminal, 102, 127
opening remote terminal sessions, unmanaged 

server to, 82
pre-assimilation checklist, 379

preparing for installing Agents, 378
primary IP addresses, setting, 228
properties

editing, 259
overview, 253

Search box, using, 201
search feature, using, 202
searching by IP address, 214
searching for, 201
See also server groups.
service levels, removing from, 276
swapping disks, examples, 217
tracking policies, viewing, 339
viewing

packages, 114

server search, using, 239

Service Automation Visualizer (SAV)
virtualization settings, 55

service levels
adding individual, 273
assigning servers to, 276
editing, 274
overview, 273
removing, servers from, 276
ways to view for servers, 274

services
CDR, overview, 320
code deployment, accessing, 322
overview, 120
performing by hostname for CDR, 325
performing by service name for CDR, 323

setting
Global Shell permissions, 401
primary IP address, server of, 228

setup for servers
pre-assimilation checklist, 379
preparation for installing Agents, 378

sftp, 292

Software Policies, browsing, Device Explorer, 108

Solaris 10 operating system, 155

Solaris zone
creating, 170
properties, 167
rebooting, 171
removing, 173
Server Agent installation, 171
starting or stopping, 172
type of virtual server, 156
zonecfg command, 170

specifying
deployment actions, ODAD in, 71
login settings, ODAD in, 71
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ssh, 289

stage values, overview for servers, 259

static, server groups, 232

static device group, 130

static NAT
changing NAT tables, affects of, 229
code deployment and rollback, use with, 228

SunOS 5.10, 157

supported, browsers, 19

supported operating systems
for managed servers, 194

synchronizations
performing for CDR, 317
site code and content, overview, 315

T
telnet, 53

time outs
server management jobs, 267

transcoding, 296

troubleshooting
unreachable servers, 353

Tunnel Setup Error
Agent to Command Engine (CE), 362
Agent to Data Access Engine (DAE), 366
Agent to Software Repository (SWR), 371
Command Engine to Agent (AGT), 356

types of, server groups, 231

U
Unexpected Error

Agent to Command Engine (CE), 360
Agent to Data Access Engine (DAE), 364
Agent to Software Repository (SWR), 368
Command Engine to Agent (AGT), 354
Machine ID Match (MID), 373

uninstalling
Agent, UNIX and Windows, 387
earlier versions of Agents from servers

UNIX, 388
Windows, 389

Untested
Agent to Command Engine (CE), 360
Agent to Data Access Engine (DAE), 364
Agent to Software Repository (SWR), 368
Command Engine to Agent (AGT), 354
Crypto Match (CRP), 358
Machine ID Match (MID), 373

updating, user profile, 20

upload, options for CLI, 303

uploading
code and content to staging for CDR, 311

user profile, updating, 20

use values, overview for servers, 259

using, server search, 239

V
verifying

agent is running, 374
port is open on managed server, 374

viewing
backup histories for configuration tracking, 342
contents, Device Explorer’s File System of, 117
history

server, 222
unmanaged server of, 81

job details in the SA Client, 265
job details in the SAS Web Client, 263
list of backup events for configuration tracking, 

343
managed servers by communication status, 92
My Jobs, Communication Test, 93
packages, 114
server’s configuration tracking policies, 339
service levels, ways to, 274
status of previous CDR operations, 328

Virtualization
supported platforms, 155

Virtualization Director
scan time out preference, 56
virtualization settings, 55

Virtualization Service, 156

virtual machine. See VMware virtual machine

virtual server
definition of, 156
refreshing, 168
relationships, 167
scheduled tasks, 190
searching, 167
Solaris zone, 156
viewing, 167, 168
VMware virtual machine, 156

VMware ESX Server, 155, 176

VMware virtual machine
console, 180
creating, 173
OS provisioning, 180
power on or off, 181
properties, 167
removing, 182
433



reseting, 181
Server Agent installation, 180
suspending, 181
type of virtual server, 156

VS. See Virtualization Service., 156

W
Windows servers

changing, domains, 279

working with
Device Explorer’s File System, 117

Z
zone. See Solaris zone

zonecfg, 170
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